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Radio and television 
interference 

The equipment described in rh is manual generates and uses radio-frequency 
energy. If ir is nor installed and used properly-that is, in strict accordance wi th 
Apple's instructions-it may cause interference with radio and television 

reception. 

This equipment has been tesred and compl ies with the limirs for a Class B 
computing device in accordance wid1 the specifications of Parr 15 of FCC 
ru les. T hese specifications are designed to provide reasonable protection against 
such interfe rence in a residential insrallation. However, there is no guarantee 
d1ar the interfe rence will not occur in a particular installation. 

You can determine whether your computer is causing interference by turning it 
off. If the interference stops, it was probably caused by the computer or one of 
the peripheral devices. 

If your computer system does cause interference to radio or television 
reception, ny to correct the interference by using one or more of the following 

measures: 

• Turn the television or radio antenna until the interference stops. 

• M ove the computer to one side or the other of the television o r radio. 

• Move the computer f..1rther away from the television or rad io. 

• Plug the computer into an oudet that is on a d ifferent circui t from the 
television or radio. (T hat is, make certain the computer and the television or 
radio are on circui ts controlled by different circuit breakers or fuses.) 

• Consider installing a roofrop television antenna with a coa.x.ial cable lead-in 
between the antenna and the television. 

If necessary, consult your autho rized Apple dealer or an experienced 
radio/television technician fo r additional suggestions. You may fi nd helpfi.tl the 
following booklet, prepared by the Federal Communications Commission: 
How to Jdentifj and Resolve Radio-TV Imerforence Problems (stock number 004-
000-00345-4). T his booklet is avai lable from the U.S. Government Printing 
Office, Washington, D C 20402. 

~ Important: T his product was tested for FCC compliance under conditions that 
included the use of shielded cables and connectors between system components. 
Ir is important that you use shielded cables and connectors to reduce the 
possibi lity of causing inrerference to radios, television sets, and other electronic 
devices. For Apple peripheral devices, you can obtain the proper shielded cables 
from your authorized Apple dealer. For non-Apple peripheral devices, contact 
the manufacturer or dealer fo r assistance. 6. 



Preface 

About This Book 

te Macintosh Reference is your sourcebook for using the 
Macinrosh® computer. This manual is a "working reference" 
-that is, it provides step-by-step instructions for all the tasks 
you are likely to perform with the computer. 

No matter which Macintosh model you use, the primary 
operations and tasks yo u perform with the computer work the 
same way, and all of them are covered in this book. 

One procedure not covered here, however, is the setup of your 
Macintosh system. Consult the booklet Setting Up Your 
Macintosh for the instructions you need to set up yo ur computer 
hardware. 

}.'V 
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What you should 
know to use 

this book 

How to use 
this book 

Complete information 
for each task 

You ca n use the Macintosh Reference most effi ciently if you are 
already fami liar with the Macintosh , because this book's 
instructions are concise and specific. If you' re new to the 

Macintosh (or to using any computer), it's a good idea to go 
through the tutorial book, Getting Started With Your Macintosh, 
or the traini ng d isk, Macintosh Basics, o r bo th. 

But even if you' re not fam iliar with the Macintosh, this reference 

book will give you the info rmation you need to perform a wide 
variety of tasks . By s imply following the prominently numbered 
steps, you can work your way through any task-whether it's 
new to yo u or a task you 've done before for which you need a 
quick review. 

As noted previously, the Macintosh Reference is o rgan ized 
accord ing to a variety of tasks that you perfo rm when working 

with your Macintosh. 

Each task is presented as a set of steps. Each step consists of 
boldface text and an illustration , side by side; the steps are 
numbered with large numerals. 

When you turn to a task in this book, the numbered steps 
provide the complete instructions you need to acco mplish that 
rask. 

Preface: About This Book 



Two ways to locate tasks The tasks in this book are grouped in major categories according 
to the work you do with the Macintosh-creating and editing 
documents, managing files, printing documents, working with 
disks, and so forth. 

Review of 
Macintosh fundamentals 

Summaries for expanding 
your Macintosh system 

Two pans of the book will help you quickly locate the tasks you 
want to do: (1 ) the table of contents, which lists the major 
categories of information and the names of all tasks, and (2) the 
comprehensive index, which lists each task under several 
different terms that you might think of in relation to that task. 

Chapter 1, "Standard Macintosh Operations," provides a brief 
review of the fundamentals-using the mouse, working on the 
desktop, using menus, basic editing, and so on. 

If your Macintosh experience is limited, you can use Chapter 1 
as a "refresher course" any time you need its help. 

Chapter 7, "Using the Macintosh on a Computer Network," 
and Chapter 9, "Expanding Your Macintosh System," provide 
summaries of the procedures involved in adding your computer 
to a net\vork and adding new components to your computer 
system. The instructions in these chapters are intended for quick 
review, and should be used with the documentation for the 
components yo u're adding to your system or network. 

A note about illustrations Some illustrations of the Macintosh screen include lists of 
options, such as the choices available for your Macintosh model 
when you install the system software or partition a hard disk. The 
lists reproduced in this book may differ from those that appear 
on your screen when you perform a task, because the options 
available vary from one model to another. 

How to use this book xvii 
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Some conventions 
used in this book 

The primary information in this book is presented as step-by­
step instructions for each task. All steps are numbered, and all 
actions are described in boldface type. 

The Macintosh lets you do many actions in more than one way, 
such as choosing a command from a menu or typing a 
combination of keys on the keyboard to initiate the command. 
This book provides step-by-step instructions fo r one method 
and advises you of other methods. 

•:• Another way to perform this action: C heck paragraphs that 
begin wirh this symbol ( •:•) for alternative methods of raking 
an action. •:• 

Because many tasks are related to other tasks, this book contains 
numerous cross-references. These cross-references always appear 
at the end of the related section, and they are preceded by their 
own typographic symbol, an arrowhead. H ere is a sample. 

)o- See also: • "Changing the Highlight Color" in Chapter 8 

Look for these other visual cues throughout rhe manual: 

6 Important: T ext set off in this manner presents important 
information. 6. 

A Warning: Warnings like this one alert you to situations in 
which you might damage your equipment or lose clara if you 
don' t follow the instructions carefully . .&. 

Preface: About This Book 



About the other 
learning 111aterials 

The lv!acintosh Reference is parr of the learning materials provided 
with your Macintosh. The other books and disks in this set include 

• the booklet Setting Up Your Macintosh, which provides 
instructions for hardware setup for the Macintosh model 
you have. 

• the tutorial book Getting Started With Your Macintosh, which 
provides insrmcrions for novice users and explains many of the 
concepts associated wid1 using a Macintosh computer. 

• the training disk Macintosh Basics, which provides hands-on 
instruction and practice for new users of the Macintosh. T he 
training disk and the tutorial book cover much of d1e same 
material; you can use one o r both, according to your preferred 
style of learning. 

• the booklet Special Features of Your Macintosh, which describes 
the special options and technical specifications of your 
Macintosh model. 

If you have a Macintosh Portable, you' ll find the information 
about your computer's special features in the Macintosh Portable 
Handbook. 

• one or more additional training or information d isks, depending 
on d1e Macintosh model. 

You can choose from these learning materials as your experience and 
information needs require. 

About the other learning materials xix 





Chapter 1 

Standard Macintosh 
Operations 

t e Apple® Macintosh® computer is designed for ease of use 
and learning. Ic presents you with a simulated desktop on your 
screen, where you can see and manipulate icons-graphic 
depictions of documents, disks, file folders, and the other parts 
of your system and the information you work with. (See 
Figure 1-1.) 

. " Application~/ 
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Teach Te-x t 
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1con D 
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Figure 1-1 Examples of Macintosh icons 
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Most important, you use abour two dozen simple operations to 

work with your Macintosh, and these operations are the same 
regardless of the program you' re using or the task you' re 
performing. 

This chapter introduces the standard Macintosh operations and 
provides brief, illustrated instructions for performing each one. 
If you are new to the Macintosh, you will probably want to use 
the tutorial, Getting Started With Your Macintosh, or the training 
disk, Macintosh Basics, before reading this chapter. If you are 
familiar with the Macintosh, you may want to review this 
chapter before beginning yo ur work. 

Using the mouse You use the mouse-a kind of pointing device-to initiate most 
operations on the Macintosh. When you move the mouse on 
yo ur desk, a corresponding pointer- such as the arrow pointer 
or 1-beam pointer-makes the same movement on the screen. 
(See Figure 1-2.) 

= IW'\1 11-" 

Figure 1-2 Mouse and pointer movement 

Chapter I: Standard Macimosh Operations 



To initiate an action with rhe mouse, you place the pointer 
where you want rhe action ro rake place, then press and release 
the mouse butron (the mechanical button near the rop of rhe 
mouse) . This action is called clicking. (See Figure 1-3.) 

= ·-~~ 

Figure 1-3 Initiating an action with the mouse 

Pointing Pointing is simply moving rhe pointer onto an object or area on 
the screen. 

Using the mouse 

1 To point, firs t grasp the 
mouse and slide it across 

the table top, as you watch 
the pointer on rhe screen. 

The pointer's movement 
corresponds ro that of rhe 
mouse. 

3 



2 Continue moving the 
mouse until the tip of the 

pointer is on the item you 
want. 

If yo u run out of room, you 
can pick up the mouse and 
place it at another spot. T he 
poinrer on the screen will not 
move while the mouse is off 
the pad or other surface. 

Clicking Clicking initiates an action at the poinrer' s location. 

Chapter 1: Standard :VIacintosh Operations 

1 To click, first point to 
an object on the screen by 

moving the mouse. 

2 Without moving the 
mouse, quickly press and 

release the mouse button with 
your index finger. 



Double-clicking Double-clicking is a way to display the contents of an icon or 
document or ro starr an application by opening a window for it. 

1 To double-dick, first 
point to an object on the 

screen by moving the mouse. 

2 Without moving the 
mouse, press and release 

the mouse button twice in 
rapid succession. 

Dragging an icon Dragging allows you to move an icon on the screen as you move 
rhe mouse. 

LJ 
• 9E]' 
~ stacks 

L.:sing rhe mouse 

1 To drag an icon, first 
point to the icon you 

want to move and press and 
hold the mouse button. 

The object becomes 
highlighted when you press the 
mouse button; that is, irs 
appearance changes, usually 
from outline form to solid 
black (or other color) . 

5 



6 

An outline of the~ 
icon being dragged F-J 

shows its movement. ! ............. .'.' .... i L.J 

'lne highlighted , .......... ; ~s 
icon stays in its T L.J 

original position 1 i1Wi 
RW HA" stacks while you drag. 

The highlighted---~ LJ 
object jumps to 
a new position 

when you release 
the mouse button. 

graphics 

stacks 

2 Move the mouse while 
continuing to hold down 

the button. 

An outline of the icon moves 
with the pointer, indicating the 
location of the icon as you drag. 

3 Release the mouse 
button when the move 

is complete. 

T he object remains 
highlighted when you 
release the burton. 

Selecting an icon 
or other object 

Selecting designates an object for action. When selected, the 
object appears highlighted. 

~ 
backup 3/4/90 

• bao::kiJ o 3/4/90 

1 To select an object, first 
point to the object you 

want to select. 

2 Click the object . 

W hen you press the mouse 
burton, rhe object becomes 
highlighted to show that it is 
selected. 

)oo- See ttlso: • "Changing rhe I-Iighlight Color" in Chap ter 8 
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Selecting multiple icons or 
objects in one area 

You can drag the pointer to select a gro up of icons or other 
objects thar are located in one area of the screen. A dashed 
rectangle indicates the area covered as you drag. 

~ddn.•sses 

g 
D 
notes budget90 

~ddresses 

g 
D 
nl)tes budget90 

- ------------~ 

1 To select multiple 
objects in one area, place 

the pointer near one edge of 
the group of objects, then 
drag diagonally over them. 

A dashed outline encloses the 
objects as you drag across 
them. Dragging diagonally 
from one corner of the area is 
most efficient. 

2 Release the mouse 
button when the objects 

you want to select are 
completely or partially inside 
the dashed outline. 

When you release the mouse 
button, the selected objects 
become highlighted. 

•!• Dragging is also used for: ( 1) selecting a group of items 
together in a list; (2) selecting text when editing; and 
(3) choosing a command from a menu. •!• 

... See also: • "Basic Editing on the Desktop" in this chapter 
• "Using Menus" in this chapter 

lsing the mouse 7 



8 

Selecting multiple objects 
in separate areas 

You can select objects that are not near each other by clicking 
each one while holding down the Shift key (called Shift-clicking) . 

i I "'=~ budq•t9~ 
notes ..Atz D 

T Project 
•l!!m-lj•N~MI!II_ .. 

1 To select multiple 
objects in separate areas, 

press down the Shift key (on 
either side of the main 
keyboard area) . 

2 While holding down 
the Shift key, click each 

object that you want to select. 

Each object becomes 
highlighted when you click it. 
Clicking an already-selected 
object with the Shift key held 
down deselects (removes the 
highlighting from) that object. 

•:• Shift-clicking is also used for: selecting multiple items in 
separate places when the contents of a window are displayed 
as a list. •:• 
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\VJ or king on 
the desktop 

You use the standard mouse operations to manage rhe objects on 
rhe desktop. Most icons can be opened as windows, and yo u can 
have multiple windows displayed at rhe same rime. You can also 
move the windows, change their size, and change rhe window in 
which you are working. (See Figure 1-4.) 

Icon dimmed. Zoom box (used to open 
window to full size) indic:ning that it's 

open, :tnd 

Close box (used to L "OJ rue Edit u1ew Spcclol 

close window) __.liJ Trees 

1
1'2Urms / 11,49SKYtdlsY. 

Tille bar (used to -l==;=::r---.....:.-----:----m 
00 CJ move window; 

lines show that 
window is active) 

S..•h m ''"" Ej Appll"t~n ,..,.r'"" 

for~!...., '"''"~'" 
CJ ~ 

or t 

from W., 0 
SV..t.'s r'tfOrt D 

LJ ~ It Dnonrlprt:lort 

_ Inactive window 
showing contents of 
the ··art" icon • ..,..,,u,. ~ l llri------H 

"';J~,·P_M_ .. _. _ _ Tt_"_h·_ .. _· ----------,,r?f.'Q~(;fl '1 11&1!11 
I Active window displaying 
contents of '·Trees'· icon 

Size box (used to 
change window size) 

Figure 1-4 Two open windows on the desktop 

Opening an icon T he quickest way to open an icon is to double-click ir. 

Working on the desktop 

1 To open an icon, first 
point to the icon. 
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2 Double-dick the icon. 

If the icon does not open, you 
may not have clicked quickly 
enough. Double-click again, 
with the second click 
fo llowing the first as rapid ly as 
possible. 

·:· Another way to open an icon: You can also select an icon and 
use the O pen command in the File menu. ·:· 

>- See aLso: • "Setting the Double-Clicking Speed" in C hapter 8 

.\1oving a \\' inclow Yo u drag a window's ride bar ro move the window. 

§0~~ Memo_ 

TO: P.Jl Staff 

FROI·,I : Program direc 

......................... ................................................... .. , 

the window 

Memo 

TO: All Staff 

FROivl : Program direc 
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1 To move a window, 
point to the window's title 

bar and drag. 

T he pointer and an outline of 
the window move as you drag, 
indicating the new location. 
T he window remains in its 
original position until you 
complete step 2. 

2 Release the mouse 
button when the outline 

reaches the location you want . 

The window moves ro the 
location of the outline when 
you release the button. 



Resizing a window You use rhe size box in rhe lower-right corner to change a 
window's size or shape. 

the window 

Working on the desktop 

1 To resize a window, 
point to the size box in 

the lower-right corner and 
drag. 

Dragging verrically changes 
height; dragging horizonrally 
changes width; dragging 
diagonally changes both 
dimensions. The poinrer and 
an outline of the window's 
borders move as you drag, 
indicating rhe new dimensions. 

2 Release the mouse 
button when the outline 

indicates the size you want. 

The window changes to the 
size of the outline when you 
release the burton. 

11 
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Enlarging a window 
to full size 

T h e zoom box at the right end of a window's tide bar offers a 
quick way to resize a window to its largest standard size (it 
covers most of the screen). 

illlil 

1 To enlarge the window 
to full size, point to the 

zoom box at the upper-right 
corner of the window. 

2 Click the zoom box 
to expand the window. 

T o return the window to its 
previous dimensions, click the 
zoom box again. 

Making a window active The active window is where yo ur actions take place. W hen E\vo 
or more windows are displayed, only one of them can be active 
at a nme. 

You can tell an active window by the horizontal lines in its 
tide bar. 

1 ,636K availablo? Y 
{}. 163K in c 

1:~: 

Cbaplcr J: S!anclarcl Macintosh Operations 

1 T o make a window 
active, first place the 

pointer anywhere inside the 
window. 

Any parr of the window 
will do, even if most of the 
window is hidden. 



2 Click in the window 
to make it active. 

T he window moves to the top 
layer on the screen. Lines 
appear in the tide bar. 

•!• Another way to make a window active: If yo u can' t see the 
window you want to make active, you can double-cl ick the 
icon it belongs to. 0/ ou may have to make the currendy 
active window smaller to see the icon.) •!• 

Closing a vvinclmv You use the close box in the upper-left corner to close a window. 

78 itl?ms 

Application Progr arns 

1 To close a window, 
point to the close box at 

the upper-le& corner. 

2 Click the box 
to close the window. 

T he icon remains selected a&er 
rhe window closes. 

•!• Another way to close a window: Yo u can use the Close 
command in the File menu to close the active window. •!• 

Working on the desktop 13 
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Discarding an icon You can clear an icon from the desktop by dragging it to the 
Trash, located at the bottom-right corner of the desktop. To 
erase that icon's content, however, you have to choose the Empty 
Trash command from the Special menu . 

.&. Warning: The Trash is emptied automatically when you shut 
down or turn off the computer, when you start a program, or 
when you eject a floppy disk from which you discarded any 
Items. .&. 

Highlighted --l!~iiii]lij!filiffil1~~~ 
T msh container 

(shows the pointer 
has re;tched it) 

'f'hc pointer must touch the icon for 
the Tmsh to accept the item. 
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1 To remove an icon, first 
drag the icon over the 

Trash so that the Trash icon is 
highlighted. 

The pointer and an outline of 
the icon move as you drag; the 
Trash icon becomes highlighted 
when the pointer reaches it. 



2 Release the mouse 
button when the Trash 

icon is highlighted. 

When you release the burton, 
the Trash icon bulges to show 
that something is inside ir; the 
icon is no longer highlighted. 

If you change your mind , 
simply open the T rash as you 
would any orher icon, and 
drag the icon yo u discarded 
back to irs original window. 

3 To erase the contents, 
choose Empty Trash from 

the Special menu. 

Once you empty the Trash, 
the discarded icon and irs 
content are gone. 

If you attempt to throw away a program or a locked document, 
you'll see a message on the screen. You have to confirm that you 
want to throw away any unlocked program, and the system 
won't let you discard a locked document or a program that's 
currently being used. 

•!• Another use for the Trash container: Yo u can eject a floppy 
disk from a disk drive by dragging the disk icon to the Trash. 
T his action does not erase the disk. •!• 

)o- See also: • "£jeering a Disk From rhe Deskrop" in Chaprer 6 
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Viewing 
the content 

of a window 

When you're working within a window, you can easily change 
your view of the conrent by scrolling. The amounr you see in 
the window at any one time depends on the window's size. (See 
Figure 1-5.) 

[}] 
S11 stf'l"i\ Fold•r 

CJ 
fOf' CI'I annln~ 

CJ 
from~ 

CJ 
Rotpc.rtsJl tU 

CJ 
fOI" I'fionl 

~ 
0 

llotn-Kalt 

Q 
0 

Sw.t.'s u~Of't 

~ 
Tuchl txt 

(shows relative 
location in window's 
total coment) 

Scroll arrow 

co~~~~~ ~~~~~~11~; ~::~ -E:::==:=:::::;:=ii=EI:::'c=ry=w=·ii=ld=o=w=h=as::tl::vo=s=·c:t:ro::ll=.b:arJs,::.iotn~U· 12: r
2

vL'ei
2
·t;l.Jcal scrolling and 

window's borders) one for horizomal scrolling. (For both. gray indicates more comem 
beyond window's borders: dem bar indkmes all com em is visible.) 

Scrolling through 
a window 

Figure l-5 Scrolling areas in an active windmv 

You can see the complete content of a window by scroll ing 
th rough ir. To scroll continuously, use the scroll arrows. 

The up arrow displays content above the window's top border; 
rhe down arrow displays content below the window's borrom 
border. T he left and right arrows d isplay contenr to the left and 
right borders of the window, respectively. 
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1 ,636K available 

1 ,636K available 

Accounts 

1 To scroll through the 
content of a window, first 

place the pointer on one of 
the scroll arrows and hold 
down the mouse button. 

The window's content moves 
to show rhe part that had 
previously been beyond the 
border in the direction the 
arrow points. T he scroll box 
also moves in the direction of 
the arrow. 

2 Release the mouse 
button when the part of 

the content you want is 
visible. 

•!• Another way to use the scroll arrows: Simply clicking a scroll 
arrow scrolls in increments of about one-half inch. ·!· 

Viewing tl1c content of a window 17 



18 

Scrolling to a specific part 
of a window 

You use the scroll box to see the window content correspondi ng 
to the box's position in the scroll bar. For example, when the 
scroll box is near the bonom of a window, you'll see what's near 
the end of the window's content. 

1 ,636K <~vailablo? 

Art de-pt. 
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1 To scroll to a specific 
part of a window, drag the 

scroll box in the direction of 
the content you want to see. 

The pointer and an outl ine of 
the scroll box move as you 
drag. 

2 Release the mouse 
button when the scroll 

box is where you want it. 

T he scroll box appears in the 
position where its outline had 
been when you released the 
button, and the window's 
content moves to reveal new 
content. 



Scroll ing the length or 
width of a window 

If the right or borrom scroll bar is white, then the entire content 
of the window vertically or horizontally is visible. Bur if the scroll 
bar is gray, then there's more to see. A gray scroll bar is active, and 
you can click in the gray area to see content beyond what's visible. 

206K available 

To Do 

206K available 

Done 

1 To display the next 
screenful of content, place 

the pointer in the gray area 
on the side of the scroll box 
where you want to see items 
that are not presently visible. 

2 Click once to display 
the next windowful of 

content. 

When you click, a new 
windowful of content is 
displayed and the scroll box 
moves to a new posmon. 

·:· Another way to see more of a windows content: Resizing the 
window to larger dimensions, if possible, displays more of its 
content. •:• 

Viewing the content of a window 19 
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Using n1enus Another of the standard Macinrosh operations is using menus. 

:o.-tenutitles 

Dimmed command 
(not a1•aibble) 

Edit menu 
(pulled down) 

W hether you are working on the desktop or in a program, you 
. . 

use menus 111 a consistent way. 

In addition, certain menus and core commands are provided as 
parr of all Macintosh softv<a re. T hese core elements include the 
Apple, File, and Edit menus and commands such as Cur, Copy, 
and Paste. (See Figure 1-6.) 

r • Fllo 11!1111 n ..... >!:Z Memo to Oeoters 

Cu i llliH 
Copy llliC 
Pas te llliU 
Clear 

We ore hOI . lhe ~uunaa.•m 
Select All llliA k tts. wh•4 -·--- to oil members or your sol es s torr. 

Pleose co Show Clipboard ld you need oddl t •onol copies or the kl l. 

Figure 1-6 \'lenu bar with the Edit menu pu lled clown 

Chapter l: Standard Macintosh Operations 

-
21 
Q 

{'\ 

'21 

:O,Icnu bar 
(menus pull dmm 
from here) 

:VIenu commands 
afTect whatever 
you·ye selected­
in this C<lSe, 

text to be edited. 



Pulling clown a menu The principal type of Macinrosh menu is called a pull-down 
menu. 

r 1--_.J_F_il_e_E1!'--t _U i_e_w 

Cut 
Copy 
Paste 
Clear 

3€H 
3€C 
3€U 

Select All 3€A 

Show Clipboard 

1 To pull down a menu, 
first point to the title of 

the menu you want in the 
menu bar at tl1e top of the 
screen. 

2 Press and hold the 
mouse button to open 

the menu. 

The menu closes when you 
release the mouse button. 

Choosing a You choose a command with the menu pulled down. 
menu command 

Cut 3€H 
Copy 3€C 
Pa ste 3€U 
Clear 
Select All 3€A 

Show Clipboard 

lsing menus 

1 To choose a menu 
command, fi rst puJI down 

the menu by pointing to its 
title and holding down the 
mouse button. 
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2 Drag the pointer to the 
command you want. 

1-lighlighted --­
command 

As you drag, a command that 
is not dimmed becomes 
highlighted when the pointer 
is on it. (Dimmed commands 
are not available and thus 
cannot be chosen.) 

(selected) 
Clear 
Select Rll 3€R 

Show Cli board 

Cut 

3 Release the mouse button 
to choose the highlighted 

command. 

Blinking indicates --­
that the command 

Copy 3€C 
Paste 
Clear 
Select Rll 

The command blinks in the 
menu, then the menu closes 
and the command takes effect. has been chosen. 

Show Clipboard 

•!• Another way to choose a command· Many commands have a 
keyboard equivalent, usually made up of the Command key 
(indicated by a propeller symbol), which is held down with 
one other key. Each of these keyboard shortcuts is displayed 
to the right of the command it represents in the menu. ·!· 

~ See also: • "Using Special Keys and Indicators on the Keyboard" in this 
chapter 

• "Adjusting the Blinking of a Selected Menu Item" in 
C hapter 8 
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Using a submenu Some menus have submenus associated with them. You use a 
variation of dragging to choose commands from the submenus. 
A submenu is indicated by a small black triangle pointing to the 
right, next to the command name. The submenu is displayed 
when you drag over the menu item to which it is subsidiary. 

Submenu indkmors 

Lsing menus 

Style [~ 
Justify ~ 
Spacing ~ 

./Plain 
Hold 
/folic 
Underline 
mrnuD~m@ 

"[i)[I(!](!)I!D 

Underline 
mrn£~D~m@ 
"[i) [ltlJ(!)I!D 

1 To use a submenu, 
first pull down its 

corresponding menu. 

A small triangle at the right of 
a menu item shows that the 
item has a submenu. 

2 Drag the pointer to the 
item with a submenu you 

want to open. 

When the item is highlighted 
in the menu, the submenu 
opens. 

3 Drag diagonally onto 
the submenu until the 

command you want becomes 
highlighted. 
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Blinking indicates -+--=---:--"'---7-

4 Release the mouse 
button to choose the 

highlighted submenu 
command. that the command 

has been chosen. 
Underline 
mrnQOnuu;J 
~Ill (l)(!](!)[!J'J 

The command blinks in the 
submenu, then the submenu 
and menu close and the 
command is iniriared. 

Using a pop-up menu Pop-up menus are similar ro pull-down menus, but they don' t 
reside in the menu bar. A common example is the pop-up menu 
that indicates levels of folders on a disk, in the on-screen box 
called a directory dialog box with which you sometimes open and 
save documents. (See Figure 1-7.) 

Pop-up menu (closed) 
Bold shadow indicates that 
this is a pop-up menu. 

Icon indicating ~~--__J:;~Siii~ii"B~ 
an open folder 

0 ABA 6/ 90 ~ 
0 ALA 10/ 90 
0 Mkt analysis 
o New policy 

= Main Disk 
12478K auailable 

[ Open ll ( !:j(H t ] 

(Cancel] ( Driue ) 

Figure l -7 A pop-up menu in a directorr dialog box 

This type of menu is used in some programs to choose serrings 
or variables such as color or units of measure. 1 
A pop-up menu can extend above or below irs tide, and some 
extend in both directions. T he item displayed as the menu ride -, 
is the item that is currently in effect. 
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Select a Document: 
Closed pop-up ---H-----1r::::::::--=---:---, 

menu (with open I o Speeches I 
folder icon) ~ 

Select a Document: 
Open pop-up menu --H----_____,~,; 

Levels of fl.les to _ _!J_-f--~ 
which the open 

folder is subsidiary 

Select a Document: 

o Speeches 
oTo Do 

1 To use a pop-up menu, 
first point to the menu's 

title and hold down the 
mouse button. 

The menu opens, showing 
some or all of the items 
available. (Some pop-up 
menus extend up as well as 
down from the tide; you drag 
upward ro see the additional 
items in such menus.) 

2 Drag the pointer to the 
item you want in the 

pop-up menu. 

The item becomes highlighted 
when rhe pointer is on it. 

3 Release the mouse 
burton to select the 

highlighted item. 

The pop-up menu closes and 
the item selected now appears 
as the menu ride. 

)o- See also: • "Moving Quickly Through Levels of Folders When Using a 
Program" in Chapcer 5 
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Responding to 
messages on 

the screen 

Disk name 
(this is a pop-up 

menu that shows 
the me levels) 

List box (used to 
select a document 
or folder to open) 

-

T he Macintosh has several standard ways of displaying messages 
on the screen. T he most common form of message is a dialog 
box, which requires that you choose an option or supply needed 
information before the Macintosh does what you want it to do. 

Some of the most frequently used commands on the Macintosh 
present dialog boxes. You can readily spot such commands, 
because their names are followed by three dots in the menu. For 
example, the O pen command in the File menu displays a 
directory dialog box, which shows a list of the files on the 
current disk or in the open folder. (See Figu re 1-8.) 

Bold border on a button indicates the 
choice if the Return key is pressed. 

Select a Document: 

I= BD's disk I 
D Letter t o Mom 

I 
=BD's disk 

CJ My EHpenses 3292K auailable 
•• I.Iu!.l . 
CJ Quotes-remodel I[ Dpen~U ( 1: j<~ < t 

CJ Remodel plans 
(Cancel ) ( Driue 

CJ Syst em Fo lder 
D Utilit ies Folder 10 

Figure 1-8 A directory dialog box 

> See also: • "Using Menus" in this chapter 
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Using a dialog box Yo u select items and choose options in a dialog box with 
standard operations-scrolling, pointing, and clicking. Here's 
how you would use the directory dialog box to open the 
document "Projects" in Figure 1-8. 

Select 11 Document: 

I= BD's disk I 
D Letter to Mom 
CJ MllclnTIIH EHpenses 
D Project' 
CJ Quotes-remodel 
CJ Remodel pl11ns 
CJ System Folder 
CJ Utilities folder 

Select 11 Document: 

I= BO's disk I 

= DD 's disk 
3292K IIIJIIilllble 

' !i~, r~1 1~ 
pi [concel ] !~ 
0 

1 To use the directory 
dialog box, first dick the 

name of the document or 
folder you want to open. 

The name appears highlighted 
in the list when you select it. 

2 Click the Open button. 

The dialog box disappears and 
the item you selected opens. 

•:• Another way to open a document or folder: Double-clicking the 
nam e of a document or folder in the list opens it. •:• 
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Using alert boxes Another type of dialog box, the alert box, is designed to keep you 
from mistakenly losing some of your work or discarding an 
application program. Its message warns you that you may be 
doing something you didn' t imend and asks that you confirm 
that you wam to go ahead with the action. 

n OK 

Many alert boxes also add a sound to warn you of a possible 
mistake. 

If you drag a program icon to the Trash (thereby discarding it), 
you' ll see an alert box like the one in the following steps. 

Are you sure you w ont to remoue the 
application "TeachTeHI " ? 

D (Cancel ) 

K OK It D ( Cancel ) 

1 To use an alert box, 
first read the message 

displayed and mal{e sure that 
you want to complete the 
action you initiated. 

2 Click the OK button to 
complete the action, or 

click the Cancel button to 
cancel the action. 

·:· Return key shortcut: You can press Return instead of clicking 
the OK bunon. (Pressing Return initiates the action fo r the 
butto n with a bold outl ine.) ·:· 

> See also: • "Serting the Alert Sound" in Chap ter 8 
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Basic editing 
on the desktop 

The Macintosh has a number of standard editing capabilities, 
which you can use on the desktop or in an application program. 
These built- in features allow you to change disk and documenr 
names with ease, to copy text or graphics between programs, and 
to save frequently used information for qu idc retrieval. 

This section introduces the fundamental text-editing operations 
you can use on the desktop or in programs. 

>- See fllso: • "Ediring Documents" in Chapter 3 

Changing all of You can easily change an icon's name. 
an icon's name 

• Insertion point -----,-----.,=-==::.....,..,:--:: 
(blinking) Archives 1 /9Cj 

Basic editing on the desktop 

1 To change an icon's 
name, first select the icon 

by clicking it. 

Selecting the icon also selects 
tts enttre name. 

2 Type a new name for 
the icon. 

When you begin typing, the 
new text appears in place of 
the old. T he insertion point­
a thin vertical line rhar marks 
the place of current activity­
blinks at the end of the texr 
you rype. 

29 



Selecting part of the 
text in an icon's name 

Archives 1 /90 

3 Place the pointer 
anywhere outside the icon 

and click. 

When you move the mouse, 
the pointer reappears. When 
you click, the insertion point 
disappears and the icon is 
deselected. 

•!• Another way to save an icon's name change: Pressing the 
Return key after typing new text for an icon's name saves the 
change; the icon remains highl ighted. ·:· 

You use dragging to select part of an icon's texr. Dragging across 
text is the way you select it in application programs as well as on 
the desktop. 

1 To select part of the text 
in an icon's name, first 

select the icon by cliclcing it. 

2 Place the pointer over 
the name. 

When you place the pointer 
!-beam poinler over the text portion of the 

icon, the arrow changes to an 
!-beam-a vertical symbol that 
resembles a capital lerter 'I'. 
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I 
Fromllohn & ,.Jirn 

I 
From~&Jim 

From 

3 Position the 1-beam 
just to the left of the first 

character in the section you 
want to select, and press and 
hold the mouse button. 

4 Drag the 1-beam over 
the part of the name you 

want to select. 

5 Release the mouse 
button when the 1-beam 

is just to the right of the last 
character in the part you want 
to select. 

•!• Selecting and deselecting text: When you're editing text o ther 
than icon names, you can extend selected text one character 
by pressing Shift- Right Arrow, and you can deselect one 
character by pressing Shift-Left Arrow. Repeat these actions 
as necessary to change the amount of text selected. •!• 
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Replacing selected text You simply type over selected text ro replace it. 
in an icon's name 

s 

1 To replace selected text, 
first select the text you 

want to replace. 

2 Type the new text you 
want to replace the 

selection. 
lnsenion point -----7--;,.,..-,,...,..,.-i 

T he selected text disappears as 
you begin typing. T he 
insertion point blinks at the 
end of the new text you type. 

(blinking) 

D 
s tationery 

3 Place the pointer 
anywhere outside the icon 

and click. 

When you click, the insertion 
point disappears and the icon 
is deselected. 

·!· Another way to save an icon's name change: Pressing the 
Return key after typing new text for an icon's name saves the 
change; the icon remains highlighted. •!• 
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Deleting selected text 
from an icon's name 

You use the Delete key ro remove selected text. (On some 
keyboards, this key is labeled Backspace rather than Delete.) 

Lond 

1 To delete text &om an 
icon's name, first select 

the text you want to delete. 

lnserlion roim -------.-~~ 

2 Press the Delete or 
Backspace key to delete 

the selected text. 

(blinking) 

London 

The selected text disappears; 
the insertion point blinks at 
the place where text was 
deleted. 

3 Place the pointer 
anywhere outside the icon 

and click. 

When you click, the insertion 
point disappears and the icon 
is deselected. 

·:· A nother way to delete text: You can also use the Cut command 
or Clear command in the Edit menu ro delete selected text. 
Cut removes text and places it in the computer's memory in 
an area called the Clipbom·d, from which it can be pasted 
elsewhere. Clear simply removes the cexr. ·:· 

> See also: • "Deleting Texr and Images" in Chapter 3 
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Inserting text in You can easily insert text without deleting what's already there. 

an icon's name 

I lnscnion point -------;-----:--
0Jiinking) Invoice- 11 2/1 /89 

I lnsenion poim -------= 
(blinking) Invoice- #211 2 I 1 /89 

Inscned text If 

Invoice #2 12/1 / 89 
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1 To insert text in an 
icon's name, first select 

the icon. 

2 Place the 1-beam pointer 
at the spot in the name 

where you want to insert text 
and click. 

A blinking insertion point 
appears at the spot where you 
clicked. 

3 Trpe the text you want 
to msert. 

As you type, the text on either 
side of the insertion point 
moves to make room fo r the 
new characters. 

4 Place the pointer 
anywhere outside the icon 

and its name and click. 

When you click, the insertion 
point disappears and the icon 
is deselected. 



Using the 
Control Panel 

section in use­
the General section. 

You can change many of the standard settings for your 
Macintosh by using the Control Panel. This panel operates as a 
desk accessory, a "mini-application" that is available no matter 
what other work you're doing with the computer. 

The Control Panel has several different sections; the ones 
included with your system depend on the model of the 
Macintosh you use. For example, if you have a Macintosh Ilci 
with a color monitor, you will have sections of the Control Panel 
for the monitor and for color, as well as cl1e standard sections for 
the keyboard, mouse, and general settings. 

Figure 1-9 shows the General Control Panel. 

Desktop Pattern 

Rate of Insertion 
Point Blinking 

.... , .... 
0@0 

1'::::·:-o>:·:·:·>:::;t 

Other icons {eyboard 

represent sections ... >. 

of the Control Panel iOJ 

Menu Blinking 

~ 
~ 

Slow Fa; t 

Time (9 
5:20:49 PM 

7-
6-
5-

@12hr.024hr. 4-
av;ulable for thts Mouse 

0 0 0 @ Date llliJ Macintosh. 
Off 1 2 3 7/29/90 

RAM Cache I32K I I;J 0 @ 
On Off 

Figure 1-9 The GenerJI Control Panel 

Using the Control Panel 

Speaker 
Volume 
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Control Panel actions The settings you can adjust in the Control Panel include: 

Opening the 
Control Panel 

• pattern and colors on the desktop 

• speed of blinking of selected menu items 

• speed of blinking of insertion point for editing 

• date, time, and display of time as 12-hour or 24-hour clock 

• speaker volume 

• size of RA1v1 cache 

• rate of character repetition when a key is pressed 

• movement of the pointer from one monitor to another 

• disk drive to be used for startup of system 

• sound w be used for warning from system 

~ See also: • "Basic Editing on the Deskrop" in this chapter 
• "Specifying Irems to Be Opened at Startup" in Chapter 2 
• ''Adjusting the RAM Cache" in Chapter 3 
• "Installing a D esk Access01y" in Chapter 8 

Like other desk accessories, the Control Panel resides in the 
Apple menu at the far left side of the menu bar. 

Alarm Clock 
Calculator 
Chooser 
Control Panel 
Disk Info 

Chapter 1: Standard Macintosh Operations 

1 To open the Control 
Panel, first open the 

Apple menu at the left side of 
the menu bar. 



Changing sections 
of the Control Panel 

About the Finder ... 

Alarm Clo cl< 
Ca lculator 
Chooser 

2 Drag the pointer to 
the Control Panel 

command, then release the 
mouse button. 

1l1e Control Panel appears. 1l1e 
General section of the Cono·ol 
Panel is always shown initially. 

You change Control Panel sections by selecting the icon for the part 
of the system you want ro adj ust at the lefr side of the panel. 

D 

m 
t1oniiors 

ill! 

111111 

1 To change sections of 
the Control Panel, first 

scroll if necessary to locate the 
icon for the section you want. 

2 Click the icon of the 
Control Panel section you 

want to display. 

\'X'hen you click, the section of 
the panel represented by rhe 
tcon appea rs. 

·:· SpeciaL sections of the ControL PaneL: If your Macintosh model has 
irs own special section of the Control Panel, refer ro the SpeciaL 
Features booklet or the Handbook that came wirh your computer 
for derails on using that panel. ·:· 
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Changing settings 
in the Control Panel 

For most settings, you click a button to make a change. 

A few settings, such as time and dare, are adjusted by selecting 
one of the existing numbers (the hour or month, for example) 
and then using small up and down arrows to change to the 
desired number. 

You adjust the speaker volume by dragging the bar up or down 
the numeric scale. 

Figure 1-1 0 shows the adj ustments in the General Control Panel. 

Clicking S:II'CS the 
pattern displayed. 

Clicking arrowheads ---;:::=====r-=~-ll-..----------, 
displays a new 

pattern. 

Clicking edits 
the pattern. 

Desktop Pattern 

Ratto of Insertion 
Point Blinking 

···· I···· 
0@ 

Slow Fast 

nuttons adjust the 
blinking mte. 

~---:=---+-- 13uttons select the 
12-hour or 
24-hour clock. 

Dragging adjusts the 
volume level. 

Buttons ad just 1 he --i~::--::--:::---c=-' 

7 -
6 -
5-
4-
3 
2-
1 -
0 -number of blinks. 

~----"-------"'q!-_::__J.._ Clicking a number 

RAMCache ~ 0 @ 
On Off 

Speaker 
Volumto 

Arrow~ adjust size of 
the RA.\1 cache. 

displays arrows for 
adjustment. 

Figure 1- l 0 :\djustnlCnls for seuings in the General Control Panel 

> See also: • "Adjus[ing [he RAM Cache" in C hap[cr 3 
• Chap[cr 8, "Personalizing Your Macimosh \'<fork 

Space" 
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Using the Chooser The Chooser is a desk accessory, supplied with the system 
software, that you use to specify which printer you will use. You 
also use the Chooser to select devices such as fil e servers on the 
Apple Talk® network system and to adjust some settings related 
to printing and ne[\vork use. (See Figure 1-11.) 

\lame~ of available 
devices (when type 
of device is selected Accounting 

HumBn Resources 1------t~r-- at left) 
External devices --++---'---' MBrketing 

SBies avaibble 

Zones (appear if 
several networks arc 

linked together) Appl eTel k 

Figure l-11 The Chooser 

Option available 
with .\-lultiFinder 

Your name 
(optional) 

ve-----1- AppleTalk must be 
active to use 
external devices on 
the AppleTalk 
network system. 

Opening the Chooser Like the Control Panel, the Chooser is a desk accessory. 

Alarm Clock: 

Using the Chooser 

1 To open the Chooser, 
first open the Apple menu 

at the far left side of the menu 
bar. 

2 Drag the pointer to the 
Chooser command, then 

release the mouse button. 

The menu closes and the 
Chooser appears. 
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Selecting a printer or other 
device in the Chooser 

You designate a primer or other device by selecting irs icon, irs 
location (if necessary), and irs name in rhe Chooser. 

40 

~ 
~ 

m 
~ 

AppleTalk 1.. . lmage'llriter 

; 
L1s..:rWrito.:r is - -+--·---r. 

the type of 
device selected. 

The network zone in 
which a J.aserWriter 

will be selected 

Appl eTal k Zones: 

CC4 Upper 
CC4-5th/North 

Se lec t a LaserWriter: 

Sales is the name of -~D 
the primer ~elec ted. 

1 Select the type of device 
you want to use by 

clicking its icon in the upper­
left area of the Chooser. 

2 If necessary, select the 
zone in which you want 

to use a device by clicking its 
name in the lower-left area of 
the Chooser. 

The list of zones appears only 
if your Macintosh is on a 
nerwork that is linked to other 
nerworks. 

3 Select the specific 
device you want to use by 

clicking its name in the list at 
the upper-right area of the 
Chooser. 

lc's a good idea to close the 
Chooser alrhough you can 
leave it open. 

Once you've selected the name of a device, such as a 
LaserWriret-®, yo ur Macintosh will use that device unril you 
select a differenr one with rhe Chooser. 
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Adjusting Chooser settings You also use the C hooser ro adjust three settings that relate to 
using a printer or a network device. You can 

• make Apple Talk active or inactive 

• turn background priming on or off (for M ulriFinderTM use) 

• enter or change your user name 

Figure 1-12 shows rhe adjustments for these settings. 

0 

".!5 . r· 
. ~ . 

ApplE'Shareo IMifljf§i 

Chooser 
Select a LaserWriler: 
Accounting 
Human Resources 
Merketi ng 
Sales 

10 
Setting for ~~=======+Background Pri nting: 0 On @ Off 

background printing 
(available only when 

using MultiFincler) 

Appl eTal k Zones: 
~ I I • User Neme: 

CC4-5th/North ill Cser name; some 
CC4-5th/South = l514i· nil n--1 network devices 

L::g=g=:==:::::~~=~=jN=s~=:=~~=:::::::o::m,!:_. __ A_P_Pl_er_a_l_k r,~ tnce~~tve :~~~o~;;;:~~·i~l;l~i~;~ 
space (if one is 

Senings for AppleT<llk supplied). 
(must be ;ICtivc to use 
network devices) 

Figure 1-12 Adjustments for settings in the Chooser 

O nce you've adj usted a Chooser setting, your Macintosh 
maintains that setting until you change it. 

»- See also: • "Managing Multiple Programs Using MulriFinder" 
in C hapter 3 

• "Priming W hile Using the Computer for Other Work" 
in C hapter 4 

• "Preparing the Macintosh System Softv;are for 
Nerv;orking" in C hapter 7 

• "Gaining Access man AppleShare File Server" in 
Chapter 7 
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Using special keys 
and indicators on 

the keyboard 

The Macinrosh keyboard resembles a typewriter keyboard, bur 
some of irs keys have special purposes. These special keys and 
their primary uses are summarized in Figure 1-13. 

Escape key-used for special 
purposes in some programs. 

Function ke~·-e-Jch of these can be 
assigned a command with a special progrJm. 

Control key-works in combination with 
other keys to provide shortcuts and 
modify other ad ions . 

GJ EJ Power On key-
rums on the Macintosh. 

= 
num 
lock 

D 
= 
caps 
lock 

= 
scroll 
lock 

Lights that are on when a 
locking key is engaged. 

Enter key-used in some programs; 
often has the same function as the 
Return key. 

. . -.-............................................................... ......... -................................... ~-....................................................... .. --................................................... . 

4l 

Option key-used in combination 
with other keys to produce 
special characters. 

Delete key- used to 
delete selected items. 

Command key-used in 
combination with other 
keys to initiate commands. 

Arrow keys-move the 
insertion point; often an 
alternative to the mouse. 

Figure 1-13 Special keys and indicators used on Macintosh keyboards 

The location of special keys varies on the different keyboards 
available for use wirh Macintosh models; some keyboards do nor 
include all of these special keys and lights. 

)o- See also: • Appendix A, "Keyboards and Character Sets" 
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Turning the 
I\1acintosh 
on and off 

Power switch locations 

AU Macintosh models have a power switch on the back of their 
cases. The location of the switch varies among different Macintosh 
models, however, and the switch is not the principal method for 
turning some models on and off. 

O n compact models-models with a built-in monitor-the 
power switch is located at the right rear side of the computer. (See 
Figure 1-14.) 

Power Sl\'itch 

Figure 1- 14 The power switch on the ~·lacintosh SE/30 
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Turning on £1 compact 
Macintosh model 

On modular Macinrosh models- models with separate 
monitors-the power switch is located on the left rear side 
of the computer. (See Figure 1-15.) 

Figure 1- 15 Power switch on tht: Macintosh Ilci 

One type of Macintosh, the Macinrosh Portable, does not have a 
power switch. It operates on batteiy power. 

You turn on a compact Macintosh model with the power switch. 

•!• Turning on an external hmd disk drive: If your system has an 
external hard disk drive, you must turn the external drive on 
before you turn on the Macintosh. Otherwise, the Macinrosh 
will not recognize the external drive. •!• 

> See also: • 'Troubleshooting" in Chapter 10 
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Turning on a modular 
Macintosh model 

The recommended way to turn on most modular Macintosh 
models is by pressing the Power On key on the keyboard. This key 
is located at the top of the keyboard and has a triangle symbol on it. 
On some keyboards the Power On key is rectangular; on others it is 
square. (See Figure 1-16.) 

GJ 
Power On key, Power On key, 
top center of keyboard top-right corner of keyboard 

Figure 1-16 The rectangular and square Power On keys 

If the Power On key does not work for your model, use the power 
switch on rhe back of the computer to turn the Macintosh on. 

•!• Turning on an external hard disk drive: If your system has an 
external hard disk drive, you must turn on the external drive 
before you turn on the Macintosh. Otherwise, the Macintosh 
will nor recognize rhe external drive. •!• 

)1-- See also: • "Troubleshooring" in Chapter 1 0 
• Appendix A, "Keyboards and Character Sets" 

Turning off the JVlacintosh The recommended way to turn ofF all Macintosh models is by using 
rhe Shut Down command in the Special menu. T his command 
signals the system software to prepare all files and disks in use for 
shutdown. 

The Shut Down command also turns off power in some Macimosh 
models. In other models, this command prepares the system for 
shutdown and then displays a message that the computer's power 
switch can now be turned of£ 

)1-- See also: • "Shutting Down the Computer" in C hapter 3 
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Chapter 2 

Starting Up 

Setting up your computer has two phases: the first is 
assembling the hardware components; the second is preparing 
the system software, which the Macintosh uses for its basic 
operanons. 

This chapter provides instructions for preparing the system 
software to work efficiently with all devices in your Macintosh 
system. 

If your system has a hard disk drive, you may want to review 
"Installing System Software," "Creating a Customized System," 
and "Specifing Items to Be Opened at Startup," later in this 
chapter. 

If your system has only floppy disk drives, you will probably 
want to review "Installing System Software," "Making an Extra 
Startup Disk," and "Creating a Small System." 
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Preparing the 
Macintosh hardware 

The precise steps in setting up your Macintosh hardware depend 
on which model of the computer you have. The setup guide, 
Setting Up Your Macintosh, that came with your model provides 
detailed instructions for purring the system together. 

48 

Preparing your 
system software 

If you set up the Macintosh and the computer or monitor does 
not turn on, see "Troubleshooting" in Chapter 10 for assistance. 

The system software manages Macintosh operations. It transmits 
information to and from disks, printers, and other hardware 
components, establishes and tracks files, and directs processing 
inside the computer. Most system software activity is invisible, 
but application programs-the software used for word processing, 
spreadsheets, and other specialized work-rest on the 
foundation system software provides. 

•!• System software already installed: If you purchased a 
Macintosh model with an internal hard disk drive, the system -
software was probably already installed at the factory. You'll 
recognize a ready-to-run Macintosh when you turn it on; 
after a few seconds you'll see a "happy Macintosh" icon, then 
the desktop will appear on the screen, with icons for the hard 
disk and the Trash. ·!· 

.6. Warning: If you received a hard disk with A/UX® installed on it, 
do not inirialize that disk; doing so will erase NUX. Instead, see 
the AIUX Installation Guide for instructions on installing system 
software. • 

You prepare the system software for your Macintosh by 
installing it on a disk and thereby crearing one or more startup 
disks-disks that contain the system software necessary to use 
your Macintosh model and the devices connected to it. 

Chapter 2: Starting Up 



Checking system software 
that is already installed 

Installing system software creates a System Folder that contains 
the system files, drivers, and other kinds of resources your 
Macintosh needs. Figure 2-1 shows the icons for a system file 
and a driver. 

fFil 
~ 

System Laser'w'riter 

Figure 2-1 Icons for a system file (System) and a driver (LaserWriter) 

If your system software is already installed, you can skip the 
installation steps. Bur it's a good idea to check the contents of 
the System Folder on your hard disk to verify that it contains the 
system files and drivers you need. 

The Macintosh icon ~c-..,~ I --t--_ 
indicates that this . . 

Open the System Folder and 
check to see that it contains 
icons for the devices used 
with your Macintosh. system has been System Folder 

installed. 
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Figure 2-2 shows the System Fo-lder for a Macimosh configured 
for a separate monitor and LaserWriter and ImageWriter® 
primers. 

System Folder l'5"f 
23 it toms 1 t 1252K in d1sk 7 ,767K available 

System files have a ----t~:::;:~:::::::::::~~:;:~:::::;~~~:;=~==~===l€;1-- Background 
Macinlosh icon. fl!Q1 fiQ I!Q1 ~ I[] ~ : printing 

8 8 8 8 ~ ·r controls 
Sys tom Findor Goneral MulliFind.,. BackgrOU\dor PrintMoni\or M ( 

Printer drivers -!---,-----,----....,, ',::!'' .•. 1, ;. using I I Multifinder) 

5: =r ~ l] m m :'li: 
l u tr Prep L~orWr lter lma.9tWritt r Monitors Star\.,; O.vloo DA Handlor i:;lt 

~ ~ (g) ~ B2li ~,~ .. ~ I 
Easv Acctss Scrapbook File Clipboard Fllo KO<Jboard Kty Layout Sound Mous• JO 

CJ r l i!Hiil ~iii:!'!~ ~m:m !i i.i!!'i!H! ~ ~~:m:mi ~mmw~ W!H'il !mmm ~ ~,, ,,m ~ m 1:1 ~ m.ul !!1'!1 ~:iu!i ~ ~m:! ~ r,u;l~ ~ 11:m Hi'! 1 i ~ ~ iWii! ~ c 1 1;11 

Separate 
monitor file 

Figure 2-2 System Folder contents for a Macintosh with a separate monitor 

If your System Folder does not co main drivers for optional 
devices used with your Macintosh, you can add the necessa1y 
ones. 

You can add some drivers- including the ones for the 
LaserWriter II, Image Writer II, and Apple Scanner-during the 
reguJar installation process or by copying them imo the 
System Folder. 

Consult the documemation for the printer, scanner, or other 
devices connected to your Macintosh for information about 
which drivers they require and instructions for adding them to 
your system. 
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Installing system software You use the program named Installer to prepare the system software 
for your Macintosh model, either when you first begin using the 
computer or when you want m update your system with a new 
version of system software. 

To install the system software, you will need 

• the System Startup disk (which contains the Installer program) 

• the System Additions disk 

• an initialized hard disk or an initialized floppy disk 

If you are updating your system software with an upgrade kit, 
you will need the disks called System Tools, Printing Tools, Utilities 
Disk 1, and Utilities Disk 2. (You may not need to use both Utilities 
disks, however.) 

6 Important: Apple recommends one of two minimum hardware 
configurations for installation and use of System 6.0 or Iacer 
versions of the Macintosh system software: (l) a hard disk and one 
floppy disk drive; or (2) two floppy disk drives. (It is possible to 
install the system software on a Macintosh with one floppy disk 
drive, however.) 6 

The Installer provides two options-Easy Install and Customize. 
T hese instructions cover the Easy Install process, which is suitable 
for most Macintosh users. (To learn more about the Customize 
option, see "Creating a C ustomized System" later in this chapter.) 

e Important: Do not use the Installer while running MulciFinder; in 
some cases, doing so may cause installation to fail. 6 
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When you start rhe Installer, the software determines which 
Macintosh model you are using and prepares to install rhe standard 
software for rhat model. T he Easy Install process installs rhe drivers 
for all available printers on Macintosh models that have a hard disk. 

You begin the installation procedw-e wirh yow- Macintosh turned off. 

System Startup 

Chapter 2: Starling Up 

1 To install rhe system 
software, first put rhe 

System Startup disk into rhe 
internal disk drive, and turn on 
the computer. 

(Use the S;1stem Tools disk if you 
are updating you r system 
software wirh an upgrade ki r.) 

If your Macintosh has two 
internal drives, use the lower 
drive or rhe rightmost drive. 

2 If you do not have a 
hard disk, put an initialized 

floppy disk in the second drive; 
orherwise, go on to the next 
step. 

3 If necessary, double­
click rhe System Startup 

disk icon to open it. 

(If you have inserted the System 
Tools disk from an upgrade kit, 
double-click the System Tools 
icon.) 

...., 

-



~ 
Installer 

~ Welcome to the Apple Installer 

~ Your Macintosh n~ certain software to start up. 

The Instal ler places this software on your disk [}] 
In the System Folder. S.,sttm ''"" 

· Easy Install' chooses the software Apple r ecommends and 
creates a disk which can be used to start up your Macintosh. 

(' Customlze•if you are sure you want to override those 
recommendations.) 

Eosy Install r-- -·---·---··-·-· -·-·-·---- -· ·---·-·-.. -·--·--·-.. -·-----·-·-·-··-.. - ---......... ·-·-·- -.. - ... -···-·-··-.. ··-· 
I Click Install to place 

Parts of !he -+.+--i • Moclntosh system Sort ware 
1 [An updote to uerslon 6.0.6 or 

SV:>l~m solhvare ~ ~~ • Any eulstlng Prin ter Software ft lnstoll D 
10 be installed 

on the hnrd disk nomed 
Disk on which --!- = !lord dis~_::: ________________________ _ 

S)'Sicm software 
\\'ill b~ installed 

llelp 

llutton to switch to a diiTerent 
disk for installation 

[ E)<!d lllsk ) 

Switch Disk ) 

r--1_ customize J 
Quit 

Button to change to a 
customized installation 

Preparing your system software 

4 Double-click the 
Installer icon to open it. 

T he Installer's Welcome dialog 
box appears. 

5 Click OK to d ear the 
Welcome box. 

The Installer's prima.ty dialog 
box appears. 

6 Make sure that the disk 
indicated on the screen is 

the one on which you want to 
install the system. 

If the wrong hard disk or floppy 
disk is indicated, click the 
Switch Disk button until the 
correct hard disk's na.tne 
appears, or click Eject Disk to 

change floppy disks. 
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............................. .. ................................................... ...... ! 
i 

I 
K Install ~~ I 

i 

~-~ Please Insert the disk: 

t .... • System Additions 

I 

Stop 

Chapter 2: Staning Up 

7 Click Install . 

The Installer begins to install 
the system sofrware for your 
Macintosh model. On-screen 
messages list the disks needed 
and report copying status. 

8 When the System Startup 
disk is ejected and you see a 

message to insert the System 
Additions disk, insert the disk. 

(If you are updating your system 
sofrware with an upgrade kit 
and the System Tools disk is 
ejected, you are asked to insert a 
different disk; just follow the 
instructions on the screen.) 

Depending on the software 
needed for your system, you 
may be asked to switch disks 
more than once. 

Clicking the Stop button 
cancels the installation. 



0 
Installation on " Hard disl< #2" was 
successful. If you are finished, clicl< 
Quit to leaue the Installer. If you 
wish to do additional installations, 
cllcl< Con tinue. 

(continue ] n Quit ~n 

9 When you see a message 
reporting that the 

installation was successful, 
click Quit. 

The Installer window closes. 
(If for some reason the 
installation was not successful, 
you'll see a different message, 
and you can begin installation 
again.) 

1 0 Choose Restart &om 
the Special menu to 

begin working with your new 
system. 

The Macintosh restarts with 
the newly installed system. 

If you do not have a hard disk, 
you'll need to reinsert the 
newly created startup disk into 
a disk drive when you see the 
blinking question mark icon. 

You may see a dialog box 
asking you to name your 
Macintosh. Type a name and 
click OK. 

,... See also: • "Printing Colo r or Gray-Scale Documents" in 
C hapter 4 

• "Initializing and Naming a Disk" in Chapter 6 
• "Initializing and Naming a H ard D isk for rhe First Time" in 

C hapter 6 
• "Moving Fonts and Desk Accessories" in C hapter 8 
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Creating a 
customized system 

If your Macintosh uses devices that are not included in the standard 
software for its model, you can use the customized installation 
process to create or modify your system. 

Customized installation allows you to select the exact combination 
of system ftles, drivers, and other kinds of resources you want in 
your system, then installs them in your System Folder. You can use 
this process for initial system installation, for updating to a new 
version of system software, or for saving space on your startup disk 
by eliminating drivers that aren't essential. 

You begin the installation procedure with your Macintosh turned 
off. 

Chapter 2: Starting Up 

1 To create a customized 
system, first put the System 

Startup disk into the internal 
disk drive, then turn on the 
computer. 

(Use the System Tools disk if you 
are updating your system 
software with an upgrade kit.) 

If your Macintosh has two 
internal drives, use the lower 
drive or the rightmost drive. 

2 If you do not have a. 
hard disk, put an initialized 

floppy disk in the second drive; 
otherwise, go on to the next 
step. 



Syste-m Startup 

~ 
lnst.a lleor 

~ Welcome to the Apple Installer 

SJ Your Macintosh needs certain software to start up. 

The Installer places this software on your disk llJ 
In the System Folder. &jsttm ''""" 

"Easy Install" chooses the software Apple recommends and 
creates a disk which can be used to start up your Macintosh. 

("Customlze· if you are sure you want to override those 
recommendations.) 

~lnst~------·-------------- __ _ 

An updnto to Uorslon 6.0.6 of 

1

1 

Click I nstoll to plnce 

• Macintosh Syst em Softworo 
Disk on which 1 • Any eulsttng Printer Softwnre U Install J 

I 
system software 1 on the hord disk nnmed 

will be installed - H-o Hnrd Disk 
L.-------·--·--·------·-·--------·--·----·--·-·--

1 Ej<H I IHsk J 

Button to switch --:!------------------ [Switch Disk ) 
to a difTerem disk 

for installation 

Help 

- ( Customize J 

Quit 

Buuon to change to a 
customized installation 

Preparing your system software 

3 If necessary, double-
click to open the System 

Startup (or System Tools) disk 
ICOn. 

4 Double-click to open 
the Installer icon. 

The Installer's Welcome dialog 
box appears. 

5 Click 0 K to dear the 
Welcome box. 

The Installer's primary dialog 
box appears. 

6 Make sure that the disk 
indicated on the screen is 

the one on which you want to 
install the system. 

If the wrong hard disk or floppy 
disk is indicated, click the 
Switch Disk button until the 
correct hard disk's name 
appears, or click Eject Disk ro 
change floppy disks. 
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List of items 
available for 
installation 

-

List of items selected 
for installmion 
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Click the Items you w ont to select; 
Shi ft -click to select multipl e Items. 

System softtuar e f or ony Moclntosh 
Soft wore for oil Apple prln tor s 
RppteShar e (workstollon softwore) 

32-Bit QulckDrow 
Software for lmogeWrller 
Soft w ore for Rpplel nlk lmogeWr ller 

Click the items you w ont lo selec t; 
Shift- click to select muiiiJtle Items. 

Softwore for lmogeWriter 
sonwor e f or Rpptel olk lmogeWrtter 
son w ore for lmogeWr iter LO 

0 ., 
' ' 

Soft w ore for Personot LoserWrlter SC 
I 

[ Switch Disl< ] 

Customize~ 

Quit 

( l ns1• 11 ) 

= llord Disk 
In 

( [j~t: l lliik ) 

( Switch Disk ) 

-------
( Eosy I nst nll ) 

I Quit ) 

po! ll tnstoli ~ J 

~~~~ore fo~~ser~-~~~~~:.: _____ In = llnrd Disk 

You hove selected: 
• RppleShore (workstntlon sofhuorel 
• Soft wore for Rpplelol k lmogoWriter LO 
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( Eject Dl•k ) 

[ Switch Disk ) 

[ Eosy l nsloll ) 

Quit 

7 Click Customize. 

The custom insrallation screen 
appears, with a list box showing 
all drivers provided with the 
system software and a choice of 
scandard or minimal system files 
for each Macintosh model. 

8 Scroll through the list 
of items and Shift-click the 

ones you want to install. 

As you select items, their names 
appear at the lower-left portion 
of the dialog box. (If you select 
only one item, details about it 
appear.) 

9 Click the Install button 
to install the selected items. 

T he Installer begins the 
installation. On-screen messages 
report copying status. 



Please insert the disk: 

System Additions 

Stop 

Installation on "Hard Disk" was 
successful. If you ore finished, click 
Quit to leaue the Installer. If you 
wish to do additional installations, 
click Continue. 

(continue ) n Quit ~D 

Clean Up Window 
Emptq 'frast1 
[rase m~k 
Set Startup ... 

Preparing your sysrem software 

1 0 If the System Startup 
disk is ejected, insert the 

System Additions disk as 
requested. 

(If you are updating your system 
software with an upgrade kit 
and the System Tools disk is 
ejected, you are asked to insert a 
different disk; just follow the 
instructions on the screen.) 

Clicking the Stop button 
cancels the installation. 

11 When you see a 
message reporting that 

installation was successful, click 
Quit. 

The Installer window doses. (If 
you see a message that the 
installation was not successful, 
begin the process again.) 

12 Choose Restart &om 
the Special menu. 

The M acintosh restarts with the 
newly installed system. 

If you do not have a hard disk, 
reinsert the newly created 
startup disk when you see the 
blinking question mark icon. If 
you see a dialog box asking you 
to name your Macintosh, type a 
name and click 0 K. 
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Installing system software 
on a Macintosh with 
only one disk drive 

Making an extra 
startup disk 

You can make sure that the correct items were installed by opening 
the startup disk's icon, then opening the System Folder and 
reviewing its contents. 

)o- See also: • "Priming Color or G ray-Scale Documents" in 
C haprer 4 

• "Moving Fonrs and Desk Accessories" in Chapter 8 

You can install the system softw·are if your Macintosh has o nly one 
floppy disk drive (and no hard disk), bur the process will involve 
many disk swaps as you copy rhe necessaty files from the four 
system software disks to the disk on which the system is being 
installed. 

T he installation process follows the same steps as those in 
"Installing System Software" earlier in rhis chapter, except that you 
will have to eject the System Startup (or System Tools) d isk and insert 
an initialized disk after starting the Installer program. 

T he Installer automatically creates a minimwn-sized system and 
installs only the Image Writer printer driver when you install on a 
floppy disk. 

Your Macintosh requires a startup disk-that is, a disk with a 
System Folder installed on it-whenever you turn on or restart the 
computer. 

If your Macintosh has a hard disk and you have installed the system 
software on it or the com puter came with the system on its hard 
disk, you already have your startup disk and don't need to create any 
floppy disks to use as startup d isks. 

If your M acintosh has only floppy d isk drives, you may want to 
create several startup disks ro use with different application 
programs fo r convenience. 
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Once you have installed the system software on one floppy disk, 
you can simply copy its System Folder to one or more initialized 
disks ro make duplicate startup disks. 

To make a new startup disk you need 

• a disk with your installed system software (in one disk drive) 

• an initialized disk (in rhe second disk drive) 

If your computer has only one disk drive, you can create a 
startup disk, but you will have ro make several disk swaps in the 
process. 

Sm~ 11 sy stern 

Preparing your system software 

1 To make an extra 
startup disk, first double­

click the icon of a disk that 
contains your installed system 
software to open it. 

2 Place an initialized disk 
in the second disk drive. 

If you have only one floppy 
disk drive, eject the disk 
containing the installed 
software and then insert an 
initialized disk. This disk will 
be your new starrup disk. 
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3 Drag the System Folder 
to the icon of the startup 

d isk you want to create. 

The System Folder is copied 
onto the new startup disk. 

T his process will require a 
number of disk swaps on a 
one-floppy-drive system. 

Creating a small system When you instal l the system software on a floppy disk, the 
Installer automatically creates the smallest practical System 
Folder. T his allows the maximum room on your startup disks 
for application programs and your own work. 

You can also create this small system by selecting the "Minimal 
software" option for your Macintosh model from the C ustomize 
dialog box of the Installer. 

If you didn' t o riginally install the minimum-sized system or 
you've added drivers, fonts, or desk accessories since installation , 
you can remove items that aren't essential. You remove drivers by 
dragging them our of the System Folder; yo u remove fonts and 
desk accesso ries with the Font/DA Mover. 
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Updating to a new 
version of system soft,·vare 

Depending on the devices connected to your Macintosh, you 
should consider removing these items: 

• drivers for printers or other devices you don't use (such 
as lmage\Xi'riter, AppleT.:uk Image Writer, LaserWriter, 
Laser Prep) 

• networking drivers, if you are not on a network (such as 
AppleShare®) 

• extra desk accessories (you wiU definitely need the Control Panel, 
bur you may nm need the Alarm C lock, Calculator, Chooser, 
Find File, Key Caps, or Scrapbook) 

• extra fonrs you have instaUed 

)o- See also: • "C reating a Customized System" in this chapter 
• "Making an Extra Starmp D isk" in this chapter 
• "Moving Fonts and Desk Accessories" in C hapter 8 

If you have been using an older version of the system software and 
you get a newer version, you can update your system by installing 
the newer software. 

To accommodate aU Macinrosh models, the system software 
upgrade is supplied on four 800K disks instead of the two 
1.4MB system disks provided with new computers. 

To install the new system software, follow the special instructions in 
"Installing System Software" or "Creating a Customized System" 
earlier in this chapter. 
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Installing 32-Bit 
QuickDraw for 

enhanced color images 

If your Macintosh can display color images, you can enhance the 
computer's color capabilities by placing the 32-Bit Q uick.DrawTM 
file in the System Folder of your startup disk. 

T he 32-Bit Q uick.Draw ftle is provided in rhe Apple Color folder 
on the System Additions disk. (If you are updating your system 
software with an upgrade !cit, you'll find the Apple Color folder on 
the Printing Tools disk.) 

32-Bit QuickDr aw 

IE . . 
32-Bit Quio:;kDt-.!J··Ii 

.......... 
r····· :ell 

. . ································ ···· ······· 

Clean Up Window 
[mpttJ lmstl 
[ras<~ m~k 

Set Startup ... 

1 To install 32-Bit 
QuickDraw, first locate 

its icon in the Apple Color 
folder. 

2 Drag the 32-Bit 
QuickDraw icon to the 

System Folder of the startup 
disk. 

32-Bit QuickDraw is copied 
into your System Folder. 

3 Restart your system by 
choosing Restart from the 

Special menu. 

T he capabilities of 32-Bit 
QuickDraw are in effect once 
you restart. 

)1.- See aLso: • "SpecifYing che Number of Colors or Shades of Gray" in 
C hapcer 8 
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Starting up the 
Macintosh 

Specifying itetns 
to be opened 

at startup 

If your Macintosh has a hard disk that's a startup disk, you 
simply turn on the computer to start up. If you're using a floppy 
startup disk, place the disk in the internal disk drive and turn on 
the Macintosh. To restart with a floppy disk, reinsert the disk 
after it is ejected. 

)o- See also: • " Installing Sysrem Sofn.vare" in this chapter 
• "Creating a Customized Sysrem" in rhis chapter 
• 'Turning the Macintosh On and Off" in Chapter 2 
• "Inserting a Disk" in C hapter 6 

You can designate one or more application programs, desk 
accessories, and documents to be opened automatically when 
you start up the Macintosh. To specify items for opening at 
startup, you use the dialog box that appears when you choose 
the Set Startup command in the Special menu. (See Figure 2-3.) 

c=J Start up "harddislc " with: 

The Finder manages -Hf----@ ~ Finder 0 <51~~ MultiFinder __ Multi Finder 
the cbktop, icons, 

and windows. Upon s tartup , automatically open: 
manages two or 
more programs 
simultaneously 
(including the 
Finder). 

Dimmed options -ll--l 0 Selec tt>tl l tt~ms 
require MultiFindcr. 0 OJHmHd flJipll< u tions <Jnd llfl~ 

@ Finder Only 

( Cancel I n OK J] 

Figure 2-3 The Set Start up dialog box 

The procedure for using the Set Startup command varies 
somewhat according to the munber and type of items you want 
to open at startup. 

Table 2-1, at the end of the instructions for "Selecting Multiple 
Startup Items," summarizes the procedures for opening 
programs, documents, and desk accessories at startup. 
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Selecting one startup 
program or document 

Whether you use the FinderT" or the MultiFinder option, you 
can easily specify a program or document for opening at startup . 

c:::J Stnrt up ' Mnln Disk " with: 

® Q Flndor 0 QIQQ Mulllflnder 

1 To specify a program or 
document for opening at 

startup, first select its icon by 
clicking. 

2 Choose Set Startup from 
the Special menu. 

3 Check that the program 
or document you selected 

is shown, then click 0 K. 
Upon st or tup, nutomotfcolly open: 

Progr.un selected --;;---~® s tudlo/o 
Changing from Finder ro 
MultiFinder or vice versa will 
not affect your selection of a 
startup program or document. 

0 Opened flppll< o tlons and 1111• 
0 Finder Only 

I Cnncel l (CE!i} 

Clean Up Window 
fmptt.~ 'fmsh 
[ l"!~S(~ ni~k 

Set Startup ... 

4 Choose Restart from 
the Special menu. 

The program or document 
you selected is opened when 
the Macintosh restarts. 

Your startup selection remains in effect until you change it with 
the Set Startup command. 

Chnpter 2: Starting Up 



Selecting multiple 
startup items 

To open more than one item at startup, you must use Multi Finder, 
the system file that permits the Macintosh to work with two or 
more programs simultaneously. You use the Set Startup command 
to turn on MulciFinder, as well as to specify the startup items. 

Until you turn MultiFinder on, the Macintosh automatically uses 
the Finder, the system ftle that manages the desktop, windows, and 
icons. (You can still use the Finder when MultiFinder is turned on.) 

The instructions that follow show how to select a group of items for 
opening at startup. Consult Table 2-1 for a summary of the 
procedures required to select several different types and 
combinations of startup items. 

Restart 
Shut Down 

Specifying items to be opened at startup 

1 To specifY multiple startup 
items, first select the 

programs and docwnents you 
want to have opened by Shift­
clicking their icons. 

All the items must be at the 
same level-on the desktop or 
in the same folder. 

If you want to specify desk 
accessories as startup items, 
you must first turn on 
MuhiFinder and then open 
the desk accessories. 

2 Choose Set Startup 
from the Special menu. 

The Set Startup dialog box 
opens. 
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c::J Stor t up ' Moln Disk ' w ith: 

® q, Finder c.> <lo <lo <lo MultiFindcr 
-·--·-----.:.~·-·-·-·-·-------
Upon stortup, outomotlcolly open: 

0 SBI~H t~d I IPIOS 

0 Op(HJed flPtllh ntlulls <l!ld OA• 
® finder Only 

c::::J Stnrt up ' Moln Disk " 1ulth: 

O<lo finder ® <lo<lo<lo MultiFinder 

Upon stortup, outomotlcolly open: 
Wilh MuhiFinder -+----® Selected Items 

turned on, !he 0 Upctnltd fll•Pfl(otlons Mod un. 

Selected Items 0 MultiFinder Only 

oplion is I conccl J ~ 
automatically 

selected. 

3 If necessary, click the 
MultiFinder button to 

turn it on. 

Skip this step if MultiFinder is 
already selected. 

4 Check that the button 
labeled "Selected Items" is 

selected, then click OK. 

5 Choose Restart from 
the Special menu. 

T he items you selected are 
opened when the Macintosh 
restarts. 

Your startup selection remains in effect until you change it with 
the Set Startup command. 

)o- See also: • "Managing Multiple Programs Using Mul riFinder" in 
Chapter 3 

• "Managing System Memory" in C hapter 3 
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Table 2-1 Summary of procedures for opt:ning items at stan up 

To open at startup Requires Do before choosing Set Startup 

1 application program f-inder or Select program icon 
Multi Finder 

2 or more programs Multi Finder Oren or select program icons 

I or more desk Multi Finder Open desk accessoric.~ 
Kcessories turned on• 

1 or more desk MultiFinder Open desk accessories and 
accessories plus turned on• program icons 
I or more programs 

I or more documents Muliif'incler Select document icons 

1 or more documents ,\luliiFinder Select document icons 
plus I or more and program icons 
application programs 

1 or more documents Not possible 
plus I or more desk 
accessories 

' Multi finder must already be in effect before you open any desk accessories to specify 
them as St:lrtup items. 
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Chapter 3 

Working With 
Application Programs 

Application programs determine what ki nds of work a 
Macintosh can do-such as writing, drawing, designing, 
calculating, conrrolling a variety of processes, and managing vast 
amounts of information. 

This chapter outlines some fundamenral operations common to 
all application programs, regardless of a program's specific 
purpose and product. 

These operations include 

• preparing to use an application program 

• moving text and images within a document 

• copying text and images from one document to another 

• saving documenrs-under various names, in various locations 

• storing frequendy used text and images for easy access 

• recognizing whether you' re in a program or on the desktop 
and moving from one "place" to the other 

This chapter also presents procedures for managing several 
application programs (often just called programs for simplicity) 
and summarizes the appropriate steps for ending a work session. 
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Preparing to use a 
progran1 for 

your work 

Installing a program 

You use standard Macintosh operations to install and starr most 
programs, and to create documents with them. Once you've created 
a document with a program, you can either stan the program and 
then open the document, or simply open the document's icon on 
the desktop, which automatically starts the program. 

In most instances, you install an application program by copying 
it fro m irs o riginal disk to your hard disk or to a floppy disk. (A 
few programs have more elaborate installation procedures.) 

~ 
Applelink 

1 To install an application 
program, first open the 

program's disk by double­
clicking its icon. 

Progr:1m icon---~~ 
,......_ 

:-........ ,... 
2 Copy the program by 

dragging its icon to the 
icon of the your hard disk or 
startup floppy disk. 

l-Iard disk icon ----~'·: .. ·IODfiiBMii'm!MBI Release the mouse button 
when the disk's icon becomes 
highlighted. T he program is 
then copied onro the disk. 
(You can also copy a program 
to a folder by dragging its icon 
to the folder icon, or copy the 
program to an open directory 
window by dragging its icon to 

the window.) 

If your system has only one 
floppy disk drive, you'll have 
to swap disks several times. 
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A lel i~k He l~· 

3 If necessary, copy any 
additional files the 

program needs by dragging 
their icons to the hard disk or 
to the startup floppy disk. 

T he program's documentation 
should specify whether any 
such files are needed. 

It's a good idea to open the icon of the hard disk or the floppy 
disk to make sure that the program and other files were copied. 

Consult the program's documentation to determine whether 
additional installation steps are necessary. 

)1>- See also: • "lnstalli ng System Sofn.vare" in Chapter 2 
• "Creating a Small System" in Chapter 2 
• "Making an Extra Starrup D isk" in Chapter 2 

Starting a program You start a program by opening it. 

FreeHand 

Preparing to use a prog 1~1111 for your \vork 

1 To start a program, 
first point to its icon. 

2 Double-click the mouse 
button to open the 

program. 

The program's window 
appears, usually with a new, 
blank document displayed. 
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Creating a new document 
in a program 

·:· Other ways to open programs: You can also open a program by 
selecting its icon and choosing the Open command from the 
File menu or by double-clicking the icon of a document 
created by the program. ·:· 

The program remains open until you quit, usually by choosing 
Qui t from the File menu (or by using the keyboard shortcut 
Command-Q provided in many programs) . 

.)o- See also: • "Opening a Document on the Deskrop" in rhis chaprer 
• "Knowing Where You Are on the Macintosh" in this 

chapter 

You create a new document while working in a program by 
choosing the N ew command. 

Open ... 
~N 

~0 

1: lose :*(HI 
S<n'<~ :~a:) 

S<n'<~ H~ ... 

1: los<~ :•:w 
S<W<~ :a: ) 
S<w<~ H~ ... 

1 To create a new 
document in a program, 

first open the File menu. 

2 Drag the pointer to 
the New command and 

release the mouse button. 

The program opens a new 
document. If another 
documen t was already open, 
the new one covers it. (Some 
p rograms don't permit more 
than one open document at a 
rime.) 
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Opening an existing 
document in a program 

You open an existing document while working in a program 
with the Open command. 

S<W(~ 

S<HI(~ fl ~ "' 

Select o Document: 

1= 110"" 
Folder icon CJ R~pllcollon rrogrnms 

Ill:; :o~=~~~ks 
Document icon --0 Chi's templalft 

0 For Ch8nnlng 
CJ For Kate 
CJ For Scottie 

Select a Document: 

J= IIO >t q 
D Applica tion Programs: 
CJ o Dobers 
CJ DO's Books 

0 For Chennlng 
CJ For Kote 
CJ For Scot lie 

P' 

' 

Iii 

= liD # ! 
6615K ouolloble 

(]8)1~ 
I 

(cancel ) I~ 

<:::~ HD # 1 

6615K ouoiloble 

n Open~U I~ 
(conce r J i~ 

1 To open an existing 
document in a program, 

first choose Open from the 
File menu. 

The program's directory dialog 
box appears, with a list of 
documents and folders on rhe 
disk in use. 

2 If necessary, scroll to 
locate the document, then 

click its name to select it. 

You can display the documents 
in a folder by selecting the 
folder and clicking the Open 
button . 

3 Click the Open button 
to open the selected 

document. 

..... See also: • "Knowing Where You Are on rhe Macinrosh" in rhis 
chapter 
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Opening a document 
on the desktop 

If you are using the desktop rather than working in a program, 
you can open a document and start the program at the same 
time. (This technique may not work if the program is already 
open when you're using MulriFinder.) 

BL Notes 

1 To open a document 
on the desktop, first point 

to its icon. 

2 Double-dick the mouse 
button to open the 

document and simultaneously 
start the program. 

T he program starts, with the 
document open in its window. 

When you close the document, the program stays open unti l 
you quit, usually by choosing Q uit from the File menu (or by 
using the keyboard shortcut Command-Q). 

>- See also: • "Knowing Where You Are on the Macinrosh" in this 
chapter 

• "Managing Mul tiple Progra ms Using MulriFincler" in 
this chapter 

Editing documents T he Macintosh computer's standard operations allow you ro edit 
text and to copy both text and images between parts of a 
document, from one document to another within a program, 
and between documents in different programs. 
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Editing text You can use the standard text-editing operations available on the 
desktop when you're in a program. These include 

• selecting text 

• replacing text 

• deleting text 

• msernng text 

If necessary, review the instructions in "Basic Editing on the 
Desktop" in Chapter 1 for instructions for basic text editing. 
You can also get practice editing in Getting Started With Your 
Macintosh and in Macintosh Basics, the training disk. 

Copying text and images You can easily copy selected text and images. 

. --~~~~~~--­
Many graphics ~ 

programs identify a • 
selected item with a 

moving clashed 
outline. 

Editing documents 

1 To copy text and images, 
first select the item you 

want to copy. 

2 Choose Copy from the 
Edit menu. 

Your selection is copied and 
stored in a part of the 
computer's memory called the 
Clipboard until you copy or 
delete another item or you 
turn off the computer. 
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Inserting copied text and 
images within a document 

·:· A keyboard shortcut for copying: You can also use the keyboard 
shortcut Command-C co copy selected items. ·:· 

·:· To check the Clipboard: You can see the current contents of 
the C lipboard by choosing the Show Clipboard command 
from the Edit menu. This command is available in some 
programs, and it's always available when you're working on 
the desktop. ·:· 

)lo- See also: • "Deleting Text and Images" in this chapter 

Once you've copied text, images, or both, you can insert that 
material anywhere in an open document. 

Insertion point - ------ 1 To insert text and 
images in a document, 

first click at the exact spot 
where you want the item to 
appear. 

White Tiger 
Has Twinsl 

A blinking insertion point 
appears at the spot where you 
dick. 

2 Choose Paste from the 
Edit menu. 

The item you copied 
previously is inserted . 
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Copying text and images 
between documents 

in different programs 

White Tiger 
Has Twins~ 

3 Check the document to 
make sure that the copied 

item was inserted as you want 
it. 

You can paste the copied item 
as many times as you wish. 

•!• Pasting shortcut: You can also use the keyboard shortcut 
Command-V co paste copied material into a document. •!• 

You can easily copy text and images from one document to 

another in the same program or from a document in one 
program to a document in another program. The instructions 
that follow cover the slightly more complicated task of copying 
between documents in two different programs. 

1 To copy an item 

~-
t\ moving dashed ----' ___,.-

outline indicates a !:. -~-~ 

between documents in 
different programs, first select 
the desired material &om a 
document in the first 
program. 

selected item in ~ 
man~· graphics ! - - ~ 

programs. 1 The pond has rounded 
I stones that seem to 
: sit atop the w ater . 
: You can cross e-asily . 

Editing documents 

In a graphics program, a 
selection is often marked by a 
moving dashed outline; in a 
text program, a selection is 
highlighted. 
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•~u~ 

New 3€N 
Open ..• 3€0 
Close 3€W 
Saue 3€S 
Saue As ... 
Delete ..• 

Page Setup ... 
Print ... 3€P 

Quit WQ 

~ 
~ 

picnic map 

2 Choose Copy from the 
Edit menu. 

The selection is copied to the 
Clipboard. 

3 Choose Quit &om the 
File menu to leave the 

first program. 

If you' re using MultiFinder, 
you don't have to quit the first 
program; you can simply 
switch to the Finder or to the 
second program if it's already 
open. 

4 Double-dick the icon 
of the document into 

which you want to paste the 
item you copied. 

Opening the document 
automatically starts the 
program. 
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Insertion point --------1·~-____:. __ _ 

~ 
N 

Highway 1 

4 

1: ut 
[ OPI.~ 

•' 

.. 
, , Jughandl~ Pond 

Paste ~ :l€U 

~ 
N 

~ : ..,;.- - .c:::::_ 
:~-- ­: - -~ 
:The pond has rounded 
: ston~s that s~em to 
:sit atop th~ wator. 
:You can cross easily . 
' .. 

5 Click at the exact spot 
where you want the item 

to appear in the document 
just opened. 

A blinking insertion point 
appears at the spot you 
clicked. 

6 Choose Paste &om the 
Edit menu. 

The selected item appears at 
the insertion point. 

7 Check the screen to 
be sure that the copied 

material was pasted where 
you want it. 

You can always delete the 
pasted item, select another 
insertion point, then paste 
agam. 

Highway 1 

4 .. 
i i Jughandle Pond 

If you are not making other 
changes in this document, save 
and close it. 

>- See also: • "Switching Programs or Desk Accessories with 
MultiFinder" in th is chapter 

• "Scarcing a New Program When Using MulriFinder" 
in chis chapter 
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Deleting text and images You can delete text and images from a document in either of 
two ways. 

One method, using the Cur command, places the deleted 
material in an area of the computer's memory called the 
Clipboard so that you can get it back (until you copy or cut 
another item). 

The second method, using the Clear command, removes the 
material and does not place it on the Clipboard. 

The Nor..,.teglan economy was 
relaU\•ely cold d tui.ng 1989. 
Ice pre'!eiLied rnuch oi the 
usu~l fi.::hmg acuvity, and the 
extremely 3hort. cool Sl.lii1mer 
ret,,.rded tl'1e growrng season. 

The outlook is much brighter 
for the 1990s in Norway. 
New manufactuiing centers 
have been constructed, more 

Clear 

1 To delete text or images, 
first select the item to be 

removed. 

The selection becomes 
highlighted (if it's text) or 
enclosed by a moving dashed 
outline (if it's graphics). 

2 Choose Cut or Clear 
&om the Edit menu. 

The selected item disappears 
from the screen. 

·:· Another way to clear text and images: Pressing the Delete key 
also clears selected material. ·:· 
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Canceling an editing action You can cancel many editing actions with the Undo command, 
which reverses your most recent action (if it is possible to reverse 
that action). 

T he actions that you can undo with this command vary among 
programs. 

1: ut 
[ DIHJ 
Paste 

1: ut 
l:opq 
Paste 

1 To undo an action, first 
open the Edit menu to see 

if the Undo command is 
available. 

The command is black if 
available; it is dimmed and 
sometimes reads "Can't undo" 
if it can't be used to reverse 
your most recent action. 

2 lfUndo is available, 
drag to it and release the 

mouse button. 

The Undo command reverses 
your previous action. Choosing 
Undo a second time restores 
your original action. 

•:• Shortcut for Undo: You can use the keyboard shortcut 
Command-Z to initiate the Undo command. •!• 
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Saving docun1ents Saving your work ofren is the best safeguard against lost data. 

Folder (holds 
documems) 

Document (dimmed 
because it can ·t 

be opened) 

Current 
document 

name 

-

Macintosh programs offer several ways to save documents, 
providing great flexibili ty in managing and storing your work. 

When you save, you can 

• name the document 

• change its name 

• change its location 

• save revisions with no change in name or location 

• save all or part of a document in the Scrapbook desk 
accessory fo r access any time 

Most saving options use a form of the directory dialog box, in 
which you name a documenc and select its storage location. (See 
Figure 3-1.) 

Disk (current 
storage location) 
I ' ' 

I 
I= Disk #2 1 

I 

CJ Accounts Q 
CJ BD letters 

~ D Bird stocks ,,. 
D Morno J 
CJ TaHes 89 0 

Saue Current Document as: = Disl< #2 

~I Molly 8/ 5/ 90 I 12541 K auailable 

D ros1 Sou.~ D ~akl~ Hot:kup ~ Saue l) ( 1: jo<t ) 

(Cancel] ( Driue ) 

Figure 3-l A directory dialog box for saving files 
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Saving a new document W hen you create a new document and save it for the first time, 
you must name 1t. 

When a document has not yet been named, the direct01y dialog 
box automatically appears when you choose the Save command. 
This dialog box also appears when you choose th e Save As 
command. 

I=Disk #21 
Folder (holds 
documents) 

Accounts 
0 BD letters 
0 Bird stacks 
D 1'11<Hno 
0 TaHeS 89 

Saue Current Document as: 

Name box -jl 
(with blinking t..:._ _ _______ _ __j 

insertion point) 

!=Disk "21 
D Recounts 
D DO le tters 
D Bird stacks 
0 MOHICI 

D roues 09 

Soue Current Document os: 
I Molly 0/ 5 / 90 

0 fo s l Snllt' 0 Mllkl' Oockutt 

Saving documen!S 

= Disk 112 
t 2S~ I K uuullu~la 

tEi) QEill 
[cancetl ~ 

1 To save a new 
document, first choose 

Save from the File menu. 

T he direcrory dialog box 
opens. An insertion point is 
blinking in the name box. 

2 Type a name for the 
document. 

If you mal<e a typing error, yo u 
can use the Delete key to 

backspace, or you can drag 
across the part of the name to 
be corrected, and then retype. 

3 Click the Save button to 
save the document. 

The program saves the 
document and the dialog box 
closes. T he nam e of the 
documenr now appears in the 
window's tide bar. 
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•!• A different way to save: Some software, such as HyperCard 
and many database programs, saves your documenr 
automatically after you make a change and when you close 
the documenr. In these programs, you name a documenr at 
the time you open it. ·:· 

Saving a revised document When you make changes ro a previously saved document, you 
can save your revisions quickly with the Save command. This 
command saves your revisions without changing rhe documenr's 
name or location. 

86 

oearTea , 

On lmlll!vaekend, the Nev YorkClty 
aJUIIUlleroup plans a picnic. Mark II on your 
clllellllar row, pleO'e. Tile commlnee vill make 
arre.neemenl3 and edvbe you M tl1ime, place, 
and olher essential Information. 

See you soon I 

1 Make the revision to 
your document. 

2 Choose Save &om the 
File menu. 

The pointer becomes a 
wristwatch while the 
document is being saved. 
(Some programs use a 
different icon.) 

•!• Save command shortcut: You can save revisions most 
efficiently by using rhe keyboard shortcut Command-S, 
which is available in many programs. •!• 
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Saving a document 
under a new name 

You can change the name of an existing documem with the 
Save As command. 

New 
Open ... 
Close 
Saue 
Saue As ... 

:i!CN 
:il€ 0 
acw 
acs 

Disk -----~I=~Diiis~k~#ffl21 

I D Recounts ~ 
Folder --0 BD letters 

Doc"~"' f g ~~:•::::•• ~ 
~~~~~----------~ 

Saue Current Document as: 
Existing name 
(selected with 

Save As command) 

Cl nccounts 
Cl DO letter< 
CJ Dl rd stocks 
[) Memo 
CJ Toues 89 

Soue Current Document os: 

J Deborah 6 /2 1/90 

0 I us I SoUl' 0 Mok~ lhu:kup 

= Disk "2 
12541K 8U8110ble 

([ Soue!tll ~ 
( Concel ] [ Orlue ] 

1 To save a document 
under a new name, first 

choose Save As from the File 
menu. 

A directory dialog box opens, 
with the documem's currem 
name selected in the name 
box. 

2 Type a new name for 
the document. 

Your typing replaces the 
selected name. If you make a 
typing error, you can use the 
Delete key to backspace, or 
you can drag across the part of 
the name to be corrected, and 
then retype. 

3 Click the Save button to 
save the document under 

its new name. 

The document is saved and 
the dialog box closes. The new 
document's name appears at 
the rop of the active window. 

•!• Return key shortcut: You can press Return instead of clicking the 
Save button. (Pressing Rerum initiates the action for the butron 
with a bold outline.) •!• 
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When you save with a new name, the original document {with 
its original name) remains intact, in the version you last saved 
before changing the name. To avoid confusion with different 
versions of a documenr, it's a good idea to include a number, 
date, or other identifying element whenever you change a 
document's name. 

To rename a document without retaining a version under the 
old name, change its name on the desktop. 

~ See also: • "Renaming a Document" in C haprer 5 
• "Basic Ed iring on rhe Desktop" in C haprer l 

Saving a second copy 
of a document 

under the same name 
on a single disk 

Yo u can make two copies of a document with the same name by 
placing them in different locations on the disk. 

1 To save a second copy of 
a document under the 

same name, first choose 

Folder selected 
for saving 

New 
Open ... 
Close 
Saue 
Saue As ... 

J=Disk 112 1 
CJ Accounts 
CJ DO letters 

D Mmno 
D Tnues 89 

St~uo Current Document ns: 

111 lmi!UiiRJN!J1 I 
0 rnsf ~•>u•~ 0 MnKt• Oeckuu 

1¥ 

lr 
= Disk #2 

1 25~ 1 K nunllnble 

[E)~ 
( Concel J ~ 

Save As from the File menu. 

The direcrory dialog box 
opens, with the document's 
current name selected. 

2 If necessary, scroll to 
locate the folder in which 

you want to save the second 
copy of your document, then 
click the folder's name and 
click the Save button to open 
the folder. 

T he folder opens, and a list of 
the folder's contents is displayed. 
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Folder opened 
in step 2 

le» JH leiters) 

D Mull~ 0 : ~; :' <JU 

Snue Current Document ns: 

ll•mm:JIIiriJIII• I 
0 rust SUUP 0 MnkP BockUJI 

p,! 

In 

= Disk "2 
12541 K nunllnblo 

~~ 
[ Cnncel ) ~ 

3 Click the Save button 
to save the document in 

the open folder. 

The dialog box closes as rhe 
program saves rhe document. 

If you open a folder that already contains a document with the 
same name as the one you' re saving, yo u' ll see a message alerting 
you rhat the version you're saving will replace rhe one already 
there. (See Figure 3-2.) 

Replace eHisting "TaH memo 
- 3/90" ? 

Yes [ No )J 

Figure 3-2 Alert box to confirm replacing old version with new 

Yo u can avoid replacing the old version by clicking No. Clicking 
Yes replaces the old version with the new one. 

~ See also: • "Copying a Document on rhc Same Disk" in Chapter 5 
• "Using Folders to Organize Your Work" in Chaprer 5 
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Saving a document You can easily change the disk on which you plan ro store a 
onto a different disk document. 

New 
Open ... 
Close 
Saue 
Saue As •.. 

(g) Pyg Ref 
168K auailable 

3€N 
3€0 
3€W 
3€S 

n Saue D ( Eject ) 

(Cancel) ( Driue ~ 

(g) Backup 8 / 6 
57K auailable 

K Saue~D ( !: j(~( t 
(Cancel) ( Driue 

1 To save a document on a 
different disk, first choose 

Save As from the File menu. 

T he d irectory dialog box 
opens, with the document's 
name selected. 

2 Click the Drive button 
to display the name of a 

different disk. 

If you are using floppy disks, 
you may have to eject a 
disk-using the Eject 
button-and then insert the 
desired disk. 

3 If necessary, select a 
new location by double­

clicking the folder where you 
want to save the document, 
then click Save. 

The program saves the 
document and the dialog box 
closes. The newly saved 
document becomes the active 
version (that is, you are now 
working on a different disk, 
and your changes will be saved 
there). 
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Saving text and images 
in the Scrapbook 

for easy access 

ScroUing displays 

If you try to save a document on a disk or in a folder that 
already contains a document with the same name, you'll see a 
message alerting you that the version you're saving will replace 
the one already there. (See Figure 3-2.) 

You can avoid replacing the old version by clicking No. Clicking 
Yes replaces the old version with the new one. 

The Scrapbook desk accessory provides an excellent storage 
place for text and images you use frequendy. The Scrapbook is 
automatically included when you install system software. (See 
Figure 3-3.) 

~0 Scrapbook 

Downtown Office Occupancy Rate 

1 902 1903 1904 1905 

stored images ---+101 O~lilml!m~HH!HlW~W~1lll~WH!l!H!llli!iW!~mm1lml~WW1l!ilm!~Hl!!ll!llllilm1mil~WlllllliHlllm!~WmHmHmWlWllll91 

Image displayed/ --1 1 10 P1CT Type of 
document 
displayed 

total images (a new 
image is placed 

ahead of the one 
displayed) Figure 3-3 The Scrapbook desk accessory 
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When the Scrapbook is open, the standard editing commands 
Cur, Copy, and Clear operate on the contents of its window. 

:·· ·· ····~· ;z;· · ············· · ·· · ···· · ········· -····: 

: ;;'f.;~,~ 
~~:i.<.: 
"I"'' 

About the Finder ... 

Alarm Clocl< 
Calculator 
Chooser 
Control Panel 
Disl<lnfo 
Find File 
Key Caps 
Scrapbook 

Undo 

[ u t 
[ OlHJ 

•zni · 

1 To put text or images 
in the Scrapbook, first 

select the material you want 
to copy. 

2 Choose Copy from the 
the Edit menu. 

The selection is copied onto 
the Clipboard in the 
computer's mem01y. 

3 Choose Scrapbook from 
the Apple menu. 

The Scrapbook window opens, 
displaying the first item in it. 

4 Choose Paste from 
the Edit menu. 

The selection is pasted in front 
of the item previously displayed 
in the Scrapbook, and the 
number of items is adjusted to 
reflect the addition. 
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5 Close the Scrapbook by 
clicking its close box. 

·:· Copy and Paste command shortcuts: You can use keyboard 
shortcuts w copy and pasre-Command-C for copy, 
Command-V for paste. ·:· 

Editing operations in the Scrapbook include 

• Cur- delete the item displayed and store it on the Clipboard 
(see "Copying Text and Images" earlier in this chapter) 

• Copy-copy the item displayed and store it on the Clipboard 
(for pasting into desired document) 

• Clear-delete the item displayed 

You can create more than one version of the Scrapbook, but rhe 
system can only work with one such file at a rime. If you 
maintain several scrapbook files, be sure to smre them under 
different names so that you don't inadvertently replace one of 
them with the content of another. 

To swap Scrapbook files, 

• remove the current Scrapbook File from the System Folder 
and give it a different name 

• then rename the file you want to substitute "Scrapbook File," 
and place it in the System Folder 
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Knowing where 
you are on 

the Macintosh 

When you work with programs and documents, the screen's 
"environment" changes according to the rype of program you're 
using. At rimes you may look at the screen and wonder where 
you are- in a program, in a document, or on the desktop. 

If you use MultiFinder, recognizing where you are from what 
you're seeing can be especially tricky, because you can see parts 
of the desktop even when you're using a program. 

Bur the Macintosh has some built-in clues to help you 
determine where you are. The figures that follow show some 
easy ways to get your bearings. 

Figure 3-4 shows rhe menu bar of an otherwise blank screen. 

* File Edll Formal Fonl Document Ullllllos Window 

Figure 3-4 Only the menu bar is showing on the screen 

Figure 3-5 shows how to determine where you are. 

Figure 3-5 'M1e menu bar's clues to what program you're in 
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Programs open: The 
Finder manages the 

desktop, which is 
visible behind 

MacWritc's active 
window (!he check 
mark indicates the 

program in usc). 

Figure 3-6 shows assorted windows and icons when using 
MulriFinder. 

* File Edit Seorch Formot Font Style 

Figure 3-6 Screen with program and desktop windows open 

Figure 3-7 shows how to see where you are and what else is open. 

About MultiFinder ... 

Figure 3-7 Clues to the programs open and rhe one currently active 

)io- See also: • "Managing Multiple Programs Using MulriFinder" in this 
chapter 
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H.eturning to the desktop 
from a program 

To return ro the desktop when you're using a program (and 
M ultiFinder is nor turned on), save your work and quit the 
program. 

New 
Open .. . 
Close 
Saue 
Saue Rs ... 
Delete ... 

Page Setup ... 

:leN 
:!CO 
:leW 
oos 

Print... :!CP 

Quit WQ 

1 To return to the desktop 
from a program, first save 

any new work in the open 
windows by choosing Save 
from the File menu. 

Most programs warn you if 
you try ro close a window or 
qui.t the program without 
saving your work. 

You can also close the open 
windows after saving. If you 
don' t, rhe program will close 
them when you quit. 

2 Choose Quit from the 
File menu. 

The program's window and 
menu tides disappear and the 
desktop appears. 

~ See also: • "Managing Mulriple Programs Using MulriFinder" in rhis 
chapter 
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Managing 
multiple progran1s 
using MultiFinder 

Macintosh system software includes MultiFinder, which can 
open and manage multiple programs at the same time. 

MultiFinder provides 

• automatic opening of specified programs, documents, and 
desk accessories at startup 

• quick and easy switching between open programs 

• copying and pasting of text and graphics between documents 
in different programs, without having to close the documents 
or quit the programs 

• continuous access to the desktop for starting new programs, 
moving or deleting documents, and changing floppy disks 

• background printing 

To make most efficient use of MultiFinder, you should also 
know how to manage your system's memory, discussed later in 
this chapter. 

> See also: • "Managing System Memory" in this chapter 
• "Specifying Items to Be Opened at Stanup" in 

C hapter 2 
• "Using Background Priming" in C hapter 4 
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Turning MultiFinder on You turn MultiFinder on with the Set Startup command, which 
provides several options once MultiFinder is selected. (See 
Figure 3-8.) 

StartUJ) disk __!_ 
G=:J Start up "Recounts '89" with: 

r------,----------rr-- Choice of Finder 
l l or MultiFinder 
®~ Finder 0 ~~~ MultiFinder (which includes 

Upon startup, automatically open: 
the Finder as an 
open application) r- 0 S(~I<H tl'il I h~ms 

Options for ___,r---1 0 OJHmHd fiJipli ( utions <Jrld [Jfl~ 

.__ ® Finder Only 
opening other 

items m startup 

( Cancel ) ( OK D 

Figure 3-8 Set Startup dialog box with the Finder selected 

Restart 
Shut Down 

c:::::J Start up "Accounts ·og· with: 

--~~.!lnd~ ~<ll<ll<li M~~.':.~ 
Upon startup, outornattcetty open: 

Q SciiO< tt~IJ I tt:>ms 

0 Opened fill II II< o ttons and lift• 

® Finder Only 

1 To turn MultiFinder 
on, choose Set Startup 

from the Special menu. 

The Set Startup dialog box 
opens. 

2 Click the MultiFinder 
button. 

The options in the lower pan 
of the dialog box change when 
you dick. 
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c:::::J St art up "Recounts '09" with: 

0<11 Finder @<11<11 <11 MultiFinder 

Upon stortup, outomoticolly open: 
®Selected items 
0 liJierled fiJIJIIi< llt!ilns drld Ofl~ 

0 MulliFinder only 

( Concel ) lC1E!J 

3 Click the OK button. 

The dialog box closes. 

4 Choose Restart from 
the Special menu. 

MultiFinder takes effect when 
the Macintosh restarts. 

You'll know that MultiFinder is in effect by the small icon 
displayed at the top-right corner of the menu bar. (See 
Figure 3-9.) 

ti File Edit Ulew special !:!-- - Active-application 
~~~~~~~~~nc~c~ou~n~ts~·o~9~!!i!!i!!i~~ii~t!l~: n::~}{j~~~j:~ :~::~ icon (indicates the 
r-.;.'.;.:";;;""";;;.. _____ ';.;.'·;.;.;••;.;;."";.;"';.;'"';;;. ·~---...;.;.7 •5;.;2;;;1 ".;.;¥<;.;;.'";;;; .. ;d" ':~U application in use 

00 
~stemfo'-!tr 

LJ 
h't<Oiets "89 

£ 
LJ 

for lis-P,~ 

LJ 
f or Mimi 

~ ttrf\'r when MuhiFinder 

@ 
Tnm:miH<~b 

~ 
O.ctronie Art Rtpof'ttr 

I~ ·~ HLT0~~: ~ H j 

Figure 3-9 Menu bar with active-application icon in top-right corner 
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Switching programs 
or desk accessories 

with MultiFinder 

Once you have turned on MulciFinder, it goes into effect 
whenever you starr up the Macintosh. You use the Set Startup 
dialog box to specify programs and documents to be opened at 
startup as well. 

MultiFinder remains in effect until you turn it off (by choosing 
the Finder option with the Set Startup command) and restart 
the computer. 

)o- See also: • "Speci~ring lrems ro Be Opened ar Startup" in 
Chapter 2 

You switch between open programs or desk accessories simply by 
clicking the active-application icon in the right corner of the 
menu bar. (See Figure 3-9.) 

Do.k '"""" ;ro~ 
(applicmion curr~mly 
in use) 

1 To switch programs or 
desk accessories, click the 

active-application icon. 

The icon changes and a 
different program or desk 
accessory appears in the active 
window. 

~ ~ 2 If necessary, click the 
----------!::§Jt active-application icon 

several more times, until the 
program or desk accessory 
you want is visible. 

·:· Other ways to switch programs: You can also d ick in a 
document window or choose the name of an active program 
from the Apple menu to change programs. •:• 
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Starting a nevv program 
when using MultiFinder 

When MultiFinder is in effect, you can start a program thar is 
not currently open by opening it from the desktop. 

~ l 1 To open a new program, 
_________ ___;!:::§~~ click the active-

application icon until the 
small Macintosh appears. 

~ 
QuarkXPress® 

T he small Macintosh icon 
indicates the Finder, which 
manages the desktop. The 
window of the icon opened 
most recently on the desktop 
appears. 

2 Locate the icon of the 
program you want and 

open it by double-clicking. 

You may have to close or resize 
the windows of one or more 
documenrs if the icon you 
want is on rhe desktop and is 
hidden by them. 
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Managing 
system memoty 

You' ll see an alert box if there is not enough RAM for the new 
program to be opened. (See Figure 3- 1 0.) 

K OK D 

The oppllcotlon "QuorlcHPress®" could 
not be opened ( 1,024K needed, 614K 
ouolloble). Try quitting from another 
oppllcotion to Increase unused 
memory. 

Figure 3-1 0 MultiFinder a len box reporting insufficienl memo!)' 

·:· Other desktop operations: You can perform all the standard 
operations on the desktop when the Finder is the active 
program. ·:· 

>- Sec also: • "Mulrifinder's Memory Requirements" in this 
chapter 

Occas ionally you may have to make an adjustment in your use 
of the computer's random-access memory (RAM) to continue 
working efficiently with large programs or with several programs 
open at once. 

Becoming familiar with the amount of memory your Macintosh 
has and the memory requirements of the primary programs you 
use can help you take full advantage of the computer's 
capabili ties. 

Chapter 3: Working With Applica1ion Programs 



MultiFinder's memoty 
requirements 

Checking the amount of 
RAM in your Macintosh 

Your computer must have 1 megabyte (MB) of RAM to use 
MulriFinder. One megabyte usually allows you ro open one 
program and one or more desk accessories, or two programs that are 
nor roo complex (and rhus do not require a large amount of 
memory). 

If you want to use two or more complex programs at the same time, 
your Macintosh probably should have at least 2MB of RAM. Most 
Macintosh models can use 4 MB of system memory or more; 
consult the Special Features booklet or the Handbook for your model 
for its memory specifications. 

You can check the amount of RAM in your system with the About 
the Finder command. 

1 To check the RAM, 
choose About the Finder 

from the Apple menu while 
using the desktop. 

The About window appears, 
displaying derails about the 
Finder. 

About the Macintosh® Finder" 

2 Click the close box to 
close the About window. Findu : 6.1.6 

Sgst•m : 6 .0 .6 
l~rry ~ .John, S ttn·•, and Druc• 
€lApp I• Computer, Inc . 1983- 90 

RAM in this -i--Total H•mory : 1 ,024K 

computer 
(I024K = 1 Mil) 

5) Finder 

[9 Syslom 

863K • ·:':-:::::::::::::-:·:-:::::.:-:-:·:':·:·:-:·:·:·:·J 

16 1K-

Consult your authorized Apple representative if you want to expand 
the RAM in your Macintosh. 
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Checking tl1e RA.M 
available for programs 

in MultiFinder 

The Finder's About window also displays a graph depicting how 
much RAM is available for programs and how much memory each 
open program is currently using. 

The largest block of 
memory available 

for a program 

a About the Moclntosh'lll Finder'" 

F;nder : 6 .1.6 
S~stem : 6 .0 ,6 

l ilrn.1., John., St •ve-., itlnd Bruce 
€~Apple Computer , Inc . 19 83 - 9 0 

1 To find out how much 
RAM is available for 

programs, choose About the 
Finder from the Apple menu. 

T he About window opens, 
displaying a bar graph that 
indicates memory allocation. 

2 Click the dose box to 
dose the About window. 

Tobl Momor~ : 5, 120K Lar ges t Unused Block : 2,~20K 

l!~~~:;c:::::.::·~;~~2~.:0~ .. ~~ ;,:~:4:: :::·;=·=-:~-:':··:.-:=!6.,.,~.:-:-~:-: ::~-:-:ll:~-1-t-- T'he bars show 
!3 Find• r t 60 K RJ memory available 
!3 Syst•m 416K ~ for each open 

-= program; the 
clark areas show 
how much is 
currently in use. 

Clearing system memory 
for efficient operation 

If you' re using MultiFinder and have opened and d osed a number 
of program s, your Macinrosh memory can become fragmented so 
that you can't open a large program. You may be able to alleviate 
this problem by quitting all the programs you have open, cl1en 
starting them again. 
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Changing the memory 
allocation for a program 

On rare occasions you may need to allocate additional memory 
for a program. You can do this by adjusting the program's 
memory size in the Get Info window. 

0 

Nen1 Fnlt1~~r 
Open 
Print 

:)[:N 

:!CO 

1: lose :J(:W 

Get Info ;. 3€:1 

Info 

Laakod 0 
SuporPaint 2.0 
SuperP-1int Version 2 .0 

Kind : applioatlon 
S izo : 526,36 7 bytes usod, 5 1 SK on disk 

Yhe-rco : Main disk, SCS I 5 

Cr .. t od : Wod, May 24, 198'3, 12:00 PM 
Modlfiod : TI"MJ, Oot 5, 1989,9 :12 PM 
Yor slon: 2 .0, 1D 1986, 1988, 198'3 Silicon 

Bf.ach Softw1r•, Inc. 

1 To change the memory 
allocation for a program, 

first dick the program's icon 
to select it. 

The program must not be in 
use when you reallocate 
memory. 

2 Choose Get Info from 
the File menu. 

The Info window appears. 

3 Drag across the number 
in the small box at the 

bottom of the window to 
select it. 

Program 
manufacturer's 
suggested 

Suggostod Momor11 Size (K) : 700 -- memory Size 
Applicotioa Momoro,~ Sizo (K) : Currem memory 

allocation 
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Suggest ed Momory Slu (K) : 700 

Application Memory Sin (K): ~ 

Info 

SuperP aint 2 .0 
SuperPaint Ver: 

Kind: application 
Size : 526,36 7 bytes 

4 Type the new number 
for the memory you want 

to allocate. 

5 Close the Info window 
to complete the 

allocation. 

1\ Important: Do not set the memory allocation for a program to a 
size that's smaller than the manufacturer's suggested size. This 
could cause the program to function improperly or nor at all. 6. 

Adjusting the RAM cache The number of programs and desk accessories you can use at rhe 
same time in MulriFinder is also affected by the size of the RAM 
cache, if you are using it. 

The RAM cache is a specified amount of memory that helps 
programs work more quicldy and efficiently. The memory 
assigned to the RAM cache is not available to MulriFinder, 
however. 

Chapter 3: Working With Application Programs 



General icon 
selected 

(the Control Panel 
that opens 

3Utomatically) 

T he maximum size of RAM cache depends on how much memory 
is available at a given time. If the available memory is less than the 
RAM cache size you have set, the system will temporarily reduce the 
RAM cache to the maximum allowable size. 

To maximize MulciFinder's ability to handle multiple programs, 
turning off the RAM cache or setting it to a very small size-such 
as 32K- is advisable. 

You set the RAM cache in the General Control Panel. (See 
Figure 3-11). 

I t~:::~~~; I 

Keyboard 

'""i 

[0 
Mouse 

<]))~ 
Sound 

Figure 3-11 

Ratt> of lnst>rtion 
Point Blinking 

Dt>sktop Pattern 

.:::1 (-
0@ 0 

Slow Fast 

Menu Blinking Timt> C9 

~ 
9:29:54 AM 

. 
@ 12hr . 0 24hr . 

0 00@ Date ~ 
Off 1 2 3 10/4/90 

General Control Panel showing preset RAM cache status 
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About the Finder ... 

Alarm Cloclc 
Calculator 
Chooser 

Size increases or ---------, 
decreases in r------1--------, 

increments preset at 
the factory 

®on 
Q Off 

1 To check the RAM 
cache, choose Control 

Panel from the Apple menu 
while on the desktop. 

T he General Control Panel 
appears. 

2 Click the up or down 
arrow to adjust the size of 

the RAM cache, or click Off 
to turn it off. 

It's a good idea ro dose rhe 
Control Panel. 

3 Choose Restart from 
the Special menu. 

The adjusted RAM cache takes 
effect when the Macintosh 
restarts. 
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Ending a 
\\rork session 

Quitting an 
application program 

W hen you've finished your work-with a program or fo r the 
day-it's a good idea ro do some h ousekeeping before leaving 
the computer. 

If you are finished using a program , use the Q uit command ro 
return to the desktop. 

New 
Open ... 
Close 

Saue As ... 

New 
Open ... 
Close 
Saue 
Saue As ... 
Delete .. . 

Page Setup •.. 

WN 
3€ 0 
ww 

WN 
3€0 
ww 
ws 

Pri nt ... WP 

Quit WQ 

Ending a work session 

1 To quit, first save any 
work done since you last 

saved the current document. 

Even though the program will 
prompt you to save if you try 
to quit before saving new 
work, it's good practice ro save 
your work regularly, rather 
than relying on the program's 
safeguards . 

2 Choose Quit from the 
File menu. 
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Backing up the If you haven' t made backup copies of your work as pare of the 
session's work saving process, be sure to copy any important documents you've 

revised during the session. The safest backup practice is to copy 
your work on a disk different fro m the one on which the 
original documents are stored. 

1 To back up your work, 
first insert a backup disk 

in one of the system's disk 
drives. 

2 Copy the new files by 
dragging their icons to the 

icon of the backup disk. 

You can back up on a hard 
disk, of course, bur making 
separate copies of your work 
on floppy disks is advisable as 
well. 

)lo- See also: • "Backing Up a Disk" in Chapter 6 
• "Backing Up a Hard Disk" in Chapter 6 

Shutting down When you have finished work for the day and have backed up 
the computer your work, you can turn off the Macintosh. (Many people leave 

their computers turned on continuously by preference; it's a 
good idea to turn off the computer if you will not be using it for 
a few days.) 

T he procedure for turning off the Macintosh varies somewhat 
depending on the model you use, but you should not simply 
turn off the power switch. 
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~ Important: Always use the Shut Down command before 
turning off your Macintosh. This command prepares the system 
sofrware for shutdown. ~ 

Clean Up Window 
rmptiJ "fn~stl 
Erase Dislc 
Set Startup ... 

Restart 
Shut Down 

!'ower switch 

1 Choose Shut Down 
from the Special menu. 

You'll see a message on the 
screen telling you that it's all 
right to turn off the switch. 

2 If your model turns off 
with a switch, turn it off 

now. 

Macintosh II models that are turned off by the Shut Down 
command can be turned on with the Power On key at the top of 
the keyboard. 

> See nlso: • "Using Special Keys and Indicators on the Keyboard" in 
Chapter I 

• "Turning the Macintosh On and Off" in Chapter 1 
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Getting ready 
to print 

Chapter 4 

Printing Documents 

he Macintosh provides several dilferenr ways to print 
documents, whether you are using a program or working on the 
desktop. 

This chapter explains the preparations you make for printing, 
summarizes the options you can choose for paper, image size, 
and print quality, and presents brief instructions for each 
printing operation. 

Before you can prim a document, you must connect a printer to 

yo ur Macintosh and prepare the system software to use the 
pnmer. 

_).. See also: • "Connecting a Printer" in C hapter 9 
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Placing printer drivers 
in the System Folder 

You must place a printer driver in your System Folder for each type 
of printer you want to use. Figure 4-1 shows the printer drivers 
provided with Macintosh system software. 

Connects directly Connects via Apple Talk* 

'Cable in icon indicmes connection 10 Apple'lalk network. 

Figure 4-1 Printer drivers supplied with system software 

If you've installed the system som'V'are with the Installer, you can 
skip this procedure; the Installer's standard installation copies the 
printer drivers to the System Folder. 

·:· Color printing: You must use a special version of the Laser Writer 
drivers to print with a color primer that is compatible with the 
LaserWrirer. Inst.ructions for using these drivers appear later in 
t.his chapter. ·:· 
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PrinU"lonitot· 

--~ ·········T·· 

1 To put printer drivers 
in the System Folder, select 

the icon or icons for the printer 
drivers you need. 

You'll find these drivers in the 
Printing folder on the System 
Additions disk. (If you are 
updating your system software 
with an upgrade kit, you'll 
find the printer drivers on the 
Printing Tools disk.) 

2 Drag the driver icons to 
the System Folder on your 

startup disk 

If you have multiple starrup 
disks, repeat this process for 
each one. 

)o- See also: • "Printing Color or G ray-Scale Documents" in this 
chapter 
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Choosing a printer You can have several output devices, such as printers, connected 
to your M acintosh- directly or by network. You select the 
printers and other devices you want to use with d1e Chooser. 

{See Figure 4-2.) 

l)'pes of devices 
available 

Network zones 
(this list appears 

only if the Macintosh 
is on a network that 

has zones) 

.JQk lim 
~~ ~ 

Appl•T• lk 1... lmaq•Wr itor 

~~ 
Lastr lt'r ltor LO AppleTal... 

AppteTatk Zones: 

Choose r Names of individual 
de1·ices appear here 

I 

when an icon for 
type of device is 

--selected. 

L._ ___ ______ ___J Network indicator 
(must be active to 
use devices on a 
network or to print 

CC4-5lh/ Norlh on any Lascr\Xiriter 
CC4-5lh/Sou lh except the Personal 

User Nome: 

I CC4-6lh/Norlh ® A ell ve --,1---t--Laser\'io'riter SC or the 
CC4-6lh/Sou th App teTotk 0 tnoclive _j 

Y:::::::::=====~~------==---..::.:..~:_-_J laserWriter lise) 

Figure 4-2 The Chooser 

Charter 4: Priming Documents 

1 To designate a printer, 
select the Chooser in the 

Apple menu. 

T he Chooser window opens. 



m 
~ 

Apple Talk 1.. . Image Writer 

=t~ 
Laser Writer LQ Apple T a 1... 0 

CC4- 5th orth 
CC4-5th/South 
CC4-6th/Nortl~ 
CC4-6th/South 

Select e LeserWriter: 

Fontsgolore 
Grophics 
Quickndirty 
S teodystr<~m 

Gell ing ready to print 

2 Click the icon for the 
type of printer you want 

to use from the upper-left 
area of the Chooser. 

3 If necessary, select the 
network zone in which 

you want to choose a printer 
in the bottom-left area. 

4 Select the name of the 
printer you want to use in 

the top-right area of the 
Chooser. 
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Selecting Page 
Setup options 

Your choice takes effect immediately. It's a good idea to close the 
Chooser window when you've chosen a printer (although you 
can leave it open if you prefer). 

·:· Choosing an Image Writer: When you use the Chooser to 
choose an Image Writer char is connected directly to your 
Macintosh, you follow the steps above, except that you don't 
select the name of a printer. Instead, you specify which of the 
compurer's two connection areas, called ports, the printer 
uses. T he Chooser displays a dialog box in which you select 
the icon for the port to which your Image Writer is 
connected. •:• 

)-- See nlso: • "Connecting a Printer" in Chapter 9 

T he Page Setup dialog box provides a number of choices for 
paper size and printing enhancements. 

§0 New branch u 90 §§! 1 First, prepare the 
document you want 

Name Earliest Start 

Start 3/4/87 

Investigate 3/4/87 

Inves tigate loans 3/4 /87 

New 3€N 
Open... 3€0 
Close 3€W 
saue 3€S 
SaueRs .•• 

Chapter 4: Printing Documents 

Lates 
to print. 

2 To select Page Setup 
options, choose Page 

Setup from the File menu. 

The preset choices (or those 
selected most recently) are 
displayed when the dialog box 
opens. 



~Lo;s;er~W~rl~te~r~P;ag~e;S~et3up~~~~~::::::~-- t:!E:J 
Paper: ®US Leller 0 R4 Lellor 

0 us Legal 0 05 Leller ol Tabloid (Cancel I 
Reduce or llliilJI'l'• 
Enlarge: 

Printer Effecls: (Options I 
3 Select the paper size and 

printing enhancements you 
want and click OK 

Orientation 

-~ 

Paper size _ 

l8l font Subslltutlon7 
l8) TeHt Smoothing? 
l8) 6raphlu Smoothing? 
l8l r aster Dllmap Printing? 

~ 

Figure 4-3 shows the Page Setup options for the Laser Writer. 

~Lft~s:or~W~rl~to~r7Pa~gT,o~Se~t~up~~~~::::::::~--~ Paper: ® US Leller 0 R4 Leller 
0 US Legal 0 OS Le llor 0 I Tabloid [ Cancel I 

Printed copy as ~f--- Reduce or.,. Printer Effecls: [Options 1- '-- Clicking the 

P-' ~:~::: 14 ~~~~::::~~:eJ:Ion ~ ~::: :::osot~~~~~o7n7 CJ!!fU ~pept~n; ~~\~g\ox 
l8)6raphlcs Smoothing? 
l8) roster Oil mop Printing? for selecting 

enhancements to 

Paper position Enhancements to the speed and the printed image. 
(venical or horizontal} quality of printed copy 

Figure 4-3 Page Setup dialog box for the LaserWriter 

The enhancements provided in the Options dialog box include 

• a flipped image (vertical or horizontal) 

• an inverted image (black-white reversal) 

• alignment of bit-mapped areas (provides greater image 
resolution but reduces the image by 4 percent) 

• a larger print area (which uses more printer memory and 
therefore limits the number of downloadable fonts) 

• unlimited downloadable fonts 

{Downloadable fonts are type styles stored separately from the printer 
and transmitted to it at the time of printing.) 

Getting ready to print 119 



120 

Figure 4-4 shows the Page Setup options for the ImageWriter. 

> . ~lm;,;,;:n6ge;.:W;;,;rl~le~r ~~----=~~-=----- O!JJ I a per SIZe Paper. ®us Letter 0 R4 Letter 

II 
0 us Legal 0 lntornallonol fanfold ( cancel ) 
0 Computer Paper 

Paper position -ortentotlon Special Effects:~Tnll Adjusted 
(vcnical or liiiil'I !Eii11 so '4 Reduction 
honzontal) ~ !!!!! No unJ•• Dclween Pages 

Image adjustments 

Figure 4-4 Page Scrup dialog box for the Image Writer 

Elimination of top 
and bottom 
margins (for 
computer paper) 

The lmageWrirer LQ provides rwo additional choices: paper size 
includes a # 10 envelope, and images can be reduced to 33 
percent and 66 percent of original size. 

You'll see different options for each type of printer you use. 
Some programs provide additional options in their version of 
Page Secup. 

Selections made in the Page Setup dialog box remain in effect 
until you change them. 

Printing your work Printing while using an application program is probably the 
most common method, bur the Macintosh also lets you print 
one or more documents from the desktop. In addition, you 
can print documents on any color printer that can use the 
LaserWrirer drivers. 

Wherever you initiate printing (by choosing the Print command 
from the File menu), you use the Print dialog box to specify 
printing options. Figure 4-5 shows the Print dialog box for the 
LaserWriter. 
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Page range (clicking All print5 the entire 
document; emering page number5 in the 
From and To boxe5 prints those pages only) 

Figure 4-5 The Print dialog box for the LaserWriter 

The Image Writer models offer some different options for 
priming. These include 

• prim quality (best, faster, draft- a choice that affects printing 
speed as well as quality) 

• bidirectional printing (Image W riter LQ only)-rhe printing 
element prints continuously as it moves back and forth across 
the paper, making for very fast output 

• cut sheet feeder use (Image Writer LQ only) 

Some programs offer additional printing options, such as 
printing from first to last page or from last to first page of a 
document. 
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Printing from 
within a program 

You can easily print a document while working in a program's 
active window. 

New 
Open ..• 
Close 
Saue 

OON 
000 

1 To print from within a 
program, choose Print 

&om the File menu. 

The Print dialog box appears. 

La•erwrtter • wellesley • (::2E:5l 
Coples:[gl] Poges:@ AII O From:Oro: D 1 Cnncetl 

Couer Page: ®No 0 First Page 0 Lost Page ~ 

Paper Source:® Paper Casse tte 0 Monuol Feed 

2 Select the options you 
want in the Print dialog 

box, then dick 0 K. 

After a moment, a status box 
appears and remains on the 
screen until printing is 
completed. 

·:· Keyboard shortcuts for printing: You can use the keyboard 
shortcut Command-P to initiate printing in most programs, 
and you can press Return instead of clicking OK in the Print 
dialog box. •!• 
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Printing from the desktop You can print one or more documents created in the same 
application program from rhe desktop-without starting the 
program first. 

LoserWrlter "Wellesley • c::E!}) 
Coples:[gl Pogos:@ Ait O From:Olo: D [ Cnncet) 

Couer roge: ®No 0 First Page 0 l ost Page ~ 

Paper Source:® Paper Cossette 0 Monuot Feed 

1 To print &om the 
desktop, select the 

documents you want to print. 

The group of documents must 
all be created by the same 
program and must reside on 
the desktop or in the same 
folder. 

2 Choose Print from the 
File menu. 

The program starts 
automatically after you choose 
the Print command; then the 
Prim dialog box appears. 

3 Select the options you 
want in the Print dialog 

box, then click 0 K 

The printing status box 
appears, remaining on the 
screen unril printing is 
complete. The program closes, 
and yo u see the desktop again. 

•!• Return key shortcut for printing: You can press Rerum instead 
of clicking OK in the Print dialog box. •!• 
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Printing a cl irectoty of 
disk or folder contents 

~0 
tl!!M 

D crf'd1t union r .. tu 

D du lor notes 

D Ylsuranee 

D mor t9•9• chart 

0 old records 

D strvic~ diagram 

D tax info 

101 

You can prim a direcrory of the files in the open window on the 
deskrop. Figure 4-6 shows a direcroty arranged by the names of 
items in a folder. 

D orf'dlt unfon ratts 

D du lor notu 

D lnsuronet 

D mor t919t ch•r t 

D old r ecords 

New Cor 
Size Kind 

18K docume-nt 

18K documtnt 

14K documtnt 

12K documtnt 

- folder 

Last Modified 

M on, Jun 19 , 1 

Fri1 Jun 16 1 1 

Mon, Jun 19 , 1 ,i;i 

D strvict diagram 

D t•x info 

80K HyperCard docume-nt Mon. Aug 7 1 1 ~! !\ 
15K documtn t Tue, J ul 18, 1 ii. 

0 1 

Figure 4-6 Directory arranged by name 

T he primed direcrory is a "snapshot" of the window's entire 
conrenrs, showing icons of folders and documenrs in their 
relative positions or a list of the items in the same order that 
they appear in the window. 

New Cor 0~ 
Siu Kind Lost Modifit d 

18K do<:umt nt Mon, Jun 19, I:!:! 
18K documont Frt,Jun 16, I 11il 
14K document Mon, Jun 19, Ill 
12K doeumtnt Fri, Jun 16, 1 ! ! 
-- fold or Sun, Nov 19, 1 !R 

SOK H~p orCord do..,.nt Mon, Au9 7, 1 ~ ~ ~ 

15K dooull'lf'nt Tuo, Ju118, 1 l'=t 
lc:> Q: 
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1 Make sure that the 
directory you want to 

print is displayed in the active 
window on the desktop . 



New Folder 3€N 
Open 3€0 
Print 
Close 3€W 

b~~ t Priuil Pl.WS :}(:P 

Get In fo 3€ 1 
nup!ie<l1 e :}(:!) 

Put Hwaq 

Page Setup ... 
Print Directory ••• 

Lose rWrlte r "We lle s ley " ~ 

Coplcs:IIIIJ Pages:@ Al l 0 rrom: D To: D 1 Cancel ] 

Coucr Poge: @ No 0 rlrs t Pogc 0 Lost Poge ~ 

Po per Source: @ l'ope r Cossette 0 Monuol reed 

2 To prim a directory, 
choose Print Directory 

from the File menu. 

The Print dialog box opens. 

3 Select the options you 
want from the Print 

dialog box, then click OK. 

The directory is printed in the 
format currently displayed. 

•!• Return key shortcut for p rin ting: You can press Return instead 
of clicking OK in the Print dialog box. •!• 

)o- See also: • "Displaying Documcnrs by N ame, Size, Date, Kind, or 
Color of leon" in C hapter 5 
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Color or 
gray-scale printing 

Installing the LaserWriter 
drivers for color 

or gray-scale printing 

Some Macintosh models can create and display documents in color 
or in multiple shades of gray (called gray scale). You can print these 
documents on any color printer that can use the Laser Writer 
drivers. 

To print color or gray-scale documents, you must use special 
versions of the Laser Writer drivers; these ftles are version 6.0 
(or later) of Laser Prep and version 6.0 (or later) ofLaserWriter. 
You drag these drivers to your System Folder to install them. 

Two sets ofLaserWriter drivers are supplied as part of the system 
software with most Macintosh models; only those wid1 version 
numbers 6.0 (or later) ca.n be used for color printing. The drivers 
for color or gray-scale printing aJe on the System Additions disk, in 
a folder named ''Apple Color." (If you' re updating yoUJ system 
software with an upgrade kit, you'll find the Apple Color folder on 
the Printing Tools disk.) 

6 Important: If you use d1e 6.0 version of d1e LaserWriter drivers, 
mal<e certain that evetyone who uses the same printer you're using 
has installed the 6.0 drivers. Different driver versions will cause the 
printer to reinitialize frequently. 6 

--~ 

Chapter 4: Printing Documents 

1 Select the icons for the 
LaserWriter drivers you 

plart to use for color printing. 

, 



Info 

:le N 
:!C O 

::[ 

Lockod 0 
l utr PYtp 

' ' S':'sttm Softwrt Ytrsion 6.0.5 

Kind : l a .. r lr'riter documfnt 
Siz~: 32 ,58 1 bytu use-d., 32K on disk 

'litu~re : Prfnti'l9 Tools, ntunal driv t 

Croa td : Mon, .Jan IS, 1990, !2 :00PM 
Hodifi• d : Mon, .Jan IS , I990, 12 :00 PM 
Y• r s ion ;.6.0.1, Copojriqht Apple Computer , 

Version number --+++--~" lno. I983· 90 

I' 
Appliulion Homory Size (K) : EJ I 

Color or gray-scale printing 

2 Choose Get Info from 
the File menu. 

When several icons are 
selected, an Info window 
opens for each one. 

3 Check the version 
number of each 

LaserWriter driver. 

Verify that the version 
numbers are 6.0 or later for 
the rwo LaserW riter fil es and 
1.3 or later for PrinrMonitor. 
Close the Info window for 
each file after yo u check its 
number. 
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Printing color or 
gray-scale documents 

.-..:t,. 
. . .............. ................ /' 

ncplocc Items with the some nomos 
tulth the sel ected Items? 

4 If necessary, drag the 
correct versions of the 

LaserWriter drivers to the 
System Folder of your startup 
disk. 

If your System Folder already 
contains LaserWriter drivers, 
a message will appear asking 
you to confirm that you want 
to replace the drivers in the 
folder. 

5 Click OK to confirm 
that you want the new 

d.rivers placed in the System 
Folder. 

You prim color or gray-scale documents in much the same way as 
black-and-white ones. 

Chapter 4: Printing Documents 

1 Prepare the color or 
gray-scale document you 

want to print and display it in 
the active window. 

Alternatively, you can prim 
from the desktop by selecting 
the icon of the document or 
documents you want to prim. 



Color option is 
available only in the 

6.0 LascrWriter 
driver (or ;t 

later version). 

New 
Open .. . 
Close 
Saue 
Saue As •.• 

Quit 

3€N 
3€0 
3€W 
3€S 

3€0 

LoserWrlter "LoserWriter" ~ 

Copleo:[gl) Pages: ® nil 0 From: D To: D ( Cancel I 
Cover Poge: ®No 0 First Pogo 0 Los t Page ~ 

Paper Source: ® Paper Cossette 0 Monuol Feed 

11 Print: ® Color/ Groyscole 0 Olock & White 

2 Choose Print from the 
File menu. 

T he Print dialog box appears, 
showing options for 
color/gray-scale and black and 
white. Color/gray-scale is the 
preset selection. 

3 Select the options you 
want, then click OK. 

If you are not printing a color or gray-scale document, it's a 
good idea to select the black-and-white option in the Print 
dialog box, because printing is faster when this option is 
selected. 

If you print a color document on a printer that prints only in 
black and white, the document will be produced in a halftone 
format; that is, it will be composed of patterns of dots that vary 
in intensity according ro the colors they represent in the 
document. 

~ See also: • "lnstalling 32-Bit QuickDraw for Enhanced Color 
Images" in Chapter 2 
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Printing while 
using the co1nputer 

for other work 

By using MulriFinder, you can print on a LaserWriter while 
continuing to work with one or more programs. This feature, 
known as background printing, doesn' t work with the 
Image Writer . 

.)o- See also: •"Managing Multiple Programs Using Mul riFinder" in 
Chaprer 3 
• "Using a Print Server" in C hapter 7 

Using background printing With MultiFinder in effect, you use the C hooser to wrn on 
background printing. 
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D Chooser 

Cepri 

~~~~~~lu 'i 
--~ 

0 ~. 

AppltShart llft51tMtjl 

Select e LeserWriler: Q 
• • 0 

~ns ~ 
Option for -lt=====~=zl--1~=======)":.=-::-:: background Beckground Printing: ~On@ Off 

printing AppleTal k Zones: 

I
CC4 Upper 
CC4-5lh/Norlh 
CC4-5lh/Soulh 

I CC4- 6lh/Soulh 

User Name: 

@Active 
AppteTetk 0 lnectlve 

Chapter 4: Printing Documents 

1 To use background 
printing, select the 

Chooser from the Apple 
menu. 

The Chooser window opens. 

2 Make sure that a 
LaserWriter is selected, 

then click the On button in 
the middle area of the 
window to turn on 
background printing. 

A LaserWriter must be selected 
in the Chooser for the 
Background Printing option to 

be displayed. 

It's a good idea to close the 
C hooser before you activate 
the window containing the 
document you want to print. 



New 3CN 
Open... 3!:0 
Close acw 
Saue 3CS 
Saue Rs ... 

Page Setup ... 
Print... 3C P 

3 Print a document 
as usual. 

Select the icons of docum ents 
you want ro prim on the 
deskrop, or display a 
document in the active 
window of a program, and 
then choose the Print 
command from the File menu. 

T he Print dialog box appears; 
select the options you want 
and click 0 K. 

Background printing is under way as soon as the printing status 
box disappears. You may notice an occasional pause as you 
continue your work while the Macintosh processes the 
document for printing. 

Managing printing jobs You can control background printing with PrintMoniror, a 
resource supplied with the system software. (See Figure 4-7.) 

Name of the 
document being 

primed and printer 
currently in use 

m-- PrlntMonltor 

Woitin 
t '2l Reod Me @I Wellesl ey 
2 '2l Ben6ne Slug Lyri cs@ Wellesley _ _ _ Documents to be prinh.:d 

next (selected item can he 
removed from list) 

Clicking cmcelsthe ---[ Cancel Printing ) ~ Clicking opens a dialog 
current pnntmg JOb. ~- box to set the print timt:. Prrntm S o tus : Seo Lion Solu te 

Description and One Pege To Print 
starus of the current s te tus: s torUng j ob 

job appear here. 

Figure 4-7 PrintMonitor window 
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Along with the appropriate printer driver, PrimMonitor must be 
in rhe System Folder of your smrrup disk. (You can drag ir to rhe 
folder or use the Installer to copy it in your System Folder. ) 

PrimMonitor lets you 

• monitor rhe status of printing 

• cancel a documem currently printing or waiting to print 

• set printing rime (date, hour) or postpone a job indefin itely 

• monitor paper supply (PrinrMoniror's icon blinks over the 
Apple symbol at the left of the menu bar when rhe printer is 
our of paper) 

• signal when to feed paper manually (PrimMonitor's icon 
blinks over rhe Apple symbol to signal rhat you must confirm 
the manual operation) 

PrintMonitor 

Chapter 4: Prinling DocumenL~ 

1 To manage print jobs, 
make sure that 

PrintMonitor is in the System 
Folder of your startup disk 
and that background printing 
is turned on in the Chooser. 



Ollout Micro so ft Word ... 

Olarm Clock 
Ca lculator 
Chooser 
Con trol Panel 
Find File 
Key Caps 
Scrapbook 

~ Finder 

~ Microsoft Word 4.0 

.[!l ' I I 

................................................... ~.--------·-
Obout MultiFinder ... 

~rmtMonitor 

111%1-fD!f·ll-i·!inlfiDJIJI:II 
WaitinQ 

1 '2l Re~o Me ~ Wellesley 
2 '2l Benena Slug Lynes f1' Wellesley 

( Concel Prln tlng 1 ( Set rrlnt Time ... 

~9 Sta tus:Soo Lion Solute 
One Pege To Print 
s tatus: starting JOb 

I 

Q 

0 

1 

2 After you have started 
printing a document, 

choose PrintMonitor from the 
Apple menu. 

T he PrinrMonitor window 
opens. (PrintMoniror is 
available only when background 
printing is under way.) 

3 Select the option you 
want, then click the close 

box. 

You can cancel printing of the 
current documem or select 
one of rhe documems waiting 
ro print. (The Cancel butron 
changes to Rem ove from List 
when a wai ring documen r is 
selected.) You can set a rime 
and dare for printing a selected 
documenr by cl icking the Ser 
Prinr T ime button and 
em eri ng rhe t ime and date in 
the di alog box that appears. 

•!• PrintMonitor shortcut: You can also open the PrintMoniror 
window by clicking the Multifinder icon in the top-right corner 
of the menu bar until the PrinrMoniror's icon appears. ·:· 

)-- See also: • "Managing Mulriplc Programs Using MulriFinder" in 
Chapter 3 

• "Using a Print Serve r" in C hapter 7 
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Chapter 5 

Organizing Documents 

te Macinrosh desktop simulates an office filing system­
with icons represeming documents, folders, and even a Trash 
comainer. Other icons represent application programs, disks, 
and orher types of files. 

The computer's electronic environment permits rapid handling 
of information, and Macintosh system software provides a 
number of tools for storing and locating documents easily 
and efficiently. 

These include 

• simple, versatile methods for naming and renaming 
documents and folders 

• a "visual" filing system that's easy to move through by 
opening containers such as folders or disk icons 

• a powerful desk accessory, Find File, to locate items by name 
or partial name 

• directories of disk or folder contents arranged by icon, name, 
dare, size, or type of document. 

• easy display of important information abour a document 
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Handling 
documents 

You use standard Macintosh operations to name and rename 
documents, copy them, and move their icons. In addition, you 
can make one or more duplicates of any document without 
changing irs name or location. 

All these operations rake place on the desktop. 

!Vloving a document You drag a document to move ir. 

Document1 

Chapter 5: Organizing Documents 

1 To move a document, 
first point to its icon. 

2 Drag the document's 
icon to the new location. 

As yo u drag, an oudine of the 
icon moves with the pointer. 
W h en you release the mouse 
button, the icon appears at the 
new location. 



Copying a document 
onto another disk 

You drag the documenr's icon to the icon of a disk to copy it 
onto that disk. 

~ 
logo 

S:····· ril=J''I 
•\ .. 

Files/ Folders remaining to be cop ied: ~ 

Writing: logo 

nmunmmmm~mu-oo-•--------~ ( Concel ) 

Handling documents 

1 To copy a document 
onto another disk, first 

point to its icon. 

2 Drag the document's 
icon to the icon of the 

disk onto which you want to 
copy it. 

As you drag, an outline of the 
document's icon moves with 
the pointer. 

3 Release the mouse 
button when the disk icon 

becomes highlighted. 

When you release the button, 
the documenr is copied on the 
disk. A dialog box reports the 
status of copying. 
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Copying a document 
on the same disk 

You can make a copy of a document on the same disk by using 
the Duplicate command. 

New Folder al:N 
Open 3€0 
Print 

1 To make a copy of a 
document on the same 

disk, first select the 
document. 

2 Choose Duplicate from 
the File menu. 

The document is duplicated; it 
has the original's name, 
preceded by "Copy of. " A dialog 
box reports copying starus. 

Files/ Folders r emaining to be copied: ~ 3 If necessary, rename the 
document or move it to 

another location on the disk. 
Writing: Copy of map 

*FfN [ Cancel J 

You can' t give the duplicate 
exactly the same name as the 
original if you keep both of 
them on the deskrop or in the 
same folder. 

·:· Duplicating shortcut: You can also use the keyboard shortcut 
Command-O to duplicate a selected document. ·:· 
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Renaming a document You use the standard desktop editing techniques to change a 
document's name. 

•. ,., .. 

~~ 
Electronic Art List 

Handling documents 

1 To rename a document, 
first select it . 

2 Type the new name for 
the document. 

When you begin typing, the old 
name disappears and an 
insertion poinr blinks to the 
right of the characters you type. 

3 Click anywhere outside 
the document's icon. 

The insertion point disappears 
when you click, and the icon is 
deselected. 
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Using folders to 
organize your work 

Like traditional fi ling systems, the Macintosh uses folders to 
store and organize documenrs. Unlike a bulky paper filing system, 
however, the Macintosh lets you easily place folders inside 
one another to create multiple levels of organization . And you 
can move folders around, changing the order in which they 
are nested. 

Figure 5-1 shows an example of a floppy disk that contains three 
levels of folders. 

System 
fo lder 

Work in 
Progress 

Figure 5-1 Three levels of folders and documents on a lloppy disk 

W hether you use a hard disk, which can srore hund reds of folders 
and documents, or floppy disks for your files, you can establish an 

efficient filing system with folders. 

Chaplcr 5: Organizing Documcllls 
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Creating and You use the New Folder command to create a new folder. 

naming folders 

Er.-. ht Folder 

LJ 
~ Expense rt?ports 

1 Choose New Folder 
from the File menu. 

A new folder named "Empty 
Folder" appears in the active 
window; it is already selected, 
so you can easily rename it. 

2 Type a name for the 
folder. 

When you begin typing, the old 
name disappears, and an 
insertion point blinks to the 
right of the characters you type. 

3 Click anywhere outside 
the folder's icon. 

The insertion point disappears 
when you cl ick, and the icon is 
deselected. 

•!• New folder shortcut: You can also use the keyboard shortcut 
Command-N ro create a new folder on the desktop. •!• 
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Placing documents You drag documents to place them in folders. 
inside folders 

D 
Caspar map 

I 11 
......... ~ 

. : 

B!iiiiiii!lll!l!ll j"" : ...... 1 ama ........................... : 

• 11!11 

Chapter 5: Organizing Documents 

1 To place a document 
inside a folder, first point 

to the document's icon. 

2 Drag the icon to the 
folder. 

An outline of the document's 
icon moves with the pointer as 
you drag. 

3 Release the mouse 
button when the folder's 

icon becomes highlighted. 

The document disappears 
inside the folder when you 
release the mouse button. You 
can verify this action by 
opening the folder and 
viewing its contents. 



Nesting folders You can store folders inside other folders to create multiple levels of 
storage. You nest folders by dragging them. 

D 
Oct . '89 

Using folders to organize your work 

1 To place a folder 
inside another folder, 

point to the first folder's icon. 

2 Drag the first folder's 
icon to the folder in 

which you want to nest it. 

An outline of the first folder's 
icon moves with the pointer as 
you drag. 

3 Release the mouse 
button when the 

destination folder's icon 
becomes highlighted. 

The first folder disappears 
inside the destination folder 
when you release the mouse 
button. You can check this 
action by opening the folder 
and viewing its contents. 
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Locating docun1ents 
and folders 

Finding documents by 
name or partial name 

Macinrosh system sofrware provides a desk accessory called Find 
File for locating documenrs and folders anywhere on a d isk. 
W hen you' re working with documents in a program, some 
dialog boxes provide menus that show levels of folders. 

)-- See also: • "Insralling a Desk Accessory" in Chapter 8 

You can use the desk accesso ry Find File to locate a document or 
folder anY"vhere on a disk. It is installed as parr of the standard 
system software for all Macintosh models with an inrernal hard 
disk drive. 

Find File lets you specify the word or phrase for which it will 
search, reporting all documents and folders whose names contain 
the search text. Then, when you select a document from those 
listed, Find File shows that documenr's location. (See Figure 5-2.) 

F=D~'"~~~~~~~~#h~~Fi~n~d£F~ile~· j;;;;;;;;;:;;~~~~~~~~~~ The stop buuon 
Disk sc;~rched __:_o horddisk l'lifiiiH- is highlighted 

I 
111!!11 1 when the search 
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Search ICXI 

Documents fo und 

Derails of selccred 
documem 

1 is complcrc. 

Search buuon 

Scorch for: Caspar 

fil 
~ 

{ 
D Cup.rmap 
D Cospar map 
[) Cupar m.1p in word proctss:or 

D Cupar tax•s 1217/88 . . . :· 

{ Cr•attd : Thu,Apr 6,1989;7~ ...,_1 e5.l Mortgage/ house 
Modlfiod : Sal, Apr 15, 198S; 11 :59 PM Gl Matching deuel. 
Siu : 2048 b~tu; Gl HyperCard 2K on disk = horddisk 

Figure 5-2 Find File howing search report and location of selected 
document 
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lb1 

p 

K5 

(dicking il 
begins <1 search) 

Locarion of 
selected 
documelll (icons 
represent levels 
of nes1ed folders 
;~nd disk 
searched) 



0 -

c:w;moindisk 

Scorch for: 

-o 
=> horddlsk 

Scorch for: IJHI 

~0 

= horddisk 

Search for: IJHI 

About the Finder ... 

Alarm Clock: 
Calculator 
Chooser 
Control Panel 
Disk Info 

Find File 

Find File 

Find File 

Locating documents :1nd folders 

-~ 
-I~ 

1 To search for a file, first 
choose Find File &om the 

Apple menu. 

The Find File window opens. 
A blinking insertion poinr is in 
the text box. 

2 If necessary, click the 
disk icon at the upper-left 

corner of the window to 
switch disks for searching. 

3 Type the text you want 
to locate. 

The text can be the complete 
name or a parrial name. 

4 Click the search button 
(the icon of a walking 

figure). 

Find File searches for the text, 
and then displays the names of 
documents and folders that 
contain the text. 
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D JH st .atus-1987 

CJ JHstatus- 1988 ~ 

0 JH's s.tlf·rtvMv 10/12/89 5 Select the document you 
want to locate (scrolling 

if necessary). Q St•tuJ 16~rtss hst.....t-1 7i 

Details of selected { 
document 

Cruttd : Wf'd,Oct 29, 19S?; 7:15 AH eil Jlt status/memos 

~oldoc '""' <o document 

"' Modifi•d: r r t,OoUO,I9S7 ;0:12: AM eil Mft t clllng douol. 
Sl:•: :5 1 2 ~1n; 

0 .51< on db-k 

Moving quickly through 
levels of folders when 

using a program 

eil llypercor~ 
= horddlsk 

Rbout Find File ... 

Search Here... 3CH 
Moue to Desktop 3€M 

li'i Information about the 
document and its location are 
displayed in the bottom panes 
of the Find File window. 

6 (Optional) To move the 
selected document or folder 

to the desktop immediately, 
choose Move to Desktop &om 
the Find File menu. 

The Find File menu, which 
appears to the right of other 
menu titles in the menu bar, is 
available only when the Find 
File window is open. 

·:· Another searchingfeature: Find File also allows you to limit a 
search to a folder's contents with its Search Here command. 
This command is also available in the Find File menu. ·:· 

~ See also: • "Putting Away h ems on [he D eskmp" in [h is chap[er 

When you're working in a program and want to open or save a 
document, you have a quick way to move around in multiple 
levels of fo lders on a disk: a directory dialog box that lets you 
change levels of nesting and even switch drives and eject disks. 
(See Figure 5-3.) 
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Open folder (title of 
pop-up menu) 

Documents -

Select a Document: 

j -"To be phoned I 
D I st call IQ = harddislc Disk 
D 2nd ca ll 6B9BK auailabte 
D form letter 

([ OtH~n Bl~ -IJ not reached 

(cancel) i~ 
I 

lo 

Figure 5-3 A directory dialog box shmving a folder's contenrs 

If the document used most recently is in a folder, the folder's 
name in the dialog box is actually the tide of a menu that "pops 
up" when you place the pointer on it and press the mouse button. 

The folder "To be phoned" in Figure 5-3 and Figure 5-4 is 
nested inside other levels of folders. Figure 5-4 shows those 
levels of folders; "To be phoned" is inside '"89 overdue," which 
is inside "Oct. unpaid," and so on. The last level in the pop-up 
menu is the disk. 

Select a Document: 
I I • I ' . ' 

'[)IS' a·ag ouerduelt: 1--Q = harddisk 
D 2n a Oct. unpaid 

6098K auailable 
D for a Oct. '89 

[~1 1~ 0 no a lnuoices '89 
= harddislc 

(cancel ) j~ 
0 

Figure 5-4 Open pop-up menu shmving levels of folders and disk 
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Moving to a new folder When a pop-up menu is available in the directory dialog box of 
level with a pop-up menu an application program, you can use it to move rapidly to 

another level of your fi ling system. 
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Select a Document: 

6J To be phoned 
D 1 s a '89 ouerdue It 
D 2n a Oct. unpaid 
D for a Oct. '89 
D no a lnuoices '89 

c::J harddisk 

Select a Document: 

II Select a Document: 
Current folder level -~~~!----f.il a;;;n--!;1 n;-;u;;o~i c;:-;e;;s~· 8i019 1 

D April '89 

Contents of 
the folder 

currently open 

DRug. '89 
D Dec. '89 
D Feb. '89 
D Jan. '89 
D July '89 
D June '89 

Chapter 5: Organizing Documents 

1 To move to a new level, 
first open the pop-up 

menu by pointing to its title 
and holding down the mouse 
button. 

The pop-up menu opens, 
showing the levels of folders 
and the disk name. 

2 Drag the pointer to the 
name of the folder or disk 

to which you want to move. 

3 Release the mouse 
button to move to the 

new level. 

When you release the button, 
the folder or disk name you 
chose appears as the tide of the 
pop-up menu in the dialog box. 



Putting away items 
on the desktop 

Often rhe simplest way to use a program, documenr, or folder is 
to drag its icon our of a window onto the desktop. T hen the 
icon stays on the desktop until you remove the disk on which 
rhe program, document, or folder actually is stored. 

If you've placed an icon on the desktop, you can replace it in its 
original location quickly and easily with the Pur Away command. 

R 
Ld41!i@Ui 

N(~W f"ol!iN ~)(:N 

Open ago 
Print 
[ !OSH ~) (:UJ 

!;t~ t ?ri!Ji!PlJt~S ~)(:j> 

Get Info ag 1 
Duplicate ago 
Put Away 

Locating documems and folders 

1 To put an item away, 
first select its icon. 

2 Choose Put Away from 
the File menu. 

The selected item disappears 
from the desktop and is pur 
back ar the level where it 
originated. (You can check that 
the item has been pm away by 
looking in irs original location.) 

1·19 



150 

Getting directoty 
information 

Displaying documents 
by name, size, date, 

kind, or color of icon 

The Macintosh provides quick access to derails about the 
documents and disks it manages. 

The View menu, which is always available from the desktop, 
offers several different ways to view the contents of a disk or 
folder. Two other commands-Get Info and About-present 
derails about individual documents and applications. 

Using the View menu, you can list the contents of a window 
according to name, size, dare, kind, or color of icon, in addition 
to by icon or small icon. 

An icon view is useful when you want to move and select icons 
frequendy. A d irectory arranged by name, size, dare, kind of 
document, or color of icon is useful when one of those attributes 
is the key information you need about the documents in the 
window. For example, listing documents by the dare and rime of 
their most recent modification makes backing up a large number 
of files an orderly task. 

../by Small I con 
by Icon 
by Name 
by Date 
by Size 
by Kind 

Chapter 5: Organizing Documents 

1 To change the way you 
view a window's contents, 

first open the View menu by 
pointing to its title and 
holding down the mouse 
button. 

The View menu opens, 
showing the choices available. 
A check mark indicates the 
view curren tly visible in the 
active window. 



_o 
Name-

CJ April '89 

CJ AU9. '89 

CJ Dec. '89 

CJ feb. '89 

CJ Jan. '89 

CJ July '89 

Ql 

Getting information 
about an icon 

l nuoices '89 
SizP Kind 

- folder 

-- folder 

-- folder 

-- folder 

-- folder 

-- folder 

Last Modifi 

IQ 121 

2 Drag until the view you 
want becomes 

highlighted. 

3 Release the mouse 
button to change to the 

newvtew. 

When you release the button, 
the view in the active window 
changes to the item you chose 
from the View menu. 

The Get Info command displays information about a single 
item on the desktop or in an open window. 

Sq stern Fo:oldet-

Getting directory information 

1 To get information, 
first select the icon for 

which you want details. 
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'lext box for 
adding notes 

~ Info 

~ Syst•m Fold•r 

Kind : folder 
Size. : 1,3 9 7,9t4bytesused, 1,313Kon 

dbk, for 3 1 filt'$ 
k'h~n-: Nrddisk, ~xtern a1 hard disk drive 

cr~et~ : Fr;, Aug 31,1990, 12 :00 PM 
ModWod: Fri, Au9 31,1 990, 12:00 PM 

2 Choose Get Info from 
the File menu. 

The Info window appears, 
displaying information about 
the selected icon. 

3 Click the close box to 
close the Info window 

when you're finished. 

•!• Get Info shortcut: You can use the keyboard shorrcur 
Command-I ro display information about the selected irem. ·:· 

•!• Another use for the Info window: You can also use the Info 
window to lock the conrenrs of a document. ·:· 

> See ttlso: • "Protecting Information on a Disk" in C hapter 6 
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Getting information 
about a program 

You use the About command in the Apple menu ro get information 
about rhe program currently in use. From the deskrop, the About 
command provides derails about the Finder. 

Alarm Clock 
Calculator 
Chooser 
Control Panel 

j!.~ Rbout the Macintosh• floder'" 

Version nwnbers - L- Fiad•r: 6 .1.6 hrr, ., .Jc•n. st . ..... • • d Druce . . I S"ston: 6 .0.6 OApph C.mp• t • r . lno. 1983- 9 D 

RAM 10 thiS -- Total ........ : I .O~K 

computer L..._~-~-~-~~m--r:l : (~•~k:""" "" 

and available (light) 

Gening directory infonnation 

1 To get informacion 
about a program, choose 

About from the Apple menu. 
(The program's name is part 
of the command.) 

The About window appears, 
displaying details about the 
program. 

2 Click the close box to 
close the About window 

when you're finished. 
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Chapter 6 

Managing Disks 
and Disk Drives 

Disks are the Macintosh's principal storage medium. Every 
Macintosh model has at least one internal floppy disk drive, and 
many models offer an internal hm·d disk as well. 

T he system software and most applications are supplied on 3.5-
inch floppy disks, which are ideal for transporting data and 
backing up important wo rk. 

H ard disks offer the advantages of large sto rage capacity and 
speed of operation, although they are not as easily transported as 
floppy disks. 
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Using floppy disks The floppy disks used in a Macinrosh are flexible plastic disks (the 
source of the name "floppy") inside a hard plastic case 3.5 inches 
wide. A metal shutter at one end of the disk slides to one side when 
d1e disk is in d1e drive, exposing the flexible plastic on which 
informacion is stared. The plastic is coated with a magnetic layer 
similar to d1ar of recording rape {such as in rape cassettes) . 

Disk capacities The amount of information a floppy disk can store depends on d1e 
type of disk drive in which it is used and on the way the disk is 
initialized-d1at is, d1e way its magnetic surface is electronically 
prepared ro store data. 

Macintosh disks have one of three capacities: 

• 400 kilobytes (K) 

• BOOK 

• 1.4 megabytes (MB) 

Consult the Special Features booldet or the Handbook that came 
wid1 your computer for the capacity of floppy disks used in your 
Macintosh model. 
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High-density disks Disks with a capacity of 1.4MB are high-density disks and are 
and SuperDrive used in the Apple SuperDrive'""' high-density disk drive. High­

density disks usually have the letters "HD" on their case or 
metal shutter. High-density disks also have an extra hole in their 
plastic case (on the opposite side from the disk-locking tab) , 
wh ich allows the SuperDrive to recognize rhem. 

6 Important: Use high-density disks in the SuperDrive only. You 
cannot use these disks in drives that accept only BOOK or 400K 
disks. (See Figure 6- 1.) 6 

~ ~ ~o~l~ ~ 
Exu~1 hole in 
disk case 

SuperDrive 

SOOK drive 

400K drive 

Figure 6- 1 Proper usc of noppy disks 

T he SuperDrive accepts all three types of floppy disks-400K, 
800K, and 1.4 MB. T his drive can also read 3.5-inch disks from 
computers that use the MS-DOS operating system. 

» See also: • "Locking a Floppy Disk" in this chapter 
• Appendix C, "Exchanging Disks and Files With 

MS-DOS Computers" 
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JH's home disk 

1 Slide the disk, metal end 
first and label side up, 

into the drive. 

The disk snaps inro place. 

2 Check the screen to be 
sure that the disk has been 

recognized. 

The screen will show either an 
icon for the disk or a dialog 
box reporting that the disk is 
unreadable. 

>-- See also: • "Initializing and Naming a Disk" in this chapter 
• "T esting and Repairing a Disk" in Chapter 10 
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Ejecting a disk You can easily eject a floppy disk from the deskwp. 
from the desktop 

JH's home disk 

. .JH · s homo? disk 

1 Point to the icon of the 
disk you want to eject. 

2 Drag the disk icon to 
the Trash icon. 

When the T rash icon becomes 
highlighted, release the mouse 
button. T he disk is then 
ejected. 

·:· Other ways to eject a disk: You can also select a floppy disk 
and choose Eject from the File menu, or use either of two 
keyboard shortcuts w eject a floppy disk. Command-E ejects 
the selected floppy disk; Command-Shift- ! ejects the disk in 
the internal drive (the first drive if there are two); Command­
Shift-2 ejects the disk in the second internal drive or an 
external floppy disk drive. ·:· 

)1-- See also: • "Initializing and Naming a Disk" in this chapter 
• "Testing and Repairing a Disk" in Chapter 10 
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Ejecting a disk from 
within a program 

Curren! disk 

Ejec1 button 
is unavailable 

for a hard disk. 

You can eject a disk when you're working in a program by using 
a command, such as O pen or Save As, that displays a directory 
dialog box. 
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Snuo this doc ument ns: ( S~ll'O I 
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1 With the directory 
dialog box displayed in a 

program, click the Drive 
button to locate the disk you 
want to eject. 

Skip this step if the displayed 
disk is the one you want. 

2 Click the Eject button 
to eject the current disk. 

T he disk is ejected. You can 
then insert a different floppy 
disk. (The Eject button is 
dimmed, and thus doesn't 
operate, when a hard disk is 
selected.) 



Initia lizing and 
naming a disk 

You name a disk when you initialize it. Initializing (also called 
formatting) prepares a new disk to store information; if a disk 
already contains data, initializing it erases that data. 

A W arning: Be sure that any disk yo u plan to initialize contains 
no info rmation you want to save, because you'll lose that 
information during initialization . .& 

1· --.1 This disk Is unreadable: 

Do you want to initialize it? 

n Eject J) [ Initia lize~ 

High-density disk 

@:! This disk Is unreadable: 

lL.JJ Do y ou wont to initialize it? 

n Ejec t J) [One-Sided I [Two-Sided) 

BOOK disk 

Using floppy disks 

1 After placing a new disk 
in the disk drive, click 

Initialize (if the disk is a high­
density one), Two-Sided (for 
an 800K disk), or One-Sided 
(for a 400K disk). 

A second dialog box appears, 
advising you that initializing 
will erase the disk. (If the disk 
has already been initialized 
and is not damaged, neither 
d ialog box will appear-you'll 
just see the disk icon.) 

You can click Eject if you don't 
want to initialize the disk. 
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/1\ This process will erase all 
ill information on th is disk. 

Cancel (( Erose J 

r!:!'1 Please nome this disk: 

lU I 

riD Please nome this disk: 

0 I Tim's backup 

n OK ~j 

2 Click the Erase button 
to continue initialization. 

You can click Cancel to avoid 
erasing the disk. 

If you click Erase, a third 
dialog box appears, asking you 
to name the disk. 

3 Type the name you 
want for the disk. 

If you don't name the disk, it 
will have the name "U ntided" 
when it is initialized. 

4 Click OK to complete 
the initialization process. 

Initialization proceeds, with a 
status box reporting its 
progress. When the process is 
complete, the disk icon 
appears on the desktop, with 
the name you typed. 

~ See nlso: • Appendix C, "Exchanging Disks and Files With MS-DOS 
Computers" 
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Erasing a disk Initializing a disk erases any information on it. To erase an 
already initialized disk, use the Erase Disk command in the 
Special menu; this command actually reinitializes the disk. 

• 

Restart 
Shut Down 

fiTl Completely erose dlslc named 
10 ' Flies for Kote ' (lnternol 

!lrlue)? 

n Con eel J) (One-Sided j ~~ 

Using floppy disks 

1 To erase a disk, first 
select the icon of the disk 

you want to erase. 

2 Choose Erase Disk from 
the Special menu. 

An alert box appears, giving 
you a chance to cancel the 
erasure and asking you to 

select the capacity of the disk 
after it is erased. 

3 Click the button for the 
disk capacity you want. 

The disk is erased and 
initialized for the selected 
capacity (one-sided is 400K, 
two-sided is BOOK). A status 
box on the screen reports the 
progress of this procedure. (If 
you're initializing a high­
density disk, the buttons are 
named Cancel and Initialize. 
Click Initialize.) 
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Renaming a disk You can easily rename a disk. 

Insertion point -----..,..---,..:.;====,~ 
0Jiinking) 

~[d 
Archiv€'s 1 /90 
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1 To rename a floppy 
disk, first select its icon. 

2 Type a new name for 
the disk. 

W hen you begi n typing, the 
pointer disappears. T he 
insertion poinr blinks at the 
end of the text you type. 

3 Click anywhere outside 
the disk icon. 

W hen yo u click, the insertion 
point disappears and the icon 
is deselected. 



Backing up a disk Although floppy disks are designed to last through thousands of 
hours of use, they can become damaged or worn. So it's wise to 

make backup copies of important work and application 
programs, especially if you use only floppy disks with your 
Macinrosh. 

You can make backup copies of individual documents as 
necessary, bur you probably will want to back up such essential 
disks as stanup disks, system software master disks, and program 
master disks. 

1dP star-tup 

Csing lloppy disks 

1 To make a backup copy, 
first point to the icon of 

the floppy disk you want to 
back up (the source disk). 

2 Drag the icon of the 
floppy disk you want to 

back up to the icon of the disk 
on which the copy will be 
made (the destination disk). 

The destination disk can be 
either a floppy disk (as 
pictured) or a hard disk. If the 
destination disk is a floppy 
disk, an alert box appears, 
asking you to confirm that the 
information being copied wiU 
replace the contenrs of the 
destination disk. 
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Are you sure you want to completely 
replace contents of 

"backup WP" (eHternol drlue) 

with contents of 

• WP startup '' (internal driue)? 

3 Read the message to 
make sure you're making 

the correct decision, then 
click 0 K to begin the backup 
procedure. 

n OK ~ Jl ( Cancel J yOUr disk is backed up; a 
dialog box reports the progress 
of copying. 

(If you click Cancel rather than 
OK, no backup takes place.) 

•!• One floppy disk drive: If your Macintosh has only one floppy 
disk drive (and no hard disk), you can use this backup 
procedure, but you'll have to swap disks a number of times. •!• 

~ See also: • "Backing Up a H ard Disk" in [h is chap[er 

USing a hard disk A hard disk consists of metal disks permanently sealed inside a 
drive compartment. The drive's sealed environment permits 
extremely fast reading and writing of information, and the 
multiple disks inside a drive store 20 to 160 megabytes, or even 
more. 
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t Hard disk precautions Because the components inside a hard disk drive are very close 
together and moving very fas t when the drive is turned on, these 
drives should be handled with care. 

Observe these precautions when working with a hard disk: 

• Avoid jostling or rough handling of the drive (and thus of the 
Macintosh with an internal hard disk) . Never move a 
Macintosh when the hard disk drive is operating. 

• Some models of the Macintosh are designed to operate either 
sitting flat or turned on one side. Setting Up Your Macintosh 
for your model includes special instructions if your model 
can be placed on one side. Do not place the computer on irs 
side unless it is designed to operate this way; ir could affect 
hard disk operation. 

• Always keep rhe d rive on a sturdy, level surface. 

• Operate a hard disk at temperatures between 50 and 104 degrees 
Fahrenheit and at a relative humidity of 20 to 80 percent. 

• Avoid spilling any liquids on or near the drive. 

• D o not expose the drive to hazardous vapors, such as those 
from cleaning solvents. 
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Initializing and 
naming a hard disk 

for the first time 

.. 
You use the Apple HD SC Setup program, supplied on one of 
the system software disks, to initialize and name a hard disk for 
the first time. Initializing (also called formatting) prepares rhe 
disk's surface to store information. 

The internal hard disks in many Macintosh models are 
initialized at the factory; these drives do not have to be 
initialized again before you use the computer. If the disk in your 
computer has been initial ized, you'll see the disk's icon on the 
desktop when you first turn on the computer. 

A Warning: If you received a hard disk with AJUX on it, do not 
initialize that disk; doing so will erase AJUX. Instead, see the 
A/UX documentation for instructions. .A. 

~ 
App lt> HD SC St>tup 

SCSI device ~~~n~pp:le~l~to~sc:..:s.::.:ot""up=---"'"' 
number of the [ Initialize 1 "' 

currem hard disk · · SCSI Oeulce: o 
( Updmto I 
( Par1111on J 

[ Tos t I 
ll Quit n 
~ The uolume nomo Is Channing's 
~diSk 

Mess.1gc ar~a 
showing the name of 
the current hard disk 

1 To initialize a hard disk, 
start Apple HD SC Setup 

by double-clicking its icon. 

The program's main dialog 
box appears. 

I 2 If necessary, click the 
Drive button to select the 

disk you want to initialize. 

The current disk's SCSI device 
number is d isplayed above the 
Drive button; the disk's name 
is shown in the message area at 
the bottom of the dialog box. 
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Apple liD SC Setup 

[ Initialize~ 
[ Updote I 
[ Portltlon I 
[ Test I 

SCS I Oeulce: 5 

l --~""--· J_ _______ -·-------
~ The uolume nome Is llnrd disk 
~#2 

lnitioli z ing will erase all of the doto 
on this disk. Oo you wont to 
initialize this disk? 

([ Cancel ) [ lnit ttl 

Using a hard disk 

3 When the number and 
name of the hard disk you 

want are displayed, click 
Initialize to begin initializing. 

A dialog box appears in which 
you must confirm or cancel 
your decision to initialize. 

4 Click lnit to initialize 
the hard disk. 

When you click, the pointer 
becomes a sp inning beach ball 
and rhe message area of the 
dialog box reportS the status 
of initialization. After a short 
while, the computer's alen 
sound signals the end of the 
process, and a message reports 
successful initialization. (If 
you see a report that 
initialization has failed, begin 
rhe process again. ) 

A dialog box appears, asking 
you to name the disk. 
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Pleose nome t his disk: 

npplc 110 SC Setup 

( lnlllollze I 
( Updole I 
( Portlllon I 
( Tcs l I 

([ Quit~ J 

sc s I Uculco: 5 

~ Drlue lnltlnllza tlen 
~ successfully completed. 

5 If necessary, type a name 
for the hard disk, then 

click OK. 

If the disk has been initialized 
previously, the naming dialog 
box will not appear. 

6 Click Quit when the 
message reports successful 

initialization. 

> See also: • "Setting the SCSI Device Number" in Chapter 9 
• "Testing and Repairing a Disk" in Chapter 10 

Partitioning a hard disk You partition a hard d isk- that is, divide its storage area into 
two or more separate sections- so that the disk can be used by 
different types of computers, such as the Macintosh and the 
Apple lies®, or by different operating systems, such as the 
standard Macintosh system and NUX. 

6. Important: Apple recommends that, whenever possible, a 
separate hard disk be used for each different operating system. 
This strategy is preferable to partitioning a single hard disk for 
use by two operating systems. 6 
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The instructions that follow provide a summary of the 
partitioning process; be sure to consult the documentation for 
the other operating system or systems you will use on the 
partitioned hard disk for derails regarding your choice of 
partitioning options . 

.A. Warning: If yo u received a hard disk with NUX on it, do not 
partition that disk; doing so will erase A/UX. Instead, see the 
A/UX documentation for instructions on partitioning. A. 

~ 
Apple- HD SC Se-tup 

SCSI device ~I;:==A=p=ple=l:;-to_s;-c s_e_tu_P_~ 
number ofthe ltnltlnllze J "-. · SCSI Oeulce: 0 

current hard disk 1 Upda te ] 

( Portlllon J ~ 
I Test J 

t ault 11 
-·-··-·-·-·-·-·-·--·-· !E The uolu.ne nom e Is Hndy's HD 

Using a hard disk 

Message area 
showing the name of 
the current hard disk 

1 To partition a hard disk, 
first start Apple HD SC 

Setup by double-clicking 
its icon. 

T he program's main dialog 
box appears. 

2 If necessary, click the 
Drive button to select the 

disk you want to partition. 

The current disk's SCSI device 
number is displayed above the 
Drive burton; the disk's name 
is shown in the message area at 
the bottom of rhe dialog box. 
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St~ndard parlitions 
(may v;uy) 
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Button to display 
a dialog box 
for adjusting 
parlition size 

-

opplo 110 5[ Sotup 

( lnltlnllze I 
( Update I 
( Portltlon~ 

( l ost J 

SCSI Oeulce: 5 

t._ ~~~ ~· _J _______________ _ 
~ Tile uolumc nome Is llord disk 
~112 

Select n predefined disk portltlonlng scheme ond click OK to partition 
the entire disk. Or select Custom to make your own portltlons. 

Mnulmum Moclntosh ~ llnrd tllsk 112 Minimum Moclntosh 
50% Moclntosh 
n/ UII OOSC (2 Moclntosh) 
A/ UII 160SC (20 Moclntosh) 

(Custom ] A/ UII 160SC 140 Moclntosh) 
A/ UII 160SC 160 Macintosh) 

I ~ QQ 
[GED) 
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3 When the number and 
name of the hard disk you 

want are displayed, click 
Partition to begin the 
partitioning process. 

4 Select a standard 
partition from the list, or 

click Custom to adjust 
partition size, then click OK 
to partition the hard disk 

Consult the documentation 
for the other operating system 
you plan to use for specific 
parritioning instructions. The 
standard partitions available 
may vary; the list shown here 
. . 
ts represenranve. 

When you click OK, a dialog 
box appears giving you a 
chance to confirm or cancel 
your decision ro partition. 



A The data on SCSI driue number '5' w ill be 
U lost during th e repartitioning process. 

Press OK to repartition. 

[ OK ~ J I Cancel n 

Opple 110 SC Setup 

[ Initia lize) 

( Updot e ) 

( Portltion I 
[ Test I 

SCS I oeuicc: 5 

[§D 

n Quit ~ B --------
~ Partitioning successfull y 
~ completed . 

5 Click OK to partition 
the hard disk. 

When you click OK, the 
pointer becomes a wristwatch 
and the message area of the 
cliaJog box reports the status of 
partitioning. After a short while, 
the computer's alert sound 
signals the end of the process, 
and a message reports successful 
panitioning. (If you see a report 
that partitioning has failed, 
begin rhe process again.) 

6 Click Quit when the 
message reports successful 

partitioning. 

...... Sec also: • "Scrring the SCSI Device N umber" in C hapter 9 
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Erasing a hard disk You can erase a hard disk using the Erase Disk command. T his 
command reinitializes the disk. 

Restart 
Shut Down 

c::J Completely erose disk nomed 
' Wolthrop" (eHternol hord disk 

driue)? 

n Concel D [ lnltlollz~ 
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1 To erase a hard disk, 
first select the icon of the 

disk you want to erase. 

2 Choose Erase Disk from 
the Special menu. 

An alert box appears, asking 
you to confirm that you want 
to initialize the disk and giving 
you a chance ro cancel the 
erasure. 

3 Click the Initialize 
button. 

The disk is erased and 
reinitialized. A status box on 
the screen reports the progress 
of this procedure. 

(Clicking Cancel rather than 
Initialize cancels the erasure.) 



Renaming a hard disk You rename a hard disk with the standard editing steps. 

1 To rename a hard disk, 
first select its icon. 

2 Type a new name for 
the disk. 

When you begin typing, the 
pointer disappears. The 
insertion point blinks at the 
end of the text you type. 

3 Click anywhere outside 
the disk icon. 

When you click, the insertion 
point disappears and the icon 
is deselected. 

Backing up a hard disk You can back up the work you store on a hard disk by copying 
individual ftles in the usual way (dragging their icons to the icon 
of another disk). 

You can also use a commercial backup program to copy some or 
all fil es from a hard disk to another hard disk, to a tape drive, or 
to a series of floppy disks. 

Whatever method you use, be sure to back up important files 
and programs on your hard disk regularly. 

~ See also: • "Backing Up a Disk" in chis chapter 
• "Backing Up the Session's Work" in Chapter 3 
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Startup disk 
sequence 

T he Macintosh follows a ser procedure, called the scanning orde1~ 
to locate a stanup disk. The computer always looks first in the 
floppy disk drives, then it looks at external and internal hard disks. 

You can specify which device will be the first hard disk in the 
computer's scanning order by using the Startup Device section 
of the Control Panel. 

The scanning order The Macintosh scans disk drives for a startup disk in the 
for a startup disk following order: 

• internal floppy disk drive 

• second internal floppy drive 

• external floppy drive 

• startup device set in the Control Panel 

• internal SCSI hard disk (the computer waits 15 seconds for 
the internal drive to warm up) 

• external SCSI hard disk (if more than one, in descending 
order of device numbers) 

• internal bard disk (the computer returns to this drive and 
waits another 1 5 seconds) 

• floppy disk drive (if no startup disk has been recogn ized, the 
computer displays a blinking question mark over a floppy 
disk icon and waits for a startup disk to be inserted in a 
floppy drive) 

> See also: • "Specifying Items w Be Opened ar Stanup" in 

Chapter 2 
• "Setting rhc SCS I Device Number" in C hapter 9 
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Designating a hard disk 
as the startup device 

If you use more than one hard disk with your Macintosh, you 
should specify which one is the startup disk. You use the Startup 
Device section of the Control Panel for this task. (See Figure 6-2.) 

[[J 
Monitors c:::J -Jon's •1 I!!II:FJ 
... .., 
~ 

Mouse 

<l~) 

: : 

Figure 6-2 The Startup Ot:\'icc section of the Control Panel 

When you designate a startup device, it precedes all other 
devices except floppy disks in the scanning order. 

Rlarm Clock 
Calculator 
Chooser 

Startup disk sequence 

1 To set a startup device, 
first choose the Control 

Panel desk accessory &om the 
Apple menu. 

The General Control Panel 
appears. 
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Sound 

~ Control Panel ~ 

-Jose's **1 
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2 ScroU if necessary, d1en 
select ilie Startup Device 

icon in ilie left area of the 
Control Panel. 

The Stanup Device section 
appears. 

3 Click ilie icon of the disk 
you want to be the 

startup device. 

4 Click ilie close box to 
close ilie Control Panel. 

It's a good idea to close the 
Control Panel, although you 
can leave its window open. 



Protecting 
infonnation 

on a disk 

Clean Up Window 
fmpt!J l mstl 
rms(~ m~k 

Set Startup ... 

5 Choose Restart &om the 
Special menu. 

The computer restans, using 
the disk you specified as the 
srarrup device. 

>- See nlso: • "The Scanning Order for a Starcup Disk" in this 
chapter 

You can protect all the information on a disk by locking the disk 
itself, or you can lock individual documents and applications in 
the Info window. 

T he information in a locked document or disk can't be changed 
or thrown away; it can usually be opened or copied, however. 

Locking a noppy disk You adjust a tab on the disk's plastic case to lock ir. 

Unlocked Locked 

1 To lock a floppy disk, 
first locate the tab at the 

top-left corner on the back of 
the disk. 
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2 Slide the tab upward 
with the tip of a ballpoint 

pen (or a similar tool) . 

The disk is locked when the 
tab is in the upper position 
and an opening is visible in the 
disk's case below the tab. 

Sliding the tab down (covering the opening in the case) un locks 
a floppy disk. 

Locking documents You use the Get Info command w lock a document. 
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1 To lock a fi le, first 
select its icon. 

2 C hoose Get Info from 
the File menu. 

T he Info window opens. 

-



~0 Info 

Iii! From Amy 
lockod ~ 

Kind : Copy of 'w'nteUov document 
Size-: 1 ,024 b41 tu usM, 1 K on disk 

Yh~r• : archivE' s , inttrna1 driv~ 

~[i! Info 

[!iJ From Am~ lockod !8J 

3 Click the Locked box in 
the upper-right corner. 

4 Click the close box to 
close the Info window. 

The document is now locked. 

You can also lock a program using the Info window (to prevent 
the program's being erased, for example), but locking a program 
may affect its operation . 

·:· Lockingfolders: You can't use Ger Info ro lock folders; 
however, you can protect the contents of folders on an 
AppleShare file server by using the Access Privileges desk 
accesso ry in the Apple menu. ·:· 

)1-- See also: • "Creating Private Files on a file Server" in Chapter 7 
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Adding the 
Niacintosh to 

a network 

Chapter 7 

Using the Macintosh on a 
Computer Network 

Au Macinrosh models have built-in circuitry for connecting 
to a LocalTalkT"' network. Loca!Talk is one of the network types 
available in the Apple Talk® network system- a means ro 
connect computers, printers, and other devices so that their 
users can share information and resources. Some Macintosh 
models can use expansion cards that provide connections for 
other types of AppleT allc networks in addition to LocalTalk. 

This chapter provides an introduction to using the Macintosh as 
part of a network and instructions for using the parts of the 
system software that are designed for network operations. 

You can easily connect the Macintosh to a network that uses the 
computer's built-in LocalTalk circuitry. If your Macintosh mode 
has slots for expansion cards, you can install a card to provide a 
connection to a different type of network, such as Ethernet. 
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Connecting to an existing 
Loca!Talk network 

You can add your Macimosh wan existing LocalTalk nerwork, 
or you can connect one o r more LocaiTalk devices ro the 
Macinrosh and create yo ur own small nerwork. 

The instructions that follow provide a summary of procedures 
for connecting to an existing nerwork. Consult the 
documemarion provided with the LocalTalk connecror and 
cable for a more detailed treatment of this task. 

To make rhe LocaJTalk connection, you use a built-in connector 
on the Macintosh- the printer port- and a LocalTalk cable (or 
a compatible cable) . 

6 Important: If you are adding the Macintosh to an existing 
nerwork, notify the other computer users on that nenvork, and 
arrange to make your connection at a rime rhar won' t disrupt the 
nerwork's operation. 6 

LocaiTalk 
connector box 

2-mch.!r t~1hlc 

D 

1 To connect to an 
existing LocalT alk 

network, first assemble the 
components you need: 
LocalT alk connector box and 
cable, extender and extra 
cable if necessary, and the 
Macintosh. 

2 Unplug the LocalTalk 
cable from the LocalT alk 

connector box of the device 
that will be next to your 
Macintosh on the network. 
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Printer icon a 
Printer port --

D /:-le11' Mac 

.---- Hcconnected 
cable here 

:-le1v cable 
:ttlached hcre 

Adding the Macintosh to a network 

3 Plug the cable end of 
the LocalTalk connector 

box into the Printer port on 
the back panel of the 
Macintosh. 

You can recognize the Primer 
port by the icon above it on 
the case. 

4 Plug the cable you 
unplugged earlier into one 

of the sockets in the the 
LocalT alk connector box now 
attached to your computer . 

If the cable isn' t long enough, 
you can attach a cable extender 
and additional cable ro ir. 

5 Plug one end of your 
LocalT alk cable into the 

second socket in the 
LocalT alk connector box 
attached to your Macintosh. 

If the cables aren't long 
enough, you can attach a cable 
extender and additional cable 
to one or both of them. 
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D New :VIae 

I 
Allachnew-­
cable here. 

6 Plug the other end of 
your LocalTalk cable into 

the empty socket of the 
LocalT alk connector box 
attached to the computer next 
to yours on the network (the 
one from which you originally 
detached a cable). 

Now your Macintosh is part of 
the nen:vork. 

When you've completed the network cable connections, it's a 
good idea to make sure that all cables and devices you worked 
with have been reconnected to a LocalTalk connector box. Two 
cables should be attached to the connector box for all devices on 
the network except for those at either end of the network. 
Devices at the end should have only one cable in their connector 
boxes. (See Figure 7 -1.) 

R D 
( Y= I 

q ~ 

D 

Figure 7-1 A LocaiTalk network with one too many cables 

As noted, some Macintosh models can also connect to other 
types of AppleTalk networks. Instructions for these connections 
are provided with their specialized hardware and software. 
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Preparing the 
Macintosh system software 

for networking 

The system sofcware supplied with the Macintosh contains 
elements for some necwork operations. Depending on what 
devices your Macintosh necwork uses, you may need w install 
some or all of these pans of the system sofcware on your 
startup disk: 

• LaserWriter printer drivers-LaserPrep and LaserWriter 

• JmageWriter printer driver-AppleTalk ImageWriter 

• Image Writer LQ printer driver- LQAppleTalk ImageWriter 

• AppleShare driver (for using an AppleShare fi le server or 
prim server) 

• Access Privileges desk accessory (for checking your access w 
files on an AppleShare fi le server) 

• any special software supplied with necworking cards or o ther 
network devices, such as Ethernet sofcware if you install an 
ErherTalk® card. 

You also need to be sure that Apple Talk is turned on if you 
wam your Macintosh w use the services of an AppleTalk 
necwork system. 
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System Folder 

AppleShare 

1 To prepare the Macintosh 
system software for network 

use, first place all the drivers for 
your network's Apple Talk 
devices in the System Folder of 
your startup d.isk. 

You can copy these drivers by 
dragging them inro the System 
Folder of your startup disk, or 
you can use the Installer to add 
them to your system. They 
include the printer drivers. 

2 If necessary, install the 
AppleShare resource by 

following any special 
AppleShare instructions 
supplied with your 
Macintosh model or by 
dragging it to the System 
Folder of your startup disk. 

If no special instructions for 
AppleShare installation are 
provided with your Macintosh 
and you plan to use an 
AppleShare file server, be sure 
to place the AppleShare 
resource in your System Folder 
by dragging irs icon or by 
using the Installer program's 
C usrom option. 

Chap1er 7: Csing I he ~·lacimosh on a Com puler \erwork 



Active bunon 
selected indicates 

that AppleTalk is on. 

~ 
Eth~rTalk 

o ront 
Mauer @Desk Accessory 

morm Clock !!:! («<o.,«~D 
Chooser 
Control Panel 

lr,l 
( Remoue I 

Find File 

8683 bytes 

rn sel ected 

system I I Recess Prlulleges 
on Jody's hord disk ( llclp I on Jody's hard disk 

3080K free 3080K free 
( Cl ose ) ( Quit ) ( Close ) 

·-··-·-------·~·--"-·-·-·---.. ·-·--·-·-·- ·----·-·- ·------·-···-··-· - --·-·-·- --·-· 

0 Chooser 

~. ~ f!o! 

I I 
App~T•1k 1... lm•Wr1t•r 

::l ~ 
luw'W'rlt•r LO AppltTIL. 

User Nt~mo: 

I I 
I [Qj l Appl eTolk ®Active 

0 lnoctlve 

3 Copy or install any 
other necessary software 

for network devices on your 
startup disk. 

Consult the documentation 
for that software for specific 
instructions. 

4 If you are using an 
AppleShare file server, use 

the Font/DA Mover to install 
the Access Privileges desk 
accessory. 

Skip this step if you are not 
using an AppleShare file server. 

5 Confirm that AppleT alk 
is turned on in the Chooser. 

If it's not, click the Active button 
to tum it on. 

)1-- See aLso: • "Creating a Customized System" in Chapter 2 
• "Installing a Desk Accessory" in Chapter 8 

Adding the Macintosh to a network 189 



190 

Changing from 
one network to 

another network 

If you have installed a c;ard and software for a network orher 
than LocalT alk, you have a Network section in the Control 
Panel. You use rhis section to designate which type of network 
you want to use and to change from one network to another. 

Alarm Clocl< 
Calculator 
Chooser 

D 
.. [OJ 
Mouse I. --1 I 

~ 

1 To change from one 
type of network to 

another, first choose Control 
Panel &om the Apple menu. 

The Control Panel opens, with 
the General section displayed. 

2 Scroll if necessary to 
locate the Network icon, 

then click it to display the 
Network section. 

The Network Control Panel 
appears, with the icon of the 
network currently in use 
selected. The pointer becomes 
a crosshair when you place it 
in rhe area where rhe netw·ork 
icons are located. 
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Crosshair pointer -~~~~~~C~on~tr~o~IP~a~ne~l~~~~~ 

1 ~~.1 · '~~ ~ Icon representing ---ir----'~---f,H-' 

the built·in • t,.~.--.-.;,· 
AppleTalk circuitry 

~$ f 

[I 

S~nd J 
mr 

S1•rtvp O.vlct 

Recess to current network serulces 
will houe to be re-established. Are 
you sure you wont to change the 
RppleTolk connection? 

OK ~ B Cancel 

3 Click the icon for the 
network you want to select. 

When you select the icon, it 
becomes highlighted. You may 
then see a message alerting 
you that you will lose your 
connection with the devices 
on your currently connected 
network. 

4 Click the 0 K button to 
confirm the change of 

networks. 

If you aren't sure that you 
want to change networks, click 
Cancel and consult the 
network administrator or the 
documentation for the 
network products you're using. 

After you close the Control Panel, your choice remains in effect 
until you choose a different network. 
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Using a printer on 
the network 

ll1is part of the Chooser 
does not appear if the 

network is not part of an 
interconnected group. 

Like the Macintosh, most models of the LaserWriter printer have 
built-in AppleTalk circuitry and connectors. The ImageWriter 
and Image Writer LQ printers can also be used on a network if 
they contain an Apple Talk adapter. If your Macintosh is parr of 
a network that has more than one printer, you can use any of 
those printers. 

If yom network is linked together with other Apple Talk 
networks, you may have access to printers on other networks. 
When multiple networks are interconnected, the resulting 
internet may be divided into Apple Talk zones for easier 
management. You can select any zone listed in the Chooser to 
use printers and servers available in that zone. 

You specify rhe zone and the printer you want to use with the 
Chooser. (See Figure 7-2.) 

-s ..... .. T. 
. ~. 

AppleShare IQQ&ltd 

CC4- 5t rth 
CC4-5th/South 
CC4-6lh/North 
CC4-6th/South 

Chooser 
Select e LeserWriter: 
Fontsgelore 
Graphics 
Quickndirty 
Steedystreem 
Tol edo 

Background Printing: ®On 0 Off 

AppleTelk 

Figure 7-2 The Chooser showing zones and Laser\Vriter primers 
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Choosing a netV\10rk printer You use the Chooser to designate boch network primers and any 
connected directly to your Macintosh. 

Icons for !he 1ype 
of de1•ice you 

wan11o use 

• Choo•er 

~~ 
Sel ect e file serYer. 

~ 

I ~ Appl•Shar• Lanr-.lr ltw 

I I 

In 
O!J Appl eTelk Zones: - ---·-------------

!"-
User Name: 

CC4-Sth/North I ifMII I CC4-Sth/South 
CC4-6th/North ~ Appl eTelk 

®Active 
CC4-6lh/South 0 lnecliYe 

Using a primer on the network 

1 To specify a network 
printer, first select the 

Chooser from the Apple menu. 

The Chooser opens . 

2 If necessary, locate the 
icon for the type of 

printer you want to use, then 
click the icon to select it. 

You may have to scroll to 

locate the icon. When you 
select a different type of 
device, the list in the box on 
che upper right changes to the 
names of available devices. 
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Appl eTol k Zones: 

CC4-5\hlt4orth 
CC4-5\h/South 
CC4-6th/ Norttlt 
CC4-6th/South 

10 

~ ~ 
AppleTolk zones: 
CC4 Upper 
CC4-5t h/North 
CC4-5\h/Sou\h 

CC4- 6\h/South 

Chooser 

Setect e~ Les erWrHer: 
Fontsgol or e 
Gr ophlcs 
Oulckndlrty 
5\eodystreom 
Tol edo 

Background Prl nt 1 ng. ® on 0 orr 

User Nome: 

. ''''" 
AppleTolk @ ACtlYe 

0 tnoctlve 

Chooser 

Sel ect o LoserWr1ter. 
Borcel ono 
Coprl 
Honolulu 
Londo 'it 
Pons 

!!:! 
~ 

lo 
Background Printing: @ On 0 OH 

User Nome: 

I '''"' I 
AppleTolk ®Active 

0 lnocllve 

3 If necessary, locate the 
name of the zone in which 

you want to use a printer, then 
click that zone to select it. 

You may have to scroll to 
locate the zone you want. 
When you select a different 
zone, the printer names 
change in the upper-right parr 
of the window. 

4 Click the name of the 
printer you want to use. 

You may have to scroll to 
locate the name. 

Your choice rakes effect immediately and remains in effect until 
you choose a different printer. (It's a good idea to close the 
Chooser window.) 

Printing your \vork 
on a network printer 

Once you have designated the printer you want to use (with the 
Chooser), you simply print your documents in the usual way­
by using the Print command in an application program or by 
selecting one or more documents on the desktop and choosing 
Print from the File menu. 

> See also: • "Priming Your Work" in C hapter 4 
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Using a print server A print server is a combination of hardware and sofrware that 
manages priming jobs sem w it by a number of compmers on a 
nerwork. A print server is often called a spooler, a term that is 
generally used as part of its name on the nerwork. 

If your Macintosh is parr of a nerwork that contains a print 
server, you can send printing jobs to it and make the most 
efficient use of your computer for other work. You may wish to 
turn off background priming if you use a print server. 

Select e LeserWriter: 
ACDT Express Spooler 
Duck Dodgers 
Shene's Shine 
Med Heller Spooler 
Mushroom 

1 To use a print server, 
first open the Chooser 

desk accessory in the Apple 
menu. 

2 Follow the regular steps 
for choosing a printer, but 

select one that has Spooler in 
its name. 

You may have to scroll to 
locate the name. 

When you print a document, the printing status box appears for 
a few moments, then closes. You can now use your Macintosh 
for other work while printing. 

)lo- See also: • "Using Background Priming" in Chapter 4 
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Using an AppleShare 
file server 

If your Macintosh is part of a network that has an AppleShare 
file server, you can expand your access to programs and data 
significantly without adding any components to your own 
computer. You can also create private files on the server and 
designate who will have access to them. 

196 

In addition, a file server allows you to exchange information 
with anyone else on your network or in a zone that you can 
reach from your computer. 

Gaining access to an You connect to a ftle server with the Chooser. 
AppleShare file server 

The instructions that follow summarize the connection process; 
consult the AppleShare file server documentation for a complete 
explanation of all options. 

~ =r f!' 

~'ltS~t l utr'w'rit.r' 

Iii 

AppleTclk Zones: 

CC4 -Sth/Norlh 
CC4-5lll/ Soulll 

~ CC4-6lhltlorth 
CC4-6lh/Soulh 

Chooser 

I ~ 
Bcckground Pnnl1ng: @ On 0 Off 

User Nome: , ... , .. I 
AppleTolk '!>Act ive 

0 lnocllve 

1 To gain access to an 
AppleShare file server, 

first select the Chooser from 
the Apple menu. 

The Chooser opens. 

2 Click the AppleShare 
icon to select it. 

When you select a type of 
device, the names of the 
devices available appear in the 
upper-right list box. 
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Chooser 

IQ 
Sel ect e rile server. .., ::!: Oetebese downl oeds 
Electronic tools 

!11111:111 L~ur'w'rlttr Grephlcs server 
More grephlcs 
Bollerp lete flies 

lo CEJ AppleTelk Zones ... 
User Nemo: 

CC4-Sth/Nor th 
CC4-5th/South 
CC4-6th/Nort~ 

In AppleTelk 
@ Activo 

CC4-6th/South 0 lnectlve 

;o Chooser 

Select e file server • =r I!= Ar t group 
Budgets 9 1 & 9\ 

~ L-I:Sf'f''l'rittr Merketlng plens 
Oota orchlves 

lo (EJ 
AppleTelk Zones 
CC4 Upper !!! User Neme: 
CC4-5l h/llorth II '''" CC4-5lh/ South 

AppleTolk ®Act we 
CC4-6lh/South 0 lnoctlve 

m CIIOOser 

~ 
Select o rno server. 

~ ~ Art group 

PJIII!II!I l aurVrlltr Mcr ketlng plens 
Dete ere hives 

lo ~ AppleTt~ l l< Zones: 
CC4 Upper IQ User Ncme 
CC4-Sth/North I £1M !I 
CC4-Slh/South 

AppleTelk ®Active 
CC4-6lh1South 0 lnecttve 

Using an AppleSharc file server 

I!= 

lei 

I 

~ 

15 

I 

I' 
lo 

I 

3 If necessary, click the 
name of the zone in which 

you want to use a ftle server. 

You may have to scroll to 

locate the zone you want. 
When you select a different 
zone, the server nan1es change 
in the list box at the upper­
right side of the window. 

4 Click the name of the 
file server you want to use. 

You may have to scroll to 

locate the name. 

5 Click 0 K when the 
name of the file server you 

want to use is selected. 

A dialog box appears when 
you click OK, in which you 
provide information for 
connecting to the server. 
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Guest does not ..c.in 
require name or ~ 

password (but may ~~~nec tto the fil e sorue r · ouagets 9 1 II' 92 " 

have limited access 0 GueH 
to infonnalion). ~]/® neglsle rea user 

Registered user's ~ Nome: ~~J:•~~y~L:er:•e::::n:::::::::::::::::::::::::::::::::::::::::= 
name and password Pns swora: U I I I I I HI tscromblea l 

must match those in 
a master fi le on the 

server or access 
will be denied. 

Cnncel [Set Pnsswora ) DK 

Connect to tho fil e serue r "Dudge ts 9 t ll' 92 " 
ns: 

0 Guc~t 
® Regis tered User 

Nome: J Jody Lorson 

Possword: h t Itt I HI (Scrembled) 

ll 

[ Ca nce l [Se t Pnsswerd J n OK ~J 

6 To connect to the server 
as a Registered User, type 

or correct your name if 
necessary. (Your name must 
match the form with which 
you are registered.) Then, type 
your password. If you're not a 
registered user, click the Guest 
button, if it's not dimmed. 

Yo ur name will be inserted 
automatically if you've 
supplied a user name in the 
C hooser. When you type your 
password, you won't see the 
characters on the screen (for 
security), so type carefully. 

If the Guest option is dimmed 
and you're not a registered 
user, yo u won't be able to 
connect to the server. 

7 ClickOK. 

When you click OK, another 
dialog box appears, in which 
you select the portions of the 
fil e server you want to use. 
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Portions of the file 
seiVer (called ~ Budget s 9! & 92 

~'Oiumes) available Select the seruer uolumes you wont t o usc: 

to this user ___JL____f Dpen!tlons FY9 I 

t7 
Operations FY92 0 

Selected volume ~~~····••l(tJ llllljllJOOdl'r 0 

A · t ( 1· d) Checked uolumes (ill! I will be opened ot 
pm•a e c unme system startup time. 
volume (to which 0 Souo My Nomo Only 

thiS user doesn't ® Soue My Nomo and Password 

have access) Quit t OK" I 

dLl 
.~) 
S~affing 

Using an AppleS hare fi le server 

8 Select the name or 
names of the volumes you 

want to use, then click OK. 

You may have to scroll to 

locate the volume or volumes 
you want. When you click 
OK, the dialog box closes and 
the selected volume or 
volumes appear as AppleShare 
icons on your desktop in the 
area where disk icons appear. 

9 Use a ftle server 
volume as you would a 

disk, opening it and using the 
documents and folders in its 
window or creating new 
documents on it. 

1 0 When you're 
finished using a file 

server volume, drag its icon to 
the Trash to disconnect your 
Macintosh from it. 
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Storing and retrieving 
information on an 

AppleShare file server 

Creating private files 
on a file server 

You use programs, documents, and folders on a file server in much 
the same way you use them on a disk in a drive that is part of your 
Macintosh system. 

Because an AppleShare file server provides a means oflimiting access 
to programs and files, you may not be able to use some server 
volumes and some folders on the volumes that are available to you. 

You' ll recognize the volumes, folders, and documents to which 
you do not have access because their icons (or their names in a 
list) are dimmed in the server window. 

With the exception of dimmed items, you can copy items from 
the file server to your disks, create and edit documents on the 
server, use programs on the server, and copy or save items from 
your Macintosh to the server. 

Consult the AppleShare file server documentation or see the 
network administrator for your work group for more detailed 
information about file server use. 

When you are connected to a file server as a registered user, you 
can create and assign access privileges to folders. That is, you 
designate who can use a folder and what the users can do with 
its contents. 

In brief, the access privileges you can assign include 

• three categories of users- owner (you), group (any group 
registered on the server by the administrator), and everyone 
(all registered users and guests who have access to the server) 

• three types of privileges for each of these user categories-the 
privilege to see any folders inside the folder you created; the 
privilege to read or copy any documents or programs in the folder 
(bur not to change any); and the privilege to make changes to any 
of the folder's contents, including deleting items from it 

Consult the AppleShare file server documentation or the 
network administrator for your work group for more detailed 
information about AppleShare's access privileges. 
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Connecting to 
another cotnputer 

via modem 

You can obtain a great deal of electronic information by using a 
modem-a device that converts computer signals for 
transmission over telephone lines-to communicate with other 
computers. 

You can connect to numerous commercial information services 
and free bulletin boards by modem, and you can also connect 
directly with another individual computer user if that person's 
system is equipped with a compatible modem and controlling 
sofrware. 

You need a communications program to direct the modem's 
operations and a telephone line that is relatively free of static or 
other interference. The documentation for a modem and for 
communications programs can provide specific instructions for 
connecting with other computers via modem. 

Once you've made a connection with another computer, you can 
use the communications program to send and receive files and 
to perform many activities on the other computer. 

)o- See also: • "Connecring a Modem" in Chaprer 9 
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Personalizing Your 
Macintosh Work Space 

Chapter 8 

T:e Macintosh is designed to let you adjust some '-'peers of its 
operation and its screen's appearance. These customizable items 
include 

• mouse operanon 

• keyboard operation 

• sound and volume 

• time and date 

• the look of the desktop 

• colors or shades of gray 

• fonts and desk accessories 

Most of these adjustments are made in the Control Panel. Some 
use desk accessories or other parts of the system software 
supplied with the Macintosh. A few adjustments, such as screen 
brightness and monitor position, are made with the hardware. 
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Adjusting mouse 
operation 

Setting the correlation 
between mouse and 

pointer movement 

You can modifY two aspects of mouse operation-pointer 
movement and double-clicking speed-in rhe Mouse section of 
rhe Control Panel. (See Figure 8-1). 

-o Contro l Panel 

Figure 8-1 111e Mouse Control Panel 

The correlation between mouse and pointer movement, called 
mouse tracking, can be adj usted so chat the pointer moves the 
same distance on rhe screen as the mouse moves, or so rhar che 
pointer moves up ro nvo times as far on rhe screen as the mouse 
moves, depending on how fast you move the mouse. 

Mouse cracking is preset co slow when you install the system 
sofnvare. T he options for tracking are 

• Slow-the mouse and rhe pointer move the same distance 

• Fasr- rhe pointer moves nvice as far as the mouse 
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• Buttons between Slow and Fast-graduations between one­
for-one and two-for-one pointer and mouse movement 

• Very Slow/Tablet-the pointer moves at a constant speed 
when the mouse is moved, a useful setting for drawing with 
the mouse or using a graphics tablet 

About the Finder ... 

Alarm Clock: 
Calculator 
Chooser 

D 

rn 
~ 

General 

Keyboat·d 

... , 

ml 

Adjusting mouse operation 

1 To set mouse tracking, 
first choose Control Panel 

from the Apple menu. 

The Control Panel opens, with 
the General section displayed. 

2 Scroll if necessary to 
locate the Mouse icon, 

then click it to display the 
Mouse section. 

The Mouse Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in rhe Mouse Tracking area. 
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Mouse Tracking 

. \':.!f~Sil 
ii:Elb!) 

3 Click the button for the 
tracking option you want . 

Crosshair pointer --1-'-(T.,_.r a""b,Jl,.,elt)..__ __ ...., OM'-"o,.,us....,_e l--.. T he new tracking option is in 
effect; you can test it by 
moving the mouse. 

Setting the 
double-clicking speed 

0 ®00Cl1 
Very Slow Slow Fast 

After you close the Control Panel, your choice remains in effect 
until you choose a different tracking option. 

You can adjust the double-clicking speed of the mouse button 
by changing the interval between clici<S. 

About the Finder ... 

Alarm Cloclc 
Calculator 
Chooser 

1 To set the double­
clicking speed, first 

choose Control Panel from 
the Apple menu. 

The Control Panel opens, with 
the General section displayed. 
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D 

n 
8 

General 

Keyboard 

The space between --+--1--l 
arrows corresponds 

to the interval 
between clicks. 

~louse buuon highlights 
twice at the interval selected 
when you click a buuon. 

'''""\ 

mi 
+ + + 
• o +® +& 

Doub lo-Click Spoed 

Crosshair pointer 

2 Scroll if necessary to 
locate the Mouse icon, 

then click it to display the 
Mouse section. 

The Mouse Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in the double-click area. 

3 Click the double­
clicking speed you want. 

When you click, the mouse 
button on the screen is 
highlighted rwice at the 
interval you selected. 

Your choice remains in effect until you choose a different 
double-clicking speed. 
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Adjusting keyboard 
operation 

You can adjust the rate of character repetition when a key is held 
down as well as the delay before the character begins repeating. 
These adjustments can be made with any Macinrosh model and 
keyboard. 

You make these adjustments in the Keyboard Control Panel. 
(See Figure 8-2.) 

~~~ID~~~~~~C~o~nt~r~o~I ~Pa~n~e~l~!!~~~~~ f 10 Options for delay rn F Key Repeat Rate Delay Until Repeat before character 
~ 000®0 0 ®000 repetition:theOff 

Options for ---lf-.J.!CGel:l!n!:!:er-'!.lal_i*i~' S;;:low;:;;:;;;;;;;:;:;;:;:;;F;;:as;;:t!.,..,.l.,...,...O,.,ff,...,...,Lo..,.ng..,...,..,..S.,..h.,...or,..,..jt buuon turns off key 
character-repetition ll!!!!!!!lll repetition 

speed 
l!mBI 

'''). 

0 
Mouse 

Sound 

Figure 8-2 The Keyboard Control Panel 
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Setting the keys' repeat rate On all Macintosh keyboards, holding down most keys causes 
the character to appear repeatedly on the screen until you 
release the key. You can adjust the rate of repetition from very 
slow to quite fast. 

Crosshair pointer 

About the Finder ... 

Alarm Clock 
Calculator 
Chooser 

rn 
~ 

General 

•·M'·' 

Key Repeat Rate 

O®OOCb 
Slow Fast 

1 To set the repeat speed 
for a key held down, first 

choose Control Panel from 
the Apple menu. 

The Control Panel opens, with 
the General section displayed. 

2 Scroll if necessary to 
locate the Keyboard icon, 

then click it to display the 
Keyboard section. 

The Keyboard Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in the Key Repeat Rate area. 

3 Click the button for the 
repeat rate you want. 

Your choice remains in effect until you choose a different key 
repeat rate. 
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Setting the delay You can adjust the keyboard's operation to your "touch" by 
before keys repeat setting the delay before a character begins repeating when a key 

is held down. 

About the Finder ... 

Alarm Clock: 
Calculator 
Chooser 

n 
~ 

General 

.. ,, 
De lay Until Repeat 

Crosshair pointer ---+----

The Off button I P ® 0@ 0 
turns off repeating Off Long Short 

characters. 

1 To set the delay until 
characters repeat when a 

key is held down, first choose 
Control Panel from the Apple 
menu. 

The Control Panel opens, with 
the General section displayed. 

2 Scroll if necessary to 
locate the Keyboard icon, 

then click it to display the 
Keyboard section. 

The Keyboard Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in the Delay Until Repeat area . 

3 Click the button for the 
repeat delay you want. 

Clicking the Off button 
overrides the character-repeat 
feature. 

Your choice remains in effect until you choose a different delay 
option. 
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Adjusting sound 
and volume 

You use the Sound Control Panel to set the speaker volume and 
to choose rhe sound rhe Macintosh makes when ir signals you. 
(See Figure 8-3.) 

Control Panel 

Alert Sound Setting 

Boing ) 

~M!o~nk~ey~--~!!!!!!!!!!!!!!ril- Options for the 
Simple Beep _ O alen sound 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .... . . . . . . . . . . . . . . . . . . . . . . . 

Figure 8-3 The Sound Control Panel 

If your Macintosh 
has sound input 
c-apability, you'll see 
an additional control 
here; for infonnation 
on using this control, 
see Special Features 
of Your Macintosh. 

Setting the speaker volume You can choose one of eight volume serrings for rhe Macintosh's 
builr-in speaker. 

About the Finder ..• 

Alarm Clock 
Calculator 
Chooser 

Adjusting sound and volume 

1 To adjust the speaker 
volume, first choose 

Control Panel from the Apple 
menu. 

The General Control Panel 
appears. 
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D 

··~ 

Mouse 

7-
6 -

Crosshair poimer ------h.t 
3-

Bar indicating ------f-.;;l.".g~i'l 
volume level 1 -1 

0 - ~g 

Speaker 
Volume 

2 Scroll if necessary to 
locate the Sound icon, 

then click it to display the 
Sound section. 

The Sound Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in the Speaker Volume area. 

3 Using the crosshair 
pointer, drag the bar to 

the number you want for the 
level of speaker volume. 

When you release the mouse 
button, the alert sound plays 
at the volume level you 
selected. 

Your choice remains in effect unril you choose a differenr level 
for speaker volume. 

•!• Speaker volume in two sections: You can also set the speaker 
volume in the General Control PaneL ·:· 

..... See also: • "Setting the Alert Sound" (next section) 
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Setting the alert sound Many programs are designed to play a sound when an alert 
message is displayed or when you try to give a command that 
the Macintosh cannot recognize. You can choose one of several 
options fo r the alert sound. 

Crosshair pointer 

About the Finder ... 

Alarm Clock 
Calculator 
Chooser 

D 

··~ 

Mouse 

Alert Sound Setting 

Boing 
Clink- Klank 
Monkey =t-. - .. . . 

Adjusting sound and volume 

l!ll[i 

!l!i!i 

Q 

0. 

1 To set the alert sound, 
first choose Control Panel 

from the Apple menu. 

The General Control Panel 
appears. 

2 Scroll if necessary to 
locate the Sound icon, 

then click it to display the 
Sound section. 

The Sound Control Panel 
appears. The pointer becomes a 
crosshair when you place it in 
the Alert Sound Setting area. 

3 Scroll if necessary, then 
click the name of the 

sound you want. 

When you release the mouse 
button, the selected sound 
plays. 
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Setting tin1e 
and date 

Your choice remains in ·effect umil you choose a differem a1erc 
sound. 

•!• Flash instead ofsound· When the speaker volume is set co 
zero, the menu bar flashes in place of an alerc sound. •!• 

)lo- See also: • "Sercing the Speaker Volume" (previous section) 

The Macintosh has an internal clock that runs continuously. A 
banery inside the computer maintains the time and date when 
the machine is turned off. 

You set the time and date in the General Control Panel. (See 
Figure 8-4.) 

Keyboard 

···;. 

c 
Mouse 

Sound 

Rate of Insertion 
Point Blinking 

.. ,.· ··:: ::-
0®0 

Slow Fast 

'l----...L-..::...:..:..:..:.:_~I'"---'<S'-I Date-setting area 

mm RAM Cache ~ [;) Q On 
1-----~.,;:"-1 @ Off 

Speaker 
Volume 

Figure 8-4 TI1e General Control Panel showing time and elate areas 

)lo- See also: • "Installing a Desk Accessory" in this chapter 
• "Changing rhe C lock Barrery" in Chapter I 0 

Chapter 8: Personalizing Your Macintosh Work Space 



Changing the time You can specify a standard 12-hour clock (showing A.M. and P.M. 

with rhe time) or a 24-hour clock when you set the time. 

About the Finder. .. 

Alarm Clock 
Calculator 
Chooser 

Crosshair pointer --+- ---
@ 12hr. (b 24hr. 

Time @ 
9:5"6: 19 AM 

Setting time and dare 

1 To set the time, first 
choose Control Panel 

from the Apple menu. 

The General Control Panel 
appears. T he poinrer changes 
to a crosshair when you place 
it in the time area. 

2 If you want to change 
the type of clock selected 

(12-hour or 24-hour), click 
the appropriate button. 

The rime changes in the Time 
area to reflect the type of clock 
selected. 

3 Click the part of the 
time you want to change 

(hours, minutes, or seconds). 

The part of the rime you click 
becomes highlighted, and 
small up and down arrows 
appear at the right. 
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Time (9 
Selected section -------a:==9:::::tmi:::::..:..3_1~A.:..:.M~l:J~ 

of the time 

Time 1!:9 
9 :~:3 1 AM (fj 

4 Click repeatedly on the 
up or down arrow until 

the time you want is 
displayed. 

The selected part of the time 
changes in the direction of the 
arrow each time you click. 

You can also type a new 
number for the time when it is 
selected. 

5 To save the new time, 
click the clock icon. 

The clock icon becomes 
highlighted briefly, then the 
new time is displayed. 

After you close the Conrrol Panel, the time you sec remains in 
effect unril you change it. 

·:· Another way to set the time: You can also set the time, as well 
as an alert time, in the Alarm Clock, a desk accessory that is 
part of the system software supplied with the Macintosh. ·:· 
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Changing the date You change rhe dare in much the same way as you change the time. 

About the Finder ... 

Alarm Clocl< 
Calculator 
Chooser 

Crosshair poimer ---+---. ~ I 
Date ~ 

"t/2 1/90 

Setting time and date 

1 To set the date, first 
choose Control Panel 

&om the Apple menu. 

The General Control Panel 
appears. The pointer changes 
to a crosshair when you place 
it in the Dare area. 

2 Click the part of the 
date you want to change 

(month, day, or year). 

The parr of the dare selected 
becomes highlighted, and 
small up and down arrows 
appear at the right. 

3 Click the up or down 
arrow repeatedly until the 

date you want is displayed. 

The selected part of rhe dare 
changes in the direction of the 
arrow each rime you click. 

You can also rype a new 
number for rhe dare when it is 
selected. 
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Crosshair pointer ----!f-----fi~::t. 
D<~t.:> 

IR/21/90 (II 
4 To save the new date, 

click the calendar icon. 

The calendar icon becomes 
highlighted briefly, then the 
new dare tal(es effect. 

After you close the Control Panel, the date you set remains in 
effect until you change it. 

·:· Another way to set the date: You can also set the date in the 
Alarm Clock, a desk access01y that is part of the system 
software supplied with the Macintosh. ·:· 

Setting an alert time with You can set the Macintosh Alarm Clock desk accessory to alert 
the Alarm Clock you at a predetermined rime. 

The Alarm C lock is part of the system software and is usually 
installed when you install the system software. If necessary, you 
can install it with rhe Font/DA Mover. 

1 To set an alert time, 
first choose Alarm Clock 

from the Apple menu. 

T he Alarm Clock appears at 
the top right of the screen, just 
below the menu bar. It 
displays the current time on 
the system clock. 
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D 3:52:18 PM l~] 

Lever to expand or 
compress the Alann Clock 

0 3:52:40 PM ~ 

6/21/90 
11le highlighted ----f:==;=:== 

area indicates 
the item displayed 

in the middle 
row-the date, 

in this example. 

Set/unset button - --r-t&.J 

3:53:34 PM e 

for the :tl:trrn 1--l---r----

Crosshair pointer 

Setting time and elate 

2 Click the upward­
pointing lever to the right 

of the time. 

The lever points downward, 
and the Alarm Clock expands 
to its full size. 

3 If necessary, click the 
alarm clock icon in the 

lower-right area to select it. 

The alarm clock area is 
highlighted when you select ic. 
(Skip this step if the alarm 
clock is already highlighted. ) 
The rime showing in the 
middle row is the last time to 

which the alarm was set. 

4 Click the button to the 
left of the time in the 

middle row to turn the 
alarm on. 

The pointer becomes a 
crosshair when you place it in 
the middle row. When you 
click, the button moves up and 
the alarm clock icon changes 
to show a ringing alarm, 
indicating chat the alarm is 
turned on. (Cl icking again 
moves the button down and 
turns the alarm off.) 
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0 3:53:34 PM e 
a:2\t:oo RM lltllton in the upper ---+--iYl 

position indicates 
that the alam1 is on. 

@~ 

D 
I!J 

@ 

Icon showing 
ringing alarm 

3:53:34 PM f~ 

amoo RM (;) 

~ • 

5 Click the part of the 
time you want to change. 

The part of the time selected 
becomes highlighted, and 
small up and down arrows 
appear to rhe right of the rime. 

6 Click the up or down 
arrow repeatedly until the 

time you want is displayed. 

The selected parr of the time 
changes each time you click. 

7 Click the lever at the 
right side of the top row 

to compress the Alarm Clock 

The alarm will nor go off 
unless you click the lever to 

rerum to the compact clock, 
select another area of the 
clock, or click the close box. 
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I Ci 3:53:34 PM ~ I 8 Click the close box to 
close the Alarm Clock. 

When the system clock reaches the time set for the alarm, the alert 
sound plays once (the menu bar flashes once if the speaker volume 
is set to zero) and an alarm clock icon blinks alternately with the 
Apple icon at the left side of the menu bar. (See Figure 8-5.) 

·iij· File Edit Uiew Special 

:,-0 
: 64 items 2 1 ,342K in disk 

Figure 8-5 The alarm clock icon in rhe menu bar 

After the alarm has gone off, you must open the Alarm Clock 
and turn the alarm off to stop the alarm clock icon blinking in 
the menu bar. 

•!• Setting the time and date: You can also set the system clock's 
time and date in the Alarm Clock, by firs t selecting the time 
or date icon and then changing the numbers. •!• 

)1-- See also: • "lns[alling a Desk Accessory" in [his chap[er 
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Changing the look 
of the desktop 

You can modifY several aspects of the desktop's and screen's 
appearance with the Control Panel as well as with controls on 
the Macintosh or its monitor. 

Three of these items-the desktop pattern, blinking of a chosen 
menu item, and blinking of the insertion point-are adjusted in 
the General Control Panel. (See Figure 8-6.) 

----...---...L.!::;;;=;;;;;;;===t- Options for setting 
the blinking rate of 
the insert ion point 

Options for setting -11---,i:~­
the number of 

blinks of a selected 
menu item 

Dat• lljl] 
6/2 1/90 

RAM Cach• ~ Ill Q On 
~---~ @off 

Sound Sp•akor 
Volum• 

Figure 8-6 Tite General Control Panel showing desktop adjustments 
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Changing the pattern 
cl isplayecl on the desktop 

You can choose from a variety of patterns provided for the 
Macintosh desktop, or you can create your own design by 
editing one of the patterns supplied. 

About the Finder ... 

Alarm Clock: 
Calculator 
Chooser 

Crosshair pointer --f~;;;:;;=~;===:;~l 
l'anem-editing area --7--L•--•-•­

(magnified view 
of pattern) 

Miniature desktop --+------r.:==r=:::: 

. .. ~ ..... -· -· ...... -· -· -· -· -· -· -· ... ...... .. , ............................................................. . 
......... , .......... rl' ............ . , .... .,. ............... . ............................................................. 
...... , ....... , ................ .!' •rJ'•rl'···· .............. . ............................................................. 
,!1, .... . . . .... ,,..,,)1,_., •••• •• e..-... . ... ........ . 

Control Panel 

Crosshair pointer -~h,...--;;;;•=-• -=---li~;:,;::;~:;j 
•• •• ~ · ·.-.•rl'• ...... rl'. 

• 

: •• •• •j. ~::;.-:;.-:;-:~ • •• ~i... . ......... ,;;,~ . .. .... , ......... . == • ;.':;.":;.":;.":;.":.~": 

Desktop Pattern 

Changing the look of the desktop 

1 To adjust the desktop 
pattern, first choose 

Control Panel from the Apple 
menu. 

The General Control Panel 
appears. The pointer changes 
to a crosshair when you place 
it in the Desktop Pattern area. 

2 To see the patterns 
available, click either small 

arrowhead at the top of the 
miniature desktop on the right 
side of the Desktop Pattern 
area. 

The pattern changes each time 
you click. C licking the 
opposite arrowhead reverses 
the order of patterns displayed . 

3 When you see a pattern 
you like, click the 

miniature desktop to see the 
new pattern on your full 
screen . 

T he new pattern replaces (he 
current pattern for (he 
desktop. If you decide no( (0 

keep (ha( pattern, begin (he 
selection process again. 
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De-sktop P atteorn 

Deosktop PaHeorn 

4 To edit a pattern, place 
the crosshair pointer in 

the pattern-editing area, then 
click where you want to make 
a change. 

Tiny squares (called pixels) turn 
from black to white or white to 
black (or change color) when 
clicked. The changes you make 
when editing a pattern are 
clisplayed immediately in the 
miniature desktop. 

5 To save the new 
pattern, double-dick in 

the miniature desktop. 

The new pattern replaces the 
one that was edited to create it. 

Clicking once djsplays the new 
pattern on the desktop; double­
clicking saves the new pattern 
but does not display it on the 
desktop. 

After you close the Control Panel, the new pattern you selected 
or created remains in effect until you change ir. 

~ See also: • "C hanging che Colors or Shades of Gray in the Desktop 
Parcern" in rhis chapter 
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Adjusting the blinking Menu items are preset ro blink three rimes when you choose 
of a selected menu item them. You can reduce or eliminate the blinking of a chosen 

menu item in the General Control Panel. 

About the Finder ... 

Alarm Clocl< 
Calculator 
Chooser 

Menu Blinking 

Crosshair pointer -----+ij] O O @ 

Off 1 2 3 

1 To adjust the blinlcing 
of a chosen menu item, 

first choose Control Panel 
from the Apple menu. 

The General Control Panel 
appears. The pointer changes 
to a crosshair when you place 
it in the Menu Blinking area. 

2 Click the button for the 
number of times you want 

the menu item to blink. 

C licking the Off button 
prevents a menu item from 
blinking. 

After you close the Control Panel, the blinking option you 
selected remains in effect until you change it. 
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Adjusting the blinking 
of the insertion point 

You can change rhe blinking rare of the insertion point- used to 

designate the place in a document or an icon name where you 
will add or change the content-in the General Control Panel. 

About the Finder ... 

Alarm Clock 
Calculator 
Chooser 

Ratt> of lnst>rtion 
Point Blinking 

lnsci1ion point, · .
1 

... 

blinking at the I ·::: =::· 
rate selected @ Q 

Crosshair pointer ~" Fast 

1 To adjust the blinking 
rate of the insertion point, 

first choose Control Panel 
from the Apple menu. 

The General Control Panel 
appears. The insertion point is 
blinking ar rhe rare currently 
selected. The pointer changes 
to a crosshair when you place 
it in the Rare of Insertion 
Point Blinking area. 

2 Click the button for the 
rate of blinking you want. 

When you dick, the insertion 
point changes to the rate of 
blinking you selected. 
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Indicating the 
relative positions of 

multiple monitors 

The pointer moves 
from one monitor to 
the other across the 
"border" where the 
two monitor icons 
touch. (The actual 

monitors do not 

If you use two or more monitors, you must indicate their 
relative positions so that the pointer can move from one monitor 
to another. You specify monitor positions in the Monito rs 
Control Panel. (See Figure 8-7.) 

Clicking Options opens 
a dialog box that lists 
the type of video card to 
which the selected 
monitor is connected. 

r"'-..;...;.-"-'--'-"-'--;_..;;.---'--'----;::::::::==:==!+-- The small white menu 

have to touch.) ---li------+--H-------... 
bar indicates the main 
monitor, on which the 
menu bar is located. 

Startup 
Icons for the -;-----!--+1------'-­ ----!+-- The dark line around 

an icon indicates 
that it is selected. 

monitors connected 
to the ~·lacintosh , 

showing their 
numbers and their 
relarive positions 

Colors in this box correspond 
to the number of colors 
selected for the monitor. 

Figure 8-7 The Monitors Control Panel showing two monitors 

Clicking the Identify 
button displays each 
monitor's number 
on its screen. 

The number of each monitor is determined by the location of 
the video card or built-in video socket to which it is connected. 
The monitor numbers remain the same unless you change the 
location of their video connections. 
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About the Finder ... 

Alarm Cloclc 
Calculator 
Chooser 

.. ~ 

Mouse 

1 To specify monitor 
positions, first choose 

Control Panel from the Apple 
menu. 

The General Control Panel 
appears. 

2 Scroll if necessary to 
locate the Monitors icon, 

then click it to display the 
Monitors section. 

The Monirors Control Panel 
appears . 
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~ (Identify~ 

mo ni1ors and mPnu b~r to th•m. 

Icon outline--+---------. 

Cros~hair pnimcr 

Changing the look of the desktop 

3 If necessary, check the 
numbers of your monitors 

by placing the pointer on the 
Identify button at the lower­
right corner of the Control 
Panel and holding down the 
mouse button. 

A large number appears in the 
cemer of each moniror's screen 
while the mouse button is held 
down; that number corresponds 
to the number of the icon in 
the C omrol Panel. 

Skip this step if you don' t 
need to verify the monitors' 
numbers. 

4 Drag the icon of the 
monitor whose position 

you want to adjust to a 
location on the screen that 
corresponds to that monitor's 
actual position. 

Because you're adjusting the 
monitor's position relative to 
the other monitor or monitors 
near it, you can't move the 
icon away from the other icon 
or icons. If you drag the icon 
to an isolated location on the 
screen, it will snap back ro 
border on the closest other 
icon when you release the 
mouse button. 
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Border between monitors; the 
pointer moves from one monitor to 
the other only along this border on 
the actual monitors. 

5 Release the mouse 
button when the outline 

of the icon you're 
repositioning is where you 
want it. 

The icon appears at or near 
where you dragged its outline, 
with one side bordering the 
closest other icon. 

If necessary, repeat steps 3 
through 5 to adjust the relative 
positions of other monitors. 

6 Choose Restart from the 
Special menu to 

implement the new monitor 
positions. 

You don't have to close the 
Control Panel before choosing 
the Restart command. 

The monitor positions you specified remain in effect until you 
change them. 

After you have specified the monitor positions, the pointer 
moves fro m one screen to another across the borders where the 
monitors' icons touch in the Control Panel. 
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Designating a You can designate a main moniror, where the Finder's menu bar 
main monitor will always be displayed. 

·:· Monitors of different sizes: It's a good idea ro make your larger 
monitor rhe main moniror. If the smaller one is rhe main 
monitor, some programs will restrict the window size to the 
size of the smaller moniror. ·!· 

About the Finder ... 

Alarm Clock 
Calculator 
Chooser 

··~ 

Mouse 

Changing the look of the desktop 

1 To designate a main 
monitor, first choose 

Control Panel from the Apple 
menu. 

The General Control Panel 
appears. 

2 Scroll if necessary to 
locate the Monitors icon, 

then click it to display the 
Monitors section. 

The Monitors Control Panel 
appears. 
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~ (Identify~ 

Dr monitors and menu bar to th~m. 

Outline of----f----­
Ule menu bar 

3 If necessary, check the 
nwnbers of your monitors 

by placing the pointer on the 
Identify button at the lower­
right corner of the Control 
Panel and holding down the 
mouse button. 

A large number appears in the 
cencer of each monitor's screen 
while the mouse button is held 
down; that number corresponds 
to the number of the icon in 
the Control Panel. 

Skip this step if you don't need 
to verify the monitors' 
numbers. 

4 Drag the white menu 
bar from the top of one 

monitor icon to the icon of 
the monitor you want to be 
your mam one. 

An outline of the menu bar 
moves with the crossha.ir 
pointer as you drag. 
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Changes won' t take effect until r estart . 5 Release the mouse 
button when the menu 

bar's outline is where you 
want it. 

The menu bar appears across 
the top of the icon for the new . . 
ma1n mon1tor. 

6 Choose Restart &om 
the Special menu to 

implement the new main 
monitor. 

You don't have to close the 
C ontrol Panel before choosing 
the Restart command. 

The monitor you specified will be the main one until you 
change it in the Monitors Control Panel. 
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Adjusting screen 
brightness 

You can adjust the screen brightness of most Macintosh models 
with a control on the compmer or on the monitor. (If your 
M acintosh model does not have a brightness control, it has a 
special section of the Control Panel that lets you adjust screen 
brightness. For instructions on using the Brightness Control 
Panel, see Special Features of Your Macintosh.) 

Contrast control 1 Locate the brightness 
control or controls on 

your Macintosh model or 
monitor. If your Macintosh 
has a separate monitor, check 
the monitor's manual for 
specific instructions. 

Certain compact models 
(Macintosh Plus, Macintosh 
SE models) have one control 
on the front of the computer. 
Modular Macintosh models 
usually have two controls­
brightness and contrast-on 
one side of the monitor. Some 
of these controls are marked 
with an icon of a sun. 

2 Turn the control dial or 
dials until the screen's 

appearance is satisfactory. 
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Designating colors 
or shades of gray 

Specifying the number of 
colors or shades of gray 

If your Macintosh model and its monitor can display color or 
multiple shades of gray, you can designate the number of colors 
or shades of gray to be displayed and then specify how the 
available colors or shades of gray will be used in highlighting, in 
the desktop pattern, and in icons. 

You use the Monitors Control Panel to specify the number of 
colors or shades of gray displayed on your Macintosh. (See 
Figure 8-8.) 

Options for the 
number of colors or 
shades of gray 
displayed on the 

BuHons for -1----l:::=---1----11 
QI!Dlia'!D~Jl-----+- selected monitor 

Button for 
displaying a list of 
video cards and 
connections in usc 

specifying color or 
shades of gray for 

the selected monitor 

Startup 

.__ __ ....__ ____ -+!-_ Icons representing 
monitors connected 
to the Macintosh 

L----1..========--=====:r- Button to identify 
the selected monitor 

Figure 8-8 l11e Monitors Control Panel 
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The number of colors or shades of gray your Macintosh model 
can display depends on the type of video capability it has. Some 
Macintosh models require a video card to connect a monitor. 
Other models don't require a video card (because they have a 
built-in video connector), bur they can use a video card if one is 
installed. 

Alarm Clock: 
Calcu lator 
Chooser 

··~ 

Mouse 

1 To specify the number 
of colors or shades of gray 

to be displayed on a monitor, 
first choose Control Panel 
from the Apple menu. 

The General Control Panel 
appears. 

2 Scroll if necessary to 
locate the Monitors icon, 

then click it to display the 
Monitors section. 

T he Monitors Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in the monitor-position or 
monitor-characteristics area. 
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Or~ monitors o~~nd mtnu bit'" to rnrranot tht m. 

Char-acteristics of selected monitor : 

@Grays :o· ; 

-ecolors : !~6 [Options ... ) 

Characteristics of selected monitor : 

QGrays : o· : -
@Colors : ~66 [Options ... ) 

3 If you have more than 
one monitor, click the 

icon of the monitor for which 
you want to specify rhe 
number of colors or shades of 
gray. 

The monitor is selected. 

4 Click the Grays or the 
Colors button to specify 

the characteristics of the 
selected monitor. 

5 Click the number of 
colors or shades of gray 

you want displayed on the 
selected monitor. 

T he number of colors or shades of gray you specified remains in 
effect until you change it. 
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Changing the 
highlight color 

You can change the color of the highlight on your screen, using 
the Color Control Panel and the color wheel dialog box. (See 
Figures 8-9 and 8-1 0.) 

--!~~IO~~~~~~~C~o~n~tr~o~I}P~a~n~e~l~~~~~~~ 
Current highlight '\. j 

color In ~ ~!m!lii.[ [ htHHJ!~ [ n!nr )- Ounon to display 
8 I!;! the color wheel 

Highlight color 
square (shows new 

selection in top half, 
current color in 

bottom half) 

Numbers 
correspond to color 
on the color wheel; 

they can be adjusted 
to select the 

highlight color. 

General dialog box 

I' 
~ 

Keyboard 

~ 
~ 

M>nitors 

1-----~ .: .: . :.:.:.:.: . : .: .: :.: .: . : 

Figure 8-9 The Color Control Panel 

Select 11 highlight color. 

20996 Hu e (;) 

36051 

50229 

(;) 
(;) 

35933 Red (;) 

50229 Green (;) 

22598 Blue (;) 
( Cancel ) n OK 

Figure 8-10 A simulation of the color wheel dialog box 

Chapter 8: Personalizing Your Macintosh Work Space 

Dot indicates 
selected color 

Brightness 
control 

'--i'f.f.iHH-- Color wheel 
showing options 
for highlight 
color (when four 
colors or grays 
are selected. 
leners appear in 
the \\'heel, 
indicating color 
values) 



To change the highlight color, the number of colors or shades 
of gray selected in the Monitors Control Panel must be four 
or more. 

About the Finder ... 

Alarm Clock: 
Calculator 
Chooser 

D 

~ 
Color 

Keyboard 

Crosshair pointer -;==::=====~==-~ 
IL¥4WI[ Ch11ng#co1or ) 

Designating the color or shades of gray 

1 To change the highlight 
color, first choose Control 

Panel from the Apple menu. 

The General Control Panel 
appears. 

2 Scroll if necessary to 
locate the Color icon, 

then click it to display the 
Color section. 

The Color Control Panel 
appears, showing an example 
of the current highlight color. 
The pointer becomes a 
crosshair when you place it in 
the color changing area. 

3 Click the Change Color 
button to display the 

color wheel dialog box. 

The color wheel dialog box 
opens, showing the current 
highlight color and brightness. 
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Circular pointer 

240 

4 If necessary, change the 
brightness of the color 

wheel by dragging the scroll 
box up or down. 

Scrolling up makes the color 
wheel brighter; scrolling down 
makes it darker. 

5 Place the pointer 
on the color wheel and 

click to select a new color or 
shade of gray. 

The pointer is circular when ir 
is on the color wheel. 

The new color or shade of gray 
is displayed in the top half of 
the square at the upper left of 
the dialog box. The current 
highlight color or shade 
remains in the bottom half of 
the square for comparison. 
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Se lect o highlight color. 

1'\ewly selected - - -~ 
color 

Current highlight __ _ 
color 

llue 20996 (;] 

So turotlon l6051 (;] 

Brightness 50229 (;] 

( Con eel I n OK~ n 

6 To experiment with 
other highlight colors or 

shades, drag the pointer 
around the color wheel or 
click at another point on the 
wheel. 

A new color or shade is 
displayed in the upper half of 
the square as you drag or each 
time you click. 

7 When you are satisfied 
with the highlight color 

or shade, dick 0 K to confirm 
your choice. 

The dialog box closes, revealing 
the Color Control Panel with 
the new highlight color 
displayed in the Example box. 

After you close the Conrrol Panel, the highlight color or shade 
of gray you specified remains in effect until you change it. 

>- See also: • "Specifying the N umber of Colors or Shades of Gray" 
in this chapter 
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Changing the colors or 
shades of gray in the 

desktop pattern 

You can change the colors or shades of gray displayed in the 
desktop pan ern in the General Control Panel. You change colors 
in rhe pan ern by editing one of the standard patterns provided, 
using the colors or shades of gray displayed in the Control Panel 
to replace the original colors or shades in that pattern. 

About the Finder .•. 

Alarm Clock: 
Calculator 
Chooser 

1 To change the colors or 
shades of gray in the 

desktop pattern, first choose 
Control Panel from the Apple 
menu. 

The General Control Panel 
appears. The pointer becomes 
a crosshair when you place it 
in the Desktop Panern area at 
the top center of the panel. 

-j!~~C~o~n~t~r~oiQP~a~n~e~l~~ Crosshair pointer --
2 To see the patterns 

available, repeatedly click 
either small arrowhead at the 
top of the miniature desktop 
on the right side of the 
Desktop Pattern area. 

Pattern-editing area ---;­
(magnified view 

of pattern) 

Miniantre desktop --~~~~_) 

Simulation of 
color bar for 

selecting color or 
shades of gray Selected color (heavy 

line across top) 

T he pattern changes each time 
you click. Clicking the 
opposite arrowhead reverses 
the order of patterns displayed. 
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Crosshair pointer 

Pattern edited with --!--! 
one color • 

Designating colors or shades of gray 

3 When you see a pattern 
you want to edit, click the 

color or shade of gray with 
which you want to replace 
some or all of the original 
colors. 

The selected color or shade is 
indicated by a heavy line at its 
top edge. 

4 Click in the pattern­
editing area where you 

want to make a change. 

The dark or light squares 
(called pixels) change to the 
color you've selected when you 
click them. The changes you 
make when edidng a pattern 
are displayed immediately in 
the miniature desktop. 

5 If you want to edit with 
another color or shade of 

gray, select that color or 
shade, and then click the 
pixels you want to change to 
that color or shade. 

Clicking a pixel once changes 
it to the selected color or 
shade; clicking it a second 
time restores its original color. 
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Designating the 
color of icons 

6 When you have 
finished editing, double­

click in the minianue desktop 
to save the new pattern. 

The new parrern replaces the 
one that was edited to create it. 

Clicking once displays the new 
pattern on the desktop but 
does nor save it. 

After you close the Control Panel, the number of colors or shades 
of gray you specified remains in effect until you change it. 

)1-- See also: • "Chan ging the Partern Displayed on the Desktop" in 
this chapter 

You can easily change an icon's color or shade of gray in the 
C olor menu. This menu is available only if your Macintosh is 
capable of displaying color or shades of gray and if you have 
specified at least 16 colors or shades of gray in the Monitors 
Control Panel. 

1 To change an icon's 
color or shade of gray, 

first click the icon to select it. 

T he icon becomes highlighted. 
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2 Choose the color or 
shade of gray you want 

&om the Color menu. 

The icon's color or shade 
changes to the one selected. 

The icon retains the new color or shade of gray until you 
change it. 

·!· Viewing icons by color: Macintosh models that can display 
color or shades of gray include an option for organizing files 
by icon color in the View menu. ·!· 

~ See also: • "Specifying the Number of Colors or Shades of Gray" 
in this chapter 

• "Displaying Documents by Name, Size, Dare, Kind, or 
Color of leon" in Chapter 5 

Designating colors or shades of gray 245 



246 

Moving fonts and 
desk accessories 

The M acintosh system software includes several desk accessories 
and a selection of type fonts. Independent manufacm rers and 
user groups or computer bulletin boards provide many 
additional fonts and desk accessories. 

When you install the system sofrware, a core set of fonts and 
desk accessories is installed. You can add more desk accessories 
or fonts-or remove any of the ones already installed-with the 
Font/DA Mover, another part of the system software supplied 
with your Macintosh. 

Figure 8-11 shows the Font/DA Mover's primary dialog box. 

Desk accessories already 
installed in the System file j.Jarkers showing 

rrl=o=rt=he=s=ta=rt=up=d=is=k=======. r;rea;=~o=o=r=co=p=)'l=·ng=, =========, 
0 Font Mouer 
@ Desk Rcce: ·sory 

-= 
~ [ « Copy « l Olorm Clock 

Colculotor ~
:Chooser 
Control Ponel 

Size of the ~-+-------...1 

item selected ~ I 
( Remoue l 

~ 
rr;;l Chooser ~ 

Con
1

trol Ponel ~~ 
r- Desk 

accessories 
available to 
install ror installation 

Button to display '---S-y-st_e_m_--'-' ..... , 

brief instn1ctions L3!~3T;ef~:e i ( llelp J 

I l !,' '"[ --::--:-:------] Space available on Close '-· _....;Q;_u_lt _ __, 

Desk Rccessorles•"'-. Desk ~cccsson.' 
on Trees r--

3443K free selected for 
installation [ Close ] 

I" 
~11944 bytes 

~ selected 
Key Cops "\, ~-
Note Pod ~IS 

the startup disk ·--- -- -- ---- ---- -- -- -- --------------------
- -;r- Message area 

Figure 8-11 The Font/0 :\ Mover showing desk accessories 
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Installing a font The Font/DA Mover and a file of fonts are supplied on the 
system software disks with the Macintosh. (See Figure 8-12.) 

w 
Font/DA Mover 

I~_ All fonts and font 
l4JJ files have this icon, 
Fonts: regardless of 

their names. 

Figure 8-12 The Font/DA Mover and fonts file 

Locate the disk or disks containing these files (or the font file you 
want to use) if you do not have them on your startup disk already. 

~ Font/l)A Mover 

Moving fonts and desk accessories 

1 To install a font, 
first open the Font/DA 

Mover by double-clicking its 
lCOn. 

The Font/DA Mover opens, 
with the Font option selected 
in its window. The box on the 
left shows a list of the fonts 
currently installed in the 
System file of the startup disk. 

If you want to install a font 
onto a different disk, click the 
Close burton, then use the 
Open button that replaces it 
to open the System file on the 
other disk. 
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Fonts installed in 
the System file 

(numbers indicate 
type size for 

screen display) 

-

®Font Moucr 0 Dosk nccouory 

Genoun I U !\:! ( fOIHJ JD Gonoun t 2 
Gonoun 14 [ Rl'mnuP. I 
Gonoun 111 
Goneun 20 

~ Gonouo 24 
lloluo11co 9 

System 
on Main Disk 

I' 
llolp II 16260K r ree 

I Cl ose I I Quit I I Open ... ~ I 
-

]ell Fonl/00 Mouer Folder! 

n ronh 

2 Click the Open button 
below the empty list box 

on the right side of the 
window. 

A directOJy dialog box appears, 
with which you locate and 
open a fonts file. 

3 If necessary, use the 
Drive, Eject, and Open 

buttons to locate the fonts file 
you want, select the Hie's 
name, then click Open. 

T he dialog box closes, and the 
fonts in the fi le are listed in 
the box at the right side of the 
Fonr/DA Mover window. 
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Size of the 
selected font 

Sample of the 
selected font 

@font 
Mouer 0 Desk Accessory 

Geneu~ ID ¥ I ( OPI1 l Courterl2 ¥ 
Geneu~ 12 Courter 14 
GeneuD 1-1 I BPmoul" l Courter 18 
Geneu~ 18 Courter 2~ 
Geneu~ 20 Geneu~ 10 
Geneu~ 24 Geneua 12 
Heluctlc~ 9 i'i Geneu~ 14 r; 

Sy stem Fonts 
on Moln Disk 

I I 
Help 

)I 
on M~ln Disk 

161 •19K rroo 16149K free 

I Close J I Quit l I Close l 
·-~·-·-·--·-·-···--- . ·-·-·-·-·- -·- --·-·--·--·---------- ---- -·-·-·- -· ·-·---·-··-.. -· 

@Font 
Mauer 0 Desk Accessory 

Foms available 
in the fonts me 
just opened 

Gcneun to IQ I « CO PI!<~) Courier 12 f¥ Geneue 12 Courier 14 
Geneu~ 14 I Aemoue l Courier I 0 
Geneuo 1 B . 
Geneuo 20 9574 bytes Geneuo I 0 
Geneuo 24 Geneua 12 

ro selec ted In Heluetlco 9 Geneua 14 1 ...... fonts 
on Main Disk ( llelp )I on Main Disk 
16149K free 16149K r ree 

I Cl ose ) I Quit l I Close l 
-

l Courier 24: The quick brown fox j 

Moving fonts and desk accessories 

4 Scroll if necessary, then 
select the font you want 

to install by clicking its name 
in the list on the right. 

Small markers appear on the 
Copy button, showing the 
direction that the selected item 
will move. A sample of the fom 
appears in the message area at 
the bottom of the window, and 
the amount of disk space 
occupied by d1e font is 
displayed between the two list 
boxes. If you select more d1an 
one font from the list (by 
Shift-clicking), the combined 
size of your selection is 
displayed, bur no sample 
appears in the message area. 

5 Click the Copy button 
to add the selected font or 

fonts to your System file's 
fonts. 

The name or names of rhe 
new fonts appear in the list on 
the left in alphabetical order 
when copying is completed. 

249 



Newly installed font -
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@Font 
0 Desk nccossory 

Courier 24 1Q ( « copu « 
6eneun I 0 il , 6enoun 12 nemouo 
6eneuo 14 
6eneun I D ~ 9574 bytes 
6eneun 20 

~ selected 
6eneun 24 

Mouer 

I Courier 12 
Courier 14 

I Courier 18 

' 
6eneun I D 
Geneuo 12 
Geneun 14 

~ 

In 

6 Click the Quit button 
at the bottom center of 

the window when you have 
finished installing fonts . 

System I, llelp J l 
Fonts 

on Mnln Olsk on Mnln Disk 
161 39K free 16139K free 

( Close I ( Oull LJ ( Close I ·--- --·--·----·--·--·- - -
Courlor 24: The quick br own f ox j 

Clean Up Window 
[mpt!J Trnstl 
[mse m~k 

Set Startup ... 

7 If you're using 
MultiFinder, choose 

Restart from the Special menu. 

By restarting, you ensure that 
the new fonts will be available. 
You can skip rhis step if you're 
not using MultiFinder. 

•!• Copying fonts from one file to another: You can also copy 
fo nts from one System or fonts file to another System or 
fonts file. ·:· 

)o- See also: • "Managing Multiple Programs Using Multi Finder" 
in Chapter 3 
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Removing a font You may need to remove one or more fonts to make more room 
on a startup disk. You use the Fonr/DA Mover to remove fonts. 

If you're using MultiFinder, you can't remove fonts from the 
System of the startup disk. Start up with a different system disk, 
then use the Font/DA Mover to open the System of the disk 
from which you want to remove fonts and proceed according to 
the steps that follow. 

·:· Saving a font when you remove it: If you want to remove a 
font and be certain that you still have a copy of it, you can 
use the Font/DA Mover to copy that item to a separate fonts 
file, and then remove it from the System. •!• 

Fontl~!v•r 

Moving fonts and desk accessories 

1 To remove a font, first 
open the Font/DA Mover 

by double-clicking its icon. 

The Font/DA Mover's window 
opens, with the Font option 
selected. The box on the left 
shows a list of the fonts 
currently installed in the 
System file of the startup disk. 
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SeleC!ed font 

Disk space occupied 
by the selected font 

Sample of the 
selected font 

® Font 
Mouer 0 Desk Occessory 

Times 12 l;! ( (01>11 ID Uenlce I 'It 
Zopr Dingbots 1 o ( n-.mou~ I 
Zopf Dlngbnts 12 
Znpf Dlngbnts 1 ' I 
Zapf Dlngbnts I 0 

{j Znpf Dingbats 24 
System 

on Moin Disk I ( lleip II 16D74K free 
( Cioso l ( Quit l . ( Upon ... l --·- - ---~-- ---- --··- - - -·----·--· ---

® Font 
Mouor· 0 uesk nccessory 

Times 12 [ !op~ ID : 
~flemuuo I Znpf Dlngbots I o 

Znpf Dlngbnts 12 
2apf Dingbnts 14 
Zapf Dingbots I 0 4190 bytes 

i zapf Dillg_bnls 24 IOJ/selcct ed 
system 

on Moln Disk 

I [ 

llclp 

I I 16074K f r ee 
( Close l ( Quit l ( Open ... l -

TUenlce 14: The qukfi. brow•~ fox jw nps over the Ca.zy 

2 Scroll if necessary, then 
click the name of the font 

you want to remove in the list 
on the left. 

A sample of the font is 
displayed in the message area 
at the bottom of the window, 
and the space the item 
occupies on the disk is 
displayed between the two list 
boxes. If you select more than 
one font from the list (by 
Shift-clicking) , the combined 
size of your selection is 
displayed, but no sample 
appears in the message area. 

3 Click the Remove 
button to remove the 

selected item or items from 
your System's fonts. 

An alert dialog box appears, 
asking you to confirm or 
cancel the action. 
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The font name 
no longer appears 

in the list. 

The available disk 
space is increased. 

-

Are you sure you wont to 
remoue the se lected items? 

(( Concel J) 

®Font 
Mouer 0 Desk Accessory 

Times 10 ~[ [OPij ID Times 12 
Zapr Dingbat s I D [ Rl'llUHIL' I 
Zupf Dingbats 12 
2opf Olngbnts I 'I 
2apf Olngbots 10 

~ 2opf Dlngbots 2'1 
System 

on Mnln Disk I [ llelp ]I 16D70K free 

I Cl ose ) ( ~ Quit ) ( Open ... ) 

4 Click the OK button to 
proceed with removal of 

the selected font. 

If you change your mind, you 
can use the Cancel button to 
stop the action. 

5 Click the Quit button 
at the bottom center of 

the window when you have 
finished removing fonts. 

).- See also: • "Creating a File of Desk Accessories or Fones" in 
chis chaprer 

Installing a desk accessoty The Font/DA Mover and a file of desk accessories are supplied on 
the system software disks with the Macintosh. (See Figure 8-13.) 

w 
Font /D A Mover 

00
---- All desk accessories 

Rm and desk accessor,· 
EHI3 files have this icon. 

Desk Accessories regardless of 
their names. 

Figure 8-13 The Font/DA Mover and desk accessories file 
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The Font/0:\ Mover 
alwa)'S opens with 

Fom selected. 

Fonts already 
installed in 
the System 

The name of 
the open file. the 

di~k. and free 
space on the disk 

-

-

I 
symbol 9 
symbol 12 
Symbol 10 
Symbol2~ 

nmes 9 
Times tO 
Times 12 

Locate the disk or disks containing these files (or the desk 
accessory file you want to use) if you do not have them on your 
startup disk already. 

Fon1[t1!ver 

':!:rant 
~Desk Accessory 

Mooer 

flo! ( [t>lllf 'D ( Armour I 

tn 

1 To install a desk 
accessory, first open the 

Font/DA Mover by double­
clicking its icon. 

The Font/DA Mover opens, 
with the Font option selected 
in its window. The box on the 
left shows a list of the fonts 
currently installed in the 
System of the startup disk. 

2 Click the Desk 
Accessory button at the 

top of the window. 

'K: System on Trees I ( 3764K free 
llelp 

I I 

The list on the left changes to 
the desk accessories currently 
installed in d1e System fi le on 
the startup disk. I Close l ( Quit l ----- ( Open •.. l 

If you want to install a desk 
accessory on a different disk, 
click the Close button, then 
use the Open button that 
replaces it to open the System 
file on the other disk. 
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Desk accessories 
currently installed 

in tl1e System 

-

o ronl 
Mouer ® Desk Accessory 

Chooser ~ ( (OI)q 'D Control Ponel 
[ l h~ IOOUL' I 

In 
system 
on Tree' I ( llelp II 376'1K free 

[ Close ) I Quit ) ( Open ... ~_) 
·-··- -·-· ,_,_ -·-···-·- - -··- ---·-· ·---------·----· ·-· --· ---·--

)<31 rent/On Mauer Folder I 
D Desk Ac cessorles e> Trees-

On ue ) 

Open It I 
New 

Concel 

Moving fonts and desk accessories 

3 Click the Open button 
below the empty list box 

on the right side of the 
window. 

A directory dialog box appears 
with which you locate and 
open a file of desk accessories. 

4 If necessary, use the 
Drive, Eject, and Open 

buttons to locate the desk 
accessories file you want, 
select the file's name, and 
then click Open. 

The dialog box closes and rhe 
desk accessories in the file are 
listed in the box at the right 
side of the Fom/DA Mover 
window. 
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Arrows indicate 
direction of 

copying-from the 
desk accessory me 

to the System 

Size of the desk 
accessory selected 

o ront Mouer @ Desk Occouory 

Clloosor 
Control Pnnel 

If![ [OI>IJ l Alnrm Clock 
Cnlculotor "" [ lh\ IOI)IH~ l Chooser 
Control Pnnel 
Find Fllo~ 

In 
Key Cnp 

I;; Note Pnd 
System Desk Accossorl IS 
on Trees 

I' 
ttelp II on Trees 

3143K free 3443K free 
( Close l ( Quit l ( Close 

---

Desk accessories in 
the file just opened 

o ront Mouer ® Desk Accessory 

Chooser ~ « Copu « II- Rlonn Clock p= 
Control Pnnet Cnlculotor 

[ nomouo l Chooser 
Control Pnnol 

lo 
II 911 bytes Key Cnps 

[;; selected Note Pod 
system Desk Rccessorlos 
on Trees I [ llolp )I on Trees 

3443k free 3443K fruo 
( Close l [ Quit ) [ Close ) 

5 Select the desk accessory 
you want to install by 

clicking its name in the list on 
the right. 

Small markers appear on the 
Copy button, showing the 
direction that the selected item 
will move. The size of the item 
is displayed between the two 
list boxes. If you select more 
than one desk accessory from 
the list (by Shift-clicking), the 
combined size of your 
selection will be displayed. 

6 Click the Copy button 
to add the selected item or 

items to your System's desk 
accessones. 

The item or items are copied 
into the System. The name or 
names of the new desk 
accessories appear in the list on 
the left in alphabetical order. 
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The name of the _ 
desk accessory 
installed in the 

Sysem appears in 
the list when 

copying is 
completed. 

Q Font Mouer 
@ Desk Accessory 

Chooser ~ ( « ~opy « ) ntorm Clock ~ 
7 Click the Quit button 

at the bottom center of 
the window when you have 
finished installing desk 
access ones. 

Control Panel Colculotor 
Find File ( Remoue I Chooser 

( 

In 
System 
on Trees I ( 3443K free 

Close l ( 
-

Control Ponel 

11944 byt es Key Cops 
sel ec ted Note Pod 

Desk Accessories 
llelp II on Trees 

3443K free 
Quit !t l ( Close l -

!. 

~ 

8 If you're using 
MultiFinder, choose 

Restart &om the Special 
menu. 

By restarting, you ensure that 
the new desk accessories will 
be available in the Apple 
menu. Skip this step if you're 
not using MultiFinder. 

·:· Starting the Font/DA Mover with the Desk Accessory option 
selected: If you hold down the Option key when you start the 
Fom/DA Mover, the Desk Accessory option is automatically 
selected. ·:· 

> See also: • "Managing Multiple Programs Using MulriFinder" 
in Chapter 3 
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Removing a desk accessory You may need to remove one or more desk accessories co make 
more room on a startup disk. You use the Font/DA Mover co 
remove desk accessories. 

258 

The Font!DA Mover 
always opens with 

Font selected. 

Fonts installed 
in the System 

-

sumbol 9 
sumbol t 2 
sumbot to 
Symbol2q 
Times 9 
Times t o 
Times 12 

•!• Saving a desk accessory when you remove it: If you want co 
remove a desk accessory and be certain that you still have a 
copy of it, you can use the Font/DA Mover co copy that 
item to a separate desk accessories file and then remove it 
from the System. ·:· 

~ 
Font/DA Movet· 

""'.!:'Font 
~ Desk Occossoru 

Moucr 

P' I [OPij ID I RPmcu~ I 

In 

1 To remove a desk 
accessory, first open the 

Font/DA Mover by double­
clicking its icon. 

The Font/DA Mover opens, 
with the Font option selected 
in irs window. The box on the 
left shows a list of the fonts 
currently installed in the 
System of the startup disk. 

2 Click the Desk 
Accessory button at the 

top of the window. 

System 

I ( 'I 

The list on the left changes co 
the desk accessories currently 
installed in the System file on 
the startup disk. 

on J's hBrd disk llelp 
3407K free 

I Close I I Oull l I 01Hm .•. l - --- ---
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Q font 
® Desk Accessory Mauer 

i 
nlonn Clock p,! L-....:..::( Co.!:.:l....-Jpq I D 
Chooser 

Desk accessories Control Panel Romoup I 
. h S f find file m t e ystem o Key Ca~ 
the startup d1sk Note Poo 

.__ ___ ......Jio"'-J 

Size of the selected 
desk accessory 

Sys tem I 
an J's hftrd disk ( 

HD7K rroo 
[ Close I [ 

llelp ] I 
uutt I ( Upon... I 

--·-·- - •-•••·- --- ---·- ---·---- - ·· ~· ·~· ·~- · -··~· M • - -----· - -- - · --··-

O Font Moucr ® Des k Accessory 

Alar m Clock ~ ( fOiliJ 'D Chooser 
Control Panel ~Aemoue I 
Find File .. 

/2720 bytes 
N ntP PArt 

1Q 
selected 

system 
on J's hard disk I ( llelp II HD7K free 

) ( Close ) ( Quit ) ( Open ... 
- -

Mo\·ing fonts and desk accessories 

3 Select the desk accessory 
you want to remove by 

clicking its name in the list on 
the left. 

The size of the item is 
displayed berween the rwo list 
boxes. If you select more than 
one desk accessory from the 
list (by Shift-clicking) , the 
combined size of your 
selection will be displayed. 

4 Click the Remove 
button to remove the 

selected item or items from 
your System's desk accessories. 

An alerr d ialog box appears, 
asking you to confirm or 
cancel the action. 
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Alorm Clock 
Chooser 
Control Ponel 
Find Fllo 
Note Pod 

Q font 

Are you sure you wont to 
remoue the selected Items? 

® Desk Accessory Mouer 

jill [1> 1111 'D [ 1\~IOOU f~ 1 

lo 

5 Click the OK button to 
proceed with removal of 

the selected desk accessory. 

If you change your mind, you 
can use the Cancel burton to 
stop the action. 

6 Click the Quit button 
at the bottom center of 

the window when you have 
finished removing desk 
accessones. 

System 

I [ II on J's hord disk llelp 
3409K free 

I Close 

Creating a file of desk 
accessories or fonts 

l I Quit II: ) I I Open .•. l 

When you move desk accessories and fonts into and our of the 
System on a startup disk, you can easily create the special types 
of files used to store these items. Figure 8-14 shows the icons for 
a desk accessories file and a fonts file. 

em m 
Desk Accessories Fonts 

Figure 8-1 4 The icons for a desk accessories file and a fonts file 

You use the Fonr/DA Mover to create these files. 
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~ 
Font /1) A Mover 

® Font 
~Desk Accessory 

Mouer 

r::R:-::-Go_r_om- o-nd"'"'n"""".-.. .,..,to""'p="' ( lotH! I D 
RGoromond 0 ... 12 
RGor omond n ... 14 1\l'lnDUl' I 
B AGoromond ... I 0 
B AGornmond ... 12 
B OGoramond ... 14 
Chicago 12 In 

on Lisss~~~~:d disk I ( llelp I I 
3367K free I 

I Close ] (' ----:0:-ul""'t -] I Open ... 

~~loving fonls and desk accessories 

1 To create a fonts file, 
first open the Font/DA 

Mover by double-clicking its 
tcon. 

The Font/DA Mover opens, 
with the Font option selected 
in irs window. The box on the 
left shows a list of the fonts 
curren rly installed in the 
System file of the startup disk. 

2 If you want to create a 
desk accessories file, click 

the Desk Accessory button. 

Skip this step if you want to 
create a fonts file. 
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o ront 
® llesk nccossonJ Mouer 

'-n,-lo-rm-C=:-Io-t-:-k----,:!:= [ Cot>•! I D 
Chooser 

Control Panel tr; n""'""'' I 
Find File 
Note Pnd 

L..._ ____ _J><J 

System I I 
on Lissy's hnrd disk r( ----:11:-.el::-p ---,1 

3367K free 

I Close I ~( ::::"::"=:lt=::_l_:_.::::::::o::p•::"::··::· =iii I 

le~ Font/ On Mouer Folder! 

= Lissy's h .•. 

Orlur 

Open 

~] 
L...----------""' [ Cnntol I 

I ell Font/ on Mouer Folder I 
D Oe~k nto!s•nriP~ 
D [utro Innis 
<ll Fnntillfl M Ol•er 
D runts 

Nelli Desk nttessory File = llssy·s ... 
Nc\v file name - f-jEutrn on~ 1 

I l:.if! t:l 
Insertion point / 

~IJ I Centel Orluo 

3 Click the Open button 
below the empty list box 

on the right side of the 
window. 

A direcrory dialog box 
appears, in which you specify 
the file to open. 

4 Click the New button 
to create a new file. 

Another direcrory dialog box 
appears, in which you name the 
new file. An insertion point is 
blinking in the name box. 

5 Type a name for the 
new file, then click Create 

to create the new file. 

The dialog box closes, again 
revealing the Fonr/DA Mover 
window. The new file is open 
on the right side of the window. 
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ntorm Clock 
Chooser 
Control Panel 
Find File 

0 Font Mouer 
® Dosk necessary 

~ 

" 

[ » Copy»lt10 
( lh~ fni)UJ~ ) 

2605 bytes 
selected 

Syst em I I Eutro ons 
on Lissy's hard disk I Help 1 on Lissy's hord disk 

3367K free 3367K free 
[ Close 1 [ Quit I ( Close I 

6 Copy the item or items 
you want to move into the 

new file. 

If you don't copy at least one 
font or desk accessory into the 
new file, that file will nor be 
saved when you finish using 
the Font/DA Mover. 

When you have finished copying the item or items you want to 

store in the new file, remove any of them you no longer want in 
the System, then quit the Fom/DA Mover. 
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Connecting 
SCSI devices 

. Chapter 9 

Expanding Your 
Macintosh System 

t e Macintosh is the heart of a powerful and versatile 
computer system. This system can include such external devices 
as disk and rape drives, primers, multiple monitors, a scanner, a 
modem, a graphics tablet, and audio devices. All of these devices 
can be connected to the computer when it is originally set up or 
added later to expand irs power. 

The Macintosh can be expanded internally by installing 
additional memory and- in some models-coprocessor cards, 
specialized video and graphics cards, mem01y cache cards, and 
communications cards. 

This chapter provides an overview of hardware connections and 
component installation for all Macintosh models. When you are 
connecting a specific device to your Macintosh, be sure to follow 
the derailed instructions that came with your Macintosh model 
and with the device itself. 

All Macintosh models have a socket, or port, for connecting devices 
that use the Small Computer System lntelface (SCSI). T he SCSI port 
permits high-speed communication between the computer and the 
device. (SCS!is commonly pronounced "skuh-zee.") 
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Setting the SCSI 
device number 

Among the SCSI devices that are commonly used with the 
Macintosh are internal and external hard disk drives, tape 
backup drives, CD-ROM drives, scanners, and primers. 

Because SCSI devices can be connected to one another, or daisy­
chained, rather than having to be connected directly to the 
computer, the Macintosh can support up to seven of these 
devices, including one internally. 

Each SCSI device has an ID number from 0 to 7 that you can 
change if necessary. Apple assigns each type of SCSI device it 
manufactures a number at the factory; in most instances, you 
should nor need to change the number unless two of the devices 
in your system have the same number. 

The Macintosh uses the ID number to assign each device a priority 
on a chain of SCSI devices. T he higher d1e number, the higher the 
device's priority; the computer itself is number 7 and an Apple 
internal hard disk is number 0 (so nothing else can have those 
numbers). The devices you use most often should have the highest 
priority numbers . 

.6. Warning: Be sure to change the lD number of one device if you 
have two SCSI devices with rhe same ID number. You could lose 
information on one or both devices if you try to use two SCSI 
devices with the same ID number. A. 

10 number switch 
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1 With the SCSI device 
turned off and unattached 

to anything, locate the ID 
number and the ID number 
switch on the back panel of 
the device. 

T he preset number is showing. 



2 Insert the point of a 
pushpin or an opened 

paper clip into the 10 
number switch and push 
gently until the number you 
want is showing. 

The number increases to 7, 
then starts over at 0. Some 
devices have blank spaces 
between the numbers 7 and 0. 

Daisy chaining SCSI devices can be linked rogether by cables ro form a chain. 
SCSI devices The arrangement of devices in a SCSI chain does not determine 

their priority in communicating with the Macintosh; the 
devices' ID numbers determine priority. 

To assure accurate transmission of information ro and from the 
computer and the SCSI devices connected to it, you must place 
special connectors, SCSI cable terminators, at each end of a 
SCSI chain. (See Figure 9-1). 

Figure 9-1 SCSI cable terminator 

Every Macinrosh that has an inrt:rnal Apple hard disk has a 
built-in SCSI terminator. For most models, the computer's 
internal terminator serves as the terminator for one end of the 
SCSI chain. If you have a Macintosh Portable, consult the 
Macintosh Portable Handbook for instructions about using 
terminarors. You may need ro use an additional terminator if 
you connect an external SCSI device to the Macintosh Portable. 
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You use terminarors with SCSI cables, which connect the first 
device ro the computer and other devices in a chain ro each other. 

Table 9-1 shows how to arrange the SCSI cables and terminators 
with several different configuratio ns of equipment. 

Table 9-1 Guidelines for using terminators when connecting SCSI devices 
to the Macintosh 

If ~ then =(> ~ 
If ~ then =(> no :let ion JH:IXI.:d 

If ~ th.:n =(> ~ 
If ~ then =(> ~ 
If 0 t==l E:J then =(> no action needed 

If ~ then =(> ~ 
If ~ then =(> no ~ction nccd.:d 

If ~ then =(> ~ 
If 0 E:J L5 then =(> no action n.:.:dcd 

If ~ then =(> ~ 

0 ~Iacimo. h without 0 Htcintosh with 
an internal hard disk an internal hard disk 

I I Peripheml without ~ Peripheral with 
an intcrnaltennimtor an intcrnaltemtinator 

o I Add terminator between C9 Add tcrminatorto connector 
device and t'able into device not used fur cable 

I u Remove tcnninawr 
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W hen yo u connect a SCSI cable to the Macintosh, you place the 

cable in the SCSI port on the computer's back panel. You can 

recognize the SCSI port by its icon, shown in F ig ure 9-2. 

Figure 9-2 The SCSI icon 

6. Important: Always turn on yo ur SCSI device before turning on 
your computer. ..j. 

Connecting 
non-SCSI devices 

Connecting a printer 

The Macintosh has several ports to which you can connect other 

types of peripheral devices. Each port is marked by a distinctive 

icon on the back panel of the computer and on the Apple cable 

that connects th e appropriate device to it. 

You con nect most primers to the M acintosh through the printer 
port. This port is a serial port, meaning that it transmits the bits 
that make up the computer 's information in single file, or serially. 

Some primers, such as [he LaserWrirer liNT and LaserWriter II TX, 

are designed for use on the AppleTalk n etwork system. Others, 

such as the ImageWriter II and ImageWriter LQ, can operate 
e ither as stand-alone primers for one Maci n tosh o r as LocalTalk 

devices. (Loca!Talle is the name for work-group net\'Vorks that 

are part of the Apple Tal k ne t\'Vork system. ) 

All these primers connect to the computer's primer po rt. Exceptions 

are [he Personal LaserWriter SC and the Laser\'<'rirer lise, which 

connect to d1e SCSI port. 

If necessary, a printer can be connected to rhe modem port, 

w hich is also a serial port. You indicate the port to which a 

printer is connected in the C hooser. 
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!'linter 

2-metcr cable 

LocalTalk 
connector box 

Printer icon A 

Printer pon - -

1 Assemble the 
components you need: 

printer, appropriate cable, 
LocalT alk connector box if 
needed, and setup instructions. 

2 Attach the larger 
connector on the printer 

cable to the printer, or attach 
one end of the LocalT alk 
cable to the printer. (Consult 
the printer's setup 
instructions for details.) 

3 Attach the small, round 
connector on the printer 

cable to the printer port on 
the back panel of your 
Macintosh, or attach the 
LocalT alk connector to the 
printer port and plug the 
LocalTalk cable into the box. 

You can easily recognize the 
printer port by its icon. 

)o- See also: • "Choosing a Printer" in C hapter 4 
• "Choosing a Network Printer" in Chapter 7 
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Connecting a modem The modem port on the Macintosh back panel is a serial port 
that is almost identical to the printer port. You use it to connect 
an external modem, a device that converts the computer's signals 
for transmission over telephone lines. 

This port is preferable for modem connection because the 
computer gives it prioriry over the printer port when checking 
for activiry, which helps to assure that the modem's 
communications link will remain intact. 

If necessary, you can connect a printer to the modem port or a 
modem to the printer port, however. 

Connecting non-SCSI devices 

1 Assemble the 
components you need: 

modem, appropriate cable, 
and setup instructions. 

2 Attach the appropriate 
connector on the modem 

cable to the modem. (Consult 
the modem's setup 
instructions for details.) 
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Connecting an external 
floppy disk drive 

Modemicon ~ 

j.1odem pon --

3 Attach the small, round 
connector on the modem 

cable to the modem port on 
the back panel of your 
Macintosh . 

You can easily recognize the 
modem port by irs icon of a 
telephone handser. 

Some Macinrosh models have a disk drive port, co which you can 
attach a floppy disk drive. 

You can also connea a non-SCSI hard disk such as rhe Apple HD 20 
(no longer man ufactured or supported with system software) . 

1 Make sure that your 
Macintosh has a disk 

drive port, then assemble the 
components you need: 
external drive, app ropriate 
cable, and setup instructions. 

Disk drin: pon icon----~ 2 Attach the free end of 
the disk drive cable to the 

disk drive port on the back 
panel of your Macintosh. 0000000000 

00000 0 000 

Chap1er 9: Expanding Your Macinlosh Sys1ern 

You can recognize the disk 
drive porr by irs icon of a disk. 



Connecting Apple 
Desktop Bus devices 

On most Macintosh models, you connect the mouse and the 
keyboard to Apple Desktop Busn • (ADB) porrs. T hese pons 
allow you to use a variety of input devices with your system, 
such as a graphics cabler, a specialized keyboard, a trackball, a 
light pen, or a barcode reader. 

You can daisy-chain ADB devices and thereby connect several to 

each ADB port on the computer's back panel. Most Macintosh 
keyboards also contain an excra ADB port, and some monitors 
have an ADB port. 

The number of input devices you can connect to the computer 
is limited by the combined power they require and by their 
performance. T he practical limit of devices is probably six­
three for each ADB port on the Macin tosh . Performance of rhe 
devices is likely to be unacceptably slow with more devices than 
three per port. 

~ Important: Do not exceed the Apple Desktop Bus power 
requirements when using ADB input devices. T he combined 
power used by all devices must not exceed 500 rnA 
(milliamperes) . Be sure to check the power required for each 
device you use and mal<:e certain that the rotal needed is less 
than 500 rnA. Consult the Special Features booldet or the 
Handbook for your model for more info rmation. ...::,. 
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Apple Desktop Bus device connected to a Macintosh 

·~ 

~ 

ADB icon ~ 

ADBport-~ 

1 Confirm that the device 
meets ADB power 

requirements, then assemble 
the components you need: 
keyboard, mouse, or other 
device; ADB cable; and setup 
instructions. 

2 Attach one end of the 
AD B cable to the device, 

if necessary. (Consult the 
device's setup materials for 
any special instructions.) 

3 Attach the other end of 
the cable to the ADB port 

on the back panel of your 
Macintosh. 

You can recognize the ADB 
pon by its icon. 

Chapler 9: Expanding Your Macintosh S}'Slem 
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Apple Desktop Bus device claisy-chainecl ro another ADB device 

Mouse cable is 

ADIJ icon ~ c:t~ 

ADilpon-~ 

1 Confirm that the device 
meets AD B power 

requirements, then assemble 
the components you need: 
mouse, graphics tablet, or 
other device; ADB cable; and 
setup instructions. 

2 If necessary, attach one 
end of the cable to the 

ADB port on the device you 
are adding. (Consult the 
device's setup materials for 
any special instructions.) 

3 Attach the other end of 
the cable to the ADB port 

on the device at the end of the 
daisy chain. 

You can recognize the ADB 
port by irs icon. T he icon may 
not be located directly above 
the socket as shown here. 

·:· Macintosh PLus mouse and keyboard: The Macintosh Plus 
does not have ADB ports; irs mouse connects to a mouse port 
on the back panel of the computer and its keyboard plugs 
into the front of the computer. ·:· 
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Connecting audio devices You can attach an audio device, such as an amplifier or 
headphones, to the audio jack on the back of the Macintosh. 
The audio jack accepts a standard stereo miniplug, like that used 
to attach headphones to a portable stereo player. 

276 

Adding an 
additional tnonitor 

Speaker icon--q ))) Connect the audio device to 
the audio jack on the back 
panel of the Macintosh, using 
a stereo miniplug. 

You can recognize the audio 
jack by its icon of a speaker. 

You can use rwo different monitors simultaneously with most 
Macintosh models. 

On some modulaJ Macintosh models, such as the Macintosh Hex, 
you connect the additional monitor to a video card installed in the 
computer. On other models, such as the Macintosh Ilci, you can 
connect the additional monitOr to a video card or to the 
computer's built-in video port. 
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Connecting a monitor 
to a built-in video port 

Some Macintosh models provide a builr-in video pon to which 
you can arrach the first or second moni tor for your system. 

~ Important: If you' re connecting a moni tor to the buil t- in video 
port of your Macintosh, make certain that the computer is 
turned off before connecting the monitor. If it is turned on 
while the monitor is connected, no system RAM will be reserved 
for the built-in video. ' 

Adding an additional monitor 

1 Assemble the 
components you need: 

monitor, appropriate cable, 
power cord, and setup 
instructions. 

12 ~t~:~~o~~::~:~:~~:e 
monitor. (Consult the 
monitor's setup materials for 
special instructions.) 
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Video icon----- ~0~ 

000 0 0000 
000 0 000 

3 Attach the free end of 
the monitor cable to the 

video port on the back panel 
of your Macintosh. 

You can recognize the video 
pore by its icon. 

4 Attach the power cord 
to its socket on the 

monitor, then plug the other 
end into a grounded outlet. 

You can plug one moniror inro 
the back panel of the 
Macintosh; a second monitor 
must be plugged directly into 
an outlet. 
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Connecting a monitor 
to a video carcl 

You can connect a monitor to a video card installed in the 
Macintosh. The card must be installed in the computer before 
you connect the monitor. 

Adding an additional monitor 

1 Assemble the 
components you need: 

monitor, appropriate cable, 
power cord, and setup 
instructions. 

2 Attach one end of the 
monitor cable to the 

monitor. (Consult the 
monitor's setup materials for 
special instructions.) 
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3 Attach the free end of 
the monitor cable to the 

port on the video card at the 
rear of your Macintosh. 

Most video cards do not have 
an icon to identi~' the video 
port. Consult your dealer or 
Apple representative if you are 
unsure about the purpose of the 
port on a card in the computer. 

4 Attach the power cord 
to its socket on the 

monitor, then plug the other 
end into a grounded outlet . 

You can plug one monitor into 
the back panel of the 
Macintosh; a second monitor 
must be plugged directly in to 
an outlet. 

•:• Additional monitorfor compact models: On models that have 
a builr-in monitor and can also use an external mo nitor, such 
as the Macinrosh SE, the extern al moniror is connected to an 
adapter that must be installed by an authorized Apple 
rep res en tative. •:• 
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Positioning monitors When you 're using rwo monitors, you may need w position 
rhem to avoid interference on rh e screen of one monitor caused 
by signals from the other. 

.A. Warning: W hen setting up yo ur moni tors, be sure nor to cover 
the ventilation open ings on the monitors or on rhe Macintosh. 
Check the setup guide for your Macintosh model and d1e 
moniwr's documentation for special instructions. • 

Installing 
expansion cards 

> See also: • " Indicating the Relarive Posirio ns of i\llulriple 
Monirors" in C hapter 8 

Macintosh II family computers contain slots in to which you can 
install expansion cards. The interface through wh ich these cards 
exchange sig nals with the computer's m icroprocessor is the 
NuBus,.·" interface; consequently, the cards are known 
collectively as NuBus cards, and the expansio n slots are called 
N uBus slots. 

Most video cards used with monitors are N uBus cards; o ther 
N uBus expans io n cards include memo ry cards, specialized 
graphics and video cards, coprocessor cards, and network 
interface cards. 
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The number ofNuBus expansion slors varies among the 
Macintosh II models, though most have either three or six slots. 

Figure 9-3 shows the expansion slots in some Macintosh II-family 
computers. 

NuBus expansion slots 

rn====t:n===r~=~ -- nack panel openings are 
f-!r====:nQ uncovered when cards are oD installed. 

Figure 9-3 The three NuBus slots in a Macintosh Ilci 

~ Important: If you are installing fewer cards than the number of 
expansion slots in your Macintosh, position the cards for 
maximum airflow and cooling: leave an empty slot berween 
cards, and use the slot closest to the fan last. 6. 
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The instructions that follow summarize installation of a NuBus 
expansion card. See the guide Setting Up Your Macintosh for 
your Macintosh model for more detailed instructions. The 
illustrations in this summary show the Macintosh IIcx. 

Installing expansion cards 

1 Take the lid off your 
Macintosh and remove 

the plastic cover plate from 
the end of the slot into which 
you will install a NuBus card. 

2 Gently slide the NuBus 
card, with the gold-tipped 

connector pointing 
downward, into the slot. 

Hold the card carefully at the 
outside top edges. Press the 
card down to be sure that it's 
seated in the slot. 

As you position the card, take 
care to fit the connector on the 
end of the card into the slot on 
the computer's back panel. 
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3 Replace the lid on the 
computer. 

4 Attach the appropriate 
cable or cables to the 

connector on the NuBus card. 

Consult the documenrarion 
for the card and the device co 
be connected to it for detailed 
. . 
111Strl1 Cti0 11S. 
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Using tnultiple 
expansion cards 

Power requirements 
and limitations 

If you use two or more N uBus expansion cards in you r 
Macintosh, you must observe the following precautio ns to 
assure safe operation of the computer. 

T he combined power consumption of all N uBus cards in your 
Macintosh must nor exceed the limi ts established fo r that model. 

Expansio n cards can draw three types of power from a N uBus 
slot: 

• +5 volt current 

• +12volt cu rrent 

• - 12 volt current 

Each card may draw from these currents in varying amounts. 
Consul t the Special Features booklet for your Macintosh 
model and the specificatio ns fo r each card that you use to 
determine rhe combi ned power consumption fo r each type of 
current. T hen make certain that the totals do nor exceed the 
recom mended limits. (You can calculate the total limits by 
mul t iplying the recommended limit pe r card by the number o f 
slo ts in yo ur model.) 

T ype of current 

+5 volt 

+ 12 volt 

- 12volr 

Recommended 
limit per card 

2.0 amps 

0 .175 amps 

0.100 amps 

~ Warning: Exceedi ng the power limits could damage one or 
more N uBus cards o r rhe computer. .&. 
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Assuring adequate 
ventilation 

lnst:dling cards in 
a specia I slot 

When operating, N uBus cards generate heat. If you use several 
cards in your Macintosh, make certain that you position them to 

allow maximum air circulation around the cards. 

For example, if your Macintosh has six N uBus slots and you are 
using three cards, place the cards in rhe second, fourth, and sixth 
slots (counting from the end opposite the disk drive) to assure 
the maximum amount of a ir circulation. 

Some Macintosh models can use a type of expansion card that 
does nor use the N uBus interface. T his card fi rs into a special slot, 
called rhe memmy cache slot in some models and the processor­
direct slot in other models. 

~ Important: If you plan ro use a card in a special slot, make 
certain that the card you install is designed for your Macintosh 
model. Installing a card designed for this slot in a different 
model could damage the card and the computer. ~ 

Instructions for installing a card in the memory cache slot o r the 
processor-direct slot vary among rhe models that use these cards. 
Consul t Setting Up Your Macintosh and the Special Features 
booldet or the Handbook for your Macintosh model for deta ils. 
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Expanding n1en1ory 
on the main 

circuit board 

The RAM in most Macintosh models is provided in packages 
called Single In-Line Memory Modules, or SIMMs. Each SIMM 
consists of a group of RAM chips on a circuit board that has 
electrical contacts along one edge. This board is plugged into a 
SIMM socket on the computer's main circuit board. 

The RAM in your Macintosh can be expanded by adding to the 
SIMM modules already installed or exchanging the modules for 
ones that contain chips with greater storage capacity. (The 
system RAM can also be expanded by installing a NuBus 
memory card.) 

If you plan to expand the computer's memory, make certain 
that the chips or SIMMs used are the correct ones for your 
M acintosh model. Consult the Special Features booldet or the 
Handbook for your Macintosh model for information about 
the RAM chips and SIMMs . 

.A. Warning: RAM expansion on the main circuit board should 
only be done by an amhorized Apple representative or another 
qualified technician. Modification or expansion by anyone 
except qualified personnel voids the equipment's warranty and 
could cause damage. .& 
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Chapter 10 

Macintosh Maintenance 
and Trollbleshooting 

Yur Macintosh computer is sturdy and requires little 
maincenance. Bur like any piece of electrical equipment, it 
should be handled carefully and positioned in accordance with 
its design and specifications. 

This chapter provides some general precautions for setting up 
and worlcing with the computer, as well as guidelines for 
maintaining a safe operating environment for rhe Macinrosh, 
instructions for cleaning system components, and a note about 
Apple service and support. 
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Safety and 
general care 

All system components 

Follow the suggestions in this section ro ensure that your Macintosh 
srays in good operating condition. 

When setting up and using rhe computer and irs components, be 
sure ro 

• Handle all equipment with care and always place components 
on a sturdy, flat surface. 

• Follow rhe setup instructions provided with your Macintosh and 
irs components precisely. 

• Always hold a cable by the connector at one end when attaching 
it to or removing it from a component; don' t force a connector 
into a socket or plug on the M acintosh or a component. If you 
can't get rhe pieces to join easily, consult your Apple dealer or a 
technician for help. 

• Turn off the computer and all components before adding or 
removing any parr of the system. If you add or remove a 
component or irs cable while the computer is on, you may 
damage rhe Macintosh, th.e component, or both. 

• Keep food and liquids away from the immediate area of your 
Macintosh if possible, and be extremely careful not to spi11 any 
liquid on the computer, keyboard, mouse, or other components. 

• If you do spill food or liquid into the computer, be sure to turn 
it off and unplug it before attempting to deal with the situation. 

A Warning: Plug the power cords for the computer and irs 
components only into three-prong, grounded outlets. The 
Macintosh's grounding-type plug is a safety feature; do not defeat 
rhe purpose of this plug. Disconnect the power plug if it becomes 
frayed or orhe1w ise damaged. • 
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A Warning: Your power supply is a high-voltage component and 
should nor be opened for any reason. There are no serviceable parts 
inside. If you think that your power supply needs servicing, please 
contact your authorized Apple service provider. .& 

\ 'lonitor Whether your Macintosh has a built-in screen or a separate 
monitor, be sure to 

• Turn down the brightness control on the screen if you 
leave the computer turned on for extended periods; if the 
brightness is not turned down, the image on the screen could 
"burn in" and permanently damage the screen. (If your 
Macintosh model does not have a brightness comrol, it has a 
special section of d1e Control Panel that lets you adjust screen 
brightness. For instructions on using rhe Brightness Control 
Panel, see Special Features of Your J\1acintosh.) 

v : " , h J.OU can use a screen-saver program to remove or vary t e 
image on the monitor's screen when the computer is rurned on 
bur idle for a specified period of rime. These programs are 
available from independent suppliers or user groups. 

• If your Macintosh has a separate monitor, position the monitor 
so rhar none of its ventilation openings are covered or 
obstructed. 

• Follow positioning instructions for a monitor precisely- don't 
put it on any surface not strong enough to support it. Some large 
monitors, such as the Apple Two-Page Monochrome Monitor, 
cannot safely be placed on top of the main unit of a modular 
Macintosh. 
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Keyboard Take special care nor ro spill any liquid on rhe keyboard or to ger 
greasy or sticky substances on it. If you should spill a liquid on rhe 
keyboard and ir stops working, follow rhese procedures: 

• If the liquid is thin and dear, try unplugging the keyboard, 

turning ir upside down to let the liquid drain our, and drying it 
for 24 hours at room temperature. If the keyboard still doesn't 
work, ralce ir to your authorized Apple dealer for repair. 

• If the liquid is sweet or sticky, unplug the keyboard and talce it 
to your authorized Apple dealer for repair. 

Floppy disk drives Whenever you transport rhe Macintosh or an external floppy disk 

drive, be sure to 

• Place rhe plastic disk-shaped piece (placed in the drive at the 
facrory) in the internal floppy disk drive and in any external drives 
when you move them. If your Macintosh model has a 
SuperDrive, you don't need to use a plastic disk- SuperDrives can 
be moved without the proteaor. 

Floppy disks Figure 10-1 summarizes the correct and incorrect ways to handle 

floppy disks. 

Figure 10-1 Dos and don"ls of handling lloppy disks 



Operating 
environment 

The Macintosh is designed to operate reliably in a suitable 
environment. To maintain this environmenr: 

• Keep the Macinrosh and components our of direct sunlight and 
free from exposure to rain or other moisture. 

• Operate the Macintosh only at temperatures between 50 degrees 
and either 95 or 104 degrees Fahrenheit (10 degrees and either 
35 degrees or 40 degrees Cenrigrade), depending on the model, 
and at a humidity ranging from 5 percenr to 95 percenr. (See 
the Special Features booldet or the Handbook for your model 
for derails.) 

• Be certain that all components are positioned so that none of 
their venrilar.ion areas are blocked or partially blocked. Do not 
pur papers, disks, or other items over the air circulation areas of 
the system, even temporarily. Preventing proper air circulation 
could result in overheating of a componenr and possible damage 
or unreliable operation. 

• If your Macinrosh and componenrs are positioned so that 
you see interference on the monitor's screen or see or hear 
interference on a nearby television or radio, move the affected 
components further aparr. 
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Cleaning system 
components 

You can clean the exterior of most Macintosh system components, 
the monitor's screen, and the mouse's mechanical parts. 

Computer and To clean the case of your Macintosh or a peripheral device: 
peripheral-device cases 

• Use a damp, soft, lint-free cloth to clean the computer's 
exterior. Avoid getting moisture in any openings. 

• Don't use aerosol sprays, solvents, or abrasives when cleaning 
the computer or other components. 

Monitor Follow this guideline when cleaning the monitor's screen: 

• Put household glass cleaner on a soft cloth and wipe the 
screen. Don't spray the cleaner directly on the screen, because 
the liquid may drip into the monitor's or computer's interior. 

Mouse The mouse contains a small ball that rolls as you move d1e 
device. You can keep this ball free of dirt and grease by using the 
mouse on a clean, hard surface and cleaning it occasionally. 
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Power switch 

Cleaning system components 

1 To clean the mouse, 
first turn off the 

Macintosh. 

You should always turn off 
electrical equipment before 
disassembling any part. 

2 Turn the mouse over 
and open the plastic ring 

on the bottom that holds the 
ball. 

M acintosh models use two 
different types of rings on the 
mouse; one is opened by 
turning the ring counter­
clockwise, the other is opened 
by pulling the ring straight 
down until it snaps. 

3 Remove the ring and the 
ball beneath it. 

You may be able to lift off the 
ring while holding the mouse 
upside down; if not, turn the 
mouse over while holding one 
hand underneath it to catch 
the ring and ball. 
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4 Clean the three small 
rollers inside the mouse 

with a cotton swab moistened 
with alcohol. 

Rotate the rollers to clean all 
their surfaces. 

5 Wipe the mouse ball 
with a clean, soft, 

dry cloth. 

Don't use any liquid to clean 
the ball. 

6 Gently blow into the 
mouse case to remove any 

dust that has collected there, 
then replace the ball and ring. 
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Testing and 
repairing a disk 

Using Disk First Aid to test 
or repair a floppy disk 

or a hard disk 

Both floppy disks and hard disks can become damaged from 
repeated use and handling. The Macintosh system software 
provides some tools for testing disks and repairing some types of 
damage or wear. 

If you see a message reporting that a disk is damaged or 
unreadable, these tools may help to diagnose and correct the 
problem. 

You can test and repair either type of disk with the Disk First 
AidT"' application, supplied with system software. 

~ 
Disk First Aid 

archiu es 

( Internal Floppy Driu e) 

Driue [ Cancel ] 

Eject n Open J) 

Testing and repairing a disk 

1 To test or repair a disk, 
start Disk First Aid by 

double-clicking its icon. 

T he application opens and 
presents a dialog box for you 
to select a disk. 

2 Select the disk you 
want to test and repair, 

using the Drive and Eject 
buttons as necessary. Then 
click Open. 

The disk you selected is the 
volume listed, and a message 
reporrs that Disk First Aid 
is ready. 
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Uolume: Rrchiues 

Stort 

0 . . 

[ Stort ~) Stop 

3 If you want automatic 
repair, choose Repair 

Automatically from the 
Options menu. 

4 Click Start to begin 
testing the disk. 

A message at the top of the 
screen reports testing and 
repair progress and results. 

5 When testing and repair 
are completed, choose 

Quit from the File menu. 

Alternatively, to test another 
disk, choose Close from the 
File menu, then select and 
open the disk and follow steps 
3 and 4 above. 
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Gsing HD SC Setup 
to test a SCSI hard disk 

You can test a SCSI hard disk with the HD SC Sewp 
application, supplied with the system software. 

~ 
App leo HD SC SE?tup 

Apple HO SC Setup 
The disk's SCSI ---if--;==::;;--;---- , 
device number [lnltlellze ) 

[ Up ddl e ) 

( I' <J riHion ) 

[ Test~ J 

( Quit D 

SCSI Deulce: 0 

~ 

~ The uol ume nome Is fiord Disk 

The disk's name --1!f------___./ 

Testing the dis lc will t alce seuer al minutes and 
A\ cannot be interrupted. It will not affect any data 
ill on the dislc. Do you wont to continue? 

n Cancel )J [ OK ~I 

Testing and repairing a disk 

1 Start HD SC Setup by 
double-clicking its icon. 

2 Select the disk you 
want to test, using the 

Drive button if necessary. 
Then dick Test. 

The disk's SCSI device 
number is displayed above the 
Drive button; the disk name is 
displayed in the message box 
at the bottom of the screen. 

3 An alert box appears 
before testing begins, 

asking you to confirm or 
cancel the test. Click 0 K to 
continue. 

T esring begins; the spinning 
beach ball icon indicates that 
resting is under way. 
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Changing the 
clock battery 

Macintosh Plus 

Apple liD SC Setup 

[ Initia lize I 
[ Update I 
[ PorUUon I 
( Test I 
H Dult II; J 

SCS I Doulce: 0 

IE Testing was succeuful. 

4 When a dialog box 
appears telling you that 

testing is complete, click 
Quit. 

All Macintosh models have a system clock that runs 
continuously. When the computer is turned off, a battery 
maintains the time. 

You can change the clock battery in the Macintosh Plus and 
earlier models. 

Ball cry 
companmcm 

1 To change the clock 
battery, first locate the 

battery compartment on the 
back right side of the 
computer and open it by 
pressing the latch. 

Remove the cover of the 
battery compartment. 
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2 Remove the battery 
from the compartment 

and replace it with another 
battery of the same type, in 
the same position. 

The battery you need is a 4.5-
volr unit-the Eveready 523 
or irs equivalent. 

3 Replace the cover on the 
battery compartment. 

Other Macintosh models The clock battery on all other Macintosh models is located 
inside the computer's case. If your system clock begins to keep 
inaccurate time or stops when the computer is turned off, have 
your authorized Apple dealer or representative replace the 
battery. 
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Tt·oubleshooting Ar some rime you may experience a problem wirh your Macintosh. 

Avoiding data loss 
or damage 

The descriptions of problems and possible solurions that follow 
should help you in troubleshooting difficulties with your 
Macintosh's operation. 

Be sure to check Special Features of Your Macintosh for additio nal 
troubleshooting information. If you have a Macintosh Portable, you 
should consu.lr the Macintosh Portable Handbook. 

In recent years, many computer users have experienced problems 
with virum-malicious programs rhar damage files or erase disks. A 
virus could be introduced into your Macintosh system from a disk 
you or someone else puts in irs drive, from a network device such as 
a file server, or from an electronic bulletin board service. 

Check regularly for viruses 

You can use any of several virus-detection and elimination programs 
ro check your Macintosh disks for viruses. Such programs are 
available from user groups, com purer bulletin boards, and dealers. 

Even if you don't notice problems with your computer's operation 
or the information on your disks, you should check for viruses 
frequently if you exchange disks or information with other users. 
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A good virus strategy includes these elements: 

• Check your primary disk or disks regularly with a virus­
detection program and correct any problems it finds. 

• Whenever you get a disk from anyone-even commercial 
software-check it for viruses before using it or copying 
anything from it to your system. 

• If your Macintosh is on a nenvork or you use a modem to 

connect with information services or bulletin boards, check 
for viruses as often as it's practical-ideally after each rime 
you copy any information from an outside source. 

• If you are part of a work group that includes a number of 
Macintosh users, set up a "virus-detection station" that 
everyone can use to check disks (and to copy the latest 
version of virus-detection software if your group has a sire 
license for it). 

• If you give information to other Macintosh users on disk or 
send information electronically, mal<e certain that there are 
no viruses on your system before distributing the 
information. 
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Computer operation Here are some potential problems, likely causes, and suggested 
solutions. 

The computer is turned on but the screen is dark 
Cause: The Macintosh is not getting power, or the screen isn' t 
getting light. 

Try these actions: 

• Check that the power cord is plugged in and firmly 
connected to the computer and that the electrical socket has 
power. 

• Check the screen's brightness control and turn it up if 
necessary. 

• If you use a screen-saving program, press a key or move the 
mouse to activate the screen's image. 

When you start up, the screen is bright but the desktop doesn't 
appear 

Cause: The system software is not on the disk or the disk drive 
is not operating ptoperly. 

When you turn on the Macintosh and insert a disk (if your 
system doesn't have an internal hard disk), you should see one of 
the icons shown in Figure 10-2. (If you turn on the Macintosh 
and don' t insert a disk, you'll see the disk icon with the blinking 
question mark.) 
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The Macimosh ---[[fi].O 
is waiting for 

a startup disk. 

II mxo 1]----The disk that has 
just been ejected is 
not a startup disk. 

"Happy Macintosh" ---~I ~-·~) ~~ "><_"I~---- "Sad Macintosh" 
indicates that the indicates a problem 

system software is with the s~·stem 
being loaded. software or 

the computer. 

Figure 10-2 Icons the Macintosh might display at startup 

Try these actions: 

• If you see the "happy Macintosh" icon, you don't need to do 
anything. The system software is being loaded. 

• If you see a disk icon with a blinking question mark on it, 
your system is waiting for you to insert a startup disk. If your 
Macintosh has an internal hard disk, this icon means that the 
computer doesn't recognize that disk. 

If this happens, use a startup disk to start up and check to 

see if the hard disk icon appears on the desktop. (If not, see 
your dealer.) 

• If you see the disk icon with an X on it, you need to insert a 
startup disk-one that contains an installed System Folder. 

• If you see the "sad Macintosh" icon, there's a problem with 
the system software on the disk or possibly with the 
computer. 

Eject the disk (by turning off the computer, then holding 
down the mouse button while you turn the computer on 
again). Try starting up with a different startup disk. If the 
"sad Macintosh" icon appears again, see your dealer. 
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The mouse moves but the pointer doesn't move 

Cause: T he mouse is nor connected properly or irs signals are 
nor reaching rhe computer. 

Try these actions: 

• C heck the connection of the mouse cable. 

• See whether the mouse needs cleaning, and if so, clean it. 
(See the instructions in this chapter.) 

• Resrarr the Macintosh with a different startup disk. If the 
pointer still doesn't move, consult your dealer. 

Typing on the keyboard produces nothing on the screen 

Cause: The keyboard is nor connected properly or its signals are 
nor reaching the computer. 

Try these actions: 

• Check the connection of the keyboard cable at both ends. 

• If the connections are secure and typing still yields no results, 
shut down and turn off the Macintosh, then unplug the 
keyboard cable. Place the computer end of the cable in the 
other Apple D esktop Bus port on the computer and the 
keyboard end in the other AD B port on the keyboard. (You 
may have to unplug the mouse to do this.) If typing still 
shows nothing on the screen, the problem is most likely in 
rhe keyboard itself. 

• Restart the Macintosh with a different startup disk. If typing 
still doesn' t produce text on the screen, consult your dealer. 
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You can't save anything onro a tloppy disk 

Cause: The disk can't accept information, it is damaged or 
locked, or the disk drive is not working properly. 

Try these actions: 

• If you see a message reporting that the disk is nor initialized, 
and you know that it has been initialized, eject the disk and 
carefully insert it again. If the same message appears, the disk 
is probably damaged. (You may be able to recover the 
information on it with a disk-recovery program.) 

• If you see a message that the disk is full, eject that disk and 
insert another that has adequate space for your document, or 
erase some unneeded data from the disk. If you see this 
message while working in a program, you can eject the disk 
by choosing the Save As command from the File menu and 
using the buttons in the directory dialog box. 

• Check the disk for obvious damage to the plastic case or the 
sliding metal shutter. 

• Make sure the locking tab on the back of the disk at the top 
left is in the down (unlocked) position. See Chapter 6 for 
more information. 

• Insert a different disk and try saving again. If you can't save 
on the second disk, the problem may be with the disk drive. 

• Before concluding that the disk drive is the problem, save 
your files onto a disk in a different drive, if you have one, and 
then restart the Macintosh. Try saving something on a disk 
you know is not damaged placed in the suspect drive. See 
your dealer if saving fails again. 
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You can't eject a J1oppy disk 

Cause: The signal co eject the disk is not reaching the computer 
or the disk or drive is damaged. 

Try these actions, in the order presented here: 

• Hold down the Command and Shift keys and press the 
number 1 key in the cop row of the keyboard ro eject a disk 
in the internal drive; press Command-Shift and the number 
2 co eject a disk in an external floppy drive or the second 
internal drive. 

• If the preceding action doesn't work, turn off the Macintosh, 
then hold down the mouse burton when you turn ir on 
agam. 

• If neither of the preceding actions works, locate the small 
hole to the right of the disk drive's opening, and carefully 
insert the end of an straightened paper clip into it. Press 
gently until the disk is ejected, bur do not force it. (See 
Figure 10-3.) This method of ejecting a disk should be used 
only when the other suggested methods do not work. If this 
method doesn't work, take the computer or disk drive to your 
dealer co have the disk removed. 

Figure 10-3 Ejecting a disk with a straightened paper clip-a last resort 
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You can't start up from a hard disk or see its icon 

Cause: The computer did not recognize th e d isk's signals or rhe 
d isk drive is not working properly. 

T ry these acrions: 

• If the hard disk drive is an ex ternal o ne, make sure iris 
[Urned on and its cable is co nn ected firmly, then restart the 
Macinrosh. 

• If the disk drive is an internal o ne, turn off the Macintosh , 
wait at least 10 seconds, then turn it on again. 

• If the hard disk is your startup disk, start up with a d ifferent 
disk and reinstall the system software on th e hard disk. 

• If the hard disk is not your startup disk and you have more 
than one hard disk in your Macintosh system, check the SCSI 
ID number of each external hard disk an d all orher SCSI 
devices connected to your computer. If two devices have the 
same ID number, one of the devices will not be recognized by 
the computer. C hange th e duplicate number to a number no t 
currently used. See C hapter 9 for more information. 

)o- See also: • "Testing and Repairing a Disk" in this chaprcr. 

A dialog box with a bomb appears 

Cause: Your system has a software problem. 

Tty th ese actions: 

• C lick the Restart burron on the screen (if one is displayed as 
part of the message) . The computer may start up norma lly. 

• If no Restart button is displayed (or clicking it doesn't work), 
use the power switch to turn off the Macin tosh, wait at least 
10 seconds, then turn it on again. T he system may starr up 
normally. 
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• If the M acintosh doesn' t restart with the same startup d isk, 
try to start up with a diffe renr startup d isk. 

• If the M acintosh starts up with a different d isk, check the 
startup d isk and program you were using when the bomb 
message appeared. You may have been using elements of the 
system software that were incompatible with each other or 
with the program you were using. For example, if you used 
the newest version o f th e System and Finder with an old 
version of the Fonr/ DA Mover, yo u could get the bomb 
message. Reinstall ing the system software may correct the 
problem with the first startup d isk. 

• Sometimes incompatible desk accessories can cause the 
system to d isplay a bomb message. Try removing any recently 
installed desk accessories to see if the computer works all 
right. 

• O ccasio nally it 's necessa.ry to pull the plug, if the power 
switch doesn't succeed in cutting power to the computer. 

6. Important: Always be su re to upgrade all parts of your system 
software when you install a new version of the Macintosh system 
software, and always veri fy that the programs you use are 
compatible with the version of system soft\111are you have 
installed. 
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The poinrer suddenly "freezes" on the screen 

Cause: Your system has a software problem. 

Try these actions: 

• Turn off the Macintosh with the power switch on the back, 
wait at least 10 seconds, then turn it on again. The system 
may start up normally. 

• If the Macintosh doesn' t restart with the same system disk, 
try to start up with a different startup disk. 

• If the Macintosh starts up with a different disk, check the 
startup disk and program you were using when the system 
froze. You may have been using elements of the system 
softvnre that were incompatible with each other or with the 
program you were using. Reinstalling the system software 
may correct the problem with the first disk. 

• Occasionally the system may freeze when you are using 
MultiFinder. With the same combination of programs 
open, check the allocation of system memory in the About 
the Finder window. See "Managing System Memo1y'' in 
Chapter 3 for more information. 

6 Important: Always be sure to upgrade all parts of your system 
software when you install a new version of the Macintosh system 
software, and always verify that the programs you use are 
compatible with the version of system software you have 
installed. 6 
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Printer operation If you have a printer connected ro your Macinrosh, you mighr 
encounter one of rhe following siruarions. 

You give the command to print a document and the printer 
doesn't respond 

Cause: The command isn' t reaching the printer or rhe primer 
isn't working properly. 

T ty these actions: 

• C heck rhar rhe printer is turned o n and warmed up (if ir's a 
LaserWrirer, it should have p rinted rhe sample page) . 

• C heck the cable connections ro rhe printer. 

• If your printer is an Image Writer, make sure rhar the Selecr 
light is on. (Press rhe Select burron ro rurn rhe light on.) 

• C heck rhar rhe printer is selccred in rhe Chooser. See 
"Choosing a Printer" in C hapter 4. 

• If the C hooser does nor show an icon for the type of p ri nter 
you want ro use, place the driver or drivers for rhar primer in 
the System Folder of your startup disk and restart the 
Macintosh. See C hapter 4 for more information. 
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You print a document on a network printer and it causes the 
printer to restan or to display an error message 

Cause: The printer has received conflicting signals. 

Try these actions: 

• lv1ake sure that you are using the same version of the printer 
driver as all other people on your network. (If not, place that 
driver in your System Folder and res tart the Macintosh.) 

• If you see an error message stating that the p ri nter cou ld 
not print your document, mrn off the printer for at least 
10 seco nds, then mrn it o n again and wait fo r the prin ter 
to warm up before trying to print again. 

General tips If your Macintosh or a component is not wo rk ing properly but 
its problem is not described in this chapter, you can try some 
general measures that may solve the p roblem. 

Start over 

Often you can eliminate a problem simply by clea ri ng the 
compmer's memory and starting over. 

• If possible, save any open documents in which you've made 
new changes before restarting the Macin tosh. (If your system 
is frozen or you have a bomb message on the screen , savi ng 
won't be possible.) 

• C hoose Restart from the Special me nu, if possible, or turn off 
the Macintosh , wait at least 10 seconds, then turn it o n 
aga111 . 

• If your problem is with a peripheral device, such as a printer 
or external hard disk, mrn it off for LO seco nds or mo re, then 
turn it o n again and restart the Macintosh. 
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r.·take certain that all patts of the system software are from the 
same version 

These tips help keep your system sofnvare in good working order: 

• When you install a new version of system software, be sure to 
copy it on all startup disks that you use, to avoid inadvertently 
working with rwo different system versions later. 

• If the System Folder becomes damaged on one of your 
startup disks, either reinstall the software on that disk or copy 
the System Folder from a good disk onto the disk with the 
damaged folder. 

• When you install a new version of system software, verify that 
the new versions of drivers fo r the printer and other types of 
devices you use are in the System Folder of your startup disks. 

Make cettain that your programs are in good working order 

Here are tips for keeping your application programs working 
effectively: 

• If you have problems with an application program, make 
another working copy of that program from the original 
program disk. 

• If a new copy of the application program doesn' t correct the 
problems with it, check with the program's manufacturer to 

make sure that the version of the program you have is 
compatible with the version of rhe M acintosh system 
software you are using. (You can often upgrade to a newer 
version of the program for a modest fee.) 
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• If you use a hard disk, be sure to keep only one System Folder 
and only one version of each application program on your 
disk. 

• If you use any special programs that customize your System 
file (these programs are usually called !NITs, Control Panel 
devices, or CDEVs), always check with the sources or 
developers of those programs before you install them to mal{e 
sure that they are compatible with the version of Macintosh 
system software you're using. 

Create free space on the startup disk 

Occasionally you may see an error message reporting that the 
Macintosh doesn't have enough memory to start up. 

Try these actions: 

• Start up with another disk, then open the startup disk that 
didn't work and remove some items from it. 

• If your Macintosh starts up from a hard disk, you can use a 
program that reduces the fragmentation of data on the disk. 
This procedure makes disk operation faster and creates larger 
areas of free space for startup. (You can obtain a utility 
program to reduce fragmentation from your Apple dealer.) 
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Take your time 

Whe n you see an erro r message on th e screen , you d on't have ro 

rake an action immediately. T he message wi ll stay o n rhe sc ree n 
until you cli ck the burton that's parr of it o r turn off rhe 
Macin tosh. 

T o help you diagnose and co rrect the problem, rry to garher as 
much info rmation about the situat ion as you ca n befo re 
stamng over: 

• Make a note of exactly w hat you were doing when the 
problem occurred. Write down the message on rhe screen a nd 
irs ID number. (This inform ati on w ill help a service perso n 
diagnose rhe problem sho uld you need to rake the computer 
to your authorized Apple dealer for repair.) 

• C heck the screen for any cl ues that are visible-a men u tid e 
selected, rhe program and docume nr ico ns rhar are open , anJ 
anything else rhar seems relevanr to rhc curre nt situatio n. 

• If you were writing new text, and were nor able to save it 
before rhe problem occurred , you can write d own rhe pan s or 
the text st ill visib le on the screen so that some of yo ur wo rk 
w ill be easy to replace. 

• Ask other experienced Macintosh users abo ut the problem 
yo u' re having; rhcy may have a solution for ir. 
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Rebuild your desktop once a year 

A process known as "rebuild ing the deskrop" helps your 
Macintosh keep t rack of data o n your startup disks. 

• To rebuild the deskrop of a startup disk , hold down the 
Optio n and Command keys while starting up your computer. 

• Follow the rebuilding procedure fo r each of your startup 
disks once a year. 

Back up your work and your programs frequently 

To ensure that the info rmation and the p rograms you use with 
your Macinrosh will always be available, back up your wo rk 
regularly and back up each program when you begin using it. 

• If you use a hard disk for most of your wo rk, be sure to make 
copies of all key programs and files on floppy disks. 

• To protect essential informatio n, such as business archives 
and fi nancial records, consider making duplicate backup 
copies on floppy d isks and storing them in a 'locatio n 
d ifferent from your regular Macintosh work place. 
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Service and support To help you get the best performance &om your Macintosh, Apple 
Computer, Inc. has esmblished a worldwide network offuU-support 
authorized Apple dealers. If you need answers ro technical questions 
or information abour product updates, your authorized Apple dealer 
can help you. Apple's Ted1nical Support organization backs each 
dealer and international tedmical support group via AppleLinl~, a 
srare-of-the-art on-line electronic information service, ro ensure 
prompt, rel iable assistance. 

Your dealer has the latest information on new hardware and 
software products as wel l as product updates. If you wish ro 
upgrade your system, you r dealer can help you select compatible 
components. 

If your Macintosh or a peripheral device requires service, your local 
authorized Apple dealer is trained and ready ro support you. Apple 
provides factory-qual icy parts and the latest available diagnostic 
equipment to the more than three thousand authorized Apple 
service centers throughout the world. Apple guarantees parts and 
warranty labor. (Regu l~1rinns in each country determine the length 1 
of warrancy. Some restrictions may apply, depending on the counny 
of original purchase.) 

If for some reason you can nor return ro the authorized dealer from 
whom you purchased your system, go ro the nearest service 
location. For the location nearest you, in the United Stares 
call (800) 538-9696; in Canada, call (800) 268-7796 or 
(800) 268-7637. For locations in other coumries, either call the 
Apple headquarters in your country or write ro 

Apple Compurer, Inc. 
Customer Relations 
20525 Mariani Avenue 
Cupertino, CA 95014 
USA 

or Apple Canada, Inc. 
7495 Birchmount Road 
Markham, Ontario 
L3R5G2 
Canada 
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Apple also offers service options designed ro meet your needs. 
O ne of these is the Apple Care® Service Agreement (available in 
the United States, Canada, and Australia only), which extends 
full warranty coverage up to three years. Your AppleCare 
contract will be honored at any participating authorized Apple 
dealer within the country of purchase-an added benefit if you 
relocate. Local service means time saved in getting your Apple 
system back to work. 

You can purchase Apple Care at any time, bur it's a good idea to 

purchase it with your system, or at least before your warranty 
has expired, to avoid an owner-paid inspection. 

There are also self-service plans designed to allow large 
installations to repair their own equipment. Whether you use 
your computer at home, in the office, or at school, Apple has a 
low-cost service plan for you. For details, please see your 
authorized Apple dealer. 

Service and support 3 1 ~ 



..., 

Appendixes 



. Appendix A 

Keyboards and 
Character Sets 

Along with the mouse, you use the keyboard ro communicate 
with your Macinrosh. You can choose from several keyboards for 
use with most Macinrosh models; the layout and selection of keys 
varies somewhat among the different keyboards. 

No matter which keyboard you use with your Macinrosh, you 
can use certain keys, such as Option, Command, and Shift, ro 
type optional characters. The Key Caps desk accessory shows the 
location of optional characters for each fonr installed in the 
System fil e. 

Keyboard layouts T he illustrations that follow show the layouts of the 
Macinrosh Plus keyboard (used only with that model) and the 
keyboards that can be used for other Macinrosh models. 

~ See also: • "Using Special Keys and Indicators on rhe Keyboard" in 
C haprer 1 

• Appendix B, "MacroMaker Command Fi les" 
• Appendix D , "Special Aids for Using rhe Mouse, 

Keyboard, and Screen" 
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Macintosh Classic/ 
Macintosh LC 

keyboard 

Tab key: Moves the insertion point horizontally 
to the next stopping place (such as a tab stop or 

data field in a dialog box or program). 

Caps lock key: A locking Shifr key for 
leuers only (numbers and symbols 

aren't affected). 

Shlft key: Produces Ltppercase letters 
(or the upper char:tcter on the key). 

Control key: Like the Command key, works 
in combination with other keys to pro\•ide 

shortcuts or modify other actions. 

D 

Power On key: On some Macintosh models, 
you press rhis key to switch on 

your computer. On the Macintosh 
Classic this key has no function. 

' 

.11j 0 ( ~ 
I 

I 

[] [J [] [] [] 

) 
J 
~ 

[] [] ~ ~ 
~ ~ ~ GJ GJ [J ~ ~ ~ 
[ caps 
lock 

I sluff 

GJ 

]GJ GJ ~ ~ GJ GJ CJ 
] ~ [!] [£_] ~ GJ ~ 

I option l ~[ 

0 tion ke •: p } 
Produces an 
optiomli SCI of" 
special characters 
when pressed in 
combination with 
other keys. 

Command ke •: Works with } 
other keys as a shortcut to 
choosing a menu command or 
(in some programs) canceling 
an operation in progress, 
such as printing. 

J .., 
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--. 

-

Ft [] 
~ I g 

Delete key: Deletes any text 
currently selected. or whatever 

character is to the left or the 
irbertion point 

[[] c (] l delete 

Return key: Ends tire 
paragraph and moves the 
ins~:rt ion point ro the 
beginning olrhe nextlirll'. 
In a eli a log box. pressing 
l{eturn is the same :1s 
clickino the out lined bunon . ~ 

rf.'p 
l) 

Numeric keys: These 
ke~·s produce numbers 
and mathematical s~;mbols: 

.-;ome program~ designate 
these keys as special 
ru net ion keys .. 

--------~ 
1 ~clear l ~ D [J 

:J GJ ~ [L [L l 11 l G 
I"' 

GJ ~ GJ J 
l -:J [J [J D [return : __) 

[: [J D [] ( shtft 1 
I 

,_ ' 

~ 
r 

CJ [J Q 

Esc ke : Esc stands y 
for liscape; the function 
or this key depends on 
the progr~un you're using. 

~ EJ --
Arrow ke s: Move y 
the insertion point. 
as an alternative 
to using the mouse. 

G 
G 
G 

D ~ GJ GJ 
n [J GJ ------
1-' 

~ c !!!!!._r_, 

Clear ke ': Deletes the } 
current sd ection, just as the 
Del ell: key does. In some 
programs, Clear may have 
other functions. 

Enter k ey: In a dialog 
box. pressing Enrer is 
the same as clicking 
the outlined button (or 
pressing Heturn); some 
programs require that 
you use Enter (not 
Heturn) to put data into 
specific Aelds. 
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Apple Keyboard 

Esc key: Esc stands for !:.~rape: the function 
of thi~ key depends on rhe program you're using. 

J~ LJ 

Power On key: \Vith most mtxlular 
.\·l:tcintosh models. you press 

this key to turn on your sr.~tem 

when it'' been tumcd off. 

t ~ 

ltJ LU lL lLJ 
J 

lJ l_J 
Tab key: Move~ the insenion point horizontally 
to the next stopping place (such as a tab stop or 

data lleld in a program). 

~ ~ ~ ~ LJ LJ ~~ 
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Control key: !.ike the Command ke)', works 
in combinmion with oth~r keys to provide 

shortcuts or modi!\• other actions. 

Shift key: Produces uppercase letters 
(or the upper char.tcter on the ker). 0 

l control 

l shift 

l;rJ * 
I 

I 
Caps Lock key: A locking ~hi ft 

key for leners only (numbers 
and symbols aren't affected). 

J~ ~ liJ ~ LJ ~~. 
I lJ ~ LJ LJ ~h J 

l option J u lJ I 
I \ 

I 
Option key: Produce:; 
an optional ~c t of >pt:ci:tl 
chmactcrs. in combination 
with other kers. 

\ 
Command key: Combine' ll'ith 
:mother key as :1 shoncut to 
choosing~~ menu command or 
(in some programs) canceling 
an operation in progrc'is. 
such as printing. 

_.,_ 

l 

Figure A-2 The Apple Keyboard 



Delete key: Deletes any text 
currently selected. or wh:llcver 

character is to the left of tiH.: 
insertion point. 

neturn key: ~ loves the 

insertion point to the beginning 
of the nt:xt line. In :1 &!log box. 
pres.,ing Retum is the same as 
clicking the outl ined button. 

----

Numeric keys: These ke)'S 
produce numbers and 
mathematical symbols. 

----JT . lU lU ~ lU r1 delete I l clear J ~ r-LJ u ·,l: -----' •, ' '. 

L~lJ ~ ~ ~ ~ 
~J lJUU U return ' '. 

~~ ~ LJ tLJ 
~-
~ L bJ ·, bJ 

-
l1 

l shih J 

lLJ '\ lLJ '··. -

Arrow keys: ,\•love 

the insertion point, 
a~ an altcrnatil·e 
to using the mouse. 

~ w ~ kJ 
~ u lJ ~ ' '. 
l_ j lu kJ 
lo J. L 

Clear key: Deletes the 
current selection. just as tht: 
Dekte key docs. In some 
programs. Clear may have 
other function~ . 

bJ 
lJ ' \ 

enter ----

Enter key: In a dialog 
box. pressing Entt:r is 
the >ame as clicking 
the outlined button (or 
pressing l~eturn): some 
programs require that 
you use Enrcr (nor 
Return) to put d3ta into 
specific llelds. 
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Apple Extended 
keyboard 

Esc key: Esc stands for Escape: the function 
of this key depends on the program you're using. 

Tab key: .\IOI'es the insenion poim horizomally 
w the next stopping place (such as a t~b stop or 

data field in a program). 

Caps Lock key: A locking Shift key for leucrs 
only (numbers and symbols :ucn't :tfl'ectcd). 

Shift key: Produces uppercase leuers 
(or the upper character on the key). 

Control key: Like the Command ke)', works 
in combination ll'ith other keys to provide 

shoncuts or modify other actions. 
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Jlunction keys: Designed to work in ahcrn:nive operating systems $UCh as 
AIL/: or MS-DOS. Wilh the help of the ~h1cro~1:lkcr utility progr.un. 

you can uso.! tho.!se keys in the .\lacintosh Opcr.uing Systo.!m to 
pr(xlucc recorded chara(tci~ and commands. 

0 

--------------- '"'""l 

0 

bJ [hJ!l-J!kJ!kJ) [bJ!bJ!~~ 

u LJ \iJ lU LU w ~ lLJ ~ l 
L lJ ~ ~ ~ lJ LJ lJ L~~ 
l= JW lJ lJ GJ LJ lJ LJ ~ u 
l sh!;1 JlJ LJ LJ LJ LJ lJ lJ lC 
l control J ~ n 

Option key: Produce~ an optional 
set of spccial ch~racters, in 

combinmion with other keys. 

~~ l 

Command key: Combine~ ll'ith 
another ke~· as a shoncutto 
choosing a menu command or 
(in some programs) cancding 
an oper.u ion in progress, 
such :ts priming. 

Figure A-3 The Apple Extended keyboard 
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-
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[a] 

Delete key: Deletes any text 
currently selected, or whaiCver 

character is to the left or the 
insertion point. 

kJ lFto J 6J lF12 J 

Special keys: These ke)"S are 
designed to work in alternative 
operating systems. In most 
cases. the function uf these keys 
depends on the operating system 
and program you're u~ing. 

l7t3 J t[t4 J t; J 

Numeric keys: These keys 
produce numbers and 
mathematical symbols; 
their arrangement matches 
th:n on the Calculator 
desk accessory. 

Power On key: With 
most modular Macintosh 
models, you press this key 
to tum on your system when 

eel off. it's been rum 

0 - - - ~ num caps scroll 
lock lock lock 

-------------- -----------------------_ll u EJ ~ l delete J [:p J 

u J ~ lU liJ LJ ~ 
JILJ u LJ l return J 

-

~.tJ lLJ l s~~m 
_:___j lo JCJ l :thn J l control ~ ld 
)~ --

Return key: Moves the insertion 
point to the beginning of the next 
line. In a di:tlog box. pressing 
Return is the same as clicking 1hc 
outlined lllltiOn. 

~ bLJ 
bJ l= J 

llJ 
lU bJ 

Arrow keys: 
~lore the insertion 
poim. as an ahcma1ive 
to using the mouse. 

l:a, J lJ lJ lJ 
~ 
~ 
G_ 

~ 

u lJ lJ ~ 
~ kJ lJ bJ 
JlJ ~ u u 
Clear key: 
Deletes the 
current selection, 
just as the Delete 
key does. In some 
programs, Clca r 
may have other 
functions. 

Enter key: In a dialog box. 
pressing Enter is the same as 
clicking the ou11ined button 
(or pressing lkturn); some 
progrmns require that you use 
Enter (not Return) to put claw 
into specific fields. 
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Optional 
characters 

Viewing optional characters 
with Key Caps 
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You can produce a variety of optio nal characters by pressing the 
Option key or Option-Shift keys in combination with certain 
character and number keys. 

T he Key Caps desk accessory shows you the standard and optional 
character sets produced when modifier keys are pressed, such as the 
Shift and O ption keys. Key Caps is supplied with the Macintosh 
system software and installed as part of the standard desk 
accessories on all Macintosh models with an internal hard disk. 

You stan Key Caps like any desk accessory-by choosing irs 
name from the Apple menu. 

Figure A-4 shows the Key Caps window with each of two sets of 
optional characters ava ilable in th e C hicago font when the 
Option key is pressed and when Option-Shift is pressed on the 
Macintosh Plus keyboard . 
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Test box: char.tctcrs 
appear here ll'hen 

rou try keys OUt hr 
pressing them on the 
k~rhuarcl or clicking 
th~m in the window. 

ll1e highlighted key 
in the Key Caps 

window represents 
the key held clown 
on the kerboarcl-

in this case, the 
Option kc>'· 

Option key 

Special chamcters 
available in the 
Chicago font 
when the Option 
key is pressed 

Special characters 
available when 
Option-Shift 
is pressed 

Figure A-4 Special characters displayed by the Key Caps desk accesso1y 

T he Control key available on some keyboards also produces 
optional characters fo r some keys. 

Optional characters 329 



You can display the character sets for other fonts installed in your 
System ftle by choosing the name of the fonr from the Key Caps 
menu when the Key Caps window is open. (See Figure A-5.) 

Ruant Garde 
B Ruant Garde Demi 
B Garamond Bold 
B Heluetica Bold 
Bl Ruant Garde DemiOblique 
B I Garamond Bold Italic 
B I Heluetica BoldOblique 
Cairo 

./Chicago 

Figure A-5 The Key Caps menu (available when Key Caps is in use) 

Typing accented characters Using the Option key with certa in other keys lets you enrer 
international language characters. Table A-1 shows the accent 
marks and the key combinations that produce them. 
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Table A-1 Option-key combinations for accent marks 

Accent mark 

Grave accent ( ' ) 

Acute accent ( ' ) 

Circumnex (11) 

Tilde ( -) 

Umlaut ( ·· ) 

The letter c with a cedilla (~) 

Key combination 

Option-', then type the character to be 
accented 

Option-e. then type the character 

Option-i, then type the character 

Option-11, then type the character 

Option-u, then type the charJcter 

Option-c 
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Macro Maker 
Command Files 

Appendix B 

! e MacroMakerT" uriliry program provided wirh rhe 
Macin tosh system software lets you record keystrokes and 
commands in special files called scripts or macros, and assign the 
scripts ro a key or a combination of keys on the keyboard. When 
you press the key or combination of keys that has a MacroMalcer 
script, the script is "played." 
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Installing 
MacroMaker 

MacroMaker is supplied in the MacroMaker Folder on the 
System Additions disk. (If you are updating your system 
software with an upgrade kit, yo u' ll find MacroMaker on 
Utilities Disk 2.) Figure B-1 shows the icons of the three fi les 
in the MacroMaker Folder. 

lllelp fi le File of scripts: the 
~scripts provided 

/ assign the Undo, 

-~) ~ 
l'rogr:un icon 61 V 

Cui. Copy. and Paste 
comm:tnds to 
function keys Fl 
through F4 on an 
extended keyboard. 1'1.acrc•M.aker tv1.acrot1aker Help ~1acros 

Figure B-1 Icons for the i\lacroMaker program, plus help and script fi les 

To install MacroMaker, follow these steps: 

1. Drag the icons for the program, its help file, and (i f you 
have an extended keyboard) the script file "Macros" to the 
System Folder of your startup disk. 

2. Restart the Macintosh. 

Once the program is installed, a MacroMaker menu appears to 

the right of the other menus in the menu bar. The MacroMaker 
menu's tide resembles a cassette tape. (See Figure B-2.) 

r • File Edit Uiew Special l&el- .\ttcro~laker 
menutcon 

Figure B-2 The tape icon that identifies the MacroY!aker menu 

You remove MacroMaker by dragging its icons out of the 
System Fol.der of your startup disk and restarting the computer. 
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Creating lTiaCrOS You create a macro in the MacroMaker window. (See Figure B-3.) 

with I\1acroMaker 

Info box with 
dt.:scription of 
loadt.:d m~cro 

l<eystrokt.: line 
(with Option-S for 

this rmcro) 

Clicking here 
initiates script 

recording. 

Kame line 
c.,ck:w.:d here) 

Pop-up menu 
of m:rm> li~t!; 

l.i'l of macro~. 
displ:rycd 
according to the 
view indicated 
below 

~~;:-;~=~~ \X'hen a macro 
i~ ~b.ted in the 
li~t. dicking this 
huuon er:tses it. 

Clicking 
hen.: pl:tr:; 
the currt·nt 
macro. 

Clicking 
here store' 
the current 
macro. 

Figure B-3 TI1c Macror\olaker window 

Follow these steps to create a macro. 

When a macro in 
the list is ~elected. 
clicking thb 
huuon lo:rd:; it. 

Views ;11·ailahle 
(sliding indic:Hl>r 
changes the li>t 
abm·e) 

1. Open a new document in the program you're using. 

If you're working on the desktop (which means you're 
using the Finder), you can skip this step. 

2. Open the MacroMaker window by choosing Open 
MacroMaker from the MacroMaker menu. 

3. Type a name for the macro on the Name line. 

T he name can be up to 16 characters long. 

4. If yo u want to add a description of the macro, click to 

select the Info box and type the information. 
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5. Click the Keystroke line to select it and type the keystroke 
or key combination that you want to trigger the macro. 

You can include modifier keys, such as Command, Option, 
and Shift, in your keystroke; MacroMaker displays a symbol 
to represent each of these keys. (See Figure B-4.) 

cS Caps Lock 
00 Command 
~ Control 

lffil Numeric keypad 

~ Option 

.0 Shift 

Figure B-4 Symbols for mod iller keys used in keystrokes for macros 

6. Click the Record button. 

M acroMaker returns you to the current program. T he 
cassette icon blinks in the menu bar to remind you that all 
keystrokes, mouse cl icks, and menu commands you use will 
be recorded until you stop reco rding. 

7. Enter the script you wish to record by typing, clicking, and 
choosing menu commands. 

If you make a mistake while ryping, use the Delete 
(Backspace) key to remove the incorrect characters. 

8. To stop recording, choose Stop Recording from the 
MacroMaker menu. 

Recording stops, and the MacroMaker window opens. 

Appendix H: Macro\laker Command Files 



9. If you want to check your script, click the Play button. 

MacroMaker returns you to the program in which yo u 
recorded the script, repeats rhe script, then reopens the 
MacroMaker window. 

10. If you want to change the script, you can record it again 
without changing the name or keystroke. 

11. Click the Store button to save the macro and move it into 
the macro list on the right side of the MacroMaker window. 

If the list already contains a macro with the same name or 
keystroke, you'll see a dialog box asking if you want to replace 
the existing macro with rhe new one or to cancel the store 
command. If you cancel, you can rename the macro or 
change the keystroke and then store it. 

If you don't store a macro and you close the MacroMaker 
window, you' ll see a message asking if you want to store the 
macro before closing. If you don't store it, the macro will be 
lost. 

·:· Creating a global macro: You can create a global macro, which 
is available regardless of the program you're using, by 
selecting Global Macros from the pop-up menu above the 
macro list box on the right side of the MacroMaker window, 
then following the regular steps to make a macro. Because 
menu commands vaty among programs, it's a good idea to 

avoid using them in a global macro unless you're certain that 
they are provided on the same menu, at the same position, in 
all programs. ·:· 

.>- See nlso: • "Using Special Keys and Indicators on the Keyboard" in 
Chapter I 

• Appendix A, "Keyboards and Character Sets" 
• Appendix 0, "Special Aids for Using the Mouse, 

Keyboard, and Screen" 
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· Appendix C · ~ 

Exchanging Disks and Files 
With MS-DOS Computers 

Some Macintosh models have rhe Apple SuperDrive as rhe 
internal floppy disk drive. The Super Drive can read and 
initialize 3.5- inch disks for both Macintosh computers and for 
computers thar use the MS-DOS operating system. 

You use the uriliry program Apple File Exchange ro initialize 
disks in the MS-DOS format and ro convert files from 
MS-005 computers for use in a Macintosh compurer. 



Using Apple File 
Exchange for 

!VIS-DOS disks 
and files 

Apple File Exchange is supplied on the System Additions disk 
provided with M acintosh system software. (If you are updating 
your system software with an upgrade kit, you'll find Apple File 
Exchange on Utilities Disk 2.) The program and one or mo re 
special translator fil es, which convert fil es, are stored in the 
Apple Fi le Exchange Folder. 

Figure C-1 shows the Apple File Exchange icon. 

Apple File Exchange 

Figure C-1 The Apple Fik: Exchange icon 

Initializing an MS-DOS disk To initialize a 3.5-inch disk in MS-DOS format, follow these 

in a SuperDrive steps: 

1. Start Apple File Exchange by double-clicking its icon. 

T he program 's window opens, showing a directory dialog 
box that lists the contents of the active window on the left 
side and has an empty list box on the right side. 
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2. Place a blank high-density disk in the SuperDrive. 

A dialog box appears, reporting that the program can't read the 
disk and asking if you want to initialize it. This dialog box 
shows the names of formats available in Apple File Exchange, 
including Macintosh and MS-DOS. (See Figure C-2.) 

(You can initialize a disk that is nor blank by inserting it, 
clicking the drive burton until its name appears above the 
right list box in the Apple File Exchange window, and 
choosing Erase Disk from the File menu.) 

High-density disk dialog box Normal-density disk dialog box 

reM this dlsl<. Do you wish to 
lnltlollzo It? 

[d Opple File Euchonge cannot 
rood this disk. Do you wish to 
lnlllollze 11 7 

II [g) Opple File Euchonge cnnnot 

o 1440K Disk capacity ----it-® 
is the same for 
Macintosh ;md 
MS-DOS high­

Macintosh 

l'roOilS 
lei 

0 400K Moctntooh jQj 
0 000K 

o 720K Prui)IIS _bj 
density disks. [ inltlollze JILJ:tect , 

i= 
[tnlllollze J ~ E~ect II 

Figure C-2 Dialog boxes for initializing high-density and normal-density disks 

3. Click MS-DOS, then click the Initialize button. 

T he disk is initialized in MS-DOS format. When 
initialization is completed, a dialog box appears, asking you 
to name the disk. 

4. Type a name for the disk, then click OK. 

The name must be valid for MS-DOS-up to 11 characters, 
with no period. 

T he dialog box closes, and the name of the disk you 
initialized appears in the Apple File Exchange window, above 
an empty direcr01y . T his disk's icon doesn' t appear on your 
Macintosh screen (because it is in MS-DOS format). 
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5. C hoose Quit from the File menu when you are finished 
using Apple File Exchange. 

•!• Initializing a normal-density disk in MS-DOS format: You 
can also use Apple File Exchange ro init ialize a regular 
(normal-density) 3.5-inch disk for MS-DOS fil es. Follow the 
preceding steps, but place an 800K disk in a Super Drive and 
click 720K in the dialog box that asks whether you want to 
initialize. (See Figure C-2.) •!• 

•!• 5.25-inch disks: Some M acin rosh models can use an external 
5.25-inch floppy disk drive that can read data fi les from 
MS-DOS disks. An internal adapter or expansion card is 
required to connect a 5.25-inch disk drive ro the Macintosh. 
Apple File Exchange can translate fil es from these d isks and 
store fil es on them. •!• 

Converting files to and from Apple File Exchange converts Macintosh fil es into MS-DOS 
MS-DOS format format and MS-DOS files into Macintosh format. T he program 

provides two bui lt-in methods of translation- text translation 
for use with text fil es, and binary translatio n, which copies a file 
in binary form. 

In addition, Apple File Exchange can use separate translator fil es 
designed to convert fi les into formats for specific programs. One 
translator file provided with Apple File Exchange is th e DCA­
RFT/MacWrite fi le, which converts documents benveen 
MacWrite format fo r the Macintosh and Document Content 
Architecture/Revisable Form Text format (used by many word 
processing programs) for MS-DOS. 
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Menus of 
translator mes 

File selected for 
translation 

Directory list 

-

-l 

Figure C-3 shows the Apple File Exchange window with a 
Macintosh hard clisk on the lefr and an MS-DOS disk on the righc. 

• File [ dlt Moe I o MS- DDS MS- DOS to Moe 

ll ... . . .. . ··· . ···. .·.· .. . . . ..... • .. .. jij·· ... • . . . ••• . zz Rppte File [uchonge 
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:: 
[ :olrnn<ln t o:» JJ) DUDGEl.OUW 

( ncrnoue II 
27K 

bytes 

1·: 
~ 

selec ted I 

·,] 

M 

I Ill 
~ 

Dir~ctory title 

lluttons to t l~tnsbtt: 

or remove a file 

Size of file sdt:cted 

Disk name 

Spac~ avatlabk ll' ;J OHK byt es a unliable 

on the disk : ( Open 'I ( Drlue ( llt>PU 'I ( Droue I u .[N~w rotd~r) [ [j<H t ' 'IN~wFolder) .,: Eject . J J 

., c:::::> llumrner (g) MSOOS.Jj h 

1324K bytes ouoi loble-- Space availabl~ 
on the disk 

::::,,· ,: ,::::·:.:: :::·:·: :· '''•' :•::·::•:::! :' : :~:~lltl~ll:~t~ •~:~~ ~~:J:cre.lt~: ~~~~~~S,~I~'IICh 
disk <hives, and eject noppy disks 

Figure C-3 The Apple File Exchange window and menu bar 

Fo ll ow these steps co uanslate a fi le: 

1. Start Apple File Exchange by double-didcing its icon. 

T he program's window opens, showing a direccory dialog box 
that lists the contents of the active window on the left side 
and has an empty list box on the right side. 

2. Use the Open, Drive, and Eject buttons, if necessary, to 
display the files you want to translate and the destination 
disk or folder where you want to store the translated files . 
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Active ll:111sl:11or 

3. Click the name or names of the files or folders you want to 
translate to select them. To select multiple ft.les or folders, 
hold down the Command key and click each name. You may 
have to scroll to locate the names of some files or folders. 

4. Open the translation menu for the kind of file translation 
you want by pointing to its title and holding down the 
mouse button. 

If you are translating MS-DOS files into Macintosh fil es, 
open the MS-DOS w Mac menu. This m enu shows the 
O CA-RFT/MacWrite translaror provided in the Apple File 
Exchange Folder, the built- in "Text translation" and "Default 
translation" (binary translation), and any other translawrs 
you've added. (See Figure C-4.) 

MS-DOS to Mac 

v DCA-RFT to MacWrite 

TeHt translation... fr-
+Default translation ... I Three dots in 

This item presents --+-~-Otller trens/81 ions... I mcnu indic;Hc 
a dialog box for 1 1 that a dwlog box 

adding translators to appears when the 
a translator menu item is chosen. 

Figure C-4 The ~-IS-DOS to Mac translator menu in Arple File Exchange 

5. Make sure that all translators for the types of files you've 
selected are active; if not, select them. 

An active translator has a check mark beside ir or, for the 
default translator, a diamond (indicating that it's always 
active). (Selecting an active rranslawr makes it inactive.) 
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6. Compare the size of the files or folders selected for 
translation with the space avaiJable on the destination disk. 

The total space fo r the items selected appears between the 
two di rectOty lists; the space available on the destination disk 
appears below the name of the destination disk. 

7 . If the size of the selected items is greater than the space 
available on the destination disk, then either deselect some 
of the items selected, select and remove some files on the 
destination disk {using the Remove button), or change disks 
in the destination drive {using the Eject button). 

8. When sufficient space is available for the selected items, 
click the T ranslate button. 

If Apple File Exchange finds two or more active 
translators-other than Text or Default-capable of 
translati ng any selected fi le, it presenrs a dialog box asking 
you to select the translator you want from a list of active 
translators. 

If the names of destination fi les or fo lders conflict with 
existi ng files or folders, or with each other, Apple File 
Exchange presents a dialog box in which you can rename the 
destination file. 

If a rranslator requi res you to select options before a file is 
translated, it presenrs a dialog box in which you select the 
options. (Translator names followed by three dots in a 
translator menu present an options dialog box.) 
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9. If necessary, select the appropriate translator from the list, 
and then either click the Continue button in the dialog box, 
rename the destination file and click Translate, or select the 
options you want and then click OK. 

T he selected files or folders are translated. A dialog box 
reports the status of copying, showing a horizo ntal bar rhar 
fills progressively with a gray parrern as rhe translation is 
completed. 

If Macintosh files are being translated into MS-DOS files, 
the names of translated files are shortened to conform to rhe 
naming conventions of M S-DOS (maximum 11 characters, 
with a period between the eighth and ninth). 

10. When all translations are finished, choose Quit from the 
File menu. 

•!• Converting MS-DOS files on a file server: Some file servers 
can store information created by Macintosh computers and 
MS-DOS computers. For example, the AppleS hare PC 
program allows MS-DOS computers to store and translate 
fil es on an AppleShare file server. ·!• 
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Other file-conversion Apple File Exchange provides several other options to assist yo u 
options with file conversio ns. Figure C-5 shows the program's File menu , 

where you choose these optio ns. 

The program keep a - -+­
log of all files transl:ued: 
il shows the dale, lime. 

:111d type of conversion. 
The log can be saved, 

cleared, or primed 
when il's open. 

You can rename 
destinmion files even if 

Saue User log As ... 
Clear User log 

Restore settings from ... 
Saue settings as ... 

Page Setup ... 
Print User log ... 

mmcs don't conflic1. - - +-Rename Destination Files ... 

t--7--- The aGivc 1 r.111~1 :uors and the 
options for c:Kh tran~l:uor c tn 
be SJI'ecl in a special file with 
the "Sa1•e sell ing~ as· 
command. You l~lll then usc 
them an)' time h)' choosing thc 
''Restore sell ing~ from" 
command and opening the llle . 

11te program dims the 
names of files that can't 

be com·erted br the 
active translators when 

this item is checked. 

./Show Only Eligible Files :ICE 
Erase Disk ... ______ ___,,__ 

Quit 

11tc Er.tsc Di~k 
command lc:ls you 
rcinilialize a disk in any 
of the formats av:til:thle. 

Figure C-5 The File menu options in Apple File Exchange 
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More information about Apple File Exchange options 

The program itself contains explanations of the translators it 
uses. Choose About the Apple File Exchange from the Apple 
menu to see the list of translators, select an item in the list, then 
click the About butron for information about that item. (Click 
the Done button to return to the program's window.) 

Converting Apple lll'iles with Apple File Exchange 

You can also rranslate fil es to and from the format for the 
ProDOS® operating system for Apple II computers. Apple File 
Exchange converts ProDOS files to and from Macintosh format 
and MS-DOS form at. You can obtain translators for ProDOS 
and other operating systems from your authorized Apple dealer. 
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Appendix D ·· 

Special Aids for Using 
the Mouse, Keyboard, 
and Screen 

The Macintosh system software includes uriliry programs 
designed to assist users who have d ifficulty using the keyboard 
or the mouse or reading the monitor's screen. These programs 
are Easy Access, which provides alternative ways to use the 
mouse and keyboard, and CloseView"'', which magnifies the 
images displayed on the screen. 



Keyboard and 
rnouse assistance 
with Easy Access 

Easier keyboard use 
with Sticky Keys 

Easy Access is a file in your System Folder that provides two 
features- " Sticky Keys" and "Mouse Keys." These features assist 
people who have difficul t)r typing with both hands or with 
manipulating the mouse. They're also useful to anyone who 
wants to use the keyboard with one hand or to make very fine 
movements of the pointer with becter control. 

The Sticky Keys feature of Easy Access lets you type 
combination keystrokes , consisting of a modifier key and 
ano ther key, without actually pressing the keys simultaneously. 
The modifier keys covered by Sticky Keys are 

• Shift key 

• Command key 

• Option key 

• Control key (nor on the Macintosh Plus keyboard) 
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Easier mouse use 
with Mouse Keys 

To use Sticky Keys, follow these steps: 

1. Press the Shift key five times without moving the mouse. 

(If you bump or move the mouse during this sequence, begin 
again.) 

When you turn Sticky Keys on, its icon appears at the far­
right end of the menu bar. (See Figure 0 - 1.) 

2. Press the key combination you want to use. 

When you press a modifier key, the Sticky Keys icon changes 
ro indicate that the modifier key is set or locked. (See 
Figure 0-l.) Pressing a modifier key once sets it; pressing the 
key rwice locks ir. 

3. To turn off Sticky Keys, press the Shift key five times again. 

You can also turn off Sticky Keys by pressing any two 
modifier keys at the same rime. 

A modifier key 
---=--'has been pr\':-."><.'tl. 

-ri--...,-J.~j_ A modifier kt:)' is 

I locked (pressing the 
key twice locks it for 
repeated usc). 

Figure D- 1 Icons for tht: Sticky Keys feature of Easy Access 

The Mouse Keys feature of Easy Access lets you manipulate the 
pointer using the numeric keypad on your keyboard instead of 
the mouse. You can click, drag, and perform all the usual mouse 
activities, and you can gain precise control of mouse movements 
when needed. 
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To use Mouse Keys, follow these steps: 

1. To turn on Mouse Keys, press Command-Shift-Clear. (You 
can use Sticky Keys for this combination if you wish.) 

2. Use the numeric keypad to move the pointer and to click, 
drag, and make other mouse movements. 

Figure D-2 shows the pointer movement produced by 
pressing keys on the numeric keypad. The 5 key serves as the 
mouse burton: press once to click; press twice to double­
click. The 0 key locks the mouse button down for dragging. 
The decimal point key (to the right of O) unlocks the mouse:' 
button. 

3. To turn off Mouse Keys, press Command-Shift-Clear 
agam. 

[dear l ~ lJ lJ 
~ ~ ~ ~ 
tJ ~ ld bJ '•. 
ltjk!J ~ u t 0 j u 

Figure D -2 Pointer movements and mouse control with Mouse Ke~·s turned on 

>- See also: • "Using Special Keys and Indicators on the Keyboard" in 
C hapter 1 

• Appendix A, "Keyboards and C haracter Sets" 
• Appendix B, "Macro.Maker Command Files" 
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Easier screen Close View is a utility program supplied 
viewing with with Macintosh system software that 

Close View makes the screen easier to view or read 

for people who have difficulty with 

standard-sized screen images. 

You install Close View by dragging its 
icon to the System Folder of your 
startup disk. (See Figure D -3.) 

Figure D-3 The Close View icon 

You turn Close View on and select its 

features in the Control Panel. With 

the General Control Panel open, 
locate and click the Close View icon to 
display the Close View Control Panel. 
(See Figure D-4.) Then select the 

. 
opuons you want to use. 
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Control Panel 

Cl~e 
View;.l Oonl 

@Off I ~:3€0 Turns 
Close View 
on or off 

Inverts -I[@ Black on \v'hite 
screen image 0 'w'hite on Black 

t1agnification 
,...------1- Turns 

0_ On magnification 
~:: QDH ,lA\ - cto on or off (or 

'1!1 Off use keystroke) 

Turns _ _ Keyboard @on 
Qoff 

~~-r 
~Ill ~~-1-keystrokes Shortcuts 

on or off 
1--------...L..---......;~-------r Arrows change 

magnification 
............................................... 
1 ~ = Option 1 ................................................ 

© 1'388 1 1 989 I 
Apple Computer) Inc. 

................................................ 
1 ~ = Command ~ 
: ............................................. ; 

developed by 
Berke ley Systems 1 Inc 

Figure D-4 Close View Control Panel 

power (or use 
keystroke). 

When Close View is on, you'll see its frame (a 
heavy box covering a portion of the screen). 
The frame moves when you move the pointer 
on the screen. 
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When the frame is displayed, you can 
turn magnification on with the 
keystroke Option-Command-X. (The 
same keystroke turns magnification off.) 

To increase or decrease the power of 
magnification, use the keystroke 
Option-Command-Up Arrow 
(increase) or Option-Command­
Down Arrow (decrease) . 
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_ Appendix E 

Where to Get 
More Information 
About Your Macintosh 

A s you increase your knowledge of computers and develop 
new uses for your Macintosh, you may want to learn more about 
programming, hardware design, or o ther technical ropics. Or 
you may simply want to know v.rhat other Macintosh users in 
your area are doing with their computers. 

T he information presented in this appendix provides a starting 
point for you to expand your Macinrosh knowledge and 
conracts, no matter what your interests. 

3)3 
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l\1acintosh 
user groups 

Technical 
infonnation 

Whatever your level of computer experience, you can get lots of 
support by joining a Macintosh user group. Macintosh user 
groups are composed of people who work with Macintosh 
computers and who enjoy sharing what they know with others. 
Activities may include new product demonstrations, 
information question-and-answer sessions, and regular classes on 
using popular programs or learning ro write your own programs. 
Many user groups have special beginners' meetings. 

Ask your authorized Apple dealer for the name of the Macintosh 
user group nearest you, or call 1-800-538-9696 for more 
information. For user groups outside the United States, or if 
you're interested in starting your own user group, contact 

Berkeley Macintosh User Group or 
1442-A Walnut Street, #62 
Berkeley, CA 94709 
(415) 849-9114 

Bosron Computer Society 
One Center Plaza 
Boston, MA 02108 
(617) 367-8080 

A variety of technical docwnentation is available for the 
Macintosh. Apple Computer releases technical information 
through three primary outlets: the Apple Technical Library and 
the Apple Communications Library, both published by 
Addison-Wesley Publishing Company, and APDATM. 
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Apple Technical Libraty The Apple Technical Library includes comprehensive technical 
documentation for all Macintosh computer models and the 
multiple-volume guide to the Macintosh operating system for all 
models, Inside Macintosh. 

Apple Communications 
Librclly 

Other books in the Apple Technical Libraty cover design of 
expansion cards and programming of device drivers for the 
Macintosh, programming for rhe Macintosh, and designing the 
user interface for Macintosh programs. 

You 'll find the Apple Technical Library in most well-stocked 
bookstores. 

The Apple Communications Library offers complete technical 
information about Macin tosh communications products and the 
Macintosh in a network environment. The library includes an 
introductory volume, Understanding Computer Networks, and 
the comprehensive guide to the Apple Talk network system, 
Inside Apple Talk. 

The books in the Apple Communications Library are available 
at bookstores. 

APDA APDA provides a wide range of technical products and 
documentation, from Apple and other suppliers, for 
programmers and developers who work on Apple equipment. 
For information about APDA, contact 

APDA 
Apple Computer, Inc. 
Mailstop 33-G 
20525 Marian i Avenue 
C uperrino, CA 95014 

1-800-282-APDA ( 1-800-282-2732) 
FAX: (408) 562-397 1 
Telex: 171-576 
AppleLink: APDA 
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Assistance for hardware and If you plan to develop hardware or software products fo r sale 
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software developers th rough retail channels, you can get valuable support from 
Apple Developer Programs. \'{/rite to 

Apple Developer Programs 
Apple Computer, Inc. 
Mailsrop 75-2C 
20525 Mariani Avenue 
Cupertino, CA 95014-6299 
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Appendix F 

Glossary 

A 
active application The applic.,'ltion program currently 

being used. W ith MultiFinder, a number of 
application programs can be open, but only one 
of them is cl1e active applic.,'ltion. T he active 
application is represented by a small icon at the 
top-right corner of the menu bar. You can S\IVitch 
from one application to ano ther by clicking the 
icon. 

active window T he fro ntmost window on the 
desktop, where th e next action will rake place. 
An active window's ride bar is highlighted 
(with a series of lines). 

~n~oee's disk~0§}--Title bar 
5 il~ms 38 ,337K in disk 

~ 
Q 

Cartoons 

AD B See Apple Desktop Bus. 

Alarm Clock A desk accessory that displays the 
current time and date, and can be set to function 
as an alarm. 

alert box A box that appears on the screen to give a 
warning o r to report an error message during use 
of an application program. Its appearance is 
usually accompanied by a beep. 

Ji\. Thb process will orase all 
ill lnformotlon on this disk. 

t nu e 

Apple Desktop Bus (Abbreviated ADB.) Built-in 
circuitry of Apple computers. Apple 
Desktop Bus ports are on the computer's 
back panel and marked with a 
"branching" icon. You use mem to 
attach cl1e keyboard, mouse, and oilier 
devices, such as graphics tablets, hand 
controls, and specialized keyboards. See 
also bus. 
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Apple menu The menu furthest to the left in the 
menu bar, indicated by an Apple symbol, from 
which you choose application programs and desk 
accessones. 

Rbout the Finder ... 

Rlarm Clock: 

AppleTalk network The Apple Talk connectors, 
cables, cable extenders, and software that Link 
computers and peripheral devices-such as 
primers or file servers-together in a network. 
Apple Talk capability is built into eve1y 
Macintosh and most L1serWriter models. 

application program A progran1 written ~or some 
specific purpose, such as word processmg, 
database management, graphics, or tele­
communication. Most application programs are 
represented by icons that show a hand working 
with a document. 

~ 
~ 

Mac Write 

A~ 
~~ 
FullPaint MacDraw II 

audio jack A connector on the back panel of the 
Macintosh marked with a "sound" icon. 

~ ))\ You use the audio jack to. attacl~ 
~ headphones or other aud1o dev1ces. 

B 
back panel The rear surface of the computer, which 

includes the power switcll, the power coi1Jlector, 
and pons for peripheral devices. 
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back up (v) To make a copy of a disk or of a file on a 
disk. Backing up yom files and disks ensures that 
you won't lose information if the original is lost 
or damaged. 

bit A contraction of binmy digit. The smallest unit of 
information that a computer can hold. T he value 
of a bit (1 or 0) represents a simple rwo-way 
choice, such as on or off, true or false, black or 
white, and so on. 

bilmap A set of bits that represents the graphic image 
of an original docwnent in memory. Used by the 
Macintosh to construct graphic images and 
typefaces. 

bitmappecl character A character that exists in a 
computer file or in mem01y as 
a bitmap, is drawn as a pixel 
pattern on the graphics screen, 
and is sent to the printer as 
graphics data. See also pixel. 

birmappecl f'ont A font made up ofbitmapped 
cl1aracters. For example, fonts stored in a 
Macintosh System file are bitmapped fonts. 

buffer A "holding area" in memory where 
information can be stored by one program or 
device and then read at a different rate by 
another. For example, some primers have built-in 
memory to store text coming from the computer 
fuster than it can be printed. This memory is 
called a print buffer. 

bus Circuits inside the computer that transmit 
information from one part of a computer system 
ro another; for example, the Apple Desktop Bus. 
In a network, a bus is a Line of cable with 
connectors linking devices rogether. 
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hun on A pushbutton-like image in dialog boxes 
which you click to designate, confirm, or cancel 
an action. Compare mouse button. 

byre 

c 

(( OK n ( Cancel J 

[Options] ( Help ) 

A uni t of information consisting of a fixed 
number of bits. One byte usually consists of a 
series of eight bits, and represents one character 
(such as a letter, numeral, or punctuation mark). 
See also kilobyte, megabyte. 

cache See memory cache, RAM cache. 

Calculator A desk accessory that works like a four­
function pocket calculator. Calculation results 
can be cut and pasted into your documents using 
the Cm and Paste commands from the Edit 
menu. 

Cancel burron A button that appears in some dialog 
boxes. Clicking it cancels the command just 
chosen. 

central processing unit (Abbreviated CPU.) The 
"brain" of the computer; the microprocessor that 
performs the actual computat ions. See also 
processor, coprocessor. 

character Any symbol that has a widely understood 
meaning and thus can convey information, such 
as the letters, numerals, and punctuation marks 
indicated on the computer's keyboard. 

check box A small box associated \"'ith an option in a 
dialog box or window. When you click the check 
box, you may change the option or affect related 
optlOilS. 

Printer Effects: 
0 font Substitution? 
181 TeHt Smoothing? 
0 Graphics Smoothing? 
(l?J FA<I e r Dllmnp Printing? 

chip See integrated circuit. 

choose To pick a command by dragging through a 
menu. You normally choose a command after 
you've selected something for the command to 
act on. 

Chooser A desk accessory that lets you designate 
devices, such as printers, that your Macintosh 
will use. 

Clear A command in the Edit menu that removes 
selected material without placing it on the 
C lipboard. You can use the Undo command 
immediately after using Clear if you change your 
mind. Compare Cut. 

click To position the pointer on something, and then 
to press and quicldy release the mouse burton. 
CLicking is normally used to select an icon, a 
word or object in a document, a choice in a 
window, or to confirm a choice in a dialog box. 
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Clipboard An area in the compurer's memory clm 
functions as a holding place for what you last cur 
or copied. Information on the Clipboard can be 
pasted into documents. 

Text or graphic 

· ..... .. .............. .. · 

Pasted from 
Clipboard 

close box The small white box on the left: side of an 
active window's title bar. Clicking it 

~~ closes the window. 

color wheel A feature that appears in a dialog box 
when you click the Change Color button in tl1e 
Control Panel desk accessory. The color wheel 
lets you adjust hue, saturation, and brightness of 
the highlight color. It is also used to adjust shades 
of gray. 

command An instruction that causes the computer 

Clear 

360 
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to perform some action. 
The most common form of 
Macintosh commands are 
ilie commands listed in a 
menu. These are chosen by 
using the mouse and 
pointer. Others can be 
typed from a keyboard. 

configuration (1) A general-purpose computer term 
tl1at can refer to the way you have your computer 
set up. (2) The combined hardware 
components-computer, monitor(s), keyboard, 
and peripheral devices-tl1at mal{e up a 
computer system. (3) The somvare settings iliat 
allow various hardware components of a 
com purer system to communicate with each 
oilier. 

Comrol Panel A desk accessory that lets you change 
various Macintosh features, such as speal{er 
volume and keyboard repeat speed and delay. 

coprocessor An auxiliary processor designed to 
relieve the demand on the main processor by 
performing a few specific tasks. Generally, 
coprocessors handle tasks that could be performed 
by the main processor but much more slowly. 

Copy A command in the Edit menu that copies 
selected material and places it on the Clipboard, 
without removing the material ft:om the original 
document. See also Clipboard. 

copy-protect To make a disk uncopyable. Software 
publishers sometimes copy-protect their disks to 
prevent iliem from being illegally duplicated. See 
also lock. 

CPU See central processing unit. 

currenr application See active application. 
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current srartup disk The disk that contains the 
System file the computer is currently using. The 
startup disk icon always appears in the upper­
right corner of the deskrop. 

cursor See pointer. 

Cur A command in the Edit menu that removes 
selected material and places it on the C lipboard; 
from there you can paste it elsewhere. Compare 
Clear. See also Clipboard. 

cut and paste To move something from one place in 
a document ro another in the same document or 
a different one. It's the compmer equivalent of 
using scissors ro clip someclling and glue to paste 
the clipping somewhere else. 

D 
data disk A disk that contains your work- letters, 

budgets, pictures, and so on-in the form of 
documents. 

defauh A value, action, or setting that a computer 
system assumes, unless you give it a different 
instruction. {Also called preset.) 

deselect To change a selected item, such as an icon, 
so that it is no longer selected. O n the desktop, 
you deselect highlighted icons by pressing the 
Shift key and clicking the icon you want ro 
deselect, or by selecting something else without 
pressing the Shift key. 

desk accessories "Mini-application programs" that 
are available from the Apple menu at all times, 
regardless of the program you're using. Desk 
accesso ries provided with the Macimosh 
include the Alarm Clock, Calcularor, Chooser, 
Control Panel, Find File, Key C aps, and 
Scrapbook. You use the Font/DA Mover ro 
install desk accessories. 

About the Finder. .. 

Alarm Clock: 
Calculator 
Chooser 
Control Panel 

desktop Your working environment on the 
computer-the menu bar and the background area 
on the screen. You can have a number of documents 
open on the desktop at d1e san1e time. 

~:---------------==-- .\!enu bar a File Edit 
ffi::!I:'Illim:;M::;:o::r:;qu:=e:::~::;~·s:=· :.I!J:. ·:;: . .. :;:;:;. ·:=· ·3· ·q· .'T;.TI'' : :'7·. :=:'?: : - Desktop 

1-------'-'------'----- - ----t . . . . 
tHm!. Siz:t Kild .... · ..... 

D Applollnk 5 .0 

D O.siojn89 

() Ouign 89 Word Stttllc;. .. 

CJ Hy~rC1rd & S ti cks 

·- 1'oldw 
-· fold+r" 

3K Mieros 

-- folder 

rotor, r--
tr•tor 8' 

.0 

destination The disk or folder that receives a copied 
or translated ftle, as in destination disk. 

dialog box A box that contains a message, often 
requesting more information from you. 
Sometimes the message is accompanied by 
a beep. 

Replace eHistlng 
"Gioss.3" 1 

Yes I n No D 
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dimmed A term used to describe words or icons that 
appear in gray. For example, menu commands 
appear dimmed when they are unavailable. A 
dimmed icon represents an opened disk o r folder, 
or a disk that has been ejected. Double-clicking a 
dimmed disk or folder icon causes the window 
for the disk or folder to become the fi·ontmost, or 
active, window. 

~ .... o ____ :)"-(:2"-.. +I _ __ Dimmed commmd 

i:liiii Superpaint Docs . 

LJSuper Paint 
Dimmed folder 
icon 

~--------Dimmed progr.un 
i<nl Ttld'ITtx t 

directory A list of the contents of a folder or a disk. 
By using commands from the View menu, you 
can set a directory window to present this list 
pictorially, alphabetically, chronologically, or 
according to size. 

directory dialog box A type of dialog box you use 
to locate fi les and change disks from within an 
application program. Directory dialog boxes 
appear whenever you choose the Open or Save 
As commands fi·om within an application 
program. 

disk A flat, circular, magnetic surface on which 
information can be recorded in the form of smal l 
magnetized spots, in a manner similar to the way 
sounds are recorded on rape. See floppy disk, 
hard disk 

disk capacity The maximum amount of data a disk 
can hold, usually measured in kilobytes (K) or 
megabytes (MB). For instance, Apple 3.5-inch 
disks typically have a disk capacity of 400K, 
800K, or 1 .4 MB. Hard d isks can hold from 
20 MB to 160 MB, and some even more. 
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disk drive The device that holds a disk, retrieves 
information from it, and saves information on it. 
All models of Macintosh computers contain at 
least one built-in disk d rive. 

clocumeni Whatever you create with an application 
program. Docu ments are 

IJll1 usually represented by icons 
~ derived from the icons of the 

document icon programs that created them. 
See also ftle. 

cloublc-click To position the pointer on an objecr, 
such as an icon, and then press and release the 
mouse burton twice in quick succession without 
moving the mouse. Double-clicking an icon 
opens the documenr, application program, or 
disk that the icon represents. 

drag To position the pointer on something, press and 
hold the mouse burton, move the mouse, and 
release the mouse button. When you release the 
mouse button, you either confi rm a selection or 
move an object to a new location. 

driver A system program that allows the 
microprocessor to di rect the operation of a 
peripheral device, such as a printer or scanner. 
(Also cal.led a resource.) Drivers are represented by 
icons; to begin using drivers with the devices 
connected to your Macintosh, you usually drag 
their icons to your System Folder and restart the 
computer. 

ffjLQjc ---Driver icons 

lmage\\'riter LQ lmage\\'r iter 
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E 
Easy Access A feature ofMacimosh system software 

that assists people who have difficulty typing on 
the keyboard or manipulating the mouse. 

Edit menu A menu that is available in most programs 
and lists editing commands--such as Cut, Copy, 
and Paste. 

•:r~n.• 

1Jn11o :)[:2 

Cut 3CH 
Copy ace 
Paste acu 

eject To remove a disk from a disk drive. 

error message A displayed message that tells you of 
an error or problem in the execution of a 
program or in your communication with the 
computer system. An error message is often 
shown in an alert box and accompanied by a 
sound. 

expansion card A removable circuit board that plugs 
into expansion slots in some models of 
Macintosh computers. Expansion cards enable 
the computer to use some types of devices or to 
perform special functions. 

expansion slor A long, thin socket on the main 
circuit board of some Macintosh models into 
which you can install an expansion card that 
expands the computer's capabilities. 

F,G 

file server A combination of a mass-storage device 
(such as a hard djsk) and software that allows 
computer users to share common fi les and 
application programs th rough a netvvork. 

fi le Any named, o rdered collection of information 
stored on a disk. Application programs and 
documents are examples of files. You make a fi le 
when you create text or graphics, give the 
material a name, and save it on a d isk. 

File menu A menu that lists commands that affect 
whole documents-commands such as Save, 
Print, and Qwt. 

New 
Open ... 
Close 
Saue 
SaueRs .. . 
Delete . . . 

Page Setup ... 
Print ... 

3CN 
3€0 
acw 
acs 

ag p 

Ouit ~tt· o 
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Finder A parr of Macintosh system software that's 
always available, creating the desktop 
environment. You use the Finder to manage 
documents and application programs, and to ger 
information to and fi·om disks. 

kind : SVsttm dooumtnt 
Size: t 101914 ~tts ustd 1 109K on disk 

Find File A desk accessory thar enables you to find 
any folder or fi le on a disk. 

tloppy disk A disk made of flexible plastic that scores 

.0 . 
com purer dara. The 3.5-ind1 disks 
used in Macintosh disk drives are 
floppy disks housed in rigid, plastic 
containers for support and 
protecaon. 

folder A holder for documents, programs, and other 
folders on the desktop. Folders let you organize 
informacion in any way you want. 

fom 
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[}] LJ 
System Folder Utilities Folder 

A collection of letters, numbers, punctuation 
marks, and other typographical symbols with a 
consistent appearance; the size and sryle can be 
changed readily. 

This is New York f ont. 

This is Geneva font . 

Font/ DA Mover A utiliry program, supplied with 
Macintosh system software, that 
lees you add or remove fonts <md 
desk accessories fi·om a disk's 
Sysrem fi le. 

Font/DA Mover 

format See initialize. 

H 
hard disk A disk made of metal and permanently 

sealed into a drive or cartridge. A hard disk 
stores very large amounts of information 

I, J 

(20 MB-160 MB) and operates mud1 fuster th<U1 
a floppy djsk. 

1-beam A rype of pointer shaped like the capital letter 
'I' and used for entering and 

icon 

stationlyi 

l·be:uJ 

editing text. See also 
insertion point. 

An image char represenrs an object, a concept, 
or a message. For example, an unopened 
HyperCard stack's icon looks like a stack of 
cards; a floppy disk's icon is a miniature of thar 
rype of disk. 

~ 
0 

Document 
I 
Trash Floppy Dis k HyperCard St ack 

ini[ialize To prepare a blank disk to receive 
information by organizi ng its surfuce into tracks 
and sectors; same as format. 
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input Inf01mation transferred into a computer from 
some external source, such as the keyboard, the 
mouse, a disk drive, or a modem. Compare 
output. 

insertion point The place in a document where 
something will be added; it is 
placed by clicking at the spot 

statio n~ry where you want to make the 

I 
change and is represented by a 

hlSl,tion JXJim blinking vertical bar. 

Installer A program that lets you install or update 
your system software or add 

~ 
resources. 

Installer 

integrated circuit (I C) An demonic circuit entirely 
contained in a single piece of sem iconducting 
material, usually silicon. Often referred to as a 
chip. 

interface The point of communication between a 
person and a computer. Often referred ro as the 
com purer's human interfoce or user interfoce. 

K 

K See kilobyte. 

Key Caps A desk accessory that shows you the 
optional character set available fo r a given font 
family. 

keyboard equivalent A combination of key presses 
that you can use instead of a mouse action ro 
perform a task. Keyboard equivalents almost 
always include the Command key, and are 
convenien t alternatives ro using the mouse m 
choose menu commands. Also called a 
Command-key equivalent or keyboard shortcut. 

Select All 3€A +I __ Keylxxudcquiv;dem 

Show Clipboard 

kilobyte A w1it of measurement consisting of 1024 
bytes. See also byte, megabyte. 

L 

LocalTalk cable system A system of cables, cable 
extenders, and connector boxes that connect 
computers and nerwork devices as part of the 
AppleT alk network system. 

lock T o prevent fi les or disks /Tom being altered. 
Individual files are locked with 
software commands. A d isk can 
be physically locked by sliding the 
small tab on the back of the plastic 
case of a 3 .5-inch disk toward d1e 
edge of the disk. 

M 

main logic board A large circuit board that holds 
RAM, ROM, the microprocessor, custom­
integrated circuits, and other components that 
mal{e the computer work. 
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main memory The part of a computer's memory 
whose contents are directly accessible to the 
microprocessor; usually synonymous with 
random-access memory (RAM). Programs are 
loaded into main memory, where the computer 
keeps information while you're working. 
Sometimes simply called memory. See also 
random-access memory, read-only memory. 

megabyte (JVIB) A unit of measurement equal to 

1024 kilobytes, or 1,048,576 byres. See also byte, 
kilobyte. 

memory A hardware component of a com purer 
system that can store information fo r later 
retrieval. See main memory, random-access 
memory, read-only memory. 

memory cache Memory that is dedicated to 

increasing the efficiency and operating speed of 
the computer. Some models of Macintosh 
computers offer an internal connecror for an 
optional memory cache card. Compare RAM 
cache. 

menu A list of actions from which you can choose. 
Menus commonly appear when you point to and 
press menu titles in the menu bar or in a dialog 
box. You choose a command by dragging 
through the menu and releasing cl1e mouse 
button when the command you want becomes 
highlighted. 

menu bar The white strip across the rop of your 
screen that contains the titles of the menus 
available to you. 
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menu title A word, phrase, or icon that is in the 
menu bar and that designates one menu. 
Positioning the pointer on a menu title and 
holding down the mouse button causes the ride 
to be selected and irs menu to appear below it. 
You then drag to choose a command. 

w Special 
:)[:2 0 . -: 

modem Shorr for modulator/demodulator. A device 
that links your computer to other computers and 
information services over telephone lines. 

modem port A connector on the computer's back 
panel marked by a telephone icon. A 

0/ port that you can use to attach a modem 
'0 to the computer, or to connect the 

computer to the Apple Talk network 
system. 

monitor See video monitor. 

mouse A small device that controls a pointer on the 
screen. When you move the mouse 

~ on a flat surfuce, the pointer 

~moves. 

mouse button The mechanical button on rop of the 
mouse. In general, pressing the mouse button 
initiates some action on whatever is under cl1e 
pointer on cl1e screen, and releasing the button 
confirms the action. 

Mouse Keys An Easy Access feature that lets you use 
keys on tl1e numeric keypad to move the pointer. 
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~·IS-DOS An acronym for M icrosoft Disk Operating 
System. T his is the operating system for 
computers manufactured by many computer 
companies. 

MulriFinder A part ofMacimosh system sofuvare 
that allows the computer to use multiple 
programs simultaneously by alternating between 
programs. An icon at the top-right corner of the 
menu bar shows the cmrent application program. 
Clicking the icon changes applications. 

N 
network A collection of interconnected, individually 

controlled computers, together with the hardware 
and software used to connect them. A nervvork 
lets users share data and peripheral devices such as 
printers and file servers, exchange electronic mail , 
and so on. 

! ore Pad A desk access01y that lets you enter and edit 
small amoums of text while working on another 
document. 

NuBus An address bus and data bus incorporated 
into the Macintosh II line of computers. NuBus 
lets you add a variety of components to the 
computer system, through expansion cards 
installed in NuBus expansion slots inside the 
computer. See eA"Pansion slot. 

numeric keypad A calculator-style keypad, to the 
riaht of the main keyboard, that 

i<IJ .:_ _ :l r' - YgU Can USe to type nUmbers. 
C :;__. L LJ T he layout of numbers on the 
GJ G J ;] LJ keypad makes it easier and fils ter 
( [Jt f ~1 to use than the the number keys 
F · t : on the regular keyboard. Some 
~' -- __,__. ·'"' application programs designate 

the keys on the numeric keypad 
as special function keys. 

0 
open To mal<.e available. You open files in order to 

work with them. Opening an icon causes a 
window to come into view, revealing the 
document or application program the icon 
represents. You may then perform further actions 
on the contents of the window. 

operating system A program that organiz~s the 
internal activities of the computer and ItS 
peripheral devices; an operating system performs 
basic tasks such as moving data to and fi·om 
devices, managing information in mem01y, and 
so on. 

output Information transferred from the com purer's 
microprocessor to some external device, such as 
the display screen, a d isk drive, a printer, or a 
modem. Compare input. 

P, Q 
password A secret word that gives you, but no one 

else, access to your data or to messages sent to 

you through electronic mail or an information 
service. 

Paste A command in the Edjr menu that puts the 
contents of the Clipboard-whatever was last cut 
or copied-at the insertion point. See also 
Clipboard. 

peripheral device A piece of hardware-such as a 
video monitOr, rusk d rive, printer, o r modem­
used with a computer and under the computer's 
comrol. Peripheral devices are often (bur nor 
always) physically separate from cl1e computer 
and connected to it by cables. 
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pixel Shorr for picture element. T he visual 
representation of a bit on the screen (white if the 
bit is 0, black if it's 1). Also a location in video 
memory that corresponds to a point on rhe 
screen. See also bit. 

pointer An arrow or other symbol on the screen that 
moves as you move the mouse. You 
use the pointer to cho.ose com~nands, 
move data, and draw 111 graph1cs 
programs. 

port A socket on the back panel of the computer 
where you can plug in a cable ro connect a 
peripheral device, another computer, or a 
network. 

printer pott A connector on the computer's back 
panel marked with a printer icon. A 

~ serial port that you can use to attach a 
~ primer to the com purer, or to serve as 

an arrachmenr poinr for an AppleTalk 
connector. 

processor The computer hardware component that 
performs the actual computations directed by 
software commands. ln microcomputers such as 
the Macintosh, the processor is a single integrated 
circuit called a microprocessor. See also central 
processing unit. 

program A set of instructions describing actions for 
a computer to perform to accomplish a task, 
conforming to the rules and conventions of a 
particular programming language. Computer 
programs are collectively referred to as software. 

pull-clown menu A menu that is hidden until you 
move the pointer to irs title and press tl1e mouse 
burton. See also menu, menu bar, and menu 
title. 
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R 
RAM See random-access memory. 

RAM cache A portion of the Macintosh main 
memory (RAM) tl1at you can set aside for special 
use. You use the Control Panel to turn the RAM 
cache on or off Compare memory cache. 

random-access memory (Abbreviated RAM.) 
Memory in which information can be referred ro 
in an arbitrary or random order. RAM usually 
means the parr of memory available for programs 
and documents tl1at the computer reads from a 
disk; the contents of RAM are lost when the 
com purer is turned off Compare read-only 
memory. 

Read .Me document A document that is included on 
some application program and system software 
disks to provide you with !are-breaking 
information about me product. 

read-only memory (Abbreviated ROM) Memory 
whose contents can be read, bur not changed. 
Information is placed inro read-only memory 
only once, during manufucruring. The contents 
of ROM are nor erased when the computer's 
power is turned off Compare random-access 
memory. 

resource A file that is contained in the System Folder 
and that the computer uses for irs operations. 
System files and drivers are examples of resources. 

RGB monitor A rype of color monitor that receives 
separate signals for each color (red, green, and 
blue). 

HOM See read-only memory. 
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s 
save To store information by transferring it from 

main memory (RAM) to a disk. Work nor saved 
disappears when you turn off the computer or 
when the power is interrupted. It's a good idea to 
save your work frequently so that you lessen the 
risk oflosing data. 

scanning order The order in which tl1e operating 
system searches the disk drives for a startup disk. 
See also startup disk. 

Scrapbook A desk accessory in which you can save 
frequently used pictures or passages of text. The 
Scrapbook can store multiple images. You can 
cur, copy, or paste images from the Scrapbook 
into documents created with most application 
programs. Compare Clipboard; see also cut and 
paste. 

screen fonts The fonts provided with Macintosh 
system software; also known as bitmapped fonts. 
You use a version of the font for each size of type 
you want to display on the screen. (A different 
version of fonts is used for printing.) 

scroll To move a document or directory in irs 
window so that a different part of 
it is visible. To scroll through 
a document or directory, you use 
the scroll arrows, scroll bars, or 
the scroll box. 

SCSI See Small Computer System Interface. 

SCSI cable terminator A device used in a SCSI chain 
to maintain the integrity of the signals passing 
along me SCSI chain. A SCSI chain should 
always have two terminators, one at each end of 
the chain. W ith some devices, the rerminaror is 
built-in. 

SCSI chain A group of SCSI devices linked to one 
another through SCSI peripheral interface cables 
and linked to the SCSI port on the computer 
through a SCSI system cable. 

SCSI port The connector on the back panel of the 
computer to which you connect SCSI 

~ devices. 

select To designate where the next action wi ll rake 
place. To select something with a mouse, you 
click an icon or drag across text or graphics. 

selection T he information or items that will be 
affected by the next command. A selected item 
is usually highlighted. 

serial ports The connectors for peripheral devices 
that receive data in a serial format (that is, one bit 
at a rime), such as the printer and modem ports 
on the Macintosh. 

Shift -click A technique that allows you to extend or 
shorten a selection by holding down the Shift key 
while you select (or deselect) . You can also Shift­
click multiple items in a list or group to select 
them all. 

Shift-drag A technique that allows you to select two 
or more groups of objects by holding down the 
Shift key ·while you drag diagonally to enclose 
each group of objects in a rectangle. 
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SI~1L\•I An acronym for Single In-line Memory 
Module, a circuit board that contains eight RAM 
chips. SIMMs arrach to SIMM sockets on the 
com purer's main circuit board. See also random­
access memory. 

size box A box on the botrom-right corner of some 
active windows. Dragging the 
size box resizes the window. 

Small Computer SysLem Interface (Abbreviated 
SCSI.) A specification of mechanical, elecuica1, 
and functional standards for connecting 
peripheral devices such as certain kinds of hard 
disks, printers, and optical disks to small 
computers. Macintosh computers use the SCSI 
interface for hard disks and other peripheral 
devices. 

:-,ource T he disk or folder rhat holds the original of 
a fi le ro be copied or translated, as in source 
disk. 

starru p disk A disk with all the necessary program 
fi les-such as the Finder and System fi les 
contained in the System Folder- to set the 
computer into operation. 

stanup drive The disk drive from which you start 
your computer system. 

St icky Keys An Easy Access feature that lets you type 
combination keysn·okes without actually pressing 
the keys simultaneously. Sticky Keys are especially 
helpful for users with impaired moror ski lls. 
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System file A file that Macinrosh computers use 

n 
~ 

System 

System Folder 

to start up and to provide 
systemwide information. T he 
System fi le must be in the 
System Folder. 

A folder containing the software that 
Macintosh computers use to 
starr up. A disk that contains a 
System Folder is a starrup disk. 

Sys tem Folder 

system soft''\vare Software components that support 
. application programs by managing system 

resources-such as memOLy-and input and 
output devices. Also lmown as the operating 
system. 

T 
TeachText A utility program on the System Tools-disk 

that functions as a limited word-

~ 
processing program. 

Teach Tex t 

terminalor See SCSI cable terminator. 

3.5-inch disk A flexible, plastic disk measuring 3.5 
inches in diameter and having a rigid plastic 
jacket. On the Macintosh, 3.5-inch disks are the 
standard type of floppy disk used. These disks 
store 400K, BOOK, or 1.4MB of information, 
depending on the type of disk drive and 
formatting used. See also kilobyte, megabyte. 
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tirle bar The horirontal bar, at the top of a window, 
that shows the name of the window's contents. 
When the window is active, the title bar is 
highlighted with a series ofhoriwntallines. 

LJ 
To Do 

Trash An icon on the desktop that you use to discard 
documents, folders, and 

I application programs. You can 
]]]] also drag disk icons into the 

Trash Trash to eject disks. 

u 
unlock To remove the restriction on the use of a disk 

or a document so tl1at it can once again be 
changed, deleted, or renamed. See also lock 

user group A computer club where computer users 
exchange rips and information. 

user interface See interfu.ce. 

util ity programs Programs you use to perform special 
operations, such as installing or updating 
software, seeing a magnified version of the 
screen's contents, and so on. 

v 
version A number indicating the release edition of a 

particular piece of sofuvare. 

video monilor A display device iliat can receive video 
signals by direct connection only, unlike a 
television set, which can receive broadcast signals. 
Sometimes simply called a monitor. 

virus A malicious program that damages files. Virus 
programs can be spread though net\'Vorks and 
bulletin board services as well as on disks. Virus­
detection and elimination programs are available 
ilirough dealers and user groups. 

volume A general term referring to a storage device; a 
source of or a destination jfor information. 
Often used in reference to hard disks and file 
servers. A volume can be an entire d isk or only 
parr of a disk. 

W,X,Y 
window The area iliat displays information on ilie 

desktop; you create and view a document 
through a window. You can open or close a 
window, move it around on ilie desktop, and 
sometimes change its size, scroll through it, and 
edit irs contents. 

\Vrite To transfer information from ilie computer to a 
destination external to the computer (such as a 
disk drive, printer, or modem), or from ilie 
computer's processor to a destination external to 
ilie processor (such as main memory) . 

z 
zoom box A small box in me top-right corner of ilie 

title bar of some windows. 
Clicking ilie zoom box expands 

36K av ailab ll' ilie window to irs maximum size; 
clicking it again returns ilie 
window to its original size. 
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Numeric Entries 
12-hour clock 

serting and location 2 14, 2 15 
24-hour clock 

setting and location 2 14, 2 15 
3 .5-inch d isks (M5-005) . See aLso devices; d isks 

initia lizing 337 
reading with Apple 5uper0rive 336 

32-Bi t Q uickOraw 
insta ll ing 64 

5.25-inch d isks (MS-D OS). See aLso devices; disks 
read ing from an external fl oppy drive 339 

720K 

A 

MS-005 normal-density fl oppy disk size, 
ini t ializing 339 

A/UX. See also altern ative operatin g systems; Apple 
File Exchange 

Funct io n keys, use with 326 
se tring up a hard d isk to run with 170 
warn ings about hard d isks containing 48, 168, 

17 1 

Index 

About com mand (Apple menu) 
Apple File Exchange, inves tigating options 345 
displaying in fo rm ation about application 

programs w ith 150, 153 
Finder, veri fying memory amount with 103 

accent 
accutc (' ) 330 
grave (') 330 

access. See also security 
p ri vileges, on a file server 200 

accessing. See aLso opening 
fil e servers 

o n Apple5hare 196 
private fl ies on 200 

menus 20,2 1,23,24 
Access Priv ileges (desk accessory). See aLso fi le 

servers; networks 
AppleShare fi le server and 187 
pro rccring folder co nten ts with 181 

access protect ion. 
See passwo rds; securi ty 

activating. See also sel ecting 
windows 12 

active window 12 
acure accent (') 

entering with O prion-e 330 

37) 



ADB. See Apple D esktop Bus 
adding. See also connecting 

desk accessories 253 
devices 265-287 
fonts 249 
Macintosh to a network 183-193 

adjusting. See changing 
air circulation. See also maintenance; ventilation 

importance for he;J t d ispersion 293 
alarm 

setting and turning off 218-220 
Alarm C lock. See also desk accessories 

desk accesso1y, setting alarm, dare, and rime 
with 216, 218-220 

icon, on menu bar 221 
turning off the alarm 221 

alert 
boxes, using 28 
Aashing, setting the 214 
sound, setting the 213 
rime, sening with rhe Alarm C lock desk 

accessory 216 
al ignment. See also graphics; printing 

of bit-mapped areas, with Laser Writer 119 
allocating memory. See memory 
alternative operating systems. See also AJUX; MS­

DOS; ProDOS 
converting fi les from 336-345 
Special keys, use with 327 

amplifier. See also devices; sound 
attaching ro the audio jack 276 

APDA 355 
Apple 

service and support information 318 
technical information available from 354 

Apple:: Care Service:: Agreement 
characteristics of 319 

Apple Communications Library 
description 355 

374 

Apple Desktop Bus (ADB) 
devices, connecting 273-276 
ports 

connecting devices to 273 
diagnosing input problems 306 

power requ irements 273 
Apple Developer Programs 

description 356 
Apple Extended Keyboard 

key descri ptions (fi gure) 326 
Apple File Exchange. See also netvvorks 

use with MS-DOS files and disks 336-345 
Apple HD SC Setup program 

using 168-170 
Apple JIGS 

sharing a hard disk with (partitioning) 170 
Apple Keyboard 

key descriptions (figure) 324 
Apple menu . See also menus 

About com mand 
as clue ro where you are 94 
for application programs 20, 150, 153 

About the Apple File Exchange command 345 
About the Finder command, verifYing mem01y 

amount with 103 
C hooser desk access01y 39-41 

file server connection with 196 
output devices, selecting 116 
printers, designating in 116-118 
printers, network setup 192 
printers, setting up background 130 
printers, solving problems with 312 

find ing active programs 95 
Find File desk accessory 144-146 
General Control P~nel location in 36 
Key C aps desk accessory 328, 329 
Scrapbook desk accessory, editing operations in 

91 
top line of, as clue to where you are 94 

Index 



AppleShare. See also networks 
driver, installing as preparation for networking 

187 
file server 196-200 
file server, using M S-DOS fil es on 343 

AppleShare PC program 
converting MS-DOS files with 343 

Apple Talk network 183-20 I . See aLso LocaiTalk; 
networks 

activating with the C hooser (figure) 4 1 
connecting printers to 269 
selecting devices on with the C hooser 39 
zones, listed in the Chooser window (figure) 41 

Apple Technical Library 
description 355 

application programs. See aLso desk accessories; 
software; system software 

active, finding our which is 95 
copying, as installation method 72 
creating new documents from within 74 
displaying information about 153 
ejecting disks from within 160 
importance of keeping only one version o n hard 

disks 315 
installing 72 
in use, effect on discarding icons 15 
managing multiple 97 
memory 

changing allocation for 105 
checking allocation for 104 

open 
at startup, specifYing 66 (table), 98-100 
finding out which are 95 

opening 73,76,101 
operations common to all 71- 1 11 
printing from 122, 194 
quitting 74, 109 
relationship with system softv.rare 48 
returning to desktop from 96 
starring 73, 76, 101 
switching with Mu.ltil~inder 100 

arrow keys. See aLso keyboard 
alternative to mouse for pointer movement 323, 

325,327 
primaty use, in summary of special keys (figure) 

42 
arrow(s) 

pointer as 2 
scroll , displaying window contenrs with 16 

arraching. Seeconnecting 
audio devices. See aLso devices; sound 

connecting to audio jack 276 
automatic repair. See aLso troubleshooting 

with Disk First Aid 297 

B 
background. See aLso MulriFinder 

editing desktop pattern 223, 242 
printing 

controlling with PrintMonitor program 131 
turning on and off in the C hooser (figure) 

4 1 
using a print server wirh 195 

backing up. See aLso securiry; v iruses 
data, by saving documents 84-93 
dare view useful for 150 
devices for, SCSI tape drives as 266 
disks 165, 175 
documents, by copying individually 137 
files 11 0 
strateg ies for 317 

Backspace (Delete) key 
deleting selected text 33, 323 

barcode readers 273. See aLso Apple Desktop Bus 
devices; devices 

battery. See aLso maintenance 
clock, changing 300 

beep. See aLso sound 
changing 

Index 

rype o f sound 2 13 
volume of sound 21 1 
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Berkeley Macinrosh User Group 
address 354 

binary rranslation 
Apple File Exchange usc for 339 

bits 269 
blinking. See also Control Panel; cusromizing 

alarm icon in menu bar, meaning of 221 
com mand, meaning of 22 
menu item, changing speed of 225 
question mark icon, meaning of 305 

BMUG 
See Berkeley Macintosh Users Group 

bomb icon 309. See also troubl eshooting 
boot. See startup 
Bosron Computer Society 

address 354 
brightness conrrol. See also moni tors; screen saving 

adjusting 234 
diagnosing moniror problems with 304 
screen saving with 291 

bulletin boards. See also networks 
accessing with a modem 201 

c 
cables. See also devices 

daisy chaining SCSI devices with 267 
handling precautions 290 
LocaiTalk network 185 

c.1 lcndar icon 
changing date with 2 17 

cancel ing. See also deleting 
background printing jobs 132 
editing actions 83 

Caps Lock key 
keyboa rd diagrams (figures) 322, 324, 326 

cards. See also devices 
expansion, installing and use 281-285 

cassette rape icon (MacroMaker) 332 
CDEV (Conrrol Panel devices) 

376 

as potential cause of software incompatibi li ty 
3 15 

CD-ROM drives. See also devices; disks 
connecting 266 

cedilla (r;). See also characters 
entering with O ption-c 330 

changing. See also adding; deleting; installi ng 
beep 

rype of sound 213 
volumeofsound 21 1 

blin ki ng 
insertion poinr, speed 225 
menu ircm, speed 225 

Chooser settings 4 1 
clock battery 300 
Control Panel 38, 203-263 
date 38, 2 17 
deskrop 

appearance 221 
patterns 238, 23, 242 

disks 
from rhe desktop 159 
fro m within a program 160 

documenrs, saving after 86 
General Control Panel 37, 38 
highlight color or gray shade 244 
ICO n 

color or gray shade 244 
name 29-34 

MacroMaker scripts 335 
memory allocation for a program 105 
mouse operation 204-207 
networks 190 
pointer movement between multiple monirors 

227 
programs, in Multi Finder I 00 
RAM cache size I 06 
screen brightness 234 
sound 211 -2 14 
speaker volume 38 
startup disk 176 
rime of day 38, 215 
windows 11 
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characters. See also customizing; editing 
deselecting 3 1 
enrenng 

international 330 
optional 328 

repeating, adjusting the rare of 209 
manipulating (appendix) 321 

check ing 
C lipboard contents 78 
installed system sofnvare 49 
memory available I 04 

C hooser desk accesso1y 39--4 1. See also desk 
accessones 

fi le server connection -vvirh 196 
output devices, selecting 1 16 
pnnters 

designating in I 16-11 8 
nenvork setup 192 
solving problems with 3 J 2 

printing, setting up backgro und 130 
choosing. See also selecting 

commands 7, 21 
font name, for Key Caps display 330 
printers I 16-11 8 

circumAe.x ( ") . See aLw characters 
emering with Oprion-i 330 

classes 
MJ.cinrosh, where to find 354 

cleaning. See also m ai ntenance 
mouse 294, 306 
system components 294-296 

C lear comm:md (Edit menu). See also Cur 
command 

deleting 
selected text in an icon name with 33 
text and images permanently 82 

with Scrapbook, use of 93 
C lear key 323, 325, 327 
clearing. See also deleting 

icons from the deskrop 14 
system memoty I 04 

clicking 4 . See also double-clicking; mouse; select ing 
double-clicking, description of 5 
in scroll bar 19 
selecting objects by 8 
in window to make it active 13 

Clipboard. See also editing 
checking contents of 78 
copying text and images to 77 
C ut comm and use of 33 
deleting (cutting) text and images to 82 
inserting text and images into a document from 

78 
clock 

battery, ch anging 300 
icon, cl icking ro change rime 215 
internal 21 4 
system, purpose of 300 

C lose box 
closing windows with 13 
(fi gure) 9 

C lose command (File menu) 
closing wind ows with 13 

C loseView Control Panel 350, 351 
closing. See also opening 

windows 13 
cloverleaf. See Command key 
colo r. See also gray shade; monirors 

desktop parrcrns, edi t ing 224, 242 
display of, designating 235 
highlight, changing 244 
how ro use 235 
ICO n S 

designating and viewing by color 244, 245 
listing the contents of a fo lder by 150 

images, enhancing with 32- Bi r Q uickDraw 64 
nu mbers of 235 
prin ting, installing d rivers for 114 
wheel dialog box 238, 240 

Color bar (Desktop Pattern area of General 
Control Panel) 242 
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C olor bunon (Monitors Control Panel) 237 
Color Control Panel 

components of (figure) 235 
Color menu 

changing icon colors with 244 
Command key 

menu equivalent use of 22, 322, 324, 326 
primary use, in summary of special keys (figure) 

42 
Sticky Keys combinations 347 

Command-C (Copy command , Edit menu) 78 
Command-O (Duplicate command, Edi t menu) 

138 
Command-£ (Eject command, File menu) 159 
Command-! (Get In fo command, File menu) 152 
Command-Q (Quit command, File menu) 74 
Command-S (Save command, File menu) 86 
Command-Shift- 1 

ejecting, floppy disks with 159, 308 
Command-Shift-2 

ejecting, external floppy disks with 159, 308 
Command-Shift-Clear 

turning Mouse Keys on and off with 349 
Command-V (Paste command, Edi t menu) 79 
Command-X (Cut command, Edit menu) 82 · 
Command-Z (Undo command, Edit menu) 83 
commands. See also keyboard shortcuts, specific 

378 

command names 
choosing 7, 2 1 
core, list of (figure) 20 
creating macros for 33 1 
di mmed, meaning of 22 
dots following, meaning of 26 
highlighted, meaning of 22 
initiated, blinking as indicator of 22 
keyboard equivalents, displayed in menu 22 
special keyboard keys for 42 

commercial in fo rmation services 
accessing with a modem 201 

commun ications. See also AppleShare; networks 
lin k, establishing 271 
programs, directing modem operation with 20 1 

compact Macintosh models 
anach ing add itional moni tors to 280 
turning on 44 

computers 
networks, using the Macintosh on 183- 201 
operation, problems 304 
sharing 

with hard disk partition 170 
by use of a network 183 

con figuration 
hardware, recommended minimum 5 1 

connecting. See also adding; installing 
Apple Desktop Bus (ADB) devices 273- 276 
audio devices 276 
computers with a modem 201 
keyboard 273 
Macintosh to a network 183-193 
modems 27 1 
monitors 276-28 1 
mouse 275 
non-SCS I devices 269 
printers 269, 271 
SCSI devices 266 

Control key 
generating optional characters with (figure) 

329 
primary use, in sum mary of special keys (figure) 

42 
Sticky Keys combinations 347 
usc similar to Command key (figure) 324, 326 
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Comrol Panel desk accessory 203-263. See also 
cusromizing; desk accessories 

C lose View Control Panel 351 
Color Comrol Panel, componems of (figure) 

235 
cusromizing the work space with 203-263 
Genera] Comrol Panel 2 14 

changing, blinking of insertion point, menu 
irem 225, 226 

changing, desktop pattern 223-224 
changing, desktop pattern in color or gray 

shades 242-244 
changing, networks 190 
changing, RAM cache I 06 
changing, sections and settings 37, 38, 

203- 263 
changing, speaker vol ume 2 12 
descri ption and use (figure) 35-38 
designating a startup disk from 177 
opening 36 
position in startup scanning order 176 
setting date and rime 214 
settings rhat may be adjusted, list of 36 

Keyboard Control Panel, adjusting character 
repetition with 208- 210 

Monirors Control Panel 
specifying main moni tor with 23 1-233 
specifying number of colors or gray shades 

with 235 
specifying relative monitors position with 

227 
Mouse Control Panel 204, 206 
Network Control Panel, changing nenvorks 

with 190-191 
Sound Control Panel 

adjusLing sound volume wirh 211 
setting alert sound wirh 21 3 

Control Panel devices (CDEV) 
as potencial cause of software incompatibil ity 

315 
conven tions 

document version nam ing 88 
converting 

Apple II files with Apple File Exchange 345 
Macimosh files into MS-DOS format 339 
MS-DOS fi les 339, 345 

coprocessor cards 
installing on Macinrosh II models 281 

Copy butron (Fom/DA Mover) 256 
Copy command (Edit menu) 

application p rograms use of (figure) 20 
copying text and images 77, 79 
Scrapbook use of 93 

copying. See also C lipboard; ed iting; Scrapbook 
desk accessory 

application programs, as ins tallation m ethod 72 
desk accessories, from one file ro another 258 
d isks, as backup method 165 
docu ments 

between d isks 137, 90 
on the same disk 88, 138 

files 
as backup procedure 110, 175 
from a fi le server 200 

fonts, from one file to another 250 
images 77, 79, 91 
network software onto a startup d isk 188 
selected graphics o r texr, effect on contents of 

C lipboard 77 
text 

between application programs 91 
between documenrs 78, 79 

correcting. See also changing 
problems, strategies fo r 313 
typing errors 85 
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crash. See also mainrenance; security 
system, srraregies for handling 309 

creating. See also changing; editing 
documcnrs 

and saving them 85 
hierarchy of 143 
multiple versions of 88 
procedures for 74 

fl ies of desk accessories and fonts 260 
folders 14 1- 143 
log, translated files 344 
macros 33 1-335 
sra rrup disks 60- 63 
systems 

customized 56-60 
small 62 
standard 52 

crosshair pointer. See pointers 
current (electric). See power 
cursor. See rtlso pointers 

movement, arrow keys as mouse alternative 42 
cusromizing 

hardware by adding devices 265-287 
working environment 203-263 

Cur command (Edit menu). See fllso edi ti ng; Paste 
command 

application program s usc of (fi gure) 20 
compared with C lea r command 82 
deleting 

selected text in an icon name wirh 33 
text and images without losing them 82 

Scrapbook use of 93 
cur sheet feeder use. See also primers 

setting for lmage\XIritcr 12 1 

D 
daisy-chaining. See also devices 

ADB devices 273, 275 
description 266 
SCSI devices 267 

clara. See also application programs; ediring; 
hi erarchical fil e system (HFS); m~nsl ating 

avoiding loss 302 
backing up, by saving documents 84- 93 
deleting 16 1, 168, 174 
preventing damage ro 302 
sending ro other compurers by moderns 20 I 

date. See also time 
listi ng the contents of a folder by 150 
setting 38, 22 1, 2 17 

DCA-RFTIM ac\XIrite translaror fi le. See also files 
converting MacWrite and MS-DOS fli es 339 

delaying key repeat inrerval 2 10 
Delete key 

compared with , C lear key 327 
correcting typin g errors with 85 
deleting 

characters ro the lefr of insertion point wirh 
325, 327 

selected text in an icon name with 33 
text and images permanenrly 82 

primary usc, in summary of special keys (figure) 
42 

deleting. See fllso Clear command; Cu r command; 
cras1 ng; remov1ng 

desk accessories 258 
fl ies 161 , 168, 174 
fonts 25 1 
from the Scrapbook 93 
icons 14 
images 82 
selected items 77 
text 

111 an 1co n name 33 
in a document 82 

dcselecting. Sf'e also selecting 
active rransl:uors 341 
characters 3 I 
icons 30, 33 
selected objects 8 
text 3 1 

Index 
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designating 
icon color 244 
main monitor 23 1-233 
primers 40, 192 
zones 192 

designing expansion cards 355 
dcskrop 

changing 22 1-234 
parrern 38, 223, 242 

clearing icons from 14 
co mponents of (figure) 9 
editing, basic procedures 29 
moving around the 9 
openmg 

documents from 76 
programs from using Mul ti Finder 10 1 

pattern 223, 242 
printing fi·o m 123 
putting away items on the 149 
rebui lding, avoiding problems by 317 
renammg 

disks from the 164 
documents from the 139 

reru rn i ng to 96 
desk accessories. See also Apple menu; application 

programs; fo n rs; software; system software; 
specific des!? accessories 

creating fil e of 260-263 
description 35 
incompatible, as potenrial cause of system crash 

3 10 
list of required and optional 63 
managing 253-263 
moving 246 
removing from System Folder 62 
sources of 246 
specif),ing for starrup (table) 66 
svvirching with MultiFinder 100 

destination disk 
specifying in Apple File Exchange procedures 

340 
destroying. See deleting 
detecting viruses 302 
devices . See also Apple Deskrop Bus (ADB) dev ices; 

cables; disks; drivers; modems; monitors; 
output devices; prin ters; resources; storage 
devices 

adding 265-287 
connecnng 

non-SCSI 269 
SCSI 266 

selecting 40 
diagnosing problems. See also troubleshooting 

disk 297 
strategies for 

general 313 
virus 302 

dialog boxes 
alert boxes as a type of 28 
description and use (figure) 26 
pop-up men u use in (figure) 24 

dimmed commands 
mea ning of 22 

directories. See also flies; folders; hi era rch ical fi le 
system (HFS) 

obtaining information about 150 
printing 124 

di recrory dialog box 
for saving fl ies (figure) 84 
moving around folder hierarchy wirh 146 
using a 26 

discarding. See also deleting 
icons 14 

disconnecting. See also connecting 
from a fi le server volume 199 

Disk First Aid 
repairing disks with 297 
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d isk(s). See also floppy disks; hard disks; high-

382 

density disks 
backing up 165, 175 
creating startup 60-63 
drives 

installing system software on a one-drive 
system 60 

managing 155-181 
port, connecting floppy disk drives to 273 

ejecting 159, 160 
erasing 161 , 163, 168, 174 
exchanging, with MS-DOS computers 

336-345 
5.25-inch disks 339 
floppy 

characteristics and use 15 6- 166 
creating small systems on 62 
installing system software on 60 

fragmentation, reducing 315 
hard 

characteristics and use 166-17 5 
initializing 168-170 
partitioning 170 
renaming 175 

initializing 161 , 168 
installing fonts on different 247 
locking, to protect information 179 
managing 155-181 
movmg 

desk accessories berween 254, 258 
fonts between 250 

natning 29, 162, 164, 168 
partitioning, hard 170 
problems, causes and suggested solutions 307 
repairing 297 
startup, designating a 176 
testing 297 
3.5-inch 288, 289 

displaying 
background patrerns, available 223 
character sets for fonts 330 
document contents 5 
ftles, information about 150 
folders, information about 150 
icon contents 5 
information, with Get Info command 151 
messages on the screen 26 
window contents by the screenful 19 

Document Content Architecture. 
See DCA-RFT 

documents. See also application programs; editing; 
fonts; text 

changing, names 29 
copymg 

between disks 90, 137 
on the same disk 138 
text and images between 79 
to different folders on the same disk 88 

creating 74 
hierarchy of 143 
multiple versions of 88 

displaying the contents of 5 
editi ng 76-83 
finding 144 
handling, Macintosh tools for 136-153 
icons, double-clicking, to start an application 

program 74 
moving 136 
nammg 

correcting typing errors in 85 
in application programs that auromatically 

save 86 
new 85 
version conventions 88 

opemng 

Index 

from the desktop 76 
from within an application program 75 
in a directory dialog box 27 



documents (continued) 
organizing 135-153 
pasting, text and images imo 78 
placing in folders 142 
printing 11 3-133 

failure, causes and suggested solutions 3 12 
on the network 194 

renaming 139 
when saving 87 
without retaining a version 88 

replacing, Alerr box verification 89 
saving 84-93 
specifying for startup 66, 98-100 
version handling 88 

dotted rectangle 
significance of 7 

double-clicking. See also selecting 
icons, to starr an application program 73, 74 
saving new desktop patterns with 224 
speed, setting 206 
windows, to make them active 13 

downloadable fonts . See also characters; fonts; 
printing 

description 1 19 
dragging. See also moving 

correcting typing errors with 85 
documents 136 
ejecting floppy disks by dragging to Trash icon 

15 
objects 5 
pomter 

to choose a submenu 23 
in menus 22 

resizing windows with 11 
scroll box 18 
selecting parr of an icon's name by 30 
windows 10 

drawing. See also graphics 
with the mouse, adjusting mouse tracking for 

205 
drivers. See also devices 

adding by copying into System Folder 50 
finding a list of system-supplied 52 
installing, as preparation for networking 187 
printer, installing 114 
programming, where to find help with 355 
removing from System Folder 62 
system resources in the System Folder (figure) 

49 
Duplicate command (File menu) copying 

documents with 138 
duplicating. See also copying 

fil es 138 

E 
Easy Access program 

characteristics and use 347- 349 
Easy Install option (Installer program) 52-55 
editing. See also adding; Clipboard; copying; 

creating; deleting; Scrapbook desk 
accessory 

canceling most recent action 83 
desktop 

basic procedures 29 
changing document names with 139 
patterns 223, 242 
renaming disks 164 

documents 76- 83 
on the file server 200 

reversing Undo command 83 
Scrapbook contents 93 
text 77-83 

Index 

actions common to all application programs 
76-83 

selecting while 7 



Edit menu 
appl ication programs use of (figure) 20 
C lear command 

deleting selected text in an icon name with 
33 

deleting text and images permanently 82 
Scrapbook use of 93 

Copy command 
copying text and images with 77, 79 
Scrapbook use of 93 

Cut command 
compared w ith C lear command 82 
deleting selected text in an icon name with 

33 
delet ing text and images witl1out losing them 

82 
Scrapbook use of 93 

Paste com mand 
copying text and images with 81 
insertin g rext and images in to a document 

fro m 78 
Scrapbook use of 93 

Show C lipboard command 78 
Undo command, canceling editing actions with 

83 
Eject command (File menu) 

ejecting floppy d isks with 159 
ejecting floppy d isks 159-160 

after display of "sad Macintosh" icon 305 
failure, causes and suggested solutions 308 
from within a program 160 

electrical safety. See also maintenance; 
troubleshooting 

precautions when setting up 290 
Empty T rash com mand (Special menu) 

erasing icon contents with 14 
ending 

macro record ing 334 
work sessions, good methods for 109-1 1 l 

enlarg ing. See also resizing 
paper size, implications of 119 
windows 11 

entering. See also characters 
optional characters 328 

Enter key 
initiating actions with 324, 325, 327 
primary use, in summary of special keys (figure) 

42 
envi ron ment 

clues to finding our where you are 94 
Erase Disk co mmand 

(File menu, Apple Fi le Exchange), erasing non­
Macin tosh d isks 344 

(Special menu), erasing disks with 163, 174 
erasing. See also deleting; editing; removing 

disks 
floppy 161 
hard 168, 174 
non-Macintosh 344 
w ith Erase Disk command 163 

macros (figure) 333 
error messages 26. 

See also problems 
errors 

See changing; correcting; ed iting; mistakes 
Escape 

See Esc key 
Esc key 

primary use, in summary of special keys (figure) 
42 

program-dependent function key 324, 327 
Ethernet 

connecting Macintosh to 183 
installing 187 

everyone 
file server access privilege, description 200 

Index 
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exchanging 
disks and files, with MS-DOS computers 

336-345 
flies, reading MS-DOS 3.5-inch disks on 

SuperDrive 157 
memory modules, as expansion method 287 

expansion 
cards 

designing 355 
installing 281 - 285 

slots, N uB us in Macintosh II models 281, 282 
extending 

selected text 3 1 
external floppy disk drives 

ejecting floppy disks from 159 
reading MS-DOS disks with 5.25-inch drives 339 

F 
File menu 

application programs use of (figure) 20 
Close Command, closing windows with 13 
Duplicate command, copying documents with 

138 
Eject command, ejecting floppy d isks vvith 159 
Get Info command 

changing memory allocation for a program with 
105 

displaying information about icons with 151 
locking application programs and documents 

with 152 
New command, creating new documents with 74 
New Folder command, creating and naming 

folders with 14 1 
O pen command 

opening icons with l 0 
starting programs with 74 

Page Setup comm and, options, choosing I 18-120 
Pri nt command 

applicatio n programs use of 194 
options 12 1 
printing on a network 194 

Print O irectOiy command 125 
Put Away comm and 149 
Q ui t command 74, 109 
Save As command, saving revised documents, by 

changing the document name 87 
Save command 85, 86 

file(s). See also application programs; documents; 
folders; hierarchical fi le system (H FS); 
networks 

backing up 1 I 0, 150 
copying desk accessories berween 258 
exchanging 

reading MS-DOS 3.5-inch disks with 
SuperD rive 157 

with MS-D OS computers 336-345 
font 

copying fonts from one fi le to another 250 
using 247 

managing, methods for 84-93 
naming 85, 86, 88 
opening in a di rectory dialog box 27 
organizing, with View menu 150 
printing a directmy of 124 
private, creating on a fi le server 200 
receiving across a nerwork 20 I 
renaming 139 
saving 84-93 

disk problems, causes and suggested solutions 
307 

in application programs 84-93 
Scrapbook, handling 93 
sending across a network 201 
servers 

selecting with the Chooser 39 
using 196-200 

sharing across a nerwork 183 
translating 

creating a log 344 
non-Macintosh flies 339 

versions 88 
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file system 
managing documents with 140-153 

Finder. See also MultiFinder; system software 
obtaining information about 103 
specifying items to be opened under 66 

Find File desk accessory. See also desk accessories 
Apple Menu, using 144-146 

finding. See also organizing 
documents 144 
files, limiting search 146 
folders 144 

5.25 inch disks (MS-DOS) . See also devices; disks 
reading from an external floppy drive 339 

fl ipped image 
LaserWriter Page Setup option 119 

floppy disks. See also devices; disks 
capacities 156 
characteristics and use 15 6-166 
creating small systems on 62 
drives 

connecting 273 
protecting during transport 292 

ejecting 15, 159 
5.25- inch 339 
handling precautions 292 
installing system software on 60 
locking 179 
managing 156-166 
MS-DOS format, initializing 3.5-inch 337 
repairing 297 
resting 297 

folders. See also documents; files; hierarchical fi le 

386 

system (HFS) 
contents, viewing 150 
moving through levels of 24 
opening in a directoty dialog box 27 
organizing documents with 140-149 
protecting the contents of 181 

Font/DA Mover. See also desk accessories; fonts; 
system sofn.vare 

creating files of fonts and desk accessories 260 
installing, desk accessories with 189, 253 
moving fonts and desk accessories with 

246-263 
removmg 

desk accessories with 258 
fonts with 25 1, 252 

window layout description (figure) 246 
fonts. See also desk accessories; documents; editing; 

text 
downloadable 119 
managing 246-263 
removing, from System Folder 62 
substitution, LaserWriter Page Setup option 

119 
formatted disk. 

See initial izing 
fragmentation 

disk, reducing 3 15 
memory, handling 104 

freezing pointer 
causes and suggested solutions 311 

Function keys 

G 

Apple Extended Keyboard, alternative operating 
system use of 327 

creating macros fo r, using MacroMaker 331 
primary use, in summary of special keys (figure) 

42 

General Control Panel. 
See Control Panel, General 

Get Info command (File menu) 
changing memory allocation with 105 
displaying information about icons with 150, 

151 
locking application programs and documents 

with 152 
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global macros 335. See also MacroMaker 
glossary 

term and concept defini tions 357-371 
graphics. See also Apple Desktop Bus (AD B); 

images; text 
cards, NuBus, instaJling 28 1 
tablets 

adjusting mouse tracking for operation with 
205 

connecting 273 
graphic smoothing 

LaserWriter enhancement 11 9 
grave accent (') 

entering with Option-' 330 
grayed-out commands 

meaning of 22 
gray shades. See also color; monitors 

changing 242, 244 
specifying the number of 235 
viewing icons by 245 

grounding. See also maintenance 
electrical, imponance of 290 

group. See also security 
file server access privilege, description 200 

guidelines 

H 

programming and user interface design for the 
Macintosh, where to find 355 

handicapped 
physically, Easy Access features for 346-349 
visually, aids for 350-352 

"happy Macintosh" icon 
meaning of 305 

hard disks. See also devices; d isks 
connecting non-SCSI 273 
connecting SCSI 266-269 
drives 266 
managing 166-1 75 
problems, diagnosing 309 
repairing 297 
testing 297 

hardware. See also devices; software 
design, finding information on Macintosh 355 
developers, assistance for 356 

HD SC Se[llp program 
testing SCSI hard disks with 299 

headphones. See also Apple Desktop Bus (ADB) 
devices; sound 

connecting ro the Macintosh 276 
help 

Macintosh organizations, user groups, and 
li terature 354 

technical information 354 
HFS. 

See hierarchical file system 
hierarchical file system (HFS) . See also directories; 

fil es; folders; organizing 
using 140-1 49 

high-density disks. See also devices; disks 
characteristics and use 157 

highlighted commands 
meaning of 22 

highlighting. See also selecting 
color 

brightness of 240 
changing 244 

objects 5 
removing 8 

hooking up. See connecting 
horizontal tab character. 

See characters 
humidity. See also maintenance 

optimaJ for M acintosh operation 293 
HyperCard 

automatic save feature of 86 

I,] 
J-beam pointer. See also poimers 

description 30 
inserring text with 34 
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icons . See aLso user interface 
Apple D esktop Bus 274 
application program, starring by double-cl icki ng 

73 
bomb, causes and suggested solutions 309 
colo r 239, 244 
deselecting 30 , 33 
dimmed , mea ning of 9 
d iscarding 14 
disk 

with blinking question mark 305 
with X character 305 

d isk drive po rt 272 
d isplaying rhe coments of 5 
examples of (fi gure) 1 
listing the conten ts of a folder by 150 
modem (figure) 272 
name 

changing 29- 34 
deleting selected text in 33 
inserring rexr in 34 
selecting text in 29 

opening 9 
ret rieving from the T rash 15 
selecting 6 

color or gray shade for 235 
multip le icons 7 

v iewing by colo r 245 
images. See aLso graphics 

copying 77, 79,9 1 
deleting 82 
inserting, from C lipboard into a document 78 
past ing, into a docum ent 78 
saving, Scrapbook desk accessory use for 9 1 

Image Writer primers. See aLso devices; Laser W riter 

388 

printers; printers 
background prin ting not available on 130 
choosing I 1.8 
connecting to 269 
network use of 192 
priming options fo r 120, 12 1 
problems, causes and suggested solut ions 312 

!N IT fi les 
as potential cause of sofi:ware incompatibili ty 

3 15 
initializing disks 

floppy 161 
hard 168 
M S-DOS 3.5 inch 337 
normal-densiry, in MS-D OS format 339 

initiat ing. See starting 
input devices. See aLso devices 

connecting 273 
inserting 

floppy disks, in a disk drive 158 
text, in an icon name 34 

and images, into a document 78 
insertion point. See aLso pointers 

arrow keys as alternat ive to m ouse fo r moving 42 
changing the bli nking speed 225 
deleti ng character to the left of with Delete key 

325 
descrip tion 29 

Installer program 
C usromize options 56-60 
Easy Insta ll option 52-55 
options fo r 5 1 

installing. See aLso connecting; devices; maintenance; 
software 

32-Bit Q uickDraw 64 
app lication programs 72 
C loseView 350 
customized systems 56-60 
desk accessories 253 
expansion cards, on Macin tosh If models 28 1 
fonts 247 
MacroMaker 33 1 
memory cache cards 286 
network software 188 
NuBus cards, procedures and ven tilation 

warnings 282 
pri nrer d rivers 11 4 
system sofrware 51-56 

on floppy d isks 60 
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insurance. See also securi ty 
savi ng documents as 84-93 

interface 
NuBus, descriptio r. 28 1 

inrerference. See also maintenance 
radio and television 293 

international language characters. See aLw 
characters 

typing 330 
internet. See also networks; zones 

connecting multiple nerworks into 192 
inverted image 

LaserWriter page setup option 119 

K 
keyboard. See also Apple Desktop Bus (AD B) 

devices; Control Panel 
adjusting character repetition 209 
connecting 273 
Control Panel , changing keyboard parameters 

with 208-210 
diagnos ing cable problems 306 
eq uivalents, fo r comm ands, displayed in menu 

22 
handicapped assistance 347 
handling spills 29 1 
layouts and character sets 32 1-330 
Macinrosh Plus, connecting to the Macimosh 

275 
one-handed use 347 
problems, diagnosing 306 
shortcuts 

Copy com mand (Command-C) 78 
Get Tnfo command (Command-1) 152 
Duplicate command (Command-D) 138 
New Folder command (Command-N) 14 I 
Pasre command (Command-V) 79 
Print command (Cominand-P) 122 
prin ting with Rerurn key 123 
Quit command (Command-Q) 74 
Rerum key, shortcut for Save burton in ' Save 

dialog box 87 

Save command (ConHnand-S) 86 
Undo comm and (Command-Z) 83 

specia.l keys, using (figure) 42 
keys. See also specific keys 

arrow, alternative to mouse for poinrer 
m ovement 323, 325 

Mouse Keys 348-349 
repeating by holding down 209 

Key Caps desk accessory 
using 328 

L 
LAN (local area network). 

See Loca.ITalk; netvvorks 
languages 

entering international characters 330 
LaserWriter printers. See also devices, Image Writer 

printers; printers 
connecting 269 
network use of 1 92 
Page Sewp optio ns for (figure) 119 
problems, causes and suggested solutions 3 1 2 

light pens. See also Apple Desktop Bus (ADB) 
connecting 273 

lights 
locking key indicators, (figure) 42 

linki ng. See connecting 
list 

selecting items in a 7, 8 
load ing. See also installing; starting 

macros (figure) 333 
local area network (LAN). 

See LocaiT alk; nerworks 
LocalT all<. See also AppleTa.lk; netvmrks 

connecting to 184-186 
description 

as an AppleTalk nervvork rype 183 
as a work group nerwork 269 

locating. See finding 
location 

clues to 94 
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locking. (a•~d unlocking). See also protecting; security 
apphcanon programs, with Get Info command 

152, 180 
disks 

as cause of inability to save to disk 307 
to protect information 179 

documents 
effect on discarding icons 15 
with Get Info command 152, 180 

implications of 179 
log 

translated fi les, creating 344 

M 
Macintosh 

expanding the system 265-287 
format, converting non-Macintosh fi les and disks 

ro 345 
operations, description of standard 1-45 
ready to run, how to recognize 49 
setting up the system 47-69 
shutting down 110 
startup, specifying items to automatically open on 

65-69 
technical help, where to find 354 
turning on and off 43-45 
user groups, names and addresses 354 

Macro Maker 
command files, creating and using 331-335 

macros. See also customizing 
creat ing and using 331-335 

MacWrire format 
converting to and from MS-005 339 

magnetic tape. See also devices 
connecting to rhe Macintosh 266 

magnification 
screen, increasing and decreasing with C lose View 

352 
maintenance. See also security 

390 

avoiding trouble, positioning of monitors 281 
maintaini.ng a safe and reliable operating 

environment 289-319 

managi.ng . . See also maintenance; organizing 
apphcanon programs 71-11 I 
desk accessories 253-263 
disks and disk drives 155- 181 
fil es 84-93 
fonts 246-263 
multiple application programs 97 
printing jobs 

with a spooler 195 
with PrinrMonitor 131- 133 

system memory 1 02 
work environment 

backing up fi les 110 
mai nt~ining a safe and reliable operating 

env1 ronment 289-319 
mani pulating 

mouse, Mouse Keys as alternative to 348 
manual paper feed. See also printing 

handling w ith PrinrMonitor 132 
mathematical symbols 

Numeric keys used for 325 
memory. See also devices 

allocating for programs 105 
cache cards, installing 286 
cards, in smlling on a Macintosh Il- fami ly 

computer 281 
expanding on the main circuit board 287 
fragm entation, handling 104 
installing 287 
insufficient 

MultiFinder alert chat reporrs 102 
suggested solutions 314 

M ultiFinder 
checking the amount available I 04 
RAM cache, adj ust ing for effici ent use 106 
requirements 97, 103 

system 
clearing l 04 
managing 102 
reserving fo r additional monitors 277 

verifying the amount in your system I 03 



menu bar 
clues to finding out where you are (figure) 94 
using 20-2 1 

menus. See also user interface 
accessing 20- 21 

pop-up 24 
puU-down 2 1 

application programs use of (figure) 20 
choosing commands from 7, 21 
co mmands, avoid using in global macros 335 
in d ialog boxes, recognizing 26 
submenus, using 23 

messages 26. See also problems; troubleshooting 
m 1croprocessor 

exchanging signals with 281 
mistakes. See also problems 

strategies fo r correcting problems 313 
typing, correcting 85 

modem port 
connecting printers to 269 
use and advantages 27 1 

modems. See also devices; net\·vorks 
connecting 20 I, 271 

modifier keys. See also keyboards 
entering optional characters with 328 
including in a macro 334 

mod ifying. Seechanging 
mon ito rs. See also Control Panel; devices; graphics; 

video 
adding addi tional 276 
adjusting the brightness of 234 
connecnng to 

compact M acintosh models 280 
video ca rds 279 

Control Panel , changing moni tor parameters 
with 227-245 

maintenance of 29 1, 293 
multiple 

avoiding interference among 28 1 
changing poin ter movemem between 227 
designating rhe main monitor 23 1-233 
indicat ing relative posit ions of 227 

specifying color characterist ics of 237 

mouse. See also Apple Desktop Bus (ADB); 
po 111ters 

arrow keys as alternative fo r moving the mouse 
42, 323 

bu tron 
description of 2 
double-cl icking speed 206 

changing mouse operation 204-207 
clea ning the 294 
Control Panel, changing mouse operaton with 

204-207 
M acin tosh Plus, connecting to the M acintosh 

275 
Mouse Keys, as alternative to 348 
moving (figure) 2 
picking up, effect on pointer 4 
pointer 

changing mouse movement relat ionship 204 
moving mouse rel at ive to 2 
picking up mouse, effect on pointer 4 

porr 
connecting mouse to Apple D esktop Bus 

(ADB) port 273 
Macintosh Plus different from the Apple 

Desktop Bus (ADB) port 275 
problems, d iagnosing 306 
tracking, options fo r 204 

Mouse Keys 348 
moving. See also dragging; shift-cl icking 

around the 
desktop 9 
folder hierarchy 146 

desk accessories 246 
documents 136, 142 
folders 143 
fo nts 246 
inserrion point 

horizontally, with T ab key 327 
to the beginning of the next line with Return 

key 325 
objects on the screen, by dragging 5 
po inter (figure) 2 
to a new folder level 148 
windows 10, 12 
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MS-DOS. See also alrernarive operating systems 
3.5-inch disks 

read ing on the SuperDrive 157, 336 
converting files 

on a fi le server 343 
to and from MacWrire format 339 

Multi Finder 
capabilities 97 
cl ues to finding our where you are 94 
copying between application programs 80 
install ing 

desk accessories 257 
fonts 250 

memory requirements and availability I 03, I 04 
pointer freezi ng, possible cause 311 
printing from rhe background 4 1, 130 
RAM cache, adjusting for efficient Mulri Finder 

use I 06 
required for 

printing from rhe background 4 l , 130 
running multiple applications 97, 101 
starting up with multiple open documents 

68 
specify ing items ro be opening under 66 
turn ing on and off 98-100 

mu ltiple application programs 
managing, with Mu ltif inder 97 

N 
naming. See also renaming 

disks 162, 168 
documents 85 
folders 14 1 
icons 29 

nesti ng. See also hierarchical fi le system (H FS); 
organ1zmg 

folders 143 

392 

networks 183-20 I. See also AppleShare; 
communications; modems 

AppleT alk, selecting devices with the Chooser 
39 

Control Panel, changing networks with 190 
devices, selecting with the Chooser 40 
EtherTalk ca rds, installing 187 
fl ies, sharing on 196 
interface cards, install ing 187, 281 
LocalTalk 185 
printers 

connecnng ro 269 
print spoolerson 195 
selecting within zones 40, I 17 
specifying with the Chooser 193 

software, installing 187, 188 
virus prevention when using 303 

New com mand (File menu) 
creating new documents with 74 

New Folder command (File menu) 
creating and naming folders with 14 1 

NuBus. See also hardware 
cards, installing 282-285 

numeric keypad 

0 

keyboard descriptions 324, 325, 327 
Mouse Keys defined on 348 

objects 
manipulating 5 
selecting multiple objects in 

one area 7 
separate areas 8 

office 111 i ng system 
Macintosh metaphor, components of 135 

Open comm and (Fil e menu) 
dialog box , (figure) 26 
opening icons with 10 
starting programs with 74 
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openi ng. See also closing; starring 
application program (s) 

icons 73 
with MulriFinder I 0 I 

Chooser 39 
documents 75, 76 
General Control Panel 36 
ico ns 9 

with Open command in File m enu I 0 
on startup, speci ~'ing 65-69 

menus 21 
pop-up menus 24 
submenus 23 
windows, by double-cli cking 5 

opera ring systems. See also alternative operating 
systems 

mul tiple, running on rhe Macin tosh 170 
operations 

initiating with the mouse 2, 3 
standard Macintosh 1-45 

Option key 
primary use, in summary of special keys (figure) 

42 
special characters 

C hicago font (figure) 329 
producing 322, 324, 328 

starting Fom /DA Mover with 257 
Sticky Keys combinations 347 
typing accented characters with 330 

Option-' 
grave accent, entering with 330 

Option-c 
cedi ll a (<;:) , emering with 330 

O ption-Command-Down Arrow 
decreasing screen magn ification with 352 

Option-Command-Up Arrow 
increasing screen magnification with 352 

Oprion-Command-X 
turning screen m agni ficat ion on and off wirh 

352 
Option-e 

acute accent, enterin g with 330 

Option-i 
circumflex("), entering with 330 

Option-Shift key combination 
entering optional characters with 328 
special characters produced in C hicago font 

(figure) 329 
Option-u 

umlaut ("") , entering with 330 
optional characters. See also ch aracters 

entering 328 
organizing. See also hierarchical fi le system (HFS); 

managmg 
documen ts 135- 153 
fi les 

by icon color 245 
with V iew menu 150 

outline 
of object, signi ficance of 5 

output devices. See also devices; printers 
selecting 11 6 

overhearing. See also maintenance 
precautions on 293 

overwriting. See also replacing; saving 
documents 86, 89 
selected rext in an icon nam e 32 

owner 
fi le server access privilege, descripti on 200 

p 
Page Setup command (F ile m enu) 

choosing options l l8-120 
paper. See also printing 

cl ip, as a h ardware troubleshooting tool 308 
positioning, LaserWriter page setup options for 

119 
size, l mage\'.V'rirer LQ options 120 
supply, monitoring rhe 132 

partition ing 
hard d isks 170 

passwords. See also access protection; security 
entering in AppleShare 198 
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Paste command (Edit menu) 
application programs use of (figure) 20 
copying text and images with 81 
inserting text and images into a document from 

78 
Scrapbook use of 93 

pasting. See Paste command 
pattern (desktop). See also customizing 

changing 
bit pattern 223 
colors and gray shades 242 
(figure) 38 

displaying available 223 
personalizing. 

See customizing 
pixels 

background, editing che color of 243 
description 224 

playing 
macros (figure) 333 

pointers 

394 

arrow 2 
crosshair, use in changing Control Panel 

parameters (figures) 209-245 
diagnosing problems 306, 31 1 
dragging 

to choose a command 22 
to open a submenu 23 

freezing, causes and suggested solutions 306, 
311 

I-beam 
description 32 
inserting ccxc with 34 

manipulating pointers with Mouse Keys 348 
movement 

between monitors, changing 227 
changing che speed of 204 

picking up mouse, effect on 4 
wristwatch, indicator of save operation 86 

pointing 
description of 3 

pop-up menus. See also menus 
moving co a new folder level with 148 
opening and using 24 
seeing items chat extend up from the tide 25 

pores. See also Apple Desktop Bus (ADB); devices 
modem 269, 27 1 
non-SCS I, how co recogn ize 269 
printer 184,269,271 
SCSI description 266 

positi oning 
monitors 28 1 

power (electric). See also installing; maintenance 
consumption , NuBus cards 283 
limi ts, NuBus cards 283 
requirements 273, 283 
switch, location of on different models 43 

powering down. See also shurcing down 
effect on Trash 14 

Power On key 
Macintosh If model, turning on computer with 

45 
primary use, in summary of special keys (figure) 

42 
starting system with 324, 327 

precautions. See also maintenance; managing; 
problems; troubleshooting 

electrical 290 
floppy disks 292 
power requirements, NuBus cards 283 
system upgrade, importance of 310 

prcveming virus damage 302 
Print command (File menu) 

application programs use of 194 
options 121 
printing on a network 194 

Print Directory com mand (File menu) 124-125 
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primers. See alro devices; I mage Writer primers; 
LaserWriter primers 

choosing 40, 116, 193 
color, installing drivers for 114 
connecting to the Macintosh 266, 269 
drivers 

installing 114, 187 
supplied with system sofi:ware (figure) 114 

network use of 187, 192, 193, 194 
Page Setup options 11 8-120 
port 

connecting printers to 269, 271 
connecting ro a Loca1Talk network through the 

184 
prmt 

area, implications of large 119 
quality setting for Image Writer 121 
server description 195 

problems, causes and suggested solutions 312 
sharing by use of a network 183 

priming. See also documents 
background printing 

procedures for 130 
turning on and off (figure) 41 

direction of, setting for Image \Xlriter 121 
direcrories 124-125 
documents I 13-133 

on a network printer 194 
keyboard shortcut, 

Command-P 122 
monitoring the status of 132 
options 122 
problems, causes and suggested solutions 312 
time, setting the 132 

PrintMonitor. See also Multi Finder 
using 131- 133 

print server 195 
priority 

modem port compared wi th the primer port 271 
SCSI devices, serring the 266 

privileges. See also access protection; password; 
protecting; security 

fi le setver access, description and use 200 
problems. See also troubleshooting 

computer operation, causes and suggested solutions 
304 

desktop doesn't appear, causes and suggested 
solutions 304 

disk not ini tialized message 307 
disk unusable, causes and suggested solutions 307 
disk won't eject, causes and suggested solutions 

308 
floppy disks, causes and suggested solutions 308 
hard disk, causes and suggested solutions 309 
keyboard, causes and suggested solutions 306 
memory, not enough 3 14 
mouse doesn't move the pointer, c.:1Uses and 

suggested solutions 306 
pointer freezing, causes and suggested solutions 

311 
primers, causes and suggested solutions 312 
screen, causes and suggested solutions 304 
software, symproms, causes and suggested 

solutions 309 
startup, causes and suggested solutions 309 
strategies for solving 313 
viruses, strategies for preventing 302 

processor-direct slot. See also cards; customizing 
installing memory cache cards in 286 

Pro DOS operating system . See also alternative 
operating systems 

for Apple II computers, converting files from 345 
products 

new, where to see demonstrations 354 
program. 

See application programs; system software 
programmmg 

help with 355 
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propeller key or symbol. 
See Command key 

protecting 
data. See backing up; copying; locking; saving 
hardware. See maintenance 
sofrware. See backing up; locking; security; viruses 

pull-down menus 21. See ab-o menus 
pulling the power plug. 

See rrouhleshoming 
Pur Away command (File menu) 

putting away irems on rhe desktop with 149 

Q 
question mark 

on disk icon, meaning 305 
Quit command (File menu) 

copying between application programs, use of 80 
quitting application programs with 74, 109 

quitting 
application programs 74, I 09 

R 
radio 

interference, handling 293 
RAM (random access memo1y). See ab-o memo1y 

d1ips, SIMMs as a group of 287 
expanding 287 

RAM cache 
MultiFinder use 106 
setting in General Control Panel 106 

random access memory. See RAM 
rebuilding. See ab-o maintenance 

desktop, avoiding problems by 317 
receiving. See ab-o nerworks 

flies across a network 20 1 
recording. See ab-o MacroMaker 

keystrokes in a macro 331 
recovery. See also troubleshooting 

crash 309 

396 

rectangle 
dotted, significance of 7 

reducing. See also printing 
paper size I 19 

removing. See also deleting; erasing 
desk accessories 62, 258 
device drivers, from System Folder 62 
Aoppy disks 14 
fon ts 62, 25 1 
highlighting 8 
icons 14 
MacroMaker 332 
resources, from System Folder 62 

renaming. See also naming 
disks 164, 175 
documents 86, 139 
non-Macintosh fi les 344 

repairing. See also troubleshooting 
disks, with Disk First Aid 297 

repeating characters. See also characters; customizing 
setting the rare and delay before 209 

replacing. See also copying 
desktop patterns, without saving 224 
documents, Alert box verification 89 
selected rext, in an icon name 32 

resizing. See also windows 
windows 11, 19 

resources. See also devices; drivers 
description (figure) 49 
removing from System Folder 62 
sharing by use of a nerwork 183 

Restart command (Special menu) 
changing srarrup device with 179 

Restore settings command 
(File menu, Apple File Exchange) 344 

restoring. See ab-o maimenance; troubleshooting 
editing actions 83 
translator settings 344 

remevmg 
flies on the file server 200 
icons from rhe trash 15 
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Return key 
Enter key use for some functions 42 
keyboard shortcut for Save button in Save dialog 

box 87 
moving the insertion point to the next line 323, 

325,327 
reversing. See also editing 

Undo command use for 83 
revised. See also editing 

documents, saving methods 86 
RGB monitor. 

Seecolor; monitors 
ringing alarm icon 

significance of 220 

s 
"sad Macintosh" icon 

meaning of 305 
Save As command (File menu) 

saving revised documents by changing the 
document name 85, 87 

Save command (File menu) 
saving new documems with 85 
saving revised documents, by overwriting previous 

versions 86 
saving. See also backing up; ed iting 

automatically, H yperCard feature 86 
desktop patterns 224 
desk accessories 258 
documents 84-93 
files 

disk problems, causes and suggested solutions 
307 

on the file server 200 
fonrs 25 1 
icon nam e changes 30-32 
images, Scrapbook desk accessory use for 9 1 
information for quick retrieval. See C lipboard 
macros 335 
text, Scrapbook desk accessot)' use fo r 9 1 
translator settings 344 

version handling 
documents 88 
Scrapbook files 93 

scanner. See also devices; SCSI 
connecting to the Macintosh 266 

scanning order 176 
Scrapbook desk accessory. See also desk accessories 

editing 
contents of 93 
operations in 9 L 

saving text and images in 9 1 
version handling 93 

screen. See also devices; monitors 
changing 

brightness level 234 
highligh t color on 244 

cleaning 294 
designating color o r gray shade 235 
magnification with CloseView 352 
messages 

disp laying 26 
responding m 26 

moving pointer on, adjusting the speed 204 
problems, causes and solutions 304 
savmg 

precautions 291 
programs for 304 
wrn ing down brightness control 234 

Vtewtng 
enhancing th rough magnification 350 
icons by color 245 

scripts 33 1. See also M acroMaker 
initiating recording of (figure) 333 

scro ll arrows 
displaying window conrents with I 6 

scroll bar 
clicking to display window contents 19 
description and use 16 

scroll box 
dragging to display window contents 18 

scrolling 16. See also user interface; windows 
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SCSI (Small Computer Systems Interface) devices. 
See also devices 

connecting 266-269 
ID number duplicated, as cause of fai lure to 

recognize a hard disk 309 
Search Here command (Find File menu) 146 
searching. See also Find File command 

for documents 144-146 
security. See also access protection; locking; passwords 

password protection in AppleS hare 198 
selected 

menu item, blinking rare, adjusting the 225 
objects, deselecting 8 
text, extending 31 

selecting. See also choosing; designating; editing 
colors, number 235 
commands 21 
devices 40, 116 
fonts to install 249 
gray shades, number of 235 
icons 6 

colors 244 
list 

group of items in a 7 
separate items in a 8 

monitors 231-233 
multiple 

desk accessories 256 
files for translation 341 
icons and objects 7 
startup items 68 

networks 190 
objects 6 
printers 40, 193 
text 

in an icon name 29 
while editing 7 

translators 343 
sending. See also networks 

data to other computers by modems 201 
files across a network 201 

serial 

398 

ports, description 269, 271 
transmission 269 

serv1ce 
Apple, information about 318 

setting. See also changing; Control Panel 
SCSI device number 266 

Set Startup command (Special menu) 
specifying items to be opened with (figure) 65-69 
tuming MulriFinder on with 98 

setting up 
monitors 281 
networks 183 
pages I 18 
printers 11 4, 187 
system components 290 
system software 48 

720K 
MS-DOS normal-density floppy disk, initializing 

339 
sharing 

computers and other resources with network users 
183 

files 183, 196 
shift-clicking 8. See also selecting 
Shift-Left Arrow 

deselecting characters with 31 
Shift-Right Arrow 

extending selected text with 31 
Shift key 

deselecting objects with 8 
entering optional characters with 328 
producing uppercase letters 322, 324, 327 
Sticky Keys combinations 347 

shortcuts 
keyboard. See keyboard shortcuts 

Show Clipboard command (Edit menu) 78 
Shut Down command (Special menu) 111 
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shutting down. See also screen saving; turning off 
eflect on Trash 14 
procedures for 11 0-11 1 

SIM!v1 (single-in-line memmy module) 287 
SIZe 

box 
resizing windows with 11 
(figure) 9 

desk accessories, obtaining the 256 
fonts, obtaining the 249 
listing folder contents by 150 
windows, changing the 11 

slots 
N uBus, description of 281 

socket. 
See port 

software. See also application programs; desk accessories; 
system software 

developers, assistance for 356 
problems 

bomb icon, causes and suggested solutions 309 
pointer freezing, causes and suggested solutions 

311 
version, incompatibilities as source of problems 

314 
sound 

changing 
volume 2 11 
type of alert 213 

connecting audio devices 276 
Control Panel, changing sound sen ings with 

211-214 
speaker. See also sound 

built-in, adjusting the sound volume of 211 
volume, changing (figure) 38 

Special keys 
Apple Extended Keyboard, alternative operating 

system keys 327 
Special menu 

Empty Trash command, erasing icon contents 
with 14 

Erase Disk command 163, 174 

Restart command, changing startup device with 
179 

Set Startup comman d 
specifying items to be opened wi th (figure) 

65-69 
turning MultiFinder on with 98 

Shut Down command 45, 11 1 
specifYing. See designating 
spooler 195. See also primers; PrintMonitor 
starting. See also startup; stopping 

application programs 5, 73 
by opening documents 76 
with Multifi nder 101 

Fom/DA Mover with Desk Accessories option 
selected 257 

Macintosh 
preparing system for use 47-69 
with MultiFinder on 98-100 

macro script recording (figure) 333 
operations with the mouse 2 
priming 120 

sr:urup. See also starting 
disks 

adding nenvork software to 188 
creating 48, 60-63 
designating 176 
making more room on 258 
removing fonts restrictions 251 

problems with, causes and suggested solutions 
309 

specifying, items to be opened on 65-69 
stereo mini plug. See also devices; sound 

connecting audio devices wi th 276 
Sticky Keys. See also handicapped 

turning on and off 348 
sropping. See also starting 

macro recording 334 
work sessions, good methods for 109- 111 

storage devices. See devices 
storage media 

disks, managing 155-181 
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storing 
documems, in folders 142 
files, on the file server 200 
Aoppy disks 292 
folders, within folders 143 
macros (figure) 333 

strategies. See also maintenance; problems, 
troubleshooting 

problem solving 313 
submenus. See also menus 

opening and using 23 
sunlight. See also maintenance 

precaution agai nst 293 
SuperDrive 

characteristics and use 157 
support. See also noubleshooting 

Apple, information about 318 
swapping 

disks 160 
Scrapbook fi les 93 

switching 
application programs or desk accessories, with 

MultiFinder 100 
disks 160 

system 
d ock, purpose of 300 
components, setting up 290 
crash, strategies for handling 309 
creanng 

cusromized 56-60 
small 62 
standard 52 

files 
finding a list of system-supplied 52 
system resources in the System Folder (figure) 

49 
verifying what you need 49 

memory 
clearing 1 04 
managing 102 

System Additions disk 
needed for installation 51 

-iOO 

System 6.0 
minimum recommended configuration 51 

System Folder 
contents 

description and verification 49 
for a Macinrosh with a separate monitor 

(figure) 50 
driver installation, primers 114 
importance of having only one version on hard disks 

315 
PrinrMoniror location 132 

system sofrware. See also application programs; desk 
accessories; software 

installing 48, 49, 51-56 
network, using 183 
preparing for use 48 
updating 63 
upgrade, importance of 310 

System Startup disk 
needed for installation 51 

T 
Tab key 

moving the insertion point horizontally to the righ t 
322,324,327 

tablet. See also Apple Desktop Bus (ADB); devices 
graphics, adjusting mouse nacking for operation 

with 205 
tape backup. See also devices 

connecting to the Macintosh 266 
technical docwnenration 

Macintosh, where to find 354 
telecommunications. See also networks 

connecting with another com purer by 201 
linking the Macintosh in telephone nerworks 27 1 

telephone 
lines, sending data to other computers by 201 
networks, linking the Macintosh inro 271 

television. See also maintenance 
interference on, hand ling of 293 

temperature. See also maintenance 
safe range 293 

Index 



rerm111anng 
work sessions, good methods fo r l 09-1 11 

terminators 
connecting SCSI devices with 267 
guidelines fo r using with SCSI devices (table) 

268 
resting. See also maintenance 

disks 297 
text. See also documents; editing 

copying 77, 79, 9 1 
deleting 33, 82 
desktop editing operations 29 
editing 77 

icon name 29 
extending selected 31 
inserting, in an icon name 34 
pasting, into a document 78 
saving, Scrapbook desk accessory use for 91 
selecting, while editing 7 
smoothing, Laser\XIriter capability 11 9 
translation, Apple File Exchange use for 339 

32-Bi r QuickOraw 
installing 64 

3.5 inch disks (MS-DOS). See also devices; disks 
initializing 337 
reading with Apple SuperDrive 336 

throwing away. See also deleting 
unwanted applicat ions, documents, and icons in 

Trash 14 
ti lde(-) . See also characters 

entering with Option-n 330 
time. See also date 

changing 38, 2 15, 2 16 
setti ng alert with Alarm C lock desk accessory 

218 
ririe 

pop-up menus, meaning of 24 
tide bar. See also user interface 

meaning of 9 
moving windows with I 0 

trackball. See also Apple Desktop Bus (ADB); 
devices 

connecting 273 

t racking 
mouse, adj usting 204 

transferring. See copying 
translating 

flies 339 
translator. See also Apple File Exchange 

active 34 I , 344 
files, description 33 7 
options, saving 344 
selecting a 343 

transmission. See also networks 
of data, by modems 20 I 

Trash 
discarding icon contents with 14 
disconnecting from a file server with 199 
ejecting floppy disks by dragging to 15, 159 
icon meaning 14 

triangle 
in menu, meaning of 23 

troubleshooting. See also maintenance 
keyboard, handling spills 29 t 
maintenance and 289-3 19 
problems, causes and solutions 302-3 17 
strategies 302 

turning off 
alarm 22 1 
Macin tosh 43, 45 

effect on T rash 14 
turning on 

alarm 2 18 
Macintosh 43 
M ultiFinder 98 

12-hour clock 
sening and location 214, 2 15 

24-hout clock 
seuing and location 214, 2 15 

type fonts, sources of 246 
typing. See also characters 

accented characters 330 
difficul ties, using Easy Access ro help with 347 
erro rs, correcting 85 
touch, adjusting for 2 10 

Index 401 



t 
umlaut("") 

entering using Option-u 330 
Undo command (Edit menu). See also editing 

canceling editing actions with 83 
Unix. See AIUX 
unlocking. See locking 
unreadable disk 

repairing with Disk First Aid 297 
updating 

system software 63, 310 
uppercase letters 

typing with Caps Lock key 322 
user interface. 

See desktop; icons; menus; mouse; title bar; 
windows 

user name 
changing wicl1 the Chooser (figure) 41 

v 
ventilation. See also maintenance 

monitor, warning against blocking 291 
NuBus cards 282,286 
opening, warning against blocking 281 

verifYing 
memory amount in a particular system 103 
System Folder contents 49 

versions. See also editing; saving 
document, creating 88 
Scrapbook, handling of 93 

video. See also color; graphics; gray shades; monitors 
capability, effect on number of colors and gray 

shades 236 

402 

cards 
connecting a monitor to 276, 279 
listing tl1ose in use 236 
monitor number determined by 227 
NuBus, installing 281 

port, connecting a monitor to 276 
socket, monitor number determined by 227 

viewing. See also organizing 
desk accessory sizes 256 
fonts and font sizes 249 
icons by color 245 
optional d1aracters with Key Caps 328 
window contents 16, 150 

View menu 
displaying information about direcro1y contents 

with 150 
viewing icons by color 245 

viruses. See also maintenance; security; 
troubleshooting 

strategies for prevention and elimination 302, 303 
vision. See also handicapped 

aids for visually handicapped 350 
volume. See also sound 

sound, changing 21 1 

w 
warnings. See also maintenance; troubleshooting 

alert box use for 28 
AIUX, against initializing disk 48 
automatic emptying ofT rash 14 
data loss during disk initialization 161 
disk programs, diagnosing with Disk First Aid 

297 
electrical 290, 295 
floppy drives 292 
hard disk care 167 
memory expansion 287 
overwriting documents 89 
monitors, position oflarge 291 
power requirements, NuBus cards 283 
screen damage 291 
Super Drive, plastic placeholder shmtld not be used 

292 
system software upgrade, importance of 310 
ventilation, importance of 281 , 282 

for monitors and Macintosh 281 

Index 
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where you are on rhe Macinrosh 
finding our 94 

windows. See also user inrerface 
activating 12 
changing shape of I I 
closing 13 
componenrs of (figure) 9 
enlarging with zoom box 12 
listing the conrenrs of 150 
moving 9, 12 
opening 5 
priming a directory of the files in 124 
resizing ll 
scrolling 16 
viewing comenrs by scrolling 1 6 

work groups. See also networks 
connecting primers ro neC\'Vorks 269 
serring up virus-detection stations in 303 

work sessions. See also maintenance; managing 
good methods for ending 109-1 11 

world. See also protecting 
fi le server access privilege, description 200 

wrisC\'Vatch. See also poimers 
pointer change ro, during save operation 86 

write-protect. See locking 

X, Y 
X character. See also troubleshooting 

on disk icon 305 

z 
zones (network). See also networks 

dividing a multiple nenvork internet inro 192 
meaning of (figure) 39 
selecting 40 

primers within 11 7 
sharing fi les through 197 

zoom box 
enlarging windows with 12 
meaning of (figure) 9 
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Keyboard shortcuts 
on the desktop 

, - @ Macintosh$ Quick Reference Card 
From the File meuu 

To create a new folder 3€-N 

To open a selected icon 3€-0 
.... .... ...... ..... .. .. ..... .. ... .. ..... .. ...... ..... 

To close the 
active window 3€-W 

To get information 
about a selected icon 3€-I 

To duplicate 
selected icons 

To eject a selected 

3€-0 

floppy disk 3€-E 

From the Edit menu 

To undo the most recent 
edit/change 3€-Z 

To cut an item 
to the Clipboard 3€-X 

To copy an item 
to the Clipboard 

To paste an item 
from the Clipboard 

To select all items in 
tl1e active window 

3€-C 

3€-V 

3€-A 

Managing windO\\TS To close all windows 
on the desktop 

Press Option while you choose 
Close from the File menu or click 
the active winclow·'s close box. 

To move an inactive windmv 
without making it active 
.. ..... .... ... .. ... ... . . . .. . ·· · ···•· · · 

To activate a \Vindow hidden 
behind other vvindows 

To align all icons left to right, top 
to bottom in the active windO\v 

To close all windows upon 
returning to the desktop from 
a program* 

Press 3€ while you drag the 
window by its title bar. 

Find the dinuned icon related to 
the hidden window (a disk or 
folder icon), then double-click 
the dimmed icon. 

Press Option while you choose 
Clean Up from the Special menu. 

Press Option while you choose 
Quit from the File menu. 

... .. .... ... .. .. ..... ....... ..... .. ... .......... ..... ..... ...... ...... . .. ... . ... .......... ... .. .... .. .......... . 

To open nested folders \Vithout 
cluttering the desktop 

','v!ultiFindcr" must be turned off. 

© Apple Computer. Inc., 1990 

Press Option while you open 
successive levels of folders. 
As you open each nev-' folder, 
the previous folder's window 
automatically closes. 

Apple, the Apple logo, ImageWriter, Macinrosh, and MultiFinder are registered trademarks 
of Apple Computer, Inc. 



Saving 
screen images 

Ejecting 
floppy disks 

To save the current screen as 
an editable and printable paint 
document• 

To. pr·i·nt the conten·r·of 
the active window on 
an JmageWriter® primer• 

~-Shift-3. The document is placed 
on d1e stamtp disk. You can take up 
to 10 screen shots (automatically 
named Screen Othrough Screen 9), 
or more if you rename these . 

. .. . . . .. . . . . . . . .. .. . .. . 
~-Shift-4 

r0 i);:il1r.an i,1iage .. o{it1e current .. . .. .. . \viti~· capsi~~~~ ·~~~~n, ... .. .. .............. .. 

screen on an TmageWriter printer• ~-Shift-4 

• Oumets of modular Maci11tosh models: This works only in 2-color mode. (Sdecl colors in 1he 
Monilors Comrol Panel.) 

To eject a selected disk 
(use one of these methods) 

To eject a ciisk·f;:c;·rn . . .. .. . ... .. . 

the first drive 

~ro .e)eC:i a·clisk'f,:om 
the second drive 

r0 eject a diskfrom 
a third drive 

...... ... ..... . . 

To eject disks while using 
a directory dialog box 

• ~-E 

• Choose Eject from the 
File menu. 

• Drag the disk icon to the 
Trash. (This also removes 
the disk icon.) 

--·-· · ··· ···· · ···-· · · ···· ·· 

~-Shift-1 

~-Shift-2 

~-Shift-0 

Click Drive until the name of the 
disk appears above the buttons. 
Then click Eject. 

Choose Shut Down from the 
Special menu. 

Printing To cancel a printing job in 
progress when not using 
background printing 

~-Period(.) 

... .. .... ..... .. ... ... ......... .. .... ....... . ...... To.ca.ncei'a' p'ri.nri'l1g'j()i:)" ....................... 6p~·~ Ptint:Monitor (by using me 

in progress when using Apple menu or clicking the icon at 
background printing the right side of the menu bar) and 

click Cancel Printing. 
-··- ...... .. .. . . . . 

, _ 



.. Tell Apple about your Macintosh 
and the documentation you received with it by answer 
the questions below. Detach, fold, and seal Lhis postag· 

fom1 and mail it to Apple. 
Please circle the number of your answers below. 

have more than one answer to a question, circle all th< 
numbers that apply. 

1. Which model of .Macintosh do you use~ 
1 ~lacintosh Plus 

2 Macintosh SE 
3 Macintosh SE/30 

4 lvlacintosh Ilci 
5 Macintosh Ilcx 

6 ~·lacintosh Ilfx 
7 Macintosh Portable 

2. l lmv would you rate your Macintosh overall? 
poor 1 2 3 4 5 6 excellent 

3. How long have you been using Macintosh comp 
1 less than a month 

2 1-6 months 
3 6 months to a year 

4 1-2 years 
5 2-3 years 

6 more than 3 years 

4. I low would you rate your level of expertise witl 
Macintosh computers? 
beginner 1 2 3 4 5 6 expert 

5. If you added memory (DRAM) to your Macimos 
how much did you add? 
1 I MB 2 2 Mf3 
5 more than 8 MB 

3 4.\'IB 4 8M 
6 don't know how 1 

6. What type and size hard disk drives are pan of} 
1\tlacintosh system? 
1 internal hard disk 

2 external hard eli$ 
3 20 1v113 hard disk 

4 40MB hard disk 
5 80 MB hard disk 

6 other hard disk 
7 shared mass storage 

8 don't knonr 
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Tell Apple about your Macintosh 
and the documentation you received with it by ans,vering 
the questions below. Detach, fold, and seal this postage-paid 
fonn and mail it to Apple. 

Please circle the number of your answers below. If you 
have more than one answer to a question, circle all the 
numbers that apply. 

1. Which model of Macintosh do you use? 
1 Macintosh Plus 

2 Macintosh SE 
3 Macintosh SE/30 

4 Macintosh Ilci 
5 Macintosh !Icx 

6 Macintosh ll fx 
7 Macintosh Portable 

2. How would you rate your Macintosh O\'erall? 
poor 1 2 3 4 5 6 excellent 

3. How long have you been using .\·lacimosh computers? 
1 less than a month 

2 1-6 months 
3 6 months to a year 

4 1- 2 years 
5 2-3 years 

6 more than 3 years 

4. How would you rate your level of expertise with 
Macintosh computers? 
beginner 1 2 3 4 5 6 expert 

5. If you added memory (DRAM) to your Macintosh, 
how much did you add7 

1 1MB 2 2MB 3 4MB 48MB 
5 more than 8 MB 6 don'r know how much 

6. What type and size hard disk drives are part of your 
Macinrosh system? 
1 internal hard disk 

2 externtl l hard eli'* 
3 20 MB hard disk 

4 40 MB hard disk 
5 80MB hard disk 

6 other hard disk 
7 shared mass storage 

8 don'r know 

7. What type of expansion cards arc installed in your 
Macimo5h? 
1 none 

2 video 
3 memory 

4 coprocessor 
5 performance acceleraror 

6 communications or network 
7 other 

8 don't know 

8. To what type of network is your Macintosh connected? 
1 none 

2 LocalTalk 
3 EtherTalk 

4 TokenTalk 
5 od1er 

6 don't know 

9. If you share infonnation electronically, what method 
do you use? 
1 don't share electronically 

2 electronic mail 
3 AppleShare file server 

4 TOPS 
5 other 

6 don't know 

10. I low did you learn to use your Macintosh? 
1 Macintosh Basics tour disk 

2 Getting Started With l'our Macintosh 
3 Macintosh Reference 

4 knowledgeable friend or co-worker 
5 od1er non-Apple documentation 

6 class 
7 trial and error 

11. \X1hen you have questions as you work \\"ith your 
~·lacimosh, where do you go for help? 
1 Getting Stm1ed \Vith Your Macintosh 

2 Macintosh Reference 
3 knowledgeable friend or co-worker 

4 application software manual 
5 other non-Apple documentation 

6 authorized Apple dealer 
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12. If you used the /vlaciutos/i Basics tour disk, how much 
did it help you learn to use your computer? 
not at all 1 2 3 4 5 6 very helpful 

13. How useful were the illustrations in the Macintosh 
Rej'ere11ce for performing step-by-step actions? 
not at all 1 2 3 4 5 6 very useful 

14. How useful was the index in the Macilllosli 
Reference? 
1 haven't used it 

2 couldn't find what I needed 
3 found some information I needed 

4 usually find what I need 
5 always find what I need 

15. How useful was the glossary in the Maci/1/os/i 
Reference? 
1 haven't used it 

2 couldn't find what I needed 
3 found some information I needed 

4 usually find what I need 
5 always find what I need 

16. Have you kept the Special Options and Technical 
Informatioll booklet? 
1 no 2 yes 

17. If you could make one suggestion for improving 
the Macintosh computer, what would it be? 

• If you include additional pages of comments, send 
them in a stamped envelope to the address on the card. 

• Contact your aud1orized Apple dealer when you have 
questions about Apple products. Dealers are trained by 
Apple Computer and are given d1e resources to handle 
service and support. If you need the name of an Apple 
dealer in your area, call toll-free 800-538-9696. 

Thank you! 



Apple Computer, Inc. 
20525 .\lariani Avenue 
Cupenino, CA 95014 
( 408) 996-1010 
TLX 171-576 

030-4015-A 
Prinlccl in U.S.A. 



'he Apple Publishing System 
his Apple~· manual was written, edited, 
nd composed on a desktop publishing 
~stem using Apple Macintosh® 
:.>mputers and Microsoft Word. Proof 
ages were crc:ued on Apple 
aserWriter® printers and the QMS 
olorScript 100. Final pages were 
roduced in QuarkXPrcss and output 
irectly to film on a Linotronic 300. Line 
n and chapter openers were cre:ued 
sing Adobe lllustr;ltOr 88. 

tispla>' type is Apple's corporate font, a 
)ndensed version of Garamond. Text 
'Pt! is Adobe Garamond. Ornaments arc 
·c Zapf Dingbats. 

)StScript, the l.aserWriter page­
~scription language, was developed by 
:lobe Systems Incorporated. 
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